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Preface

Welcome to the Oracle Trade Management User Guide, Release 11i.

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ Oracle Trade Management.

If you have never used Oracle Trade Management, Oracle suggests you attend 
one or more of the Oracle Trade Management training classes available through 
Oracle University.

■ Oracle Self-Service Web Applications. 

To learn more about Oracle Self-Service Web Applications, read the Oracle 
Self-Service Web Applications Implementation Manual.

■ The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.

How To Use This Guide
The Oracle Trade Management User Guide contains the information you need to 
understand and use Oracle Trade Management.This guide contains twelve chapters:

■ Chapter 1 provides a brief introduction to Oracle Trade Management and 
introduces the new features.
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■ Chapter 2 describes the common business user flows for Oracle Trade 
Management and explains how you can manage different business scenarios in 
Oracle Trade Management.

■ Chapter 3 explains how to create customers and define relationships between 
customers. It also explains how to create and manage persons, and lists.

■ Chapter 4 explains how to create and work with products and pricelists.

■ Chapter 5 includes concepts and procedures for quota allocation. It explains 
how to create and manage quotas, and quota allocations.

■ Chapter 6 describes the features that are available in the Account Manager 
Dashboard, and explains how to make use of these features to plan and track 
sales activities.

■ Chapter 7 gives an overview of the trade planning and offers functionality, and 
explains how to create and manage offers.

■ Chapter 8 gives an overview of campaigns and programs, and explains how to 
work with campaigns and programs.

■ Chapter 9 gives an overview of the budgets functionality, and explains how to 
create and manage budgets.

■ Chapter 10 gives an overview of the claims functionality, and explains how to 
create and manage claims.

■ Chapter 11 gives an overview of chargeback, third party accruals, and indirect 
inventory tracking, and includes the related procedures. It also includes 
information on how claims related to Oracle Partner Management are handled 
in Oracle Trade Management.

■ Chapter 12 includes information on common components such as notes, tasks, 
attachments, and team options. It also includes information managing your 
user profile. You can also find information on system parameters, mandatory 
rules, locking rules, and trade profile.

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
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technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program Web site at http://www.oracle.com/accessibility/

Other Information Sources
You can choose from many sources of information, including documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle Trade Management.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). 

■ PDF Documentation - See the Documentation CD provided with each release 
for current PDF documentation for your product. This Documentation CD is 
also available on OracleMetaLink and is updated frequently.

■ Online Help - You can refer to Oracle iHelp for current HTML online help for 
your product. Oracle provides patchable online help, which you can apply to 
your system for updated implementation and end user documentation. No 
system downtime is required to apply online help.

■ 11i Release Content Document - Refer to the Release Content Document for 
new features listed release. The Release Content Document is available on 
OracleMetaLink.

■ About document - Refer to the About document for patches that you have 
installed to learn about new documentation or documentation patches that you 
can download. The new About document is available on OracleMetaLink.

Related Guides
Oracle Trade Management shares business and setup information with other Oracle 
Applications products. Therefore, you may want to refer to other guides when you 
set up and use Oracle Trade Management.

You can read the guides online by choosing Library from the expandable menu on 
your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.



xx

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Guides Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI). This guide also includes information on setting user 
profiles, as well as running and reviewing reports and concurrent processes.

You can access this user’s guide online by choosing “Getting Started with Oracle 
Applications” from any Oracle Applications help file.

Guides Related to This Product

Oracle Trade Management Implementation Guide
This guide provides detailed functional and integration setup information for 
Oracle Trade Management, which can be used by technical consultants, application 
administrators, and implementation team members.

Oracle Marketing User Guide
This guide explains the key features of Oracle Marketing such as Campaigns, 
Campaign Schedules, Programs, and so on.

Oracle Marketing Implementation Guide
This guide provides detailed functional and integration setup information for 
Oracle Marketing, which can be used by technical consultants, application 
administrators, and implementation team members.

Oracle Advanced Pricing User Guide
This document provides information on how to set up pricing features of Oracle 
Marketing.

Oracle Business Intelligence System Implementation Guide
This guide outlines the steps required to create the End User Layer (EUL) and 
import EUL Export File (EEX) for Oracle Discoverer.
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Oracle Discoverer Administration Guide
This document provides general information on the set up and administration of 
Oracle Discoverer. It includes features, terms, and information on how to use Oracle 
Discoverer with Oracle Applications.

SQL* Plus User’s Guide and Reference
This guide provides information and guidelines for SQL *Plus commands that can 
be used during list import.

Oracle Receivables User Guide
Use this user guide to learn how to implement flexible address formats for different 
countries. You can use flexible address formats in the suppliers, customers, banks, 
invoices, and payments windows in both Oracle Payables and Oracle Receivables. 
This user guide also explains how to set up your system, create transactions, and 
run reports in Oracle Receivables.

Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. This is a useful 
book, which you can read before installing Oracle Applications. This guide also 
introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications. 

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications, 
the Oracle8 technology stack, and the Oracle8i Server technology stack by 
automating many of the required steps. This guide contains instructions for using 
Oracle Rapid Install and lists the tasks that you must perform to finish your 
installation. You should use this guide in conjunction with individual product user 
guides and implementation guides.

Oracle Applications Supplemental CRM Installation Steps
This guide contains specific steps needed to complete installation of a few of the 
CRM products. The steps should be done immediately following the tasks given in 
the Installing Oracle Applications guide.
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Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists the database and product-specific upgrade tasks. You must be either at Release 
10.7 (NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 
11i. You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications
Use this guide to run the various AD utilities such as AutoUpgrade, AutoPatch, AD 
Administration, AD Controller, AD Relink, License Manager, and others. It contains 
how-to steps, screenshots, and other information that you need to run the AD 
utilities. This guide also provides information on maintaining the Oracle 
applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library components 
needed to implement the Oracle Applications user interface described in the Oracle 
Applications User Interface Standards for Forms-Based Products. It also provides 
information to help you build your custom Oracle Forms Developer 6i forms so that 
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
 This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.
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Other Implementation Documentation

Multiple Reporting Currencies in Oracle Applications
If you use the Multiple Reporting Currencies feature to record transactions in more 
than one currency, use this manual before implementing Oracle Trade Management. 
This manual details additional steps and setup considerations for implementing 
Oracle Trade Management with this feature.

Multiple Organizations in Oracle Applications
This guide describes how to set up and useOracle Trade Management with Oracle 
Applications' Multiple Organization support feature, so you can define and support 
different organization structures when running a single installation of Oracle Trade 
Management.

Oracle Applications Product Update Notes
Use this guide as a reference for upgrading an installation of Oracle Applications. It 
provides a history of the changes to individual Oracle Applications products 
between Release 11.0 and Release 11i. It includes new features, enhancements, and 
changes made to database objects, profile options, and seed data for this interval.

Oracle Workflow Administrator's Guide
This guide explains how to complete the setup steps necessary for any Oracle 
Applications product that includes workflow-enabled processes, as well as how to 
monitor the progress of runtime workflow processes.

Oracle Workflow Developer's Guide
This guide explains how to define new workflow business processes and customize 
existing Oracle Applications-embedded workflow processes. It also describes how 
to define and customize business events and event subscriptions.

Oracle Workflow User's Guide
This guide describes how Oracle Applications users can view and respond to 
workflow notifications and monitor the progress of their workflow processes.

Oracle Workflow API Reference
This guide describes the APIs provided for developers and administrators to access 
Oracle Workflow.
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Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle Trade Management implementation team, as well as for users responsible for 
the ongoing maintenance of Oracle Applications product data. This guide also 
provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on OracleMetalink

Oracle Applications Message Manual
This manual describes all Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.

Oracle Manufacturing APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Manufacturing.

Oracle Order Management Suite APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Order Management Suite.

Oracle CRM Application Foundation Implementation Guide
Many CRM products use components from CRM Application Foundation. Use this 
guide to correctly implement CRM Application Foundation.

Training and Support

Training
Oracle offers a complete set of training courses to help you and your staff master 
Oracle Trade Management and reach full productivity quickly. These courses are 
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organized into functional learning paths, so you take only those courses appropriate 
to your job or area of responsibility.

You have a choice of educational environments. You can attend courses offered by 
Oracle University at any one of our many education centers, you can arrange for 
our trainers to teach at your facility, or you can use Oracle Learning Network 
(OLN), Oracle University's online education utility. In addition, Oracle training 
professionals can tailor standard courses or develop custom courses to meet your 
needs. For example, you may want to use your organization structure, terminology, 
and data as examples in a customized training session delivered at your own 
facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Trade Management 
working for you. This team includes your technical representative, account 
manager, and Oracle’s large staff of consultants and support specialists with 
expertise in your business area, managing an Oracle server, and your hardware and 
software environment.

OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.
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Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle develops and markets an integrated line of software products for database 
management, applications development, decision support, and office automation, 
as well as Oracle Applications, an integrated suite of more than 160 software 
modules for financial management, supply chain management, manufacturing, 
project systems, human resources and customer relationship management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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1
Introduction to Oracle Trade Management

This chapter discusses the key features of Oracle Trade Management.

Sections in this chapter include:

■ Section 1.1, "Oracle Trade Management Product Overview"

■ Section 1.2, "Oracle Trade Management Key Features"

■ Section 1.3, "Oracle Trade Management Integrations"

■ Section 1.4, "What’s New in this Release"
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1.1 Oracle Trade Management Product Overview
Oracle Trade Management addresses the following critical business requirements of 
Business-to-Business (B2B) and Business-to-Consumer (B2C) industries.

■ Trade planning and offer management

■ Budget management

■ Claim and deduction management

■ Indirect sales management

Sales activities in these industries often suffer from poor sales planning and 
untested trade promotion activities. These organizations find it difficult to track and 
manage their budget spending, and track claims and deductions. They also face the 
problem of invalid deductions, whereby the retailers short pay invoices without 
valid reasons. If these deductions are not identified in a timely manner, they serve 
as interest-free credit to wholesalers and retailers. Other challenges are that these 
organizations face are those of co-ordinating the efforts between the different sales 
teams, and sharing timely information and reports.

Oracle Trade Management enables consumer goods industries to overcome these 
problems by offering end-to-end solutions including planning trade promotion 
activities, executing and tracking them, and researching and paying off the 
associated claims and deductions. With Oracle Trade Management, organizations 
can plan for trade promotion activities based on realistic data, track performance 
requirements, and monitor and track competitive products in the market. They can 
plan, execute, monitor, and track budgets and budget spending. Organizations can 
research, resolve, and manage claims and deductions. They can also track the sales 
activities, and accruals of indirect customers, and make payments accordingly.

1.2 Oracle Trade Management Key Features
The following sections describe the key features of Oracle Trade Management.

Customers, Products, and Pricelists
Customers are the entities with whom you do your business.You can create contacts 
for organizations and persons. You can also create and generate Lists. Partner and 
Partner Contact information is picked from Oracle Partner Management.

The Products functionality enables you to access product-related information and 
attributes that are required to better target, define, and manage sales and trade 
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promotion initiatives. This includes managing products and their price lists, 
tracking competitor products, and maintaining trade deals.

Quota Allocation
Quota is the total sales target (in terms of money or quantity of products) that must 
be achieved in a specific time period. Quota allocation is the starting point for the 
sales activities in an organization. You can define quota and allocate sales targets to 
Sales Representatives of different regions, and territories. You can monitor the sales 
activities and performance through the Account Manager Dashboard.

Account Manager Dashboard
Account Manager Dashboard is an integrated planning and controlling tool that 
enables you to plan trade activities based on realistic data. It provides solutions to 
achieve everyday sales objectives. You can view historical sales information, 
forecast sales, and calculate return on investments. Target allocation worksheets and 
account plans of customers enable you to efficiently plan, execute, and monitor 
sales activities. The reports and statistics give you an overall view of the sales 
activities of the organization. You can also collect information on the sales 
performance of competitors products, and view the relevant trends and reports.

Trade Planning and Offers
The Offers functionality simplifies the process of discount planning, execution, and 
tracking. You can plan and create different kinds of offers depending upon the 
requirements and the results to be achieved. You can associate offers with products 
or campaigns, predict the performance of new offers, and create adjustments to 
active offers. You can also track and monitor the costs and revenues for active offers.

Budget Management
The Budget functionality provides centralized information of all the sales and trade 
promotion activities, and fund usages. This enables you to plan and track fund 
usage and ensure that resources are deployed effectively. It offers access to historical 
sales and pricing information, which you can use to plan for budgets based on facts. 
You can create a budget, transfer funds between budgets, allocate a budget, accrue 
budget based on sales, and perform budget adjustments. You can create and reserve 
budgets for specific products or geographic locations. You can track budget 
utilization at any point of time, and view payment details and statuses of all the 
trade promotion activities that are associated with a budget.
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Claim and Deduction Management
Claims and deductions form an important aspect of B2B operations. Deductions are 
created when customers short pay for various reasons such as to claim 
compensation for shipping errors, pricing errors, and to claim promotional 
earnings. Customers submit claims for various reasons such as overpayments that 
have been made by mistake, compensation for damaged goods, claims for 
promotional accruals, and so on.

The Claims functionality enables organizations to shorten the claims-processing 
cycle, and reduce claims and the associated costs. Information related to all the 
claims is stored in a centralized manner. This makes it possible for you to access 
accurate views of promotional payments and other customer claims and disputes. 
You can research, validate, and settle deductions, charge backs, and claims. You can 
also identify invalid and duplicate claims and prevent unauthorized claims and 
deductions.

Indirect Sales Management
The Indirect Sales Management functionality enables manufacturers to validate 
requests from retailers and wholesalers (or dealers and distributors), and manage 
and track funds when trade promotion activities are executed indirectly through 
retailers and wholesalers. You can manage these scenarios, and validate, track and 
settle the related claims. The Indirect Sales Management functionality includes 
Chargebacks, Third Party Accruals, Indirect Inventory Tracking, Special Pricing, 
Soft Funds, and Referral Management.

1.3 Oracle Trade Management Integrations
The following sections describes how Oracle Trade Management integrates with the 
other Oracle applications.

General Ledger
GL entries are created when there are debits or credits. When you create offers, and 
book orders against the offers, the discount information and revenue is passed on to 
Oracle Receivables, and GL entries are created for the transaction. GL entries are 
also created when the budgets get utilized.

Oracle Advanced Pricing
Advanced options is an Oracle Advanced Pricing feature that enables you to define 
groups of modifiers where the modifiers in a group are incompatible with each 
other. Advanced Options enables you to accurately control the behavior of offers.
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Oracle Costing
During offer forecasting, the Return on Investment (ROI) is calculated by using the 
unit cost for the various products, and the discount information from the offer. 
Oracle Trade Management integrates with Oracle Costing for information on the 
actual Cost of Goods Sold. This information is used for calculating the promotional 
ROI.

Oracle Discoverer
Oracle Discoverer is a tool that you can access from Oracle Trade Management. 
Depending upon how Oracle Discoverer is implemented in your organization, it 
can be used as either a query tool to create and view user workbooks for extracting 
all the customer information from the database, or as a page with pre-defined 
reports that you select to run and refresh whenever reports must be updated.

Oracle Inventory
Oracle Trade Management integrates with the product and product category 
definitions in Oracle Inventory. All the features such as Budgets, Trade Planning 
and Offers, Claims, and Indirect Sales Management make use of these products and 
product definitions.

Oracle iStore
Offers that are created in Oracle Trade Management are visible in Oracle iStore. Any 
accrual offer that applies on Oracle iStore orders can be tracked in the Budgets 
module in because the Funds Accrual Engine fetches information back from all 
ordering channels, including Oracle iStore.

Oracle Marketing
Campaigns, programs, and events that are created in Oracle Marketing can be 
associated with offers and budgets in Oracle Trade Management.

Oracle Partner Management
Oracle Trade Management integrates with Oracle Partner Management such that 
when there are fund requests related to Special Pricing, Soft Funds, and Referrals, 
the funds are sourced from budgets in Oracle Trade Management. The budget 
source can be specified as a profile value. Offers and claims are automatically 
created in Oracle Trade Management; these claims are settled by the claims user.
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Oracle Payables
Promotional payments related to Oracle Trade Management are made and adjusted 
through Oracle Payables. The budgets and offers get updated with all the payment 
information.

Oracle Receivables
When customers make payments against orders that are shipped, all the payment 
information is updated in Oracle Trade Management. When customers take 
deductions, or make overpayments, deductions and overpayments are 
automatically created in Oracle Receivables and passed on to Oracle Trade 
Management.

Oracle Task Management
Oracle Trade Management integrates with Oracle Task Management in Offers and 
Claims. For Offers, tasks can be generic tasks such as printing the offer to customer 
for customer review. For Claims, tasks are the research activities that a user goes 
through for a claim. For example, verify proof of delivery, call customer to get 
information for the claim, and so on.

Oracle Trading Community Architecture - Data Quality Management
During chargeback and third party accrual data processing, information regarding 
the end customers such as sales, identification, PO number, product number and 
price is captured and stored. The end-customers are created as parties and accounts 
in Oracle Trading Community Architecture (TCA). The Chargeback module 
integrates with the Data Quality Management (DQM) application available in TCA 
to search for duplicate data. During chargeback or third party accrual submission, 
based on data checking rules that are set up in DQM, the chargeback system finds 
the corresponding party ID that has been set up in TCA. If the party does not exist, 
a new party will automatically be created in TCA.

Oracle Territory Management
Territories that are used in Oracle Trade Management for various purposes such as 
budget allocation, quota allocation, and defining markets are created in Oracle 
E-Business Suite Territory Management module.

Order Management
When a customer places an order against an offer, orders are created in Order 
Management. Reference information of the order such as product number, units, 
quantity, value and discount, as well as the offer details are updated in Oracle Trade 
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Management. Budgets and offers get updated with this information accordingly. 
Orders can be created either automatically or manually.

Tax Engine
When promotional accruals are created based on sales orders, taxes may have been 
charged to customers, and tax liability may have been accrued. When claims are 
paid, some of the tax liability may be recovered, and the total claim amount may 
consist of promotional accruals and also the tax recovery amount. The Tax Engine 
provides an estimate of taxes before transactions are interfaced into Oracle 
Financials or Order Management. Oracle Trade Management integrates with the Tax 
Engine to get a quote of the estimated tax amount.

1.4 What’s New in this Release
The current release of Oracle Trade Management includes a few new features, and 
enhancements to the existing features.

Topics included are:

■ Section 1.4.1, "New Features"

■ Section 1.4.2, "Trade Planning and Offer Enhancements"

■ Section 1.4.3, "Budget Enhancements"

■ Section 1.4.4, "Claim Enhancements"

■ Section 1.4.5, "Third Party Accrual Enhancements"

1.4.1 New Features
The following sections describe the new features in this release.

Quota Allocation
Quota is the total sales target (money or quantity of products) that must be achieved 
in a specific time period. Quota allocation is the process of allocating sales targets to 
individual Sales Representatives of different regions, and territories. The Quota 
Allocation functionality enables you to:

■ Create sales forecasts and create quota based on this data

■ Define market eligibility and product eligibility for a quota

■ Add thresholds to a quota
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■ Create quota allocations

■ Allocate targets by accounts and by products

Account Manager Dashboard
Account Manager Dashboard is an integrated planning and controlling tool that 
enables organizations to plan trade activities based on realistic data. The Account 
Manager Dashboard includes the following features:

■ Target Allocation

Target allocation is the process whereby targets are automatically allocated to 
the customer accounts of the Sales Representatives. The target allocation will be 
automatically generated based on the sales figures during the same period in 
the previous year. If you are a Sales Representative, then you can track and 
analyze the total target allocated by the Sales Management. The Sales 
Management can view the target allocation and the performance of individual 
Sales Representatives.

■ Account Planning

An account plan gives you an overall view of the activities related to the 
customer account. You can access information such as sales promotions, 
outstanding claims, competitive products, and all other activities that are 
related to the customer account. Tools such as the Offer Evaluator, Offer 
Worksheet, and Discount Calculator enable you to forecast, plan, create, and 
evaluate trade promotion activities such as offers and campaigns, and evaluate 
potential returns. You can generate graphs based on different account and 
product combinations. The Retail Monitoring functionality enables you to 
capture retail pricing and competitive intelligence.

■ Alerts and Notifications

The Administrator can create threshold rules, which highlight any exceptional 
conditions through alerts and notifications. Alerts appear either as workflow 
notifications, or as dashboard alerts.

Chargeback
The Chargeback functionality enables organizations such as pharmaceutical 
industries and food service industries to process rebates and chargeback claims for 
their customers and their wholesaler network.

You can import indirect sales data or Point Of Sales data (POS data) into Oracle 
Trade Management, calculate the earnings and initiate payment for each transaction 
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batch or for multiple batches. You can validate the chargeback transactions, and 
either process or reject the transactions based on whether they are valid or invalid. 
By automating the whole process, companies can minimize discrepancies in 
chargeback requests and reduce time required to process chargeback adjustments.

Indirect Inventory Tracking
The inventory levels of wholesalers can be automatically tracked in Oracle Trade 
Management. You can track the quantity of products that wholesalers have 
purchased from your organization and the quantity of products that they have sold, 
and also make adjustments to the wholesalers’ inventory levels.

Oracle Partner Management Business Flow Support
Special Pricing, Soft Funds, and Referrals are features that are available in Oracle 
Partner Management. Funds for requests related to Special Pricing, Soft Funds, and 
Referrals are sourced from budgets in Oracle Trade Management. Offers and claims 
are automatically created in, and settled through Oracle Trade Management by the 
claims user.

■ Special Pricing

Partners can request special pricing from a portal for three types of special 
pricing including Meet Competitor Quote, Blanket Request, and Bid Request. 
The process of submitting, and approving requests is managed through Oracle 
Partner Management. Special pricing requests can also be submitted in Oracle 
Trade Management on behalf of the partner.

■ Soft Funds

In the earlier releases, manufacturers were able to manage the soft funds by 
using the budgets and offers functionality. In this release, partners can also 
manage the whole process through Oracle Partner Management.

■ Referrals

A partner (retailer or wholesaler) can refer a business prospect, lead, or an 
opportunity to a vendor (manufacturer). If the referral results in an order, the 
partner can claim incentive for the referral.

1.4.2 Trade Planning and Offer Enhancements
The offer enhancements in this release include the following:

■ Autopay for offers
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You can specify the payout date and payment method for Autopay at the offer 
level.

■ Volume-based performance requirements

The enhanced performance requirements functionality enables you to structure 
trade deals with performance requirements that are based on volume and 
value. You can create incentives that have quantifiable objectives, and this 
increases the predictability of an offer.

■ Offer adjustment enhancement

The enhanced offer adjustment functionality supports unlimited backdating 
functionality.

■ Net Accrual offer

Net Accrual offer is a new offer type, which bypasses Oracle Advanced Pricing. 
It directly processes order transactions data and applies accruals based on the 
net sales of the specified product, or for the specified customer.

1.4.3 Budget Enhancements
The budget enhancements in this release include the following:

■ Profile-driven GL postings

In this release, GL entries for accruals are created based on a profile option 
setting. The setting can be either Ship Confirmed or Invoiced.

■ Additional earned column with GL postings tracking

The price adjustments and accruals that are estimated before the order is 
ship-confirmed are tracked in the Utilized column. An extra column called 
Earned tracks all the adjustments and accruals based on the status of the order. 
Certain types of users can view the GL postings for better tracking and 
reconciliation purposes.

■ Option to post off-invoice discounts

You can create debit and credit entries to account to account for off-invoice 
amounts as promotional expenses. This enables you to account off-invoice 
discounts as expenses rather than reductions in revenue.

■ Facility to view transaction information from the Budget Checkbook

You can view the invoice and shipment information of an order through the 
Budget Checkbook.
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■ Budget mass transfer (transfer of committed but un-earned funds)

When you copy a budget to create a new version for the upcoming year, a 
transfer program automatically transfers funds that are committed, but are not 
yet earned. Offers that span multiple fiscal periods can therefore have the 
earnings tracked in the right budget.

1.4.4 Claim Enhancements
The claim enhancements in this release include the following:

■ Ability to handle subsequent receipts

When customers pay for invoices that were short paid earlier, or deducted, 
Oracle Trade Management receives notifications through Oracle Receivables. 
Thus, claim amounts and receipts get mapped between the two applications.

■ Netting overpayments and deductions

Netting of overpayments and deductions enables you to offset an overpayment 
with a deduction.

■ Customer reason code mapping

The claim reason codes used by the customer can be imported and matched 
with your organization’s internal reason codes. When the cash application 
processes take place in Oracle Receivables, the customer reason codes are 
automatically translated to internal reason codes.

■ Total write-off solution

Total write-off solution enables you to write off claims below a certain 
threshold. You can also choose a write-off activity to determine where the 
write-off expenses will be absorbed.

■ Passing memo lines

Passing memo lines refers to passing all the parameters that can be used for 
configuring the necessary GL accounts.

■ Mass claims

You can perform functions such as mass update and mass approval, and 
efficiently process the settlement of multiple claims.

■ Paying earnings over thresholds

When a customer gets paid more than the actual accrual, you can set up a 
threshold limit for the overpayment, and maintain control over the payments.
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■ Autopay enhancements

Autopay enhancements include performance validation, mapping to GL period, 
as well as enhanced buying group and account relationships support.

1.4.5 Third Party Accrual Enhancements
The earlier releases include the Third Party Accrual API, which enables 
manufacturers to import any indirect sales data into the system. Based on an Oracle 
Advanced Pricing simulation call, accruals can be calculated and be placed into 
different budgets. Third Party Accrual enhancements in this release include:

■ Ability to upload data through multiple sources

You can load third party accrual data into the Point Of Sales (POS) tables either 
through a web interface, or through an XML data feed by using the XML 
Gateway. Indirect customer data is validated and deduped during the loading 
process. Based on the POS data, you can create party relationships between the 
indirect customer and direct customer. This enables you to have a 
comprehensive view of your indirect customers.

■ Ability to configure the processing of Indirect Sales Data

You can specify the type of processing that must be done on the indirect sales 
data at the system level, and account level. This enables you to process rebates 
only from authorized accounts.

■ Ability to maintain cross-reference information for each account

You can map the codes and IDs that are used by customers, with the internal 
codes and IDs.

■ Pay earnings

You can specify the payment frequency (immediately, weekly, monthly, 
quarterly) at the account level. Even though the amounts are accrued during 
processing, the payment gets processed based on the account setup. This 
enables you to schedule payments based on the type of contractual agreements 
that your organization has with the customers.
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2
Business User Flows

This chapter describes the common business user flows for Oracle Trade 
Management.

Sections in this chapter include:

■ Section 2.1, "Overview"

■ Section 2.2, "Account Manager Dashboard Flow"

■ Section 2.3, "Trade Promotion Forecasting to Execution"

■ Section 2.4, "Creating an Offer-related Claim and Settling it by Check Payment"

■ Section 2.5, "Deduction to Auto-Resolution for Non-Invoice Deduction"

■ Section 2.6, "Top-down Bottom-up Budgeting"

■ Section 2.7, "Volume Accrual"
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2.1 Overview
The business user flows included in this chapter describe the end-to-end process for 
a few common tasks and activities that you can execute in Oracle Trade 
Management. These business user flows will enable you to understand the budgets, 
offers, and claims functionality. You can also understand the background processes, 
and the role of concurrent programs in these processes.

Oracle Trade Management integrates with Oracle Receivables, Oracle Payables, and 
Order Management. Some of the steps included in the flows may need to be 
executed in Order Management, Oracle Receivables, and Oracle Payables. These 
actions are performed by the respective users and have been included in the flows 
for your understanding only. To perform these steps, you must log into Oracle 
Forms with the appropriate responsibility. The logins, users, and responsibilities, 
and some of the data used in these flows are seeded in the Vision demonstration 
database.

2.2 Account Manager Dashboard Flow
This business user flow describes how to use the Account Manager Dashboard to 
view the target allocation, access account plans, create and evaluate offers by using 
offers evaluator and offer worksheet, and capture retail pricing information of your 
products as well as the competitors’ products. It also describes how you can make 
use of various tools in the Account Manager Dashboard to analyze sales 
performance.

2.2.1 Dependencies and Prerequisites
■ Integration with Oracle Payables and Oracle Receivables must be set up.

■ Territories must be set up for quota allocation.

■ The workflow background process with the parameter AMS Marketing Generic 
Approvals must be running to initiate an approval notification to the Budget 
Approver to approve the budget.

■ The following concurrent programs must be running in the background:

■ OZF-TM: Refresh Account Manager Dashboard: to refresh the data on the 
dashboard.

■ OZF-TM: Refresh Materialized View for Order Sales: to refresh the 
materialized view that summarizes the order data from Order 
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Management, and which is the source for all order sales information used 
across Oracle Trade Management.

■ OZF-TM: Refresh Trade Management Activities (Offers and Schedules): to 
populate de-normalized tables with up-to-date information of new and 
changed Offer and Schedules.

2.2.2 Scenario
The Sales Management of Vision Industries targets to sell 10 million product units 
in the year 2005-2006. The sales activities of Vision Industries span across many 
territories and regions in USA. The Sales Management has allocated this total quota 
number to the Sales Representatives in these territories and regions. You, the Sales 
Representative in California have received a quota of 1,00,000 product units that 
you must achieve during this year.

You must now evaluate and create offers to achieve the desired results. The Sales 
Management has also requested you to submit quarterly sales reports, which will 
include information such as the sales performance for individual accounts, budget 
spending for each account, and retail pricing information of similar competitor 
products.

2.2.3 Process Flow Diagram
Figure 2–1 illustrates the Account Manager Dashboard flow starting from quota 
allocation to viewing the budget summary and claim summary of customer 
accounts.

Note: The Administrator in your organization should automate 
these concurrent programs by scheduling them to run regularly.
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Figure 2–1 Account Manager Dashboard Flow

2.2.4 Procedure

Step 1: Create Quota
Quota is the total sales target (in terms of money or quantity of products) that must 
be achieved in a specific time period. The Sales Management first creates a quota 
and then allocates the quota.

a. Login as trademgr/ welcome. This user has Oracle Trade Management 
Super User responsibility.

b. Navigate to Quota > Quotas.

c. Click Create.

Enter the following information.

Note: Steps 1-3 will be performed by the Sales Manager with the 
Oracle Trade Management Super User Responsibility.

Field Value

Setup Type Fixed

Name QuotaFY05
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d. Click Create.

e. Click Request Approval.

Step 2: Activate Quota
If Quota Approval is checked under Custom Setup, then the quota must go through 
the quota approval process to become active.

a. Log in to Oracle Trade Management as trademgr/ welcome. This user has 
Oracle Trade Management Super User responsibility.

b. Log into Oracle Trade Management as Oracle Trade Management Super 
User, and navigate to Workflow > Worklist. You can also launch the 
worklist by navigating to Home > Tools > View Notification Work List.

The list of open notifications is displayed.

c. Select the notification that you sent during quota creation.

d. Click Approve.

Number Enter a unique number for the quota.

If you do not enter a number, the system automatically 
generates a number when you create the quota.

Owner The quota owner will by default be the person who is creating 
the quota.

Quota 100,00,000

This is the total quota that must be allocated.

Start Period Jan 2005

This is the period from which the quota will be active.

End Period Jan 2006

This is the period until which the quota will be active.

Time Spread Select a time spread.

Threshold Optionally, add a threshold to the quota.

Description Optionally, write the description for the quota.

Field Value
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Step 3: Create Quota Allocation
Quota allocation is the process by which the Sales Management distributes targets 
to each level in a sales team hierarchy. If you are the Sales Manager, you can create 
any number of quota allocations from a quota. You can create allocations for 
different hierarchies within the selected territory, and for different time periods, as 
long as the quota remains active. Use the following procedure to create a quota 
allocation.

a. Log into Oracle Trade Management as trademgr/ welcome. This user has 
the Oracle Trade Management Super User responsibility.

b. Navigate to Quota > Quotas 

c. Select the Quota you created and click on the link to open it.

d. Click the Allocation side navigation link.

e. Click Create. 

Enter the following information:

f. Click Generate.

g. In the Allocation Worksheet, enter the Total and Reserve quota numbers for 
each of the territories.

h. Click Update.

i. Click Publish.

The allocation status changes to Planned.

Field Value

Action Create a new allocation from this quota

Hierarchy Use your own hierarchy.

Start Level Country

End Level City

Start Point Select a start point.

Active From Enter Start Date.

Method Manual

Allocation Amount Enter the allocation numbers. This must be lesser than the quota 
numbers.
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Step 4: View Quota Allocation, Target Allocation, and Product Spread
If you are the Sales Representative, you will receive notifications after the process of 
quota allocation is complete. As the first step, you can view the targets that have 
been allocated to you by logging into the Account Manager Dashboard. The quota 
allocated to you will be automatically reallocated to each of your customer 
accounts. This automatic allocation is known as Account Allocation or Target 
Allocation. The target allocation worksheet gives you a comprehensive view of how 
the quota has been allocated to each of your accounts. It displays the targets that 
you must achieve for each of the accounts. After the process of quota allocation is 
complete, product spreads will also be automatically generated for each account. 
The generated product spreads are based on the product eligibility that the Sales 
Management has defined. The product spread for an account appears as a 
worksheet and displays the products and the product allocation numbers either on 
monthly basis or quarterly basis; this depends on the time spread that the Sales 
Management has selected while creating the quota. 

a. Log into Oracle Trade Management as trademgr/welcome. This user has 
the Account Manager responsibility.

b. Click Account Manager Dashboard.

c. Click the Quota Summary quick link.

The list of quotas that have been allocated to you will be displayed here.

d. To view the target allocation for a quota, click the Account Allocation icon 
corresponding to the quota.

All the accounts that you are responsible for will be listed in the Target 
Allocations Worksheet page; you can see that targets have been 
automatically allocated to each of the accounts.

The allocation will be based on the sales figures during the same period in 
the previous year. If there is any unallocated target, it will be accounted for 
in the general category--Others.

e. To view the product spread for a quota, click the Product Spread icon 
corresponding to the customer account whose product spread you would 
like to view. To view the product spread for a bill-to or sold-to location of a 
customer account, first expand the customer account and then click the 
Product Spread icon corresponding to the bill-to or sold-to location.

The product spread will be based on the sales figures during the same 
period in the previous year. If there are any unallocated products, they will 
be accounted for in the general category--Others.
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Step 5: View Account Plans
After the process of quota allocation is complete, individual account plans are 
automatically created for each account and each of the bill-to and sold-to locations 
of the respective account.

a. Log into Oracle Trade Management as trademgr/welcome. This user has 
the Account Manager responsibility.

b. Click Account Manager Dashboard.

c. In the My Accounts region, drill down the customer account whose account 
plan you wish view.

The Account Plan for the selected customer appears. You can view the 
quota details, activity summary, manufacturer’s activities, retailer’s 
performance, and retail price point details.

Step 6: Evaluate Offers
To achieve your targets, you must now start evaluating and creating offers to 
encourage the customers to buy products. Offer evaluator enables you to search for 
a list of offers that fit specific criteria such as customers, products, territories, costs, 
and return on investments. You can copy each offer that you select from the offers 
evaluator, as an offer worksheet. By using the offer worksheet, you can create new 
offers of the offer types--Accrual, Off-invoice, Lump sum, Scan Data, and Volume. 
After you copy an offer as a worksheet, you can evaluate and create offers that will 
fetch the desired return on investments. When you create an offer from the offer 
worksheet, you can use the discount calculator to obtain a forecasted ROI value. 
You can also enter your own discount values and modify them. You can enter the 
performance requirements for the offer, create an offer forecast, and create new 
offers. 

a. Log into Oracle Trade Management as trademgr/welcome. This user has 
the Account Manager responsibility.

b. Click Account Manager Dashboard.

c. Click the Offer Evaluator Quick Link.

d. You can do either one or all of the following to search for offers based on 
specific criteria:

* To search for offers based on the products or product categories that are 
defined in the offer, select either Item or Category from the Item Filter 
drop-down list, and select a value from the LOV.
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* To search for offers based on qualifiers such as the customer name, 
bill-to and ship-to locations, buying groups, lists, segments or so on, 
select a value from the Qualifier Filter drop-down list, and select a 
value from the LOV.

* To search for offers based on parameters such as the forecasted ROI, 
actual ROI, start date, and end date of the offer, click Advanced Search.

e. Click Go.

All the offers that match the specified criteria are displayed.

f. Optionally, click the hyperlink of the offer to view the offer details.

g. Optionally, select the offers and click Gantt Chart to display the offers in 
the form of a Gantt chart.

h. Optionally, select an offer and click Export to save the offer as a .csv file.

i. Optionally, select the offers and click Copy to Worksheet to copy the offers 
as an Offer Worksheet.

The selected offers are copied as offer worksheets and are displayed in the 
Worksheet Summary page.

j. Click the Offer Worksheet quick link.

k. To evaluate an existing offer worksheet, click the corresponding Details 
icon.

The Worksheet Details page displays information such as the offer name, 
offer code, currency code, and so on. This information is picked from the 
offer that was converted into the offer worksheet.

l. As the first step, enter the following information in the Offer Details region.

* Select an offer type from the Offer Type drop-down list.

* Select an Activity, Start Date, and End Date for the offer.

* Select a Price List, and the Forecasted UOM. This information will be 
used for creating the offer forecast.

m. Optionally, complete the following steps in the Qualifiers Selection region:

* Click Add Another Row to specify the conditions based on which the 
customers will be eligible for offer.

* Select a value from the Qualifier drop-down list, and select a value from 
the Name LOV. For example, to apply the offer for a selected list, select 
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List from the Qualifier drop-down list, and select the appropriate list 
name from the Name LOV.

* To delete a qualifier, select the qualifier and click Delete.

n. To obtain forecasted ROI for the offer, click the Worksheet sub tab and 
complete the following steps for each row:

* Select values for Item Level (product or product category), and the Item 
name.

* Enter the other values as required.

* Optionally, click Add Another Row to add another Item.

* Optionally, to delete a row, select the row and click Delete.

* Click Discount Calculator.

* Click Apply in the Discount Calculator page.

The forecasted revenue, forecasted costs, and the forecasted ROI are 
displayed. You can use the ROI information to offer optimum discount. 
Repeat these steps by entering different discount values till you arrive 
at a desired forecasted ROI.

o. To specify performance requirements for the offer, click the Performance 
sub tab and complete the following steps for each row:

* Click Add Another Row to add a new performance requirement.

* Select the Item Level, and the Item Name. This is the product item or 
category for which performance requirements will be defined.

* Select a value from the Trade Medium LOV. The list of values that 
appears is set by the Administrator.

* Select the Start Date and End Date. The start date and the end date 
determine the time period within which the requirement must be 
executed.

* Enter a value in the Estimated Value field, and select the Required 
check box to make it mandatory for the customer to execute this 
requirement to qualify for the offer.

* Optionally, click Add Another Row to define performance 
requirements for another product or product category.

* Optionally, to delete a row, select the row and click Delete.
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p. To create an offer forecast, click the Forecast sub tab and complete the 
following steps:

* Select a value from the Forecast Basis drop-down list.

* Select a time spread, and optionally click the Increment Quota check 
box. The time spread that you select determines how the forecast will 
be divided. For example, if you select the time spread as monthly, then 
the forecast will be divided on a monthly basis.

* Enter the forecasted quantity of products. This is the quantity of 
products that you expect to sell.

* If you selected the Offer Code as the forecasted basis, then select an 
offer code from the Offer Code LOV.

* Click Generate Actuals.

q. After you have satisfactorily evaluated the offer, click Save as Offer to save 
the worksheet as an offer.

Step 7: View Sales Performance Graphs
During the target allocation process and offer creation process, you can view the 
sales graphs to analyze past sales performance. You can select various combination 
based on the customer and ship-to sites, product categories and products, and the 
time (start date and end date). In the graphs, the sales numbers (quota, current 
sales, prior year sales) are displayed in lines. The cost numbers (list price, costs of 
goods, margin, and discount) are displayed as columns.

a. Log into Oracle Trade Management as trademgr/welcome. This user has 
the Account Manager responsibility.

b. Click Account Manager Dashboard.

c. In the My Accounts region, drill down the customer account.

d. In the Activities sub tab, click Sales Analysis.

e. Select the period for which you wish to generate the graph. To generate the 
graph for a specific date range, select the From and To dates.

f. Select a Time Spread based on how you wish to display the graph.

For example, to generate a graph for the data on a monthly basis, select 
Time Spread = monthly.

g. Select from either Line or Bar graph type depending on how you wish to 
display the graph.
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h. Select an Item Type and Account Type from the respective drop-down lists.

The item type and account type that you select here will determine the 
values for which you can generate the graphs. For example, if you select 
Item Type = Products, and Account Type = Accounts-Ship To, then all the 
products, and ship-to locations for the customer account will be listed. You 
can choose a combination from these values to generate the graph.

i. Choose a combination from the displayed values by checking the products/ 
product categories, and the accounts; the graph will be generated based on 
the values that you select here.

j. Click Apply.

Step 8: Update Retail Pricing Information
You can record the retail prices at which a retailer sells your products. You can also 
update information and keep track of competitive products and the prices at which 
they are sold. This enables you to keep a track of competitive products and the 
associated prices. You can use this information to plan for offers and trade 
promotions in an optimal way.

a. Log into Oracle Trade Management as trademgr/welcome. This user has 
the Account Manager responsibility.

b. Click Account Manager Dashboard.

c. In the My Accounts region, drill down the customer account.

The Account Plan for the selected customer appears.

d. Click the Retail Price Points sub tab and click Update Retail Pricing.

e. To update retail pricing information for your products:

* Enter the details as required.

* Optionally, click Add Another Row to add a new product, and select a 
product. Enter the details as required.

* Click Apply.

f. To view and update competitor product details:

* Click the Competitor icon corresponding to the product for which you 
would like to update the competitor information.

* Modify the details as required.
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* Optionally, click Add Another Row to add a new competitive product. 
Enter the details as required.

* Click Apply.

Step 9: View Budget Summary and Claim Summary
The budget summary report summarizes the budget utilization for each customer 
account. The claim summary report gives a summary of claims for each of the 
customer accounts. You can use this information to create reports on the budget 
spending for each account.

a. Log into Oracle Trade Management as trademgr/welcome. This user has 
the Account Manager responsibility.

b. Click Account Manager Dashboard.

c. In the Quick Links region:

* Click Budget Summary to view the budget summary report.

The budget summary gives you a consolidated report of the Available, 
Planned, Committed, Utilized, Earned, and Paid amounts for each cus-
tomer account.

* Click Claim Summary to view the claim summary report.

The claim summary gives you a consolidated report of the total amount 
that is claimed, the number of open claims, and the claims that have 
been due for more than 30 days, 60 days, and so on, for each customer 
account.

2.3 Trade Promotion Forecasting to Execution
This business user flow describes how to use Oracle Trade Management to forecast 
product sales for an offer to a customer, create and ship orders, update the budget 
associated with the offer, pay the customer automatically, and settle the claim.

2.3.1 Dependencies and Prerequisites
■ Integration with Oracle Payables and Oracle Receivables must be set up.

■ The workflow background process with the parameter AMS Marketing Generic 
Approvals must be running to initiate an approval notification to the Budget 
Approver to approve the budget.
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■ The workflow background process with the parameter Claim Settlement must 
be running to close the claim.

■ The following concurrent programs must be running:

■ OM Order Line: to generate an invoice from an order that is created in 
Order Management

■ Pick Release Process: to pick, and pack a sales order

■ Interface Trip Stop: to ship a sales order to the customer location

■ Funds Accrual Engine: to update the budget that is related to the offer and 
the order

■ Autopay: to automatically create a claim for the customer

■ AutoInvoice: to validate and import records as completed transactions into 
Oracle Receivables

■ Claim Settlement Fetcher: to close the claim that you have prepared to settle

2.3.2 Scenario
Vision Industries has manufactured and launched a new product. Because the 
product is new in the market, not many customers are aware of the product, and the 
product has not been selling well. The Sales Management decides to promote the 
product. The Sales Management assigns you the responsibility of creating a plan to 
promote and advertise this product in the market.

You, the Sales Manager decide to promote this product by creating an accrual offer 
to give delayed discounts on purchases of the new product within the first three 
months. You wish to find out how well the offer would perform, and then activate 
the offer. You also plan to settle accruals and pay customers automatically.

2.3.3 Process Flow Diagram
Figure 2–2 illustrates the Oracle Trade Management application process flow from 
forecasting product sales for an offer to a customer, to settling the claim.

Note: The Administrator in your organization should automate 
these concurrent programs by scheduling them to run regularly.
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Figure 2–2 Trade Promotion Forecasting to Execution

2.3.4 Procedure
Follow the steps in this section to complete this flow.

Step 1: Create a Budget
A Budget is a pool of money, which you can use to fund trade promotion activities 
such as offers and campaigns. As the first step, you create a budget for $5,00,000. 
This budget can be used for general sales and trade promotion purpose. You can 
use this budget to source an accrual offer to offer delayed discounts to your 
customers.

a. Login as trademgr/ welcome. This user has Oracle Trade Management 
Super User responsibility.

b. Navigate to Budget > Budgets.

c. Click Create.

Enter the following information.

Field Value

Budget Type Fixed

Name New Product Promotion

Number Enter a unique number for the budget. If you do not enter a 
number, the system automatically generates a number.
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d. Click Create.

The budget status appears as Draft.

e. Click Request Approval.

f. Click Confirm.

The budget status changes to Active.

g. Click Update.

Step 2: Approve the Budget
If Budget Approval is checked under Custom Setup, then the budget must go 
through the budget approval process to become active. You can source funds for 
sales and trade promotion activities from a budget only if it is active.

a. Log into Oracle Trade Management as trademgr/ welcome. This user has 
Oracle Trade Management Super User responsibility.

b. Log into Oracle Trade Management as Oracle Trade Management Super 
User, and navigate to Workflow > Worklist. You can also launch the 
worklist by navigating to Home > Tools > View Notification Work List.

The list of open notifications is displayed.

Parent Budget Select the Parent Budget name to source funds for the New 
Product Promotion budget from a parent budget.

Category Select a budget category.

Budget Amount $5,00,000

If this is a child budget, you must enter an amount lesser than 
the funds that are available in the parent budget. However, it 
also depends on how many child budgets the parent budget 
has.

Holdback Amount You can define your own depending on how much money you 
want to reserve before allocating it to be spent.

Currency US Dollar

You can select your own currency depending upon the 
requirement.

Description Optionally, write the description for the budget.

Field Value
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c. Select the notification that you sent during budget creation.

d. Click Approve.

Step 3: Create an Accrual Offer
In this step, you will create an accrual offer to provide 10% discount on each unit of 
the product, which customers purchase. An accrual offer enables you to give 
delayed discounts on items that the customer or distributor purchases. The 
discounts get accrued over a period of time, and customers can later claim this 
amount. You can also enter the minimum quantity or amount that the customer 
must purchase to get the discount.

a. Login as trademgr/ welcome. This user has Oracle Trade Management 
Super User responsibility.

b. Navigate to Trade Planning > Offers > Create.

Enter the following information:

Field Value

Setup Type Accruals

Offer Name Enter a name for the offer.

Customer Select the customer type and customer name.

Customers can be Buying Groups, Bill-to Customers, Sold-to 
customers, Lists, Territories, Segments. The values change 
depending upon the customer type that you select.

Offer Code Enter a code for the offer.

The offer code must be unique. The system automatically 
generates an offer code if you leave this field blank.

Request Only Checked

Do not check if you want to use an Automatic Offer.

Start Date Enter the system date (Required to create a forecast for the 
offer).

End Date A year from the system date (Required to create a forecast for 
the offer).

Currency US Dollar

You can select your own currency depending upon the 
requirement.
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c. Click Create.

d. Enter the offer details and review the offer information.

e. Scroll down to Discount Rules.

Enter the following information.

f. Click Update.

Step 4: Create Promotional Offer Forecast
You can create an offer forecast for the customer and product to find out how well 
the offer may perform. It enables you to determine whether the offer will provide 
the required promotional lift and yield the desired results. A forecast is created 

Discount Level Select either Line or Group of Lines.

Owner Select the name of the budget owner.

Budget New Product Promotion

Reusable Checked

Campaign Optionally, attach a campaign to the offer.

Description Optionally, write the description for the offer.

Field Value

Level Item Number

Name Select Item (Product)

UOM Enter the unit of measurement for the product.

For example, to offer discount on each unit, select UOM as Each.

Tier Type Single

Minimum Volume 1

Volume Type Quantity

Discount 10

Discount Type Percent

Field Value
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based on historical data. The offer must be in Draft status in order to create the 
forecast.

a. Navigate to Trade Planning > Offers.

b. Click the name of the offer that you created in Step 4.

c. Navigate to Planning > Forecast > Create.

Enter the following information.

You can select different dimensions for the Forecast. Dimensions available 
are Product (Product selected for the Offer), Market (Customers selected in 
Market Eligibility for the Offer), and Time (Range based on Period View). 
You can freeze the forecast after you create it. Freezing the forecast ensures 
that the data is not changed or edited by someone else. You cannot modify a 
forecast after it is frozen.

Note: The concurrent program AMS-TM: Refresh Materialized 
Views must be run to update Base Sales and Actual Sales. This 
concurrent program can be automated by scheduling it to run 
regularly. It updates the forecasting information to show the 
historical purchase of the product for the customer from the 
previous year period. You will use this information to create a 
forecast for your offer.

Field Value

Base Volume Number that is generated from the previous year.

Start Date Same as the Offer Start Date.

End Date Same as the Offer End Date.

Total Forecast Quantity Enter the total number of products that you plan to sell.

Forward Buy Double previous forecast number.

Automatic Spread Baseline Ratio

Time Time

Period View 13 weeks

Forecast By Product
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d. Click Calculate.

e. Click Manufacturer’s ROI.

f. Select Price List = Corporate and click Calculate ROI.

A table with ROI information based on the forecast is displayed.

Step 5: Activate Offer
You must activate an offer to make it available for customers. Discounts are applied 
to the offer when customers place orders against the offer.

a. Navigate to Trade Planning > Offers.

b. Click the name of the offer that you created in Step 4.

c. Click Request Approval.

d. Click Confirm.

The offer status changes to Active.

Step 6: Create a Sales Order
After an offer is active, customers can start placing orders against the offer. Orders 
are created in Order Management by the Order Management clerk. Discounts are 
applied when orders are created.

a. Log into Order Management as ebusiness/welcome. This user has the 
Order Management Super User responsibility.

b. Navigate to Orders, Returns > Sales Orders.

Enter the following order information:

The following values default in:

* Customer Number

* Ship-to Location

* Bill-to Location

Field Value

Customer Customer Name

Order Type Mixed
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* Order Type 

* Price List

* Sales Person

* Currency

* Payment Terms

* Warehouse

c. Navigate to Orders, Returns > Sales Orders.

d. Click Line Items.

Enter the following information:

e. Create Promotion Pricing Attributes for Oracle Trade Management. 
Complete the following for a request only offer, for an automatic offer skip 
to view adjustments:

* Click Actions.

The Actions window appears.

* Select Promotion/Pricing Attributes and click OK.

The Promotion/Pricing Attributes window appears.

* Select Promotion Number and click Apply.

* Click OK.

f. View adjustments:

* Click Actions.

The Actions window appears.

* Select View Adjustments and click OK.

* Click Apply.

Field Value

Ordered Item Product ID

Quantity 1

Scheduled Ship Date Current Date
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* Click OK.

g. Click Save.

Make a note of the Order Number.

h. Click Book Order.

A message appears indicating that the order has been booked. The Order 
Header tab reappears and the status appears as Booked.

The Pick Release Process concurrent program picks and packs the order. The 
Interface Trip Stop concurrent program ships the sales order to the customer 
location.

Step 7: View Budget Utilization
The Funds Accrual Engine updates the budget that is related to the offer and the 
order. The utilized and the earned columns in the budget get updated according to 
the discounts that are offered against the orders that the customers have placed. The 
budget shows the utilized amount based on the discount applied to the order. The 
earned column shows the amount utilized based on the orders that have been 
shipped.

a. Log into Oracle Trade Management as trademgr/welcome. This user has 
the Oracle Trade Management Super User responsibility.

b. Navigate to Budget > Budgets.

c. Look for the New Product Promotion budget.

d. Optionally, click the amount under the Utilized column to view the order 
number.

Step 8: Claim Creation and Settlement
The concurrent program AMS-TM: Claims Autopay automatically creates a claim 
for the customer if Autopay is enabled in the customer’s Trade Profile. To enable 
Autopay for the customer, navigate to Administration > Marketing > Trade Profile, 
and select Autopay.

After the claim is automatically created, the following processes occur in the 
background:

■ The AutoInvoice concurrent program validates and imports records as 
completed transactions into Oracle Receivables. If there are any errors in the 
process, they are listed in the output report.
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■ The Claims Settlement Fetcher concurrent program closes the claim that you 
have prepared to settle.

■ The workflow background process with the parameter Claim Settlement closes 
the claim.

Step 9: View Credit Memos
Review the credit memo that is created from Oracle Receivables.

a. Log into Oracle Trade Management as trademgr/ welcome. This user has 
the Oracle Trade Management Super User responsibility.

b. Navigate to Claim > Claims.

c. Look for the credit memo in Receipts.

d. Click the credit memo to open it, and view the details.

Step 10: View Closed Claim
Review that the claim has been closed. This concludes the claim settlement process. 
The claim will be closed when the AMS-TM: Claims Settlement Fetcher concurrent 
program is complete.

a. Navigate to Claim > Claims.

b. Look for the claim that you created and settled. Verify that the claim status 
has changed to Closed.

c. Click the claim number to view the claim details.

d. Click the Report side navigation link.

e. View the Claim Report Information for the claim. 

It shows the Receipt, Settlement, Vendor, Payment Detail, and other 
information.

2.4 Creating an Offer-related Claim and Settling it by Check Payment
This business user flow describes how to use Oracle Trade Management to settle an 
offer-related claim with a check payment.

2.4.1 Dependencies and Prerequisites
■ Oracle Trade Management must be fully implemented.
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■ Integration with Oracle Payables must be set up.

■ The workflow background process with the parameter Claim Settlement must 
be running to close the claim.

■ The following concurrent programs must be running:

■ Payables Open Interface Import: to track the claim in Oracle Payables the 
same way all other payments through Oracle Payables are tracked

■ Claim Settlement Fetcher: to close the claim that you have prepared to settle

2.4.2 Scenario
You, the manufacturer, wanted to promote a new shampoo. To do this, you created 
an accrual type offer for your customer, Goodway Stores. The offer stated that 
Goodway would receive 10% off all purchases of the new shampoo for a 3 month 
period. The 10% savings was accrued during that period. Goodway has now 
submitted a claim requesting payment for their accruals by check.

2.4.3 Process Flow Diagram
Figure 2–3 illustrates the Oracle Trade Management application process flow for 
settling a trade promotion claim by check payment.

Figure 2–3 Creating an Offer-related Claim and Settling it By Check Payment

Note: The Administrator in your organization should automate 
these concurrent programs by scheduling them to run regularly.



Creating an Offer-related Claim and Settling it by Check Payment

Business User Flows 2-25

2.4.4 Procedure
Follow the steps in this section to complete this flow.

Step 1: Create a Claim
The claim you create for this flow will be related to an offer. However, customers 
can file claims for a variety of reasons including shipping errors or defective 
merchandise. In some cases, the reason may be unknown. 

a. Login as trademgr/welcome. This user has the Oracle Trade Management 
Super User responsibility.

b. Navigate to Claims > Claims > Create.

Enter the following information:

c. Click Create.

Record the claim number. You will need it later on.

d. Click the Lines side navigation link.

You will now create a claim line by entering the following information:

Field Value

Claim Type Promotional

Reason Promotional

Oracle Trade Management can be implemented so that claim 
owners are assigned automatically based on the claim reason.

Customer Goodway (location = Phoenix (OPS))

Amount 5.00

Field Value

Type Offer

Name Offer name (Goodway Accruals Offer 03)
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e. Click Update.

Step 2: Associate Earnings
In this step, the 10% accrual (also called "rebates" or "earnings") which you, the 
manufacturer, tracked for Goodway on its purchases of shampoo, will be associated 
to the claim. Associating the earnings to the claim means that the claim will be 
paying off these accruals. When you associate earnings, you associate an offer to a 
claim so that the claim is tied to the offer, and to the budget that is funding the offer. 
You can then view how much the customer has earned for the associated offer. In 
most cases, you will associate earnings for many offers rather than just one.

a. Click the Associate Earnings icon (far right column of the claim line.)

b. Verify that the Activity Type = Offer and Activity = the offer name. This is a 
system default.

c. Click Update.

d. In the Accruals and Adjustments for Customers section, enter $5.00 in the 
Line Amount field.

e. Click Update.

f. Return to the Claim Detail page by clicking the claim name.

Step 3: Select the Check Payment Settlement Method
Now you will select a settlement method for the claim and submit it for approval. 

a. Click the Settlement side navigation link.

Select the following:

Amount 5.00

Enter the same amount here that you entered when creating the 
claim.

An amount is entered only if you do not enter a product 
quantity and UOM. When the product quantity and UOM are 
entered, the amount is calculated automatically.

Field Value

Status Open

Field Value
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b. Click Update.

c. Click Request Approval.

d. Click Confirm. Note that the status of the claim changes to Pending Close.

Step 4: Import Invoices Into Oracle Payables
This is an interim stage for creating a check to Goodway for the 10% accrual it has 
earned. The purpose of this step is to track the claim in Oracle Payables the same 
way all other payments through Oracle Payables are tracked. You, the 
manufacturer, should have your Administrator automate this step. 

a. Log into Oracle Forms as ebusiness/welcome: Payables, Vision Operations 
(USA).

b. Navigate to Other > Requests > Run.

c. Select Single Request.

d. Click OK. The Submit Request window opens.

Enter the following parameters:

e. Click OK.

f. Click Submit.

g. Click No.

h. View the output to confirm that the invoice was imported.

* View > Requests > All My Requests.

* Click View Output.

Settlement Method Check

GL Date (optional) Current Date (format DD-MON-YYYY)

Parameter Variable

Name Payables Open Interface Import

Source CLAIMS

GL Date (optional) Current Date (format DD-MMM-YYYY)

Field Value
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Step 5: Search Standard Invoice
This is a step performed by the manufacturer's accounts payable clerk. This is 
another interim stage for creating the check to Goodway. The purpose of this step is 
to validate the payment information before actually creating a check. The payables 
invoice created from the claim should indicate that the customer will be paid the 
amount you entered on the claim. You, the manufacturer, can ask your 
Administrator to automate this step. 

a. Log into Oracle Payables as ebusiness/welcome. This user has Oracle 
Payables Super User responsibility.

a. Navigate to Invoices > Entry > Invoices.

b. Perform a query in the Invoice Number field using the claim number.

* Press the F11 key.

* Enter the claim number in the Invoice Number field.

* Press Control, and then the F11 key.

Notice that additional information related to this claim is filled in 
automatically, for example supplier name, invoice amount, and invoice 
currency. Quickly check to make sure that the Distribution Total and the 
amount are the same. If they are not the same, you will not be able to 
complete this task.

c. Click Actions.

d. Select Validate.

e. Click OK. 

The invoice status changes from Never Validated to Validated. Changes are 
saved automatically.

Step 6: Create Check
This step shows how to create a check to pay the customer for the claim. The 
customer will be paid with the designated amount in Oracle Payables. 

a. Click Actions.

b. Select Pay in Full.

Note: The concurrent program, Invoice Validation, can validate 
multiple invoices simultaneously.
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c. Click OK.

Enter the following data:

The Note window appears as the system reserves the check document. This 
prevents other users from generating duplicate checks.

Although the currency of this bank account is set to USD, by setting the 
Multiple Currency Payments flag to Yes, the system will allow you to create 
a check from this bank in another currency.

d. Click OK (in response to the message regarding the document reservation).

e. Click Save.

f. Click OK when the Discount note appears.

g. Click Actions.

h. Select Format.

i. Click OK.

j. Click OK. 

The Payment Process Manager is submitted.

Step 7: View Budget Utilization
The Claim Settlement Fetcher concurrent program imports the Oracle Payables 
information back into Oracle Trade Management, and closes the claim that you 
have prepared to settle. You can review the budget paid column to observe that the 
budget has been paid for the claim amount. 

a. Log into Oracle HTML applications as trademgr/welcome.

b. Navigate to Budget > Budgets.

c. Review the Budget you used to see that the claim has been paid.

d. (Optional) Click the Paid Amount link. Note that the Paid amount has been 
updated.

Parameter Variable

Bank Account BofA

Payment Date Defaults to System Date

Document Check
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Step 8: View the Closed Claim
Review the claim that has been closed. This concludes the claim settlement process. 
The claim will be closed when the AMS-TM: Claims Settlement Fetcher concurrent 
program is complete. 

a. Navigate to Claim > Claims.

b. Look for the claim you created and settled. Verify that the status has 
changed to Closed.

c. Click the claim number to view the claim details.

d. Click the Report side navigation link.

e. View the Claim Report Information for the claim.

It shows the Receipt, Settlement, Vendor, Payment Detail, and other 
information.

2.5 Deduction to Auto-Resolution for Non-Invoice Deduction
This business user flow describes how to create a non-invoice deduction, close the 
claim through auto-resolution, and settle it by invoice credit.

2.5.1 Dependencies and Prerequisites
■ Oracle Trade Management must be fully implemented

■ Integration with Oracle Receivables must be set up

2.5.2 Scenario
Goodway had placed an order for a particular product. You, the manufacturer, had 
shipped the products, but the shipment got delayed by many days due to bad 
weather conditions. Because of the delay in shipment, Goodway was not able to 
honor the requirements of end customers and therefore suffered losses. To claim 
compensation for these losses, Goodway takes a deduction from the payments.

You now have to create a non-invoice deduction, ensure that the orders and 
invoices related to the claim are valid, and automatically settle the deduction claim.
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2.5.3 Process Flow Diagram
Figure 2–4 illustrates the process flow for deduction to auto-resolution for a 
non-invoice deduction, starting from creating a receipt to reviewing the Oracle 
Receivables receipt.

Figure 2–4 Deduction to Auto-resolution for Non-invoice Deduction

2.5.4 Procedure

Step 1: Create Receipt and Non-Invoice Related Deduction
You must create a non-invoice related receipt and a short payment (receipt amount 
is less than the invoice amount). The short payment creates a deduction claim. 
Based on the reason you select, the claim will be assigned to the appropriate person 
in Oracle Trade Management who owns the claim. 

a. Navigate to Receipts > Receipts Summary.

The Receipts Summary window opens.

b. Click New.

Enter the following information in the Receipts window:

Field Value

Receipt Enter unique receipt number.

Receipt Type Cash

Currency USD

Receipt Amount Enter an amount that is less than the invoice for which you wish 
to create a deduction.



Deduction to Auto-Resolution for Non-Invoice Deduction

2-32 Oracle Trade Management User Guide

c. Click Applications.

The Applications window opens. Enter the following information:

Other information such as Trans Currency, Balance Due, Allocated Receipt 
Amount, Customer Number, GL Date, Apply Date, Class, and Type are 
automatically populated.

d. Repeat the above step for each invoice line that you have.

e. Create another line for Claim Investigation Activity.

Enter the following information:

An example of the Receipt applied to invoices is shown below:

Receipt Date System Date

GL Date System Date

Payment Method Automatic Receipts

Status Confirmed

Customer Name Goodway

Field Value

Apply To Select invoice number from the LOV.

Amount Applied Apply full invoice balance.

Field Value

Apply to Claim Investigation

Amount Applied Apply amount of Invoice (Deduction Claim is created since 
receipt amount is less than invoice amount).

Activity Claim Investigation Activity

Reference Type Oracle Trade Management Claim

Reference Reason Unknown

Field Value
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A receipt of $800 has been received and this must be applied to 2 invoices in 
full. The invoice amount of the first invoice is $1062.50 and invoice amount 
for the second invoice is $531.25. So the claim investigation amount is $800 - 
$1062.50 - $531.25 = $793.75. The difference between the total amount of the 
invoice and the original receipt amount is the amount that is used for 
deduction (unresolved claim).

f. Click Save.

Note down the Reference Number generated. This is the deduction number. 
The Deduction amount should be the sum of invoice amounts minus the 
Receipt Amount.

Step 2: View Deduction
Deductions are created in Oracle Receivables and can be viewed in Oracle Trade 
Management. To view a claim or deduction in Oracle Trade Management:

a. Log into Oracle Trade Management as trademgr/ welcome. This user has 
Oracle Trade Management Super User responsibility.

b. Navigate to Claim > Claims.

c. Look for the claim or deduction generated in Receipts.

d. Click the claim or deduction to open it.

Apply To
Amount 
Applied Balance

Deduction 
Amount Activity

Reference 
Type

Reference 
Reason

Invoice 1 1062.50 
(Including 
Tax)

0 -NA- -NA- -NA- -NA-

Invoice 2 531.25 
(Including 
Tax)

0 -NA- -NA- -NA- -NA-

Claim 
Investigat
ion

793.75 -NA- 793.75

Shows negative 
in Oracle 
Receivables

Shows positive 
in Oracle Trade 
Management

Claim 
Investigat
ion 
Activity

Oracle 
Trade 
Managem
ent Claim

Unknown
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Step 3: Settle Claim with AutoResolution by Issuing a Credit Memo
You decide to choose autoresolution to automatically close the claim, and choose 
the settlement method as credit memo. After this step is complete, the claim gets 
closed automatically.

a. Navigate to Claim > Claims > Claim to be settled.

b. Click the Settlement side navigation link.

Enter the following information:

c. Click Update.

The claim status changes to Open.

d. Click Request Approval.

e. Click Confirm.

The claim status changes to Closed.

Step 4: View Closed Claim
You can review the claim that has been closed. This concludes the claim settlement 
process. For auto-resolution claims, you do not have to run the AMS-TM: Claims 
Settlement Fetcher concurrent program.

a. Navigate to Claim > Claims.

Look for the Claim you created and settled. 

b. Optionally, click the link for the claim you created and settled.

c. The Claim Details screen appears.

View the claim details.

d. Click the Report side navigation Link.

The Claim Report shows the Receipt, Settlement, Vendor, Payment Detail, 
and other information.

Field Value

Status Open

Settlement Method Credit Memo - On Account

GL Date Current Date
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Step 5: Review Oracle Receivables Receipt
You can review the Oracle Receivables Receipt that has been created. Note that the 
Receipt On-account Credit line has replaced the Claim Investigation line earlier. The 
deduction amount or short payment that was recorded in Oracle Receivables will be 
updated with the amount that is issued in the form of on-account credit.

a. Log into Oracle Receivables as ebusiness/welcome.

b. Navigate to Receipt > Receipts.

c. Click Flashlight.

The Find Receipts window opens.

d. Click Open.

The Receipts window opens.

e. Click Applications.

The Applications window opens. Note that the on-account credit has 
replaced the claim investigation line earlier because the overpayment is 
settled. The on-account credit is a cash application line that can be used for 
the customer later on.

2.6 Top-down Bottom-up Budgeting
This business user flow describes how a Sales Manager can allocate a budget to the 
Sales Representatives. The Sales Representatives can view the budget allocation 
before it is activated, and manually request for more funds.

2.6.1 Dependencies and Prerequisites
■ Oracle Trade Management must be fully implemented.

■ The workflow background process with the parameter AMS Marketing Generic 
Approvals must be running to initiate an approval notification to the Budget 
Approver to approve the budget.

2.6.2 Scenario
You, the Sales VP in USA, plan to finalize the sales budget for the upcoming year. 
You create a total budget for the entire sales hierarchy and allocate it to different 
sales territories.
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The Sales Representatives may view the allocation and offer their inputs. You may 
reallocate the budget based on these inputs. After the allocation is finalized, the 
Sales Representatives can start using the allocated funds to execute trade promotion 
activities in their respective territories.

2.6.3 Process Flow Diagram
Figure 2–5 illustrates the top-down bottom up budgeting process, starting from 
creating a budget and allocating it, to reviewing inputs and activating the 
allocation.

Figure 2–5 Top-down Bottom-up Budgeting

2.6.4 Procedure
Follow the steps in this section to complete this flow.

Step 1: Create Budget
A Budget is a pool of money, which you can use to fund trade promotion activities 
such as offers and campaigns. If Budget Approval is checked under Custom Setup, 
then the budget must go through Budget Approval process to become active.

a. Log into Oracle Trade Management as trademgr/ welcome. This user has 
the Oracle Trade Management Super User responsibility.

b. Navigate to Budget > Budgets > Create.

Enter the following information.

Field Value

Budget Type Fixed
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c. Click Create.

The budget status appears as Draft.

d. Click Request Approval.

e. Click Confirm.

The budget status changes to Active.

f. Click Update.

Step 2: Approve the Budget
The budget becomes active after it is approved by the designated approvers. To 
approve the budget:

a. Log into Oracle Trade Management as trademgr/ welcome. This user has 
the Oracle Trade Management Super User responsibility.

b. Log into Oracle Trade Management as Oracle Trade Management Super 
User, and navigate to Workflow > Worklist. You can also launch the 
worklist by navigating to Home > Tools > View Notification Work List.

The open notifications show up.

c. Select the notification that you sent during budget creation.

Name US West 2004 Budget

Number Enter a unique number for the budget. If you do not enter the 
number, the system automatically generates a number.

Parent Budget Select the parent budget name. If you select a parent budget, 
then the parent budget will fund this budget.

Category Select Campaign Execution Budget.

Budget Amount $1,00,000

Holdback Amount You can define your own depending on how much money you 
want to reserve before allocating it to be spent.

Currency US Dollar

However, you can select your own currency depending upon 
the requirement.

Description Optionally, write the description for the budget.

Field Value



Top-down Bottom-up Budgeting

2-38 Oracle Trade Management User Guide

d. Click Approve.

Step 3: Allocate Budget
After the budget is approved, you can allocate the Budget to the Sales 
Representatives in the territory hierarchy. 

a. Log into Oracle Trade Management as trademgr/ welcome. This user has 
the Oracle Trade Management Super User responsibility.

a. Navigate to Budget > Budgets 

b. Select the Budget you created and click on the link to open it.

Note that the budget status should be Active before you allocate it

c. Click the Allocation side navigation link.

d. Click Create. 

Enter the following information:

e. Click Generate.

Enter the following information under the Amount Distribution section:

Field Value

Action Create a new allocation from this budget

Hierarchy Use your own hierarchy

Start Level Region/ Province

End Level Region/ Province

Start Point US West Region

Active From Enter Start Date

Method Manual

Allocation Amount Enter the allocation amount. This must be lesser than the budget 
amount.

Field
Holdback 
Amount

Holdback 
Percentage Allocation

Country Optional Optional Even Distribution

Region/ Province Optional Optional Even Distribution



Top-down Bottom-up Budgeting

Business User Flows 2-39

f. Click Worksheet.

The worksheet shows the distribution of the budget across the hierarchy 
that you created.

g. Click Update.

h. Click Publish.

The allocation status changes to Planned.

Step 4: View Budget Allocation
After you allocate and publish the budget, the Sales Representatives can log into 
Oracle Trade Management and view the budget that has been allocated to them. 
This is a step performed by the Sales Representative.

a. Log into Oracle Trade Management as cstubbs/welcome. This user has the 
Oracle Trade Management Super User Responsibility (assuming that 
cstubbs is the US West Region Sales Representative to whom the budget 
was allocated).

b. Navigate to Budget > Budgets.

Select the budget and click on the link to open it.

c. Click the Allocation side navigation link to view the budget allocation that 
you have received.

Step 5: Submit Inputs For the Allocation
After you allocate the funds, the Sales Representative who is the recipient of the 
allocation, can review the amount that has been allocated, and if they require a 
different amount than what has been allocated, they can suggest a new amount for 
the allocation. This is a step performed by the Sales Representative.

a. Log into Oracle Trade Management as cstubbs/welcome. This user has the 
Oracle Trade Management Super User responsibility (assuming that cstubbs 
is the US West Region Sales Representative to whom the budget was 
allocated).

b. Navigate to Budget > Budgets.

c. Select the budget and click on the link to open it.

d. Click the Allocation side navigation link to view the budget allocation that 
you have received.
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The list of all the allocations that have been created from the selected 
budget is displayed.

e. In the Worksheet column, click the link corresponding to the allocation.

f. In the Rollup Total field, enter the new recommended amount.

g. Optionally, enter an amount that must be reserved from the allocation.

h. Optionally, enter any form of free text in the Notes field to justify why you 
require a different amount that what was originally allocated.

i. Optionally, attach any supporting files (.doc, .pdf, .xls, and so on).

j. Click Submit.

The Sales Management may either accept or reject the request. If the request 
is rejected, then you must resubmit the request.

Step 6: Accept Inputs
You may accept or reject the request submissions that have been made by the Sales 
Representatives. If you accept the inputs, then the allocation gets reconfigured 
based on the changes.

a. Log into Oracle Trade Management as trademgr/ welcome. This user has 
the Oracle Trade Management Super User responsibility.

b. Navigate to Budget > Budgets.

c. Select the Budget you created and click on the link to open it.

d. Click the Allocation side navigation link.

The list of all the allocations that have been created from the selected 
budget is displayed.

e. In the Worksheet column, click the link corresponding to the allocation for 
which the request submission has been made.

The list of all the territory hierarchies are displayed. To identify the territory 
that has submitted the request, check the Requested Amount, and the 
Allocation Status columns. The Requested Amount column shows the 
details of the total amount that has been requested by the territory, and the 
allocation status appears as Submitted.

f. From the Action Required drop-down list, select an option based on 
whether you wish to accept or reject the request.

g. Click Update.
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Step 7: Activate Allocation
After the allocation is finalized, you can activate the Budget Allocation to make the 
funds available the respective Sales Representatives in the hierarchy. This is a setup 
step and does not have to be performed. You can skip this step if you do not wish to 
allocate the budget immediately.

a. Log into Oracle Trade Management as trademgr/ welcome. This user has 
the Oracle Trade Management Super User responsibility.

b. Navigate to Budget > Budgets.

c. Select the Budget you created and click on the link to open it.

Note that the budget should be active before you allocate it.

d. Click Allocation.

e. Click Worksheet.

The worksheet shows the distribution of the budget across the territory 
hierarchy.

f. Change the allocation status to Active.

g. Click Update.

The allocation status changes to Active.

2.7 Volume Accrual
Volume offers are created to encourage customers to buy high volumes of products. 
This business user flow describes how to create a Volume offer that has different 
discounts based on the amount of products purchased, and settle the related 
deduction through an on-account credit memo.

2.7.1 Dependencies and Prerequisites
■ Oracle Trade Management must be fully implemented.

■ Integration with Oracle Receivables must be set up.

■ The workflow background process with the parameter AMS Marketing Generic 
Approvals must be running to initiate an approval notification to the Budget 
Approver to approve the budget.

■ The workflow background process with the parameter Claim Settlement must 
be running to close the claim.
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■ The following concurrent programs must be running:

■ OM Order Line: to generate an invoice from an order that is created in 
Order Management

■ Pick Release Process: to pick and pack a sales order

■ Interface Trip Stop: to ship a sales order to the customer location

■ Funds Accrual Engine: to update the budget that is related to the offer and 
the order

■ AutoInvoice: to validate and import records as completed transactions into 
Oracle Receivables

■ Claim Settlement Fetcher: to close the claim that you have prepared to settle

2.7.2 Scenario
Vision Industries wishes to encourage its customers to purchase a particular 
product in large quantities. The Sales Management assigns you the responsibility of 
working out a strategy to achieve this objective. You, the Sales Manager decide to 
create a Volume offer to encourage a particular customer--Goodway to buy the 
product in higher quantities. The discounts vary for a range of quantities of an item 
that is purchased. If Goodway purchases quantities in a higher range, they receive 
higher discounts. When Goodway reaches a higher sales level, they can get 
discounts even retroactive to the previous purchases.

You create a Volume offer to offer discounts to Goodway. You source funds for this 
offer from an existing budget. Goodway starts placing orders after the offer 
becomes active, and accrues discounts accordingly. Instead of submitting claims, 
Goodway takes a deduction for the amount that your organization owes them. You 
plan to settle these deductions by issuing on-account credit memos.

2.7.3 Process Flow Diagram
Figure 2–6 illustrates the process flow for creating a volume offer that has different 
discounts based on the amount of products purchased, and settling the related 
deduction through an on-account credit memo.

Note: The Administrator in your organization should automate 
these concurrent programs by scheduling them to run regularly.
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Figure 2–6 Volume Accrual Offer

2.7.4 Procedure
Follow the steps in this section to complete this flow.

Step 1: Create Offer
As the first step, you create a Volume offer whereby Goodway receives discounts 
based on the quantity of products that they purchase. You can also enter the 
minimum quantity or amount within certain ranges that the customer must 
purchase to get the appropriate discount.

a. Log into Oracle Trade Management as trademgr/ welcome. This user has 
the Oracle Trade Management Super User responsibility.

b. Navigate to Trade Planning > Offers > Create.

Enter the following information:

Field Value

Setup Type Volume

Offer Name Enter a name for the offer (Goodway Volume Offer 03).
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c. Click Create.

d. Enter Offer details and review the offer information.

e. Scroll down and enter following information under Discount Rules:

f. Select your own range for the discount. The From and To fields represent 
the quantity range. The Discount field represents the percentage. Check the 
range that you want the budget update and adjustment to show up.

Enter the following information:

Offer Code Enter a unique offer code.

If you leave this field blank, the system automatically generates 
an offer code.

Customer Sold-to Goodway

Request Only Unchecked

Incentive Accrual

Start Date System date (required to create a forecast for the offer)

End Date A year from the system date

Activity Coupon

Discount Level Line

Committed Amount Enter the amount that you wish to commit to the offer.

Reusable checked

Budget CDS ADS72111 Budget 2003 is seeded

Campaign Optional

Description Optional

Field Value

Range in Quantity

UOM Each

Discount in Percent

Field Value
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g. Select the Item number (CP40005) in the Item field.

h. Click Update.

Step 2: Activate Offer
After creating the offer, you must activate it to make it available to be used. 
Discounts are applied whenever the customer places an order.

a. Log into Oracle Trade Management as trademgr/ welcome. This user has 
the Oracle Trade Management Super User responsibility.

b. Navigate to Trade Planning > Offers > Goodway Volume Offer 03 (offer that 
you created).

c. Click Request Approval.

d. Click Confirm.

The status of the offer changes to Active.

Step 3: Create a Sales Order
After the offer is active, Goodway can start placing orders against the offer. 
Goodway places an order for 3 units of a product, and discounts are applied when 
orders are created in Order Management by the Order Management clerk.

a. Log into Order Management as ebusiness/welcome. This user has the 
Order Management Super User responsibility.

b. Navigate to Orders, Returns > Sales Orders > Order Information.

Enter the following order information:

From To Discount Checked

1 5 3 X (if you check this range, you want the 
budget adjustment to show up when the 
quantity meets the first range. You can check 
only one range).

6 10 4 -NA-

11 20 5 -NA-

Field Value

Customer Goodway
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The following values default in:

* Customer Number

* Ship-to Location

* Bill-to Location

* Order Type 

* Price List

* Sales Person

* Currency

* Payment Terms

* Warehouse

c. Navigate to Orders, Returns > Sales Orders.

d. Click Line Items.

Enter the following information:

e. Create Promotion Pricing Attributes for Oracle Trade Management. 
Complete the following for a request only offer. For an automatic offer skip 
the step to view adjustments:

* Click Adjustments.

The Actions window appears.

* Select Promotion/Pricing Attributes and click OK.

The Promotion/Pricing Attributes window appears.

Order Type Mixed

Field Value

Ordered Item CP40005

Quantity 3

Scheduled Ship Date Current Date

Field Value
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* Select Promotion Number and click Apply.

* Click OK.

f. View adjustments:

* Click Actions.

The Actions window appears.

* Select View Adjustments and click OK.

* Click Apply.

* Click OK.

g. Click Save.

Make a note of the Order Number.

h. Click Book Order.

A message appears indicating that the order has been booked. The Order Header 
tab reappears and the status appears as Booked. The Pick Release Process picks and 
packs the sales order. The Interface Trip Stop program ships the sales order to the 
customer location. Shipping is mandatory for Volume offers.

Step 4: View Budget Utilization
The Funds Accrual Engine updates the budget related to the offer and the order. 
The utilized and the earned columns in the budget get updated according to the 
discounts that are offered against the orders that the customers have placed. The 
budget shows the utilized and earned amount based on the discount applied to the 
order, and the orders that are shipped.

a. Log into Oracle Trade Management as trademgr/welcome. This user has 
the Oracle Trade Management Super User responsibility.

b. Navigate to Budget > Budgets.

c. Look for the budget that you created in Step 1.

d. Optionally, click the amount under the Utilized column to view the order 
number.

Step 5: View Invoice for Order
The concurrent program OM Order Line automatically creates an invoice for the 
order. To view the invoice for the order:
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a. Log into Oracle Receivables as ebusiness/welcome, and navigate to 
Transactions > Transactions.

The Transactions window appears.

b. Enter the Sales Order Number, click Find, and then click Open.

The invoice details are displayed. Note the invoice number.

c. Click Line Items.

A secondary window opens and displays the Lines. Review these details.

d. Close all the windows.

Step 6: Create Receipt and a Non-invoice Related Deduction
Goodway takes a short payment (deduction) to claim the accrued discounts. You 
must create a receipt to record the payment and the short payment. The short 
payment creates a deduction claim. Based on the reason you select, the claim will be 
assigned to the appropriate person in Oracle Trade Management who owns the 
claim.

You must create a non-invoice related receipt and a short payment (receipt amount 
is less than the invoice amount). The short payment creates a deduction claim. 
Based on the reason you select, the claim will be assigned to the appropriate person 
in Oracle Trade Management who owns the claim. 

a. Navigate to Receipts > Receipts Summary.

The Receipts Summary window opens.

b. Click New.

Enter the following information in the Receipts window:

Field Value

Receipt Enter unique receipt number

Receipt Type Cash

Currency USD

Receipt Amount Enter an amount that is less than the invoice for which you wish 
to create a deduction.

Receipt Date System Date

GL Date System Date
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c. Click Applications.

The Applications window opens. Enter the following information:

Other information such as Trans Currency, Balance Due, Allocated Receipt 
Amount, Customer Number, GL Date, Apply Date, Class, and Type are 
automatically populated.

d. Repeat the above step for each invoice line that you have.

e. Create another line for Claim Investigation Activity.

Enter the following information:

f. Click Save.

Note down the Reference Number generated. This is the deduction number. 
The Deduction amount should be the sum of invoice amounts minus the 
Receipt Amount.

Payment Method Automatic Receipts

Status Confirmed

Customer Name Goodway

Field Value

Apply To Select invoice number from the LOV

Amount Applied Apply full invoice balance

Field Value

Apply to Claim Investigation

Amount Applied Apply amount of Invoice (Deduction Claim is created since 
receipt amount is less than invoice amount).

Activity Claim Investigation Activity

Reference Type Oracle Trade Management Claim

Reference Reason Unknown

Field Value
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Step 7: View Claim or Deduction
Deductions are created in Oracle Receivables and can be viewed in Oracle Trade 
Management. To view the claim in Oracle Trade Management:

a. Log into Oracle Trade Management as trademgr/ welcome. This user has 
Oracle Trade Management Super User responsibility.

b. Navigate to Claim > Claims.

c. Look for the claim or deduction generated in Receipts.

d. Click the claim or deduction to open it.

Step 8: Associate Earnings
Associate Earnings is used to associate an offer to the claim so that the claim can be 
tied to the offer and budget. After associating earnings, you can view how much 
Goodway has earned through the claims for the associated offer.

a. Click the Associate Earnings icon (far right column of the claim line.)

b. Verify that the Activity Type = Offer and Activity = the offer name. This is a 
system default.

c. Click Update.

d. Enter the amount in the highlighted section.

e. Click Update.

f. Return to the Claim Detail page by clicking the claim name.

Step 9: Settle Claim
You wish to settle the claim with an on-account credit.

a. Log into Oracle Trade Management as trademgr/ welcome. This user has 
Oracle Trade Management Super User responsibility.

b. Navigate to Claim > Claims.

c. Look for the Claim that must be settled.

d. Click the claim to open it.

e. Click the Settlement side navigation link.

f. The Claim Settlement window opens. Enter the following information:
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g. Click Update.

Claim Status appears as Open.

h. Click Approval.

i. Click Confirm.

Claim Status changes to Pending Close.

The following processes occur in the background:

■ The AutoInvoice program validates and imports records as completed 
transactions into Oracle Receivables. If there are any errors in the process, they 
are listed in the output report.

■ The Claims Settlement Fetcher concurrent program closes the claim that you 
have prepared to settle.

Step 10: View Closed Claim
You can review and check if the claim has been closed. This concludes the claim 
settlement process. The claim will be closed when the AMS-TM: Claims Settlement 
Fetcher concurrent program is complete.

a. Navigate to Claim > Claims.

b. Look for the claim that you created and settled. Verify that the claim status 
has changed to Closed.

c. Click the claim number to view the claim details.

d. Click the Report side navigation link.

e. View the Claim Report Information for the claim. 

It shows the Receipt, Settlement, Vendor, Payment Detail, and other 
information.

Field Value

Status Open

Settlement Method Credit Memo - On Account

GL Date Current Date (format DD-MMM-YYYY)
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Step 11: View Paid Budget
You can optionally review the budget paid column to observe that the budget has 
been paid for the claim amount.

a. Log into Oracle Trade Management as trademgr/welcome. This user has 
Oracle Trade Management Super User responsibility.

b. Navigate to Budget > Budgets.

Review the budget from which you have sourced funds for the offer and to 
settle the claim.

c. Click Paid Amount.

Note that the Paid amount has been updated.

Step 12: Review Credit Memo
You can optionally review the generated credit memo. Make sure that the 
AutoInvoice Program running in the background for creating Credit Memos from 
claims has completed successfully before searching for the credit memo.

a. Log into Oracle Receivables as ebusiness/welcome.

b. Navigate to Transactions > Transactions.

The Transactions window appears.

c. Enter the claim number and click Find.

Note the Transaction number.

d. Click Line Items.

The Lines window opens. Review the details.



Customers 3-1

3
Customers

This chapter gives an overview of the different types of customers and explains 
how to create customers in Oracle Trade Management.

Sections in this chapter include:

■ Section 3.1, "Overview"

■ Section 3.2, "Organization and Person"

■ Section 3.3, "Customer Groups (Lists)"

■ Section 3.4, "Partner and Partner Contact"
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3.1 Overview
Customers are entities with whom you do business. Customers can be 
organizations, persons, partners, or partner contacts. The Customer tab in Oracle 
Trade Management enables you to create entries for organizations and persons. You 
can also create and generate Lists. Partner and Partner Contact information is 
picked from Oracle Partner Management. The customers that you create here are 
the ones that you will use while defining market eligibility for budgets and offers, 
settling claims and deductions, and for all other customer-related activities. These 
customers appear as a list of values whenever you perform a search for fields that 
require customer information. See the Oracle Trading Community Architecture User 
Guide for more information on Customers. See the TCA Best Practice White Paper 
available on Oracle MetaLink for the best practices related to modeling customer 
and prospect data.

3.2 Organization and Person
A party is an entity of type Organization or Person, with which you can do 
business. A party exists separately from any business relationship that it enters in to 
with another party. Information about a party such as addresses and contacts can be 
shared with the customer accounts of the party. For example, Vision Distribution 
could be a party within your trading community.

Topics included are:

■ Section 3.2.1, "Overview"

■ Section 3.2.2, "Creating an Organization"

■ Section 3.2.3, "Accessing Customer 360 View"

■ Section 3.2.4, "Creating a Person"

3.2.1 Overview
A customer is an organization or person with whom you have a selling relationship. 
This selling relationship can result from the purchase of products and services or 
from the negotiation of terms and conditions that provide the basis for future 

Note: This section only gives a brief overview of Organization 
and Person. See the Oracle Receivables User Guide and Oracle Sales 
Online User Guide for more information.
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purchases. For example, a division of Vision Distribution could become one of your 
customers.

A customer account represents the business relationship that a party can enter into 
with another party. The account has information about the terms and conditions of 
doing business with the party. For example, you could open a commercial account 
for purchases to be made by Vision Distribution for its internal use and a reseller 
account for purchases made by Vision Distribution for sales of your products to 
end–users.

You can create multiple customer accounts for a party to maintain information 
about categories of business activities. For example, to track invoices for different 
types of purchases, you can maintain an account for purchasing office supplies and 
another account for purchasing furniture. You can also maintain multiple customer 
accounts for a customer that transacts business with more than one line of business 
in your organization. You can maintain separate customer profiles, addresses, and 
contacts for each customer account.

A contact communicates for or acts on behalf of a party or customer account. A 
contact can exist for a customer at the account or address level. A person usually 
acts as a contact for an organization, but can also be a contact for another person. 
For example, an administrative assistant could be the contact for an executive. A 
person represents a contact point for an organization for all the business dealings 
and correspondence. A contact point can be either an employee or any other person 
related to the customer organization who will be responsible for coordinating 
business transactions between your organization and the customer organization.

Buying Groups and Related Customer Accounts
Buying groups are formed when organizations group themselves to leverage their 
buying power. For example, you create a promotion for a buying group. When 
buying group members place orders, accruals for each member are tracked 
individually, even though the buying group entity may be handling all the invoices 
and claims for the group. During claim settlement, you can view the buying group 
member accruals and decide whether to issue payment to the buying group, or 
directly to one of its members.

A customer site or an account site is the location where a particular party is 
physically located. Every party has only one identifying address, but a party can 
have multiple party sites. A customer address is a party site used in the context of a 
customer account for billing, shipping, or other purposes. Related Customer 
accounts are set up with relationships. Common relationships include bill-to and 
ship-to. Large organizations may have many sub divisions and legal entities. 
Sometimes, the headquarters my place an order and request you to ship the goods 
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to one of its divisions. Another division of the same customer may be responsible 
for handling the invoices related to the orders. Bill-to and ship-to accounts enable 
you identify the different locations of such customer organization, and process the 
orders, shipments, and payments seamlessly.

For example, the headquarters of an organization may be set up as the bill-to 
account and location for multiple retail stores. Each retail store can be set up as a 
ship-to account and location. In addition, the headquarters office may be handling 
all the claims for retail stores, but these retail stores may ultimately receive their 
payment directly. For more information on setting up Buying Groups and Related 
Customer Accounts, see the Oracle Receivables User Guide.

Related customer accounts are also used for tracking and reporting financial 
transactions. Whenever a customer places an order, an invoice is created or 
payment made, the transactions are posted against the customer’s account. In the 
Campaign to Cash business flow, an account must be created before an order can be 
entered for the customer. Only valid addresses that satisfy the address validation 
rules that you have set up within Oracle Receivables can be used as account sites. 
See the Oracle Receivables User Guide for more information.

Relationships
Organizations can have two types of relationships: Organization to Organization 
and Organization to Person. Use Organization to Organization relationships to 
create relationships between companies, such as, parent and subsidiary, 
headquarters and division, partner and competitor. Use Organization to Person 
relationships to create business contact relationships. You can create multiple 
relationship addresses for a relationship. These addresses are selected from a list of 
customers and related customer existing addresses. If you change one of these 
addresses, you must complete this action by going to the customer or related 
customers record and changing the location there. Please note, the change of 
address cannot be performed in the relationship record itself.

The Relationships link takes you to the Relationships summary page. From this 
summary table you can view existing Organization to Organization, Organization 
to Person relationships, multiple relationship addresses, phone number, start date, 
end date, and relationship status.

Leads, Opportunities, and Interactions
The details of prospects who respond to a campaign or an offer, or who make an 
enquiry are stored as leads. Leads are prospective end customers. After the leads 
are processed, they are assigned to appropriate sales teams. The sales teams convert 
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some leads to opportunities. An opportunity is still a prospect, but it is more 
mature. An opportunity is more likely to be converted to an order.

Interactions are customer touch-points that you can view through the Customer tab. 
You can view interactions that are entered by sales, marketing, and service 
department representatives. An interaction is a single contact event between a 
customer or customer system and a resource of the business.

See the Oracle Sales Online User Guide and the Oracle Marketing User Guide for more 
information.

3.2.2  Creating an Organization
An organization can be a retailer or a wholesaler organization. Use the following 
procedure to create an organization.

Prerequisites
None.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User, and 

navigate to Customer > Organization.

2. Click Create.

3. Enter the following details in the Organization Profile region:

a. Enter the Organization name, Alias (alternate name), and Pronunciation 
(For example, Goodway, for Goodway International).

b. In the E-mail Address Book field:

– Click the E-mail Address Book icon, and type the e-mail address of the 
contact person in the customer organization.

– Optionally check the Inactive, or the Do Not Use check box.

– To display a specific e-mail address, select the display option against it. You 
can enter any number of e-mail addresses, but you can display only one of 
them at a time.

– Click OK.

c. In the Phone Book field:

– Click the Phone Book icon, and enter the required details.
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– Optionally check the Inactive, or the Do Not Use check box.

– You can enter any number of phone numbers, but you can display only one 
of them at a time. To display a specific phone number, select the display 
option against it.

– Click OK.

d. In the Web Site field:

– Click the Website Address Book icon, and enter the web site addresses of 
the customer organization.

– Optionally check the Inactive or Do Not Use check boxes.

– You can enter any number of web site addresses, but you can display only 
one of them at a time. To display a specific website address, select the 
corresponding display option.

4. Enter the following details in the Company Information region:

a. Optionally, in the Annual Revenue field, select the currency type from the 
drop-down list, and enter the annual revenue of the customer organization.

b. Optionally enter values in the Total Employees, Fiscal Year End, and the 
Year Established fields.

c. Select the Standard Industrial Classification Code Type (SIC Code Type), 
and the SIC Code. The SIC code is an index that describes the function 
(manufacturer, wholesaler, retailer or service) and the business line of the 
organization.

d. Optionally enter the Data Universal Numbering System Number (DUNS 
Number), Business Line, and Tax ID. DUNS number is a unique business 
identification number that is assigned to each commercial entity. If the 
organization has multiple locations, then each location will have a unique 
DUNS number.

e. Select a customer category from Customer Category drop-down list.

5. Optionally, enter the priority for the customer organization in the User 
Preference region.

6. Enter the following details in the Address region:

a. From the Country drop-down list, select the country where the customer 
organization is located, and enter the address of the organization in the 
Address 1 field.
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b. Optionally, enter alternate addresses for the customer organization in the 
Address2, Address3, and Address4 fields.

a. Select the state where the customer organization is located.

b. Optionally enter the Country, City, Postal Code, and select an Address 
Type.

7. In the Address Attributes region:

a. Select the status from the Status drop-down list. If you select Active, the 
organization contact will be available for use.

b. Select a Reason, and optionally check the Do Not Mail check box.

c. Select the Context Value.

8. In the Contacts region, you can specify the contact details of the person who 
will be the contact point for all the business dealings. Follow these steps to add 
a contact:

a. Select the Title, and enter the First Name and the Last Name of the contact 
person.

b. Select the relationship that the contact person has with the organization.

c. In the Phone Book field:

– Click the Phone Book icon, and enter the required details.

– Optionally check the Inactive, or the Do Not Use check box.

– To display a specific phone number, select the display option against it. You 
can enter any number of phone numbers, but you can display only one of 
them at a time.

– Click OK.

d. In the E-mail Address Book field:

– Click the E-mail Address Book icon, and type the e-mail address of the 
contact person in the customer organization.

– Optionally check the Inactive, or the Do Not Use check box.

Note: To add an existing person as a contact, select the person in 
the Add a Person field.
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– To display a specific e-mail address, select the display option against it. You 
can enter any number of e-mail addresses, but you can display only one of 
them at a time.

– Click OK.

e. Optionally enter the Job Title, and select the Decision Maker check box if 
the contact is the decision maker in the customer organization.

f. In the Organization Relationships region, you may select an existing 
organization to be added as a related organization.

9. Click Create.

10. To modify an organization, navigate to Customer > Organization, and select the 
organization.

11. Make the appropriate changes, and click Update.

3.2.3 Accessing Customer 360 View
The 360 view of a customer lists all the customer’s transactions including all orders, 
invoices, debit memos and chargebacks. From this page, you can click the link for 
any of these transactions and view it in more detail. For example, if you click the 
link for an order, the order line information, prices, quantities and shipping details 
will be displayed. Use the following procedure to access the 360 view for a 
customer.

Prerequisites
Customers must exist.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Customer > Organization.

2. Click the hyperlink of the customer.

3. Click the 360 View side navigation link.

All the details such as the Orders, Invoices, Service Requests, Products, Returns, 
Campaigns, and Events that are related to the customer will be displayed.
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3.2.4 Creating a Person
A Person represents a contact point for an organization for all the business dealings 
and correspondence. A contact point can be either an employee or any other person 
related to the customer organization who will be responsible for coordinating 
business transactions between your organization and the customer organization. 
Use the following procedure to create a person.

Prerequisites
An existing organization.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Customer > Person.

2. Click Create.

3. Enter the required details in the Personal Profile region.

4. Optionally, in the Additional Information region, enter the details as required.

5. In the User Preference region, optionally select a priority.

6. In the Business Information region, enter the following details:

a. Select a relationship from the Relationship drop-down list.

This is the relationship that the person has with the organization.

b. Select the organization from the Organization LOV; the address defaults in.

c. Optionally enter the Department Name, and select a Department Type.

d. Optionally enter the other details as required.

7. In the Personal Information region, enter the required details of the person such 
as personal phone number, personal e-mail address, country, address, state, and 
so on.

8. In the Address Attributes region:

a. Select the status from the Status drop-down list. If you select Active, the 
organization contact will be available for use.

b. Select the Reason.

c. Optionally check the Do Not Mail check box.

d. Select the Context Value.
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9. In the Notes region, optionally create a Note by selecting the note type, and 
typing any form of free text in the Note field. If the space is not sufficient for the 
text, click More and type the text. You can make the Note either Public, Private, 
or Publish it. For more information on Notes, see Chapter 12, "Common 
Components".

10. In the Relate To region:

a. Select a value from the Type drop-down list.

b. Select the name of a person to whom you would like to relate the person 
that you create.

The list of values that appear here depends on the value that you select 
from the Type drop-down list. The Description defaults in after you select 
the name of a person.

c. Click Create.

To modify the details of a person, navigate to Customer > Person.

1. Select the person, and make the appropriate changes.

2. Click Update.

3.3 Customer Groups (Lists)
List management is the process of analyzing, generating, and managing a list of 
customers or prospects. A list is a group of customers and prospects that are 
typically based on user defined filter criteria. By filtering the lists based on simple 
or complex criteria, you can generate target lists for specific trade promotion 
activities.

For example, for a product launch campaign, you can create a list of high-income 
families with children. You can then create offers to target this list of customers to 
meet your sales objectives.

Topics included are:

■ Section 3.3.1, "Understanding Lists"

■ Section 3.3.2, "Creating a List"

■ Section 3.3.3, "Modifying List Selections"

Note: Use the Quick Create option to quickly create organizations 
or persons, without entering detailed information.
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■ Section 3.3.4, "Modifying List Options"

■ Section 3.3.5, "Generating a List"

■ Section 3.3.6, "Adding Manual Entries to a List"

■ Section 3.3.7, "Exporting a List"

■ Section 3.3.8, "Searching Lists for a Person or Organization"

3.3.1 Understanding Lists
Oracle Trade Management enables you to analyze, generate, and manage a list of 
customers and prospects. You can source lists internally, or from the Oracle 
Customer Model (TCA). You can also purchase or rent lists from a third-party 
vendor and import it for use within Oracle Trade Management. You can use the list 
functionality to create a list which you can associate with an offer, or to define 
market eligibility. You can also add notes to lists. Adding notes to a list can provide 
historical perspective on why a list was created and generated, as well as indicate 
trade promotion object associations. The list functionality is common to Oracle 
Trade Management and Oracle Marketing.

The following types of lists are available within the List functionality:

■ Standard List

A standard list is a combination of other lists (manual, standard or import lists), 
segments, Oracle Discoverer workbooks, or SQL queries. The components of 
the list can be combined by using different operations such as include, exclude, 
or intersect.

■ Manual List

Manual Lists are built manually by selecting either customers or prospects or 
both from data sources such as Persons or Organization Contacts.

■ Suppression List

A suppression list enables you to automatically exclude prospects or customers 
from specific trade promotion activities.

In addition to these lists, you can also import a list of customers or prospects from 
an external data source and use the list for future trade promotion activities. See the 
Oracle Marketing User Guide for more information on Lists.
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List Generation and Deduplication
After you have selected your list data, you can direct the system to generate the list 
either immediately or at a pre-defined future date. The list generation process 
involves combining the data from different sources (list selection), applying any 
deduplication and word standardization rules to the list data and finally inserting 
this data to the Oracle Marketing List Entries table. When a list is successfully 
generated, it can either be used to generate a target group for a specific trade 
promotion activity or can be exported to a third-party fulfillment house for 
outbound execution.

Table 3–1 describes the various list generation modes that you can use while 
generating a List.

Table 3–1 List Generation Modes

Generation Type Description

Standard This is the default type of list generation. The list is generated 
(or regenerated) based on the list selection criteria (Oracle 
Discoverer Workbook, list, segment, and so on). Any old list 
entries will be deleted. This will also remove any manual 
adjustments that have been made to the list.

Incremental In this mode, the old list entries for this list are not deleted. It 
will include all the entries from the previous list generation 
and any new entries added to the list since the previous 
generation date. For example, your team may have reviewed 
the initial list and manually added or deleted entries from the 
list. By choosing this mode, you can capture any new 
customers or prospects who meet your list criteria and at the 
same time not remove any manual adjustments.

Update In this mode, any changes to the customer attributes (First 
Name, Address, and so on) in the Oracle Customer Model 
(TCA) will be reflected in the corresponding list entry records. 
This mode will delete any list entry that does not satisfy the 
list criteria. It will also remove any manual adjustments made 
to the list. For an existing party record in the list entries table, 
the unique identifier (PIN#) for the list entry is retained after 
generating the list in Update mode (an important difference 
between Update and Standard mode).

Update No Purge In this mode, any changes to the customer attributes (First 
Name, Address, and so on) in the Oracle Customer Model 
(TCA) will be reflected in the corresponding list entry records. 
List entries that no longer meet the list selection criteria will be 
retained. In addition, any manual adjustments made to the list 
will also be retained.
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When you generate a list, you can apply deduplication rules (defined by your 
Administrator) to eliminate duplicate records in the list. This ensures that a 
customer or prospect is not contacted twice within the same trade promotion 
activity. The seeded deduplication rules that can be applied include:

■ E-mail Dedupe: Dedupe all records with the same First Name, Last Name, 
E-mail Address

■ Address Dedupe: Dedupe all records with the same First Name, Last Name, 
Address1, Address2, State, City, Postal Code, Country

■ Phone Dedupe: Dedupe all records with the same First Name, Last Name, 
Phone Area Code, Phone Number, Phone Extension

■ Fax Dedupe: Dedupe all records with the same First Name, Last Name, Area 
Code, Fax Number

Your Administrator can extend the list of attributes within the seeded deduplication 
rules. In addition, the Administrator can also set up additional deduplication rules 
by selecting from a list of customer attributes. Some word standardization rules can 
also be applied during the deduplication process. The word standardization 
ensures, for example, that “200 Main Street” and “200 Main St.” are considered the 
same address in the deduplication rule.

List Statuses
List statuses enable you to know the exact status of a list at any point of time. 
Table 3–2 describes the possible list statuses.

Table 3–2 List Statuses

Status Name Description

Draft The list has not yet been generated and hence will not be 
available for selection from other lists or campaign schedules.

Available The list has been generated and the entries of the list are 
available for other lists and campaign schedules.

Generating The list has been submitted for Generation. This requires a 
Workflow Background Process to be running (the AMS - List 
Generation concurrent program). See the Oracle Marketing 
Implementation Guide for more information.

Cancelled The list will not be available for other lists and campaign 
schedules.
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3.3.2 Creating a List
A list is a group of customers and prospects that are typically based on user defined 
filter criteria. Use the following procedure to create a list.

Prerequisites
None.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Customer > Customer Groups.

2. Click Create.

3. Enter a unique name for the List, and select a list type from the Type 
drop-down list.

4. Enter a Source Type, and provide a brief description for this list.

A source type identifies the data source for this list.

5. Click Create.

The status of the list is initially Draft. The Owner is the person responsible for 
creating and maintaining this list.

3.3.3 Modifying List Selections
You can indicate the order in which lists must be combined from multiple sources. 
You can select Import List, List, SQL, Segment, or Workbook as the record source for 
this list. If you select more than one record source, then you must indicate the list 

Locked The list attributes cannot be modified. The status of this list 
must be changed to Available, in order to modify the list 
attributes.

Archived The list will not be available for other lists and campaign 
schedules. All the list entries will be deleted.

Note: After you create a list, you cannot change the defined list 
type or source type.

Table 3–2 List Statuses

Status Name Description
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order, operation (Include, Exclude or Intersect) and the deduplication rank that 
must be associated with each of the record source making up this list. The various 
list selection attributes that are available are:

■ Order: This designates the order in which the individual record sources (or line 
items) will be incorporated in composing the list. The lowest numbered record 
source will be used first.

■ Operation: The options available are Include, Intersect, and Exclude.

■ Type: This includes the following options:

■ Import List: An external data source such as a purchased or rented list, or 
an existing customer database.

■ List: Any existing Standard Manual or Suppression list (status = Available 
Locked).

■ Segment: A saved criteria, which can be used as a record source for this list. 
The status of the Segment should be Available.

■ SQL: Using a SQL statement is another method for storing the criteria used 
to select list entries. Select the “Create Custom SQL” button to create a new 
SQL.

■ Workbook: A Discoverer Workbook that contains the list of records that 
satisfy a user defined criteria defined through Discoverer. A workbook can 
have multiple worksheets. When you choose a Workbook as a list selection 
type, the Flashlight icon displays all the workbooks and their associated 
worksheets.

■ Name: Click on the Flashlight icon at the end of the Name field to select from 
the Available objects of the selected record source Type (Import List, List, 
Segment, SQL or Workbook).

■ Dedupe Rank: This determines the record that will be retained in cases where 
there are duplicate records within the List Entries. Deduplication occurs only 
during Include operations.

■ % of Records: This is the percentage of records that must be selected from the 
record source. This field accepts only positive integers from 1 to 100. It restricts 
the number of entries from a selected record source. For example, if a record 
source has 1000 entries then entering a value of 50 in this field will result in 500 
records to be selected from this record source. This is only applicable for 
Include operations.
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■ Available Records: This is a read-only field that will be populated when the list 
is generated. It displays the number of records that are available for this record 
source. This is only applicable for Include operations.

■ Requested Records: This indicates the number of records after the “% of 
Records” is applied. This column is populated after the list is generated. This is 
applicable only for Include operations.

■ Selected Records: This indicates the number of selected records after 
deduplication is applied. This column is populated after the list is generated. 
This is only applicable for Include operations.

Prerequisites
An existing list.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Customer > Customer Group.

2. Click the hyperlink of the list.

3. Click the Selections side navigation link. This link does not appear for Manual 
lists.

4. Complete the table, one row for each record source that must be incorporated.

5. Click Update.

The record sources are incorporated and the Available Records, Requested 
Records and Selected Records columns are updated. The Record Count 
Subtotal, Manual Additions and Record Count Total are also updated.

3.3.4 Modifying List Options
You can restrict the size of your list by entering the corresponding list size options. 
You can also specify the deduplication and the word standardization rules that 
must be applied while generating a list. Use the following procedure to modify list 
options.

Prerequisites
An existing list.
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Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Customer > Customer Groups.

2. Click the hyperlink of the list.

3. Click the Options side navigation link.

4. From the Selection Method choose one of the following:

– Top Down: The percentage of records requested will be selected starting 
from the top of the list.

– Every Nth Row: The percentage of records requested will be selected by 
choosing every nth record until the correct number is selected.

– Random Percent of Rows: The percentage of records requested will be 
selected randomly from the available records.

5. Enter a Minimum, and Maximum number of records that must be selected.

This is the minimum and maximum number of records that must be included 
while generating this list. The selection Method criteria (Top Down Every Nth 
Row Random) will be applied before the Record Count criteria. However, if the 
record count minimum is not met or the record count maximum is exceeded, 
then the record count criteria prevails.

6. Optionally select a rule to remove duplications.

You can select the deduplication rule that must be applied while generating this 
list. Selecting the Remove Deduplication Using Rule option does not actually 
remove duplicates from the list but instead flags them as duplicates and 
disables those records from the List Entries. The deduplication rules can be 
configured by your Administrator. See the Oracle Marketing Implementation 
Guide for additional information.

7. Optionally check the Use Word Standardization check box.

Using Word Standardization will not change any text in your entries, but words 
will be converted on a temporary basis only for the purpose of comparison.

8. Click Update.

3.3.5 Generating a List
Use the following procedure to specify an immediate list generation or the 
generation of a list at a future date and time.
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Prerequisites
An existing list.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Customer > Customer Groups.

2. Click the hyperlink of the list.

3. Click the Generation side navigation link.

4. To generate the list immediately, select Generate Immediately, and click Update.

5. To generate the list at a later point of time, select Generate at a future time, and 
enter the date, time, and time zone in the future when the list should be 
generated. This may be changed to set the generation earlier or later.

3.3.6 Adding Manual Entries to a List
You can augment a List by manually adding entries to it. To manually add an entry, 
the customer record must already exist in the Oracle Customer Model (TCA). Use 
the following procedure to add manual entries to a list.

Prerequisites
An existing list.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Customer > Customer Groups.

2. Click the hyperlink of the list.

3. Click the Entries side navigation link.

4. Click Add to List to display the Person Search page. 

Note: When you submit a list for generation, the list status 
changes to Generating. The AMS: List Generation background 
process must be running to pick up the request to generate the list. 
See the Oracle Marketing Implementation Guide for information on 
setting up this background process.
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5. Enter the search criteria (Person, Address or Relationship information) and click 
Search to locate the respective customer records.

6. Select the entries that you would like to add to the list. The Select All option 
enables you to select all the records with a single click.

7. Click Add to List.

3.3.7 Exporting a List
Exporting a list generates a comma separated value (.csv) file, which you can use 
within spreadsheet applications to further analyze the list entries. You can also 
provide it to third-party fulfillment houses for outbound execution. Use the 
following procedure to export a list.

Prerequisites
An existing list.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Customer > Customer Groups.

2. Click the hyperlink of the list.

3. Click the Entries side navigation link.

4. Click the Download icon.

5. Click Save File.

6. Select an appropriate location, and click Save.

3.3.8 Searching Lists for a Person or Organization
Use the following procedure to locate a person or an organization on all the lists 
that you have access to.

Prerequisites
Existing lists.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Customer > Customer Groups.
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2. Select List Source.

List Sources are either Consumers (B2C) or Organization Contacts (B2B).

3. Select Search All Lists or only Lists Created Between and supply the dates to 
limit the Search.

4. Click Search to begin the searching process.

5. Any lists in which the name appear will be displayed at the bottom of the page 
along with List Name, Consumer Name, Status, Generated Rows, Last 
Generation Date and Type.

3.4 Partner and Partner Contact
A partner is a company acting on behalf of your enterprise. Partners can be 
wholesalers or retailers who help to close business deals for you by selling your 
products. A partner is an entity that will assist you in sales, trade promotion, 
support services and so on. Partners provide industry expertise or add value to 
products and services. The different types of partners include:

■ Prospects

■ End Users

■ Original Equipment Manufacturers

■ Resellers

■ Value Added Distributors

Oracle Trade Management focuses on connecting you with indirect channels to 
meet the customers’ purchasing needs.

A partner contact is a person in the partner’s organization with whom you can 
correspond and communicate. The person is the single point of contact for the 
organization and represents the partner organization.

Partners and Partner Contacts are created in Oracle Partner Management. For more 
information on creating Partners and Partner Contacts, see the Oracle Partner 
Management User Guide.
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4
Products and Price Lists

The Products tab enables you to access all product-related information and 
attributes that are required to better target, define, and manage trade promotion 
initiatives. This includes managing products and their price lists, and tracking 
competitor products.

Sections in this chapter include:

■ Section 4.1, "Managing Products"

■ Section 4.2, "Managing Price Lists"
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4.1 Managing Products
The Products tab enables you to review, maintain, and create new and existing 
products. A product is considered anything you manufacture, purchase or sell, 
including physical items you can stock in inventory. By this definition, a product is 
not necessarily physical; it can also be a service, or a combination of physical items 
and services. A grouping of products is often referred to as a product bundle. 

By using the Products tab, you can easily access all product-related information and 
attributes required to better target, define, and manage trade promotion initiatives. 
It also gives you a consolidated view of all trade promotion-related product 
information and the key Enterprise Resource Planning (ERP) decision-making 
variables from inventory, purchasing, sales and customer relationship management 
modules.

Topics in this section include:

■ Section 4.1.1, "Understanding Inventory Attribute Templates"

■ Section 4.1.2, "Single Product Catalog"

■ Section 4.1.3, "Creating a Product"

■ Section 4.1.4, "Modifying Inventory Options"

■ Section 4.1.5, "Assigning a Product to a Category"

■ Section 4.1.6, "Assigning a Product to an Organization"

■ Section 4.1.7, "Associating a Product to Price Lists"

■ Section 4.1.8, "Creating Product Relationships"

■ Section 4.1.9, "Creating a Collateral Relationship with another Product"

■ Section 4.1.10, "Creating Product Revisions"

■ Section 4.1.11, "Specifying Products for a Product Bundle"

■ Section 4.1.12, "Creating a Competitor Product"

Note:  Oracle Trade Management supports access to the basic 
features of Oracle Inventory. Depending on your business practices, 
your organization may require further parameters to be set up in 
Oracle Inventory before the manufacturing and shipping of a 
product or bundle. See the Oracle Inventory User’s Guide and the 
Oracle Marketing Implementation Guide for more information.
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■ Section 4.1.13, "Associating Product Contents"

4.1.1 Understanding Inventory Attribute Templates
Oracle Trade Management provides default inventory attribute templates based on 
whether you are defining a product or a service. The template can be overridden by 
selecting or deselecting the desired product attributes. For each product attribute 
grouping, you can specify whether a check box defaults to being checked or 
unchecked and whether the default can be overridden or not. You can define the list 
of product attributes for each responsibility and you can also specify if the product 
attributes are editable in the product options page. This feature enables you to 
segregate product attributes and limit their access to the appropriate users in 
accordance with business and integration requirements.

In addition, this flexibility enables you to display only the relevant product 
attributes, and quickly create a product ensuring that the requisite attributes are 
available.

4.1.2 Single Product Catalog
In this release, Oracle Trade Management uses Oracle Product Lifecycle 
Management (PLM) for product cataloging and management. The concept of using 
the hierarchy provides an efficient and re-usable catalog and product management 
system.

Using catalog categories, you build a structured hierarchy that contains 
characteristics (such as attributes and functions). These characteristics are inherited 
throughout the hierarchy. For example, you can create a catalog category Phone. 
This category can have children Mobile Phone and Land Line. All children will 
inherit the characteristics defined for Phone. 

Catalogs
A collection of categories that are setup in a hierarchical format. When building 
your product catalog (and associated hierarchy), the first thing to do is create the 
catalog structure.

Categories
Using PLM, you can create categories and sub-categories. Sub-categories can only 
be added under categories with no product associated to it. Products can only be 
associated to leaf level categories.



Managing Products

4-4 Oracle Trade Management User Guide

4.1.3 Creating a Product
Use the following procedure to create a product or a service.

Prerequisites
An understanding of the organization’s inventory practices and inventory 
numbering conventions.

Steps
1. Login into Oracle Trade Management as a Oracle Trade Management Super 

User and navigate to Product > Products.

2. Click Create Product in the Products page.

3. In the Create Product Page, select a setup type from the drop-down list.

The setup type indicates the template that you want to use for this product or 
service product. It determines which side navigation items will be available for 
this record. See the Oracle Marketing Implementation Guide for information on 
creating custom setup types.

4. Select either the Product or Service option buttons. 

Choose Product to create a physical product, or Service to create a service 
product. Depending on which type of product you select, the system displays a 
corresponding set of attributes on the attribute definition pages.

5. Enter a name for the product or service.

6. Enter a product number for the product or service, following your 
organization’s guidelines for creating inventory numbers.

This field is a key flex field that validates the product number entered. If you 
enter an invalid value, you will be directed to a page that lists the appropriate 
values. For more detailed information, see the Oracle Inventory User’s Guide.

7. Enter the name of the owner of the product.

Your Master Organization is displayed. The value is the default value that is set 
for the AMS: Item Validation Master Organization profile option. See the Oracle 
Inventory User’s Guide for more information on master organizations.

8. Select a unit of measure, and enter a product description.

9. If you are creating a product of type Service: 

a. Click Go to select a Coverage Template.
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This specifies the coverage template type for a warranty.

b. Enter values in the Duration Value and Duration Period fields.

The duration value specifies the unit of time for the service. The duration 
period specifies the current duration for the service.

10. Click Apply.

The Product Details page appears displaying flexfields, if any. You can add 
details for these fields.

4.1.4 Modifying Inventory Options
Use this procedure to modify the inventory options of an existing product or a 
service.

Prerequisites
You can modify inventory options only for products that are created within Oracle 
Trade Management.

Steps
1. Login into Oracle Trade Management as a Oracle Trade Management Super 

User and navigate to Product > Products.

2. Click the hyperlink of the product.

3. Click the Inventory Options side navigation link in the Product Details page.

4. Fill in the Product Weight and Unit Weight fields.

5. Select or deselect the desired inventory option check boxes.

6. Click Apply.

7. Optionally, click Revert for the original settings.

4.1.5 Assigning a Product to a Category
To assign your products to a category, you must define categories to group items 
that share similar characteristics, and then define category sets to create different 
category grouping schemes. Category sets group your categories into functional 
areas, such as inventory, cost, purchasing, order entry, and so on.

You can define multiple segment structures for the Item Category flexfield. The 
categories that are assigned to a category set must have the same flexfield structure 
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as the set itself. You can define unlimited number of categories in a category set. By 
default, every product that you create are added to the Purchasing, and Inventory 
category sets.

Use the following procedure to define category assignments for an existing product.

Prerequisites
■ An existing product

■ The Load Inventory Category concurrent program must be running in the 
background.

Steps
1. Login into Oracle Trade Management as a Oracle Trade Management Super 

User and navigate to Product > Products.

2. Click the hyperlink of the product.

3. Click the Category side navigation link in the Product Details page.

The Product Details - Categories page is displayed.

4. Select a category set from the drop-down list.

5. Select a description.

6. Repeat the previous two steps until you have entered all desired categories.

7. Click Apply.

4.1.6 Assigning a Product to an Organization
An organization may have several inventory organizations with a master 
organization. You can use this feature to assign the inventory organization and its 
unit of measure. Use the following procedure to define organization assignments 
for an existing product.

Prerequisites
An existing product

Steps
1. Login into Oracle Trade Management as a Oracle Trade Management Super 

User and navigate to Product > Products.

2. Click the hyperlink of the product.
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3. Click the Organization Assignments side navigation link in the Product Details 
page.

4. Select an organization and a unit of measurement.

5. Repeat the previous step to enter another organization.

6. Click Apply.

4.1.7 Associating a Product to Price Lists
A product may be part of one or more price lists. Use this procedure to add a 
product to price lists. 

Prerequisites
An existing product and price list

Steps
1. Login into Oracle Trade Management as a Oracle Trade Management Super 

User and navigate to Product > Products.

2. Click the hyperlink of the product.

3. Click the Price List side navigation link in the Product Details page.

4. Add the product to one or more price lists. To select a price list:

a. Select a price list from the Name column.

The Status and Currency fields will be populated later.

b. Enter the price, and select a Unit of Measure (UOM).

UOM is the unit in which the quantity of an item is expressed. UOMs are 
established and defined in Oracle Inventory.

c. Select a Static Formula, and a Dynamic Formula.

Prior to order entry, you execute a concurrent process which calculates the 
list price based on a static formula.

When you enter an order, the pricing engine uses the dynamic formula to 
calculate the list price.

d. Enter the start date when the price becomes effective.

e. Optionally, enter an end date.
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5. Click Apply.

The Status and Currency fields are displayed. 

6. Optionally, you can also create a price list for this product. 

See Section 4.2.1, "Creating a Price List" for details.

4.1.8 Creating Product Relationships
You can build a relationship between two products. The relationship type could 
vary from Prerequisite to Complimentary. For example, if the product is a CD 
Player, you may want to give a complimentary CD free. On the other hand, a 
mobile charger is optional with a mobile handset.

Use the following procedure to build a relationship between products.

Prerequisites
Two existing products.

Steps
1. Login into Oracle Trade Management as a Oracle Trade Management Super 

User and navigate to Product > Products.

2. Click the hyperlink of the product.

3. Click the Related Products side navigation link in the product details page.

The Product Details - Related Products page is displayed.

4. Select the desired product in the Product Name column.

5. Select the relationship type from the Relationship Type drop-down list.

6. Click the Reciprocal check box if you want the relationship activated on both 
products. Conversely, if you only want a one-way relationship, do not check 
this box.

7. Click Apply.

4.1.9 Creating a Collateral Relationship with another Product
Collateral is another kind of relationship between two products. For example, a user 
manual for a television set is a collateral. In this case, both the user manual and the 
television set must be part of the inventory. 
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Use the following procedure to create a collateral relationship with another 
product.

Prerequisites
Two existing products.

Steps
1. Login into Oracle Trade Management as a Oracle Trade Management Super 

User and navigate to Product > Products.

2. Click the hyperlink of the product.

3. Click the Collateral side navigation link in the Product Details page.

4. From the Product Name column, select the desired product.

5. Select the collateral relationship type from the Relationship Type drop-down 
list.

6. Click the Reciprocal check box if you want the relationship activated on both 
products. Conversely, if you only want a one-way relationship, do not check 
this box.

7. Click Apply.

4.1.10 Creating Product Revisions
A product revision is a new, amended, improved, or up-to-date version of an 
existing product. Oracle Trade Management supports iterations of the same 
product. Each time you work on a revision, you are always working from the most 
current products. Use the Revisions functionality to build a history for each revision 
you make on the given product. 

Use the following procedure to add details to the product revision history.

Prerequisites
None.

Note: The system accepts the date only if the effective date of the 
revision is a date after the current date.
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Steps
1. Login into Oracle Trade Management as a Oracle Trade Management Super 

User and navigate to Product > Products.

2. Click the hyperlink of the product.

3. Click the Revisions side navigation link in the Product Details page.

The Product Details - Revisions page is displayed. The revision A is seeded. 
You can remove or modify it, if required.

4. Enter the name of revision, the description, and an effective date for the 
revision.

5. Click Apply.

4.1.11 Specifying Products for a Product Bundle
The bundling feature supports the creation of a product bundle by combining 
products with other products and services.

Use the following procedure to specify which products this product bundle will 
contain.

Prerequisites
■ The products you wish to bundle must already exist in inventory.

■ The product bundle must exist before adding the list of products.

Steps
1. Login into Oracle Trade Management as a Oracle Trade Management Super 

User and navigate to Product > Products.

2. Click the hyperlink of the product.

3. Click the Bundling side navigation link in the Product Details page.

The Product Details - Bundling page is displayed.

4. Enter a number in the Item Sequence column.

Note: Set the BOM allowed flag for this product bundle to “Y“, as 
the system stores the bundling specification that you define in the 
Bill of Material.
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5. Select a product, and enter the item quantity.

The item quantity indicates the number of items to include in the bundle.

6. Repeat these steps until you list all products for inclusion.

7. Click Apply.

4.1.12 Creating a Competitor Product
A product from another company with solutions for the same domain as your 
product is a competitor product. You can create, view and update competitor 
product information from either the Product Tab (Competitor Product cue card) or 
from the Competitor Products tab.

Use the following procedure to create a new competitor product.

Prerequisites
■ The product for which you are creating competitive information must exist in 

inventory.

■ The competitor name must exist in the party table.

Steps
1. Login into Oracle Trade Management as a Oracle Trade Management Super 

User and navigate to Product > Products.

2. Click the hyperlink of the product.

3. Click the Competitor Product side navigation link in the Product Details page.

The Product Details - Competitor Products page is displayed.

4. Enter a name and a product code for the competing product.

5. Select the name of the competing vendor, and enter the competitor’s URL.

6. Enter the Start and End Dates for the product.

The competitor product is disabled after the end date specified here.

7. Click Apply.

4.1.13 Associating Product Contents
Use the following procedure to associate product contents with a price list.
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Prerequisites
Content items must exist in the library.

Steps
1. Login into Oracle Trade Management as a Oracle Trade Management Super 

User and navigate to Product > Products.

2. Click the hyperlink of the product.

3. Click the Product Content side navigation link in the Product Details page.

4. To upload content from your desktop:

a. Click Quick Upload.

b. Select the location where you want the content to be stored.

c. Click Add Another Row, select the content type (File or Image), browse and 
select the file or image you want to create, and click Submit to submit the 
content for approval. Click Save For Later for work in progress items.

5. To select a content item from the library (Oracle Content Manager repository):

a. Click Add Another Row.

b. Select a Content Type and using the Name Search icon, select a content 
item from the list of values and click Save.

c. To disassociate a content item, click the Delete icon of the corresponding 
row.

6. To create a content item of a specific content type:

a. Select the Content Type and click Create.

You must have the required access permissions to the OCM folders to be 
able to create content items. Refer Oracle Content Manager User Guide for 
more details.

b. Enter a name and description for the content item and browse and select an 
attachment. If the content item you are creating is of the content type Image, 
specify its attributes in the Attributes region.

c. Click Submit to submit the content for approval.

7. Optionally repeat the previous three steps to create and associate more content 
items, and click Apply.

Optionally, click Revert for the original settings.
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4.2 Managing Price Lists
A price list specifies the price that must be offered to a customer. You can create 
price lists and associate them with products. Based on various factors, you may 
create different price lists for the same product. For example, as a Sales Manager, 
you may want to create an exclusive price list for your premium customers, and a 
different price list for the other customers.

Pricelists are also used for validating chargeback submissions in Oracle Trade 
Management. The chargeback lines refer to the price list that is used to calculate and 
offer the selling price to the customer. If the chargeback transaction does not quote 
any list, then the chargeback is not processed. However, if the chargeback line 
includes a price list, verifications are automatically made to check if the:

■ List is valid on the invoice date indicated on the chargeback data

■ Customer is specified in the chargeback, and the sale price is valid

The market eligibility of the agreement lists all members who are eligible for the 
price. Price Lists can be directly linked to an end customer or with a buying group 
to which the customer belongs. See Chapter 11, "Indirect Sales Management" for 
more information on the chargeback process flow.

Topics in this section include:

■ Section 4.2.1, "Creating a Price List"

■ Section 4.2.2, "Defining the Market Eligibility for a Price List"

4.2.1 Creating a Price List
Use the following procedure to create a price list. 

Prerequisites
None.

Steps
1. Login into Oracle Trade Management as a Oracle Trade Management Super 

User and navigate to Product > Price Lists.

2. Click Create.

The Create Price Lists page is displayed.

3. Select a setup type from the Setup Type drop-down list.
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The setup type indicates the template that you want to use for this price list. It 
determines which side navigation items will be available for this record. See the 
Oracle Marketing Implementation Guide for information on creating custom setup 
types.

4. Enter the details for the price list.

5. Click Create.

The Products region is displayed. You can now add products to this price list.

6. From the Level column, select the product level from the drop-down list.

7. Select the product number that you would like to add to this price list.

The name of the corresponding product is displayed in the Product Name field.

8. Select a unit of measurement for the product, and enter the price at which this 
product must be sold.

9. Repeat the previous three steps to add other products to this price list.

10. Click Update.

11. Click Request Approval.

The price list will be active only after it is approved.

4.2.2 Defining the Market Eligibility for a Price List
The market eligibility indicates the customer segment or list that the price list is 
applicable to. Use the following procedure to define the market eligibility for a price 
list.

Prerequisites
An existing price list.

Steps
1. Login into Oracle Trade Management as a Oracle Trade Management Super 

User and navigate to Product > Price Lists.

2. Click the hyperlink of the pricelist.

3. Click the Market Eligibility side navigation link in the Price List Details page.

4. From the Market Context drop-down list, select the context in which this price 
list will be applicable.
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5. Select a context attribute, and enter the other details for the market context.

The context attribute is based on the market context chosen in the earlier step.

6. Click Update.
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5
Quota Allocation

This chapter gives an overview of quota allocation and explains how to create and 
allocate quotas.

Sections in this chapter include:

■ Section 5.1, "Overview"

■ Section 5.2, "Process Flow"

■ Section 5.3, "Understanding Quota and Quota Allocation"

■ Section 5.4, "Creating and Managing Quotas and Quota Allocations"
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5.1 Overview
Sales activities of manufacturing organizations in general span many territories and 
regions. Before planning for the sales activities, it is essential to analyze what 
should be the target for the current year, and what territories and products must be 
targeted. Manufacturers often face the problem of analyzing and arriving at realistic 
sales targets. Moreover, the dynamic business conditions require frequent changes 
in these targets. Making such real-time adjustments, driving the sales of specific 
products, monitoring sales activities, and communicating about these changes to 
the sales teams are some of the challenges that these organizations face.

Quota Allocation in Oracle Trade Management enables you to plan, track, and 
monitor sales activities by enabling you to:

■ Create and allocate quotas based on realistic data, sales figures of previous 
years, and by communicating and accepting inputs from the lower levels in the 
sales team hierarchy.

■ Define the markets and the products that the sales team must focus on selling.

■ Make real-time adjustments and modifications to quotas and quota allocations.

■ Make business information available to the sales teams on a timely basis.

5.2 Process Flow
Figure 5–1 illustrates the process flow for quota allocation.

Figure 5–1 Process Flow for Quota Allocation

Create Quota
The trade planning process begins with the Sales Management allocating sales 
targets to the Sales Representatives in different territories and regions. Quota is the 
total sales target (in terms of money or quantity of products) that must be achieved 
in a specific time period. You must first create a quota and then allocate it to the 
lower levels of the sales team hierarchy. After you create a quota, you can also 
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define the market eligibility and product eligibility for the quota to identify the 
regions, territories, and the products, which the quota must target. Products are 
automatically allocated based on the quota number and the product eligibility that 
you define, and the sales figures of the previous years. The product spread gives 
you a comprehensive view of how the products have been allocated.

Approve Quota
The quota must be approved by the designated approvers before it becomes active. 
However, a quota need not go through an approval process if you are the creator 
and approver of the quota according to the approval rules.

Allocate Quota
After a quota is approved, you can allocate the quota to the Sales Representatives in 
the lower levels of the sales team hierarchy. The Sales Representatives can review 
the quota that they have received, and offer their inputs for changes to be made in 
the allocation. You can review these inputs and reallocate the quota. Multiple such 
top-down bottom-up cycles can occur before the quota numbers are finalized.

Activate Quota Allocation
After the quota allocation numbers are finalized, you can activate the quota 
allocation. This will be the final quota number that the individual territories and 
regions in the sales team hierarchy must achieve.

After you activate the quota allocation, the sales teams will receive workflow 
notifications. They can view these quota numbers by logging into the Account 
Manager Dashboard. You can monitor and track the sales performance through the 
Account Manager Dashboard. For more information, see Chapter 6, "Account 
Manager Dashboard".

5.3 Understanding Quota and Quota Allocation
Topics included are:

■ Section 5.3.1, "Overview"

■ Section 5.3.2, "Market Eligibility, Product Eligibility, and Product Spread"

■ Section 5.3.3, "Quota Approval and Statuses"

■ Section 5.3.4, "About Copy Quota"

■ Section 5.3.5, "Top-down Bottom-up Allocation"



Understanding Quota and Quota Allocation

5-4 Oracle Trade Management User Guide

■ Section 5.3.6, "Quota Allocation Views"

■ Section 5.3.7, "About Notes and Team Options"

5.3.1 Overview
The trade planning process begins with the Sales Management allocating sales 
targets to the Sales Representatives in different territories and regions. This process 
whereby the Sales Management sets sales targets for individual Sales 
Representatives is known as Quota Allocation. Quota is the total sales target (in 
terms of money or quantity of products) that must be achieved in a specific time 
period. The Sales Management must first create a quota, and then allocate it.

For example, the Sales Management of an organization in US West sets a target of 1 
million product units for their sales teams for the year 2004-2005. The Sales 
Management later allocates this quota to Sales Representatives in different US West 
territories such as California, and Oregon based on the sales performance and 
potential in each of these regions. In this case, 1 million product units is the quota, 
and quota allocation is the process by which this quota is allocated across territories.

Targets can be allocated by territories and by products. After creating a quota 
allocation, the Sales Management can also modify and edit it. A quota allocation can 
be modified only when it is in the Draft or Active status. See Section 5.3.3, "Quota 
Approval and Statuses" for more information on quota statuses.

Sales Representatives receive notifications after the process of Quota Allocation is 
complete. The quota that you allocate to the Sales Representatives gets 
automatically reallocated to their customer accounts. This automatic reallocation is 
known as Target Allocation. See Chapter 6, "Account Manager Dashboard" for more 
information on Target Allocation.

5.3.2 Market Eligibility, Product Eligibility, and Product Spread
Market eligibility defines the territories that a quota must target. For a quota, 
defining market eligibility enables you to classify a quota to ensure that sales targets 
are achieved by executing trade promotion activities in the specified territories. 
Territories are created in the Oracle E-Business Suite Territory Management module, 
and are based on various customer and geographical attributes.

Product Eligibility defines the products and product categories that the Sales 
Representatives must focus on selling. Products are items in the Inventory System. 
Product categories contain products. For a quota, you can define product eligibility 
for product categories and products. While defining product eligibility, you can 
either include or exclude products from the product category.
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Defining products, however, does not limit the quota to these products. For 
example, if you include Monitors and Keyboards in the product eligibility, it does 
not mean that the sales teams must achieve quota only by selling these products. It 
means that the sales teams must focus on these products; the sales teams can 
achieve this quota also by selling other products.

The product spread can be generated after defining products for a quota. The 
product spread is generated based on the products that you define, and the sales 
data of the previous year. For example, the sales data of January 2004 will be used to 
forecast the demand for January 2005, and the products will be allocated 
accordingly.

The product spread appears as a worksheet and displays the products and the 
product allocation numbers either on monthly basis or quarterly basis; this depends 
on the time spread that you have selected while creating the quota. If a product 
does not fall under any of the product lines, it is accounted for in a general category. 
The total sum of all the product allocation numbers in the product spread is exactly 
equal to the quota.

For example, you have created a quota for 1,00,000 product units for the fiscal year 
2005-2006, and have selected the time spread as quarterly. You have included 
Product A, Product B, and Product C in the product eligibility, and have generated 
the product spread. Assume that the sales that was achieved in the previous year 
2004-2005 was as shown in the table below:

The following table shows this data as the percentage value that will multiplied by 
the total quota number for the current year (1,00,000 product units) to get the new 
quota values.

Product Jan - Mar Apr - Jun Jul - Sep Oct - Dec Total

Product A 3,600 4,050 2,790 1,080 11,520

Product B 45,000 3,645 3,600 1,890 13,635

Product C 6,750 3,510 1,485 2,700 13,635

Product D 4,500 5,400 3,600 10,800 24,300

Product E 4,950 5,040 4,050 12,060 26,100

Grand Total -NA- -NA- -NA- -NA- 90,000
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The percentage values are multiplied by the quota number for the current year; and 
the products Product A, Product B, and Product C are automatically allocated based 
on this calculation. The product spread appears as shown in the table below:

The sum total of the allocation numbers of Product A, Product B, and Product C is 
44,000 (12,800 + 15,150 + 16,050). The Products D and E that were a part of the base 
calculation are represented as "Others" in the allocation process. Therefore 
remaining 56,000 (1,00,000 - 44,000) product units are allocated and accounted for in 
the Others category.

You can also manually edit the allocation numbers and save your changes. If you 
reduce the quantity of products that has been assigned to a territory, then the 
balance is moved to the Unallocated category. For example, you do not wish to 
immediately allocate the whole of 4,000 units to Product A in the first quarter, and 
wish to hold back a portion. You reduce the allocated number to 3,000. The 
remaining 1,000 product units are moved to Unallocated. The product spread 
appears as shown in the table below.

Product Jan - Mar Apr - Jun Jul - Sep Oct - Dec Total

Product A 4% 5% 3% 1% 13%

Product B 50% 4% 4% 2% 15%

Product C 8% 4% 2% 3% 16%

Product D 5% 6% 4% 12% 27%

Product E 6% 6% 5% 13% 29%

Grand Total -NA- -NA- -NA- -NA- 100%

Product Jan - Mar Apr - Jun Jul - Sep Oct - Dec Total

Product A 4,000 4,500 3,100 1,200 12,800

Product B 50,00 4,050 4,000 2,100 15,150

Product C 7,500 3,900 1,650 3,000 16,050

Others 10,500 11,600 8,500 25,400 56,000

Unallocated 0 0 0 0 0

Grand Total -NA- -NA- -NA- -NA- 1,00,000
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Notice the changes in the Total column for Product A. If required, you can later 
reallocate these products by moving them out of the Unallocated category.

You can also add new products to the existing product spread. The quota for the 
new product will be allocated based on the sales figures for the specific product in 
the previous year. You can also manually change the allocation numbers for the new 
product. The quota numbers in the Others column reduces accordingly.

For example, if you add a new product--Product X to the existing product spread, 
and the allocation numbers for the four quarters for this product are 1,500, 2,000, 
1,000, and 4,000 respectively, then the product spread appears as shown in the table 
below.

Therefore, whenever you make any manual changes in the product spread, 
automatic adjustments are made to the product allocation numbers such that the 
total sum of the product units is always equal to the quota.

Product Jan - Mar Apr - Jun Jul - Sep Oct - Dec Total

Product A 3,000 4,500 3,100 1,200 11,800

Product B 5,000 4,050 4,000 2,100 15,150

Product C 7,500 3,900 1,650 3,000 16,050

Others 1,0500 11,600 8,500 25,400 56,000

Unallocated 1,000 0 0 0 1,000

Grand Total -NA- -NA- -NA- -NA- 1,00,000

Product Jan - Mar Apr - Jun Jul - Sep Oct - Dec Total

Product A 3,000 4,500 3,100 1,200 11,800

Product B 5,000 4,050 4,000 2,100 15,150

Product C 7,500 3,900 1,650 3,000 16,050

Product X 1,500 2,000 1,000 4,000 8,500

Others 9,000 9,600 7,500 21,400 47,500

Unallocated 1,000 0 0 0 1,000

Grand Total -NA- -NA- -NA- -NA- 1,00,000
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5.3.3 Quota Approval and Statuses
A quota can become active only after it is approved by the designated approvers. 
The approvers may approve, reject, or put the quota on hold. The quota status 
changes accordingly. However, a quota need not go through an approval process if 
the person who creates the quota is the approver according to the approval rules.

Table 5–1 describes the various statuses that a quota may go through.

Note: You can make changes to the product spread only for the 
current and future periods.

Table 5–1 Quota Statuses

Status Description

Draft The quota status appears as Draft when the quota has not yet 
been submitted for approval. A quota in the Draft status can 
be updated any time. From Draft, the quota status may change 
either to Pending Approval or Cancelled. If you are the quota 
owner, then you can directly change the status to Active.

Pending Approval The quota status appears as Pending Approval if the quota is 
awaiting approval. The quota status may change to either 
Active or On Hold if all the approvers respond positively. The 
quota status changes to Rejected if the approvers reject the 
quota.

On Hold On Hold is an interim status, which means that the quota has 
already obtained approval, but is not completely ready to be 
made active. From On Hold, the quota status may change to 
either Active or Closed.

Rejected The quota status appears as Rejected if the approvers reject the 
quota. From Rejected, the status can be changed back to Draft.

Active The quota status appears as Active after the quota has been 
approved. From Active, the status may change to either 
Closed and Cancelled.

Cancelled The quota status appears as Cancelled if it has been aborted. 
From Cancelled, the status can only change to Archived.

Archived When the quota status appears as Archived, the quota can no 
longer be used. This status cannot change to any other status.

Completed The quota status appears as Completed after all the activities 
that are associated with the quota are complete and the quota 
has been achieved.
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5.3.4 About Copy Quota
The copy quota functionality enables you to copy information from an existing 
quota and save it as a new quota. For example, you can create a copy of the yearly 
quota that repeats the same essential information each year, and update it.

5.3.5 Top-down Bottom-up Allocation
Oracle Trade Management supports top-down, bottom-up quota allocation. 
Top-down allocation is the process by which the Sales Management allocates quota 
to lower levels. Bottom-up allocation is the process by which the lower levels of the 
sales team hierarchy offer their inputs, and request for modifications to be made in 
the quota allocation.

In a top-down, bottom-up allocation, the Sales Management first allocates the quota 
to lower levels of the sales team hierarchy. The lower levels then review the 
allocation, offer their inputs, and request for changes to be made in the allocation. 
The Sales Management may incorporate these inputs and make the changes. 
Multiple such top-down, bottom-up cycles may continue until the allocation 
numbers are finalized. After the allocation numbers are finalized, you can activate 
the quota.

5.3.6 Quota Allocation Views
The Quota Allocation page gives a summary of all the allocations that have been 
created for a quota.

Table 5–2 describes the various quota allocation views.

Closed The quota status appears as Closed after the quota period 
comes to an end.

Table 5–2 Quota Allocation Views

View Description

Allocation Number The unique number, which is assigned to the allocation 

Table 5–1 Quota Statuses

Status Description
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5.3.7 About Notes and Team Options
Notes enables you write and record information that you would like to 
communicate to others who deal with a quota or quota allocation at various levels. 
You can create any number of notes, and edit and modify notes.

The Team option enables you to add or remove other groups or users to the 
activities of quotas. By using this option, you can assign access to team members. 
The access that the group or team member gets depends upon the group type that 
the team member belongs to.

See Chapter 12, "Common Components" for more information and procedures 
related to Notes and Team options.

5.4 Creating and Managing Quotas and Quota Allocations
Topics included are:

■ Section 5.4.1, "Creating a Quota"

■ Section 5.4.2, "Updating Market Eligibility for a Quota"

Allocation Type This appears either as:

■ Receiving - The lower levels see this as receiving. This 
means that the top levels have created the allocation, and 
the lower levels have received it.

■ Distributing - the top levels see this as distributing. This 
means that the top levels have created this allocation and 
have distributed the quota to lower levels.

Hierarchy The territory hierarchy

Allocation Status The status of the allocation

Approved Date The date on which the allocation was approved

Active From The period from which the allocation will be active

Active To The period until which the allocation will remain active

Allocation The quota that has been allocated

Worksheet icon Displays the amount that has been allocated to each of the 
hierarchy levels

Table 5–2 Quota Allocation Views

View Description
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■ Section 5.4.3, "Updating Products for a Quota"

■ Section 5.4.4, "Generating and Modifying a Product Spread"

■ Section 5.4.5, "Submitting a Quota for Approval"

■ Section 5.4.6, "Approving a Quota"

■ Section 5.4.7, "Creating a Quota Allocation"

■ Section 5.4.8, "Submitting a Change Request During Top-down, Bottom-up 
Allocation"

■ Section 5.4.9, "Updating a Request Submission During Top-down, Bottom-up 
Allocation"

5.4.1 Creating a Quota
Quota is the total sales target (in terms of money or quantity of products) that must 
be achieved in a specific time period. You, the Sales Manager must first create a 
quota, and then allocate the quota. Use the following procedure to create a quota.

Prerequisites
None.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User, 

and navigate to Quota > Quotas.

2. Click Create.

3. Select Quota from the Setup Type drop-down list.

4. Enter a name for the quota, and a quota number.

The quota will be identified by its name and number. If you leave the quota 
number field empty, then a new quota number will be generated automatically. 
This number will be used to identify the quota.

5. Verify the owner.

By default, the user entering the quota details will become the owner. Owner of 
a quota has all the access to update it.

6. Enter the quota.

This is the total sales that must be achieved.
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7. Enter the Start and End periods, and select the Time Spread.

The start and end periods will be defined in the GL calendars, and will limit the 
start and end periods for the quota. The start and end periods and the time 
spread that you select together determine how the quota will be divided and 
tracked. For example, if you select the start period as Jan 04, end period as Jan 
05, and select the time spread as quarterly, then the quota will be divided on a 
quarterly basis--Jan-Mar, Apr-Jun, July-Sep, and Oct-Dec.

8. Optionally select a Threshold for the quota, and enter a description.

9. Click Create.

5.4.2 Updating Market Eligibility for a Quota
Market eligibility defines the territories that a quota must target. By updating 
market eligibility for a quota, you can specify the territories that the sales teams 
must target. Defining market eligibility ensures that the quota is achieved by 
executing sales activities in the specified territories. Use the following procedure to 
define market eligibility for a quota.

Prerequisites
An existing quota.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User, 

and navigate to Quota > Quotas.

2. Click the hyperlink of the quota.

3. Click the Market Eligibility side navigation link.

4. Select Territories from the Eligibility Context drop-down list.

5. Select an Eligibility Name.

Note: The values that are listed in the time spread LOV depend 
upon the start and end periods that you have selected. If the 
selected period spans a year, then the time spread LOV displays the 
values--Yearly, Monthly, and Quarterly. If the selected period spans 
a quarter, then the time spread LOV displays the values--Quarterly, 
and Monthly, and so on.
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The list of values that appears here depends on the eligibility context that you 
select. Because you have selected the eligibility context as Territories, a list of all 
the territory names appears here.

6. Repeat the previous two steps and complete additional rows as required.

7. Click Update.

5.4.3 Updating Products for a Quota
You can define products for a quota by selecting broad groups of products (category 
sets and categories) or by selecting specific products. You can use a combination of 
category sets and categories. For example, you may select a particular category but 
exclude certain products within that category. Use the following procedure to 
update products for a quota.

Prerequisites
An existing quota.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User, 

and navigate to Quota > Quotas.

2. Click the hyperlink of the quota.

3. Click the Products side navigation link.

4. In the Product Family region, select the product category set and category.

a. Select a category set from the Category Set drop-down list, and select a 
category from the Description LOV. The list of values that appear in the 
Description LOV depend upon the category set that you have selected.

b. Optionally check the Primary Category check box.

c. Repeat the previous two steps to include additional product categories as 
required.

5. In the Products region, select the products you would like to include or exclude 
from the category set that you have selected.

a. From the Product Number LOV, select the product number that must be 
included or excluded; the Product Name defaults in.

b. Check the Exclude check box to exclude the product from the product 
category.
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c. Repeat the previous two steps to include or exclude additional products as 
required.

6. Click Update.

After you define products for a quota, to remove a product or a product category, 
check Remove check box against the respective product or product category, and 
click Update to save your changes.

5.4.4 Generating and Modifying a Product Spread
The product spread can be generated after defining products for a quota. The 
product spread is generated based on the sales data of the previous year. The 
product spread appears as a worksheet and displays the products and the product 
allocation numbers either on monthly basis or quarterly basis; this depends on the 
time spread that you have selected while creating the quota.

After the product spread is generated, you may modify the allocation numbers, and 
add new products or product categories to the product spread. Whenever you make 
any manual changes to the product spread, automatic adjustments are made to 
adjust the allocation numbers such that the total sum of all the product allocation 
numbers in the product spread is exactly equal to the quota.

Use the following procedure to generate and modify the product spread for a quota.

Prerequisites
■ Products must have been defined for the quota.

■ The quota must be in the Draft status.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User, 

and navigate to Quota > Quotas.

2. Click the link of the quota.

3. Click Generate Product Spread to generate the product spread.

The product spread gets generated based on the products that you have defined 
for the quota, and the sales figures of the previous year. If there is any 
remaining quota after the selected products have been allocated, it is accounted 
for in a general category--Others.

4. Click Edit Product Spread to modify the product spread.
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The product spread displays the allocation numbers based on the time spread 
that you have selected (monthly or quarterly) while creating the quota. If it is 
monthly, then the quota is divided on a monthly basis (January, February, 
March, and so on). If it is quarterly, then the quota is divided on a quarterly 
basis (January-March, April -June, and so on). The product sales that was 
achieved during the same period in the previous year is displayed against the 
respective targets for the current periods.

5. To modify the product spread:

a. Manually make changes as required, and click Apply.

b. Click Recalculate.

6. To add a new product or product category to the product spread:

a. Click Add Another Item.

b. From the Item Level drop-down list, select either Item or Category 
depending on whether you wish to add a product or a product category.

c. Select a value from the Item Name LOV, and enter the sales target for the 
item.

d. Repeat the previous three steps to add another product or product category.

e. Click Recalculate.

5.4.5 Submitting a Quota for Approval
A quota becomes active only after it is approved. The only instance where the quota 
does not require approval is when you are the creator, and the approver of the 
quota according to the approval rules. Use the following procedure to submit a 
quota for approval.

Note:

■ You can modify the product spread only for the current and 
future periods.

■ If you reduce the quantity of products that has been assigned to 
a territory, then the balance is moved to the Unallocated 
category.
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Prerequisites
An existing quota.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User, 

and navigate to Quota > Quotas.

2. Click the hyperlink of the quota.

3. Review the details, and click Request Approval.

4. Review the approver details, and click Confirm.

Notifications will be sent to the designated approvers.

5.4.6 Approving a Quota
After a quota has been submitted for approval, you will receive workflow 
notifications if you are the designated approver. Use the following procedure to 
approve a quota.

Prerequisites
A quota must have been submitted for approval.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User, 

and navigate to Workflow > Worklist. You can also launch the worklist by 
navigating to Home > Tools > View Notification Work List.

The list of open notifications is displayed.

2. Select the notification corresponding to the quota that has been submitted for 
approval.

3. Click Approve.

5.4.7 Creating a Quota Allocation
Quota allocation is the process by which you distribute targets to each level in a 
sales team hierarchy. You can create any number of quota allocations from a quota. 
You can create allocations for different hierarchies within the selected territory, and 
for different time periods, as long as the quota remains active. Use the following 
procedure to create a quota allocation.
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Prerequisites
An existing quota.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User, 

and navigate to Quota > Quotas.

2. Click the hyperlink of the quota.

3. Click the Allocation side navigation link.

4. Click Create in the Quota Allocations page.

5. In the Action field, select Create New Quota from this Allocation.

If you select this option, then the hierarchy that has been defined for the quota 
will be used.

6. From the Hierarchy drop-down list, select the territory that you have defined in 
the Market Eligibility.

7. Select the Start Level, End Level, and the Start Point.

The Start Level can be anywhere within the territory hierarchy. For example, in 
a hierarchy level, say, Country > State > City, the Start Level need not always be 
Country. It can also be State or City. The End Level, and Start Point must be 
lesser than or equal to the Start Level.

8. Select the Active From Period, and Active To Period.

9. Select an allocation method from the Method drop-down list. The values that 
are available are:

– Even Distribution: Allocates quota equally across all the territories

– Manual: You can manually enter the quota that must be allocated to each 
territory

– Prior Year Sales Total in Amount: Allocates quota based on the sales figures 
of the previous years

10. Select the Basis Year if you select the method as Prior Year Total Sales Total in 
Amount. Quota will be allocated based on the sales figures of the basis year that 
you select.

11. Enter the Allocation Numbers.

12. Click Generate.
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The Allocation status changes to New.

5.4.8 Submitting a Change Request During Top-down, Bottom-up Allocation
After a quota allocation has been created, if you are a Sales Representative and 
recipient of the quota allocation, then you can review the allocation, offer your 
inputs, and request for changes to be made in the allocation. You can also add 
supporting documents to justify why you need more or less quota numbers than 
what was originally allocated. Use the following procedure to submit a change 
request.

Prerequisites
An existing quota allocation.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User, and 

navigate to Quota > Quotas.

2. Click the hyperlink of the quota.

3. Click the Allocation side navigation link.

The list of all allocations for the selected quota is displayed.

4. In the Worksheet column, click the link corresponding to the allocation for 
which you would like to offer your inputs.

5. Enter the quota number that you would like to recommend.

6. Optionally, in the Notes field, type any form of free text to justify why you need 
more or less money than what was originally allocated.

7. Optionally attach any supporting documents. Documents can be any type of 
electronic file (.doc, .pdf, .xls, and so on).

8. Click Submit.

A workflow notification will be sent to the allocation owner.

5.4.9 Updating a Request Submission During Top-down, Bottom-up Allocation
If you are the Sales Manager who has created the allocation, you may accept or 
reject the request submissions that have been made by the Sales Representatives. 
Use the following procedure to accept or reject a request submission.
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Prerequisites
■ An allocation has been initiated, and the allocation is not active yet.

■ You are the creator of the allocation.

■ The recipient has made a request submission.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User, 

and navigate to Quota > Quotas.

2. Click the hyperlink of the quota.

3. Click the Allocation side navigation link.

The list of all the allocations that have been created from the selected quota is 
displayed.

4. In the Worksheet column, click the link corresponding to the allocation for 
which the request submission has been made.

The list of all the territory hierarchies are displayed. To identify the territory 
that has submitted the request, check the Requested Amount, and the 
Allocation Status columns. The Requested Amount column shows the details of 
the total amount that has been requested by the territory, and the allocation 
status appears as Submitted.

5. Select an option from the Action Required drop-down list depending on 
whether you wish to approve or reject the request. If you reject the request, the 
allocation status changes to Rejected. The submitter may make changes in the 
request and resubmit it.

6. Optionally repeat the previous step to accept or reject another request 
submission.

7. Click Update.

5.4.9.1 Approving a Quota Allocation
A quota allocation can become active only after it is approved. Use the following 
procedure to approve a quota allocation.

Prerequisites
A planned quota allocation.
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Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User, 

and navigate to Quota > Quotas.

2. Click the hyperlink of the quota.

3. Click the Allocation side navigation link.

4. Click Worksheet.

The worksheet shows the distribution of the quota across the territory 
hierarchy.

5. Change the allocation status to Active, and click Update.
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6
Account Manager Dashboard

This chapter gives an overview of the Account Manager Dashboard and explains 
how to use the different features that are available in the Account Manager 
Dashboard.

Sections in this chapter include:

■ Section 6.1, "Overview"

■ Section 6.2, "Process Flow"

■ Section 6.3, "Account Manager Dashboard Regions"

■ Section 6.4, "Offer Evaluator and Offer Worksheet"

■ Section 6.5, "Quota Allocation"

■ Section 6.6, "Target Allocation"

■ Section 6.7, "Account Planning"
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6.1 Overview
Trade planning involves planning the sales activities, and organizing resources to 
meet the sales objectives. It includes sales forecasting, analyzing business 
information, allocating targets, managing sales performance, and responding 
proactively to the changing business scenarios and conditions, thus maximizing 
sales volumes. Organizations face many challenges due to changing customer 
demands and dynamic business conditions. Trade plans are affected by untested 
promotional plans, unrealistic targets, and unproven goals and objectives. Account 
Manager Dashboard in Oracle Trade Management, is an integrated planning and 
controlling tool that enables organizations to plan for trade activities based on 
realistic data. It provides solutions to achieve everyday sales objectives, and enables 
you to:

■ View historical sales information, forecast sales, and calculate the return on 
investments

■ View sales targets, and monitor sales performance

■ View reports and statistics that give an overall view of the sales activities of the 
organization

■ Create and evaluate offers to promote sales and achieve the desired return on 
investments

■ Collect information on the sales performance of competitors’ products, and 
view the relevant trends and reports

6.2 Process Flow
Figure 6–1 illustrates the process flow for Account Manager Dashboard starting 
from quota allocation to tracking sales performance.

Figure 6–1 Process Flow for Account Manager Dashboard



Process Flow

Account Manager Dashboard 6-3

Quota Allocation
Quota Allocation is the process by which the Sales Management allocates sales 
targets to individual Sales Representatives of different regions and territories. 
Targets can be allocated by territories and by products. The Sales Management may 
allocate products based on either the currency amount or the quantity of the 
products.

Target Allocation
After the quota allocation is complete, the sales target, which is allocated to the 
Sales Representatives is automatically reallocated to their customer accounts and 
sites. This allocation process is termed as target allocation. The Sales 
Representatives can view the target allocation by logging into the Account Manager 
Dashboard.

Account Planning
Based on the target allocation, account plans are automatically created for each of 
the customer accounts. An account plan gives you an overall view of the activities 
such as trade promotions, outstanding claims, competitive products, and all other 
activities that are related to the customer account. You can also forecast, plan, create, 
and evaluate trade promotion activities such as offers and campaigns, and evaluate 
potential returns.

Create and Execute Offers
You can use the offer evaluator and offer worksheet to evaluate and create offers. 
Offer evaluator enables you to search for offers that fit a specified criteria. Each of 
the offers that is retrieved can be copied as an offer worksheet. By using the offers 
worksheet, you can create new offers of the offer types--Accrual, Off-invoice, and 
Trade Deal. When you create an offer from the offer worksheet, you can apply the 
following operations to the offer:

■ Use the Discount Calculator to obtain a discount recommendation

■ Enter the performance requirements for the offer

■ Create an offer forecast

Sales Performance Analysis and Tracking
The Account Manager Dashboard includes notifications and dashboard alerts. 
These alerts are automatically raised whenever the sales performance is not 
according to the plan and expectations. Other than notifications and dashboard 
alerts, during the target allocation process and offer creation process, you can 
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specify different graph parameters, view sales performance graphs, and analyze the 
sales performance. You can also select one or more offers or campaigns to display 
them in the form of Gantt Charts and analyze them.

Retail Execution Monitoring
You can monitor the retail price information of products for each customer account. 
You can also monitor the performance and price changes of the competitive 
products in the market. This information enables you to better plan for offers and 
trade promotion activities.

6.3 Account Manager Dashboard Regions
Account Manager Dashboard serves as a starting point for the trade planning 
activities in an organization. The Account Planning Dashboard includes customer 
reports and statistics, which you can use to organize resources to reach your targets. 
You can access tools such as the offer evaluator and offer worksheet to create and 
evaluate offers to fetch the desired return on investments. You can display the offers 
in the form of Gantt charts and analyze them. You can also record the retail prices at 
which a specific retailer sells your products.

Topics in this section include:

Section 6.3.1, "Account Manager Dashboard Regions"

Section 6.3.2, "About Trade Planning Thresholds"

Section 6.3.3, "Capturing Retail Pricing Information"

Section 6.3.4, "Viewing Budget Summary and Claim Summary Reports"

Section 6.3.5, "Personalizing the My Accounts and My Products Regions"

6.3.1 Account Manager Dashboard Regions
The following sections describe the each of the regions that you can see when you 
log into the Account Manager Dashboard.

Key Performance Indicators
The Key Performance Indicators (KPI) region displays the overall product-specific 
quota and sales for the month, quarter, and year. The quota numbers that appear 
here are based on the quota allocations that have been created by the Sales 
Management.
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Sales Performance
The Sales Performance region graphically displays information with respect to the 
sales in the pervious year, sales in the current year, and the current target to be 
achieved for 4 running Quarters (including the current quarter-to-date). This graph 
is based on the KPI data. The target that must be achieved in the current year is 
displayed as a line. Sales figures of the previous and current years are displayed as 
bars.

Quick Links
The Quick Links region provides links, which you can use to quickly access certain 
features such as the offers evaluator, offer worksheet, budget summary, claim 
summary, and quota summary.

My Accounts
The My Accounts region displays information with respect to the accounts that fit 
the personalized view filter. You can view only those accounts that you are 
responsible for. Each account can have multiple bill-to and ship-to locations. You 
can access a customer’s account plan by drilling down the account.

My Products
The My Products region displays information with respect to the products that fit 
the personalized view filter. You can view only those products that you are 
responsible for selling, as defined in the target allocation. You can view the details 
of a product by drilling down the product name.

6.3.2 About Trade Planning Thresholds
Trade Planning thresholds are flexible alerts set by the Administrator. These 
thresholds are set to notify sales users when the business conditions change, and 
enable them to take preventive actions to address any issue that may arise. For 
example, the Administrator can create a rule set to alert sales team members when 
they do not achieve their targets on time. This enables the team members to take 
timely actions to improve their performance.

The Administrator can also create ROI threshold limits for products or offers. When 
sales users create offers and calculate discounts, the threshold limits and warning 
functions ensure that the product margin requirements are protected. If the sales 
users cross a defined ROI threshold limit for a product or an offer, alerts will be 
raised to notify them that the threshold has been exceeded. If the threshold is 
exceeded, the offer creator must identify a reason and submit the offer for approval.
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Whenever the conditions specified in a threshold rule takes place, alerts are raised 
in the form of notifications or dashboard alerts. Trade planning thresholds may 
appear in one of the following ways:

■ Notification alerts

When the threshold condition holds in the specified start date and end date 
range, a notification is sent through Oracle Workflow based on the frequency 
indicated by the rule.

■ Dashboard alerts

Dashboard alerts appear as icons in the Account Manager Dashboard. When the 
threshold condition holds in the specified start date and end date range, sales 
users see the icon that meets the condition in the dashboard every time they log 
in. The icons represent one of the following conditions:

■ Acceptable: this is indicated by a tick mark icon.

■ Warning: this is indicated by an exclamation mark icon.

■ Not Acceptable: this is indicated by a cross mark icon.

Thresholds include threshold rule sets and threshold rules. A threshold rule set 
consists of one or more threshold rules. Each threshold rule set can have its own 
start date and end date. The threshold rules belonging to a threshold rule set can 
also have individual start dates and end dates, but these must fall within the start 
date and end date range of the threshold rule set. You can modify, extend, and 
personalize threshold rule sets and threshold rules based on the profile option 
settings made by the Administrator. See the Oracle Trade Management Implementation 
Guide for more information on setting up thresholds.

6.3.3 Capturing Retail Pricing Information
The Capture Retail Pricing quick link enables you record the retail prices at which a 
specific retailer sells your products. Retail price is the price at which a retailer sells 
your products to end-customers. Each retailer may sell your products at a different 
retail price. For example, Walmart may sell your product say, Product A at $10.00, 
whereas Bigmall may sell the same Product A at $12.00.

Use the following procedure to update retail pricing for your products.

Prerequisites
Products must exist.
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Steps
1. Log into Oracle Trade Management as Account Manager, and click Account 

Manager Dashboard.

2. Click the Capture Retail Pricing quick link.

3. Select a Customer Name and Location.

4. To search for the retail prices at which a retailer sells a particular product, 
complete the following steps:

a.  Select a product from the Product LOV.

b. Select a Product, and select the Start Date and End Date.

c. Click Go.

5. Optionally to add a new product, click Add Another Row.

6. Select a product, enter the details as required, and click Apply.

6.3.4 Viewing Budget Summary and Claim Summary Reports
The budget summary report summarizes the budget utilization for each of the 
customer accounts. The claim summary report gives a summary of claims for each 
of the customer accounts.

Use the following procedure to view the budget summary and claim summary 
reports.

Prerequisites
None.

Steps
1. Log into Oracle Trade Management as Account Manager, and click Account 

Manager Dashboard.

2. In the Quick Links region:

a. Click Budget Summary to view the budget summary report.

The budget summary gives you a consolidated report of the Available, 
Planned, Committed, Utilized, Earned, and Paid amounts for each 
customer account.

b. Click Claim Summary to view the claim summary report.



Account Manager Dashboard Regions

6-8 Oracle Trade Management User Guide

The claim summary gives you a consolidated report of the total amount 
that is claimed, the number of open claims, and the claims that have been 
due for more than 30 days, 60 days, and so on, for each customer account.

6.3.5 Personalizing the My Accounts and My Products Regions
You can personalize the My Accounts and My Products regions in the Account 
Manager Dashboard to create new views and define the manner in which the 
information is displayed. A view includes data display specifications such as the 
number of rows and columns that must be displayed. It also includes sort settings 
and search criteria to filter the data that is displayed in the region. Each view can 
have different data display settings. You can create any number of views, but set 
only one of them at a time as default.

The following procedure describes how to personalize the My Accounts region. You 
can use the same procedure to personalize the My Products region.

Prerequisites
None.

Steps
1. Log into Oracle Trade Management as Account Manager, and click Account 

Manager Dashboard.

2. Click Personalize in the My Accounts region.

A list of all the pre-configured and personalized views that are applicable to the 
My Accounts region are displayed.

3. To set an existing view as the default view:

a. Select the view that you would like to set as default.

b. Click Update.

The information in the My Accounts region will be displayed according to 
the specifications of the new view that you have selected.

4. To create a new view:

a. Click Create View.

b. Enter a name for the view, and select the number of rows that must be 
displayed. For example, select 10 to display 10 rows of information in the 
My Accounts region.
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c. Optionally check the Set as Default box, and optionally enter a description. 
If you check the Set as Default box, then the view will be set as the default 
view for the My Accounts region.

d. In the Column Properties region, select the columns that must be displayed, 
by moving the items from the Available Columns to Columns Displayed. 
You can also set the display order for the columns.

e. In the Sort Settings region, select values from the First Sort, Second Sort, 
and Third Sort drop-down lists, and select a Sort Order for each of the 
options. The data will be sorted based on the options that you select here.

For example, assume that you select the sort order as shown in the table 
below.

The list of all accounts will be displayed in the Descending order, and these 
accounts will again be sorted based on the percentage of quota that has 
been met. So on the top of the list, you will find the account that has 
achieved the maximum sales.

f. In the Search Query to Filter Data in the table region, specify the required 
parameters and values to filter the data that is displayed in the My 
Accounts region. For example, you can set the parameters to display 
accounts that have achieved sales of more than 1,00,000 product units.

g. Click Apply.

6.4 Offer Evaluator and Offer Worksheet
After the process of target allocation is complete, you can start planning to achieve 
your targets. You can start evaluating and creating offers to encourage the 
customers to buy products. Offer evaluator and offer worksheet are tools that 
enable you to search for offers that fit a specific criteria, and evaluate offers before 
creating them.

Topics in this section include:

Sort Settings Column Name Sort Order

First Sort Account Name Descending

Second Sort Year Quota No Sort Order

Third Sort Percentage Year Met Descending
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■ Section 6.4.1, "Understanding Offer Evaluator and Offer Worksheet"

■ Section 6.4.2, "Using Offer Evaluator to Search and Copy Offers as Offer 
Worksheets"

■ Section 6.4.3, "Evaluating Offers By Using the Offer Worksheet"

6.4.1 Understanding Offer Evaluator and Offer Worksheet
Offer evaluator enables you to search for a list of offers that fit specific criteria such 
as customers, products, territories, costs, and return on investments. For example, 
you can use the offer evaluator to search for a list of offers that a certain customer is 
eligible for. Similarly, you can search for offers that will give the desired return on 
investment.

When you perform a search by using the offer evaluator, all the matching offers are 
displayed on the user interface. You can create an offer directly from this user 
interface, or visit the offer worksheet summary screen.

Apart from creating offer, you can apply the following operations to the list of offers 
returned from the offer evaluator:

■ Export the offer as a .csv file, save the offer and send it as an e-mail attachment.

■ Display the offers in the form of a Gantt chart and analyze them.

■ Copy the offers to the worksheet and create new draft offers, enter and modify 
discount values, and create forecasts for offers.

Each offer that is selected from the offer evaluator can be copied as an offer 
worksheet. By using the offer worksheet, you can create new offers of the offer 
types--Accrual, Off-invoice, Lump sum, Scan Data, and Volume. When you create 
an offer from the offer worksheet, you can use the Discount Calculator to obtain the 
forecasted ROI. The system generates a forecasted ROI based on the following 
details that you enter:

■ The desired retail price point or percentage off the Manufacturer's Suggested 
Retail Price (MSRP) that you would like to reach

■ The retail unit of measurement, the desired retail price, and the retailer's margin 
requirement

■ The forecast units information

Based on the price and margin information, the system calculates the appropriate 
forecast information by using the formula--Retail Price = (1 + customer margin) * 
list price * (1 - discount value). You can also enter your own discount values. The 
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ROI information is automatically calculated based on this information. The ROI 
information enables you to predict the performance of new offers.

Apart from discount values, you can enter the performance requirements for the 
offer. Performance requirements are the requirements that the retailer or wholesaler 
must meet to qualify for discounts that are defined in an offer. 

For more information on performance requirements, see Chapter 7, "Trade Planning 
and Offers".

6.4.2 Using Offer Evaluator to Search and Copy Offers as Offer Worksheets
Offer evaluator enables you to search for a list of offers that fit specific criteria such 
as customers, products, territories, costs, and return on investments. For example, 
you can use the offer evaluator to search for a list of offers that a certain customer is 
eligible for. Similarly, you can search for offers that will give the desired return on 
investment. You can copy these offers as offer worksheets to evaluate and create 
new offers. Use the following procedure to search for offers based on a specific 
criteria, and copy an offer as an offer worksheet.

Prerequisites
Existing customer accounts and offers.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

select the Account Manager responsibility.

2. Click the Account Manager Dashboard link.

3. Click the Offer Evaluator quick link.

4. Do either one or all of the following to search for offers based on specific 
criteria:

a. To search for offers based on the products or product categories that are 
defined in the offer, select either Item or Category from the Item Filter 
drop-down list, and select a value from the LOV.

b. To search for offers based on qualifiers such as the customer name, bill-to 
and ship to locations, buying groups, lists, segments or so on, select a value 
from the Qualifier Filter drop-down list, and select a value from the LOV.

c. To search for offers based on parameters such as the forecasted ROI, actual 
ROI, start date, and end date of the offer, click Advanced Search.
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5. Click Go.

All the offers that match the specified criteria are displayed.

6. Optionally, click the hyperlink of the offer to view the offer details.

7. Optionally, select the offers and click Gantt Chart to display the offers in the 
form of a Gantt chart.

8. Optionally, select an offer and click Export to save the offer as a .csv file.

9. Optionally, select the offers and click Copy to Worksheet to copy the offers as 
an Offer Worksheet.

The selected offers are copied as offer worksheets and are displayed in the 
Worksheet Summary page. See Section 6.4.3, "Evaluating Offers By Using the 
Offer Worksheet" for information on how to evaluate and create offers by using 
the offer worksheet.

6.4.3 Evaluating Offers By Using the Offer Worksheet
After you copy an offer as a worksheet, you can evaluate and create offers that will 
fetch the desired return on investments. When you create an offer from the offer 
worksheet, you can use the Discount Calculator to obtain a forecasted ROI value. 
You can also enter your own discount values and modify them. You can enter the 
performance requirements for the offer, create an offer forecast, and create new 
offers. Use the following procedure to evaluate an offer by using the offer 
worksheet.

Prerequisites
Existing offers.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

select the Account Manager responsibility.

2. Click the Account Manager Dashboard link.

3. Click the Offer Worksheet quick link.

4. To evaluate an existing offer worksheet, click the corresponding Details icon.

The Worksheet Details page displays information such as the offer name, offer 
code, currency code, and so on. This information is picked from the offer that 
was converted into the offer worksheet.
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5. As the first step, enter the following information in the Offer Details region.

a. Select an offer type from the Offer Type drop-down list.

b. Select an Activity, Start Date, and End Date for the offer.

c. Select a Price List, and the Forecasted UOM.

 This information will be used for creating the offer forecast.

6. Optionally complete the following steps in the Qualifiers Selection region:

a. Click Add Another Row to specify the conditions based on which the 
customers will be eligible for offer.

b. Select a value from the Qualifier drop-down list, and select a value from the 
Name LOV. For example, to apply the offer for a selected list, select List 
from the Qualifier drop-down list, and select the appropriate list name from 
the Name LOV.

c. To delete a qualifier, select the qualifier and click Delete.

7. To obtain forecasted ROI for the offer, click the Worksheet sub tab and complete 
the following steps for each row:

a. Select values for Item Level (product or product category), and the Item 
name.

b. Enter the other values as required.

c. Optionally click Add Another Row to add another Item.

d. Optionally, to delete a row, select the row and click Delete.

e. Click Discount Calculator.

f. Click Apply in the Discount Calculator page.

The forecasted revenue, forecasted costs, and the forecasted ROI are 
displayed. You can use the ROI information to offer optimum discount. 
Repeat these steps by entering different discount values till you arrive at a 
desired forecasted ROI.

8. To specify performance requirements for the offer, click the Performance sub 
tab and complete the following steps for each row:

a. Click Add Another Row to add a new performance requirement.

b. Select the Item Level, and the Item Name.



Offer Evaluator and Offer Worksheet

6-14 Oracle Trade Management User Guide

This is the product item or category for which performance requirements 
will be defined.

c. Select a value from the Trade Medium LOV. The list of values that appears 
is set by the Administrator.

d. Select the Start Date and End Date.

The start date and the end date determine the time period within which the 
requirement must be executed.

e. Enter a value in the Estimated Value field, and select the Required check 
box to make it mandatory for the customer to execute this requirement to 
qualify for the offer.

f. Optionally click Add Another Row to define performance requirements for 
another product or product category.

g. Optionally, to delete a row, select the row and click Delete.

9. To create an offer forecast, click the Forecast sub tab and complete the following 
steps:

a. Select one of the following values from the Forecast Basis drop-down list:

– Custom Date Range: to generate the forecast for a given time period.

– Last Year Same Period: to generate the forecast based on the sales figures 
that were achieved during the same period in the previous year.

– Offer Code: to generate the forecast based on the performance of another 
offer.

b. Select a time spread, and optionally click the Increment Quota check box.

The time spread that you select determines how the forecast will be 
divided. For example, if you select the time spread as monthly, then the 
forecast will be divided on a monthly basis.

c. Enter the forecasted quantity of products.

This is the quantity of products that you expect to sell.

d. If you selected the Offer Code as the forecasted basis, then select an offer 
code from the Offer Code LOV.

e. Click Generate Actuals.

10. After you have satisfactorily evaluated the offer, click Save as Offer to save the 
worksheet as an offer.
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6.5 Quota Allocation
The trade planning process begins with the Sales Management allocating sales 
targets to the Sales Representatives in different territories and regions. Quota is the 
total sales target (in terms of money or quantity of products) that must be achieved 
in a specific time period. The process whereby the Sales Management sets sales 
targets for individual Sales Representatives is known as Quota Allocation. 

For example, the Sales Management of an organization in US West sets a target of 1 
million product units for their sales teams for the year 2004-2005. The Sales 
Management later allocates this quota to Sales Representatives in different US West 
territories such as California, and Oregon based on the sales performance and 
potential in each of these regions. In this case, 1 million product units is the quota, 
and the process by which this quota is allocated across territories is quota allocation.

The Sales Management can allocate targets by territories and by products. For more 
information on quotas and quota allocation, see Chapter 5, "Quota Allocation".

6.6 Target Allocation
Topics included are:

■ Section 6.6.1, "Understanding Target Allocation"

■ Section 6.6.2, "Viewing and Modifying a Target Allocation"

■ Section 6.6.3, "Viewing the Product Spread"

6.6.1 Understanding Target Allocation
If you are the Sales Representative in one of the regions or territories to which the 
Sales Management has allocated the quota, then you will receive notifications after 
the process of quota allocation is complete. You can view the quota that has been 
allocated to you, by logging into the Account Manager Dashboard.

The quota allocated to you will be automatically reallocated among each of your 
customer accounts. This automatic allocation is known as Account Allocation or 
Target Allocation. The target allocation worksheet gives you a comprehensive view 

Note: You can optionally select or more worksheets from the 
Worksheet Summary page and click Copy to create duplicate copies 
of the offer worksheets.



Target Allocation

6-16 Oracle Trade Management User Guide

of how the quota has been allocated to each of your accounts. It displays the targets 
that you must achieve for each of the accounts.

For example, the Sales Management of Vision Industries, USA has created a quota 
allocation for 1 million product units (Monitors, Keyboards, and Printers) for its 
sales teams for the year 2004-2005. The time spread selected is quarterly. The quota 
that has been allocated to you, a Sales Representative in New York is 1,00,000 
product units.

You are responsible for the customer accounts--Fabstore, Bigmall, Megastar, and 
Shopping World. You receive a notification after the process of quota allocation is 
complete. You log into the Account Manager Dashboard and view the Quota 
Summary. You can see that the quota allocated to you has been automatically 
reallocated among Fabstore, Bigmall, Megastar, and Shopping World. The target 
allocation worksheet will appear as shown below.

Targets will be allocated based on the sales that was achieved during the same 
period in the previous year. If there is any unallocated quota, it is accounted for in a 
category known as Unallocated. If there is any quota that you are not able to 
achieve, you can justify it by using notes.

Note: A customer account may have multiple bill-to and sold-to 
locations. The target allocation worksheet displays the targets that 
you must achieve for each of the accounts as well as each of their 
bill-to and sold-to locations. The rollup view of the customer 
account shows the sum total of all the targets that have been 
allocated to all of its bill-to and ship-to locations.

Account Jan - Mar Apr - Jun Jul - Sep Oct - Dec Total

Fabstore 4,000 4,500 3,100 1,200 12,800

Bigmall 5,000 4,050 4,000 2,100 15,150

Megastar 7,500 3,900 1,650 3,000 16,050

Shopping 
World

10,500 11,600 8,500 25,400 56,000

Unallocated 0 0 0 0 0

Grand Total -NA- -NA- -NA- -NA- 1,00,000
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You can also remove customer accounts or a bill-to or sold-to location from a target 
allocation. If you remove a customer account from a target allocation, then the 
allocation gets reconfigured accordingly. The target that was allocated to the specific 
customer account will be moved into the category--Unallocated.

For example, if you remove the customer account Shopping World from the target 
allocation worksheet, then the new worksheet appears as shown below. Notice that 
the target that was allocated to Shopping World has moved into Unallocated.

For each of the customer accounts, you can view the product spread and the 
account plan. The following section discusses more about the product spread. For 
more information on account plans, see Section 6.7, "Account Planning".

Understanding Product Spread
The Sales Management defines product eligibility during quota allocation. The 
product eligibility defines the products and product categories that you must focus 
on selling. After the process of quota allocation is complete, along with the target 
allocation, product spreads will automatically generated for each of the accounts as 
well as their bill-to and sold-to locations. The generated product spreads are based 
on the product eligibility that the Sales Management has defined.

The product spread for an account appears as a worksheet and displays the 
products and the product allocation numbers either on monthly basis or quarterly 
basis; this depends on the time spread that the Sales Management has selected 
while creating the quota. For more information, see Chapter 5, "Quota Allocation".

Products are automatically allocated to each customer account based on the sales 
performance in the previous year. If a product does not fall under any of the 
product lines, it is accounted for in a general category--Others. The total sum of all 
the product allocation numbers in the product spread of an account is exactly equal 
to the target that is allocated to the account.

Account Jan - Mar Apr - Jun Jul - Sep Oct - Dec Total

Fabstore 4000 4500 3100 1200 12800

Bigmall 5000 4050 4000 2100 15150

Megastar 7500 3900 1650 3000 16050

Unallocated 10,500 11600 8500 25400 56000

Grand Total -NA- -NA- -NA- -NA- 1,00,000
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For example, a target of 10,000 product units (Monitors, Keyboards, and Printers) 
has been allocated to Fabstore for the fiscal year 2005-2006, and the time spread is 
quarterly. You can view the product spread by clicking the product spread icon 
corresponding to Fabstore, in the target allocation worksheet. The product 
allocation worksheet will appear as shown below.

When the target allocation is generated, Monitors, Keyboards, and Printers are 
automatically allocated to each account (and its bill-to and ship-to locations) based 
on the sales performance of these products in the previous year. In this example, for 
Fabstore, the sum total of the allocation numbers of Monitors, Keyboards, and 
Printers is 9,500 (4,000 + 3,500 + 2,000). Therefore, the remaining 500 (10,000 - 9,500) 
product units are allocated and accounted for in the Others category.

6.6.2 Viewing and Modifying a Target Allocation
If you are the Sales Representative in one of the regions or territories to which the 
Sales Management has allocated the quota, you will receive notifications after the 
process of quota allocation is complete. The quota allocated to you will be 
automatically reallocated among each of your customer accounts. This allocation 
worksheet is known as Account Allocation or Target Allocation. You cannot modify 
the allocation numbers in the target allocation worksheet. However, you can 
remove customer accounts from the target allocation worksheet. Use the following 
procedure to view or modify a target allocation.

Product Jan - Mar Apr - Jun Jul - Sep Oct - Dec Total

Monitor 500 1000 2000 500 4,000

Keyboard 500 750 1250 1000 3,500

Printer 100 450 550 900 2,000

Others 500 0 0 0 5,00

Grand Total -NA- -NA- -NA- -NA- 10000

Note: Product spreads can be modified only at the Quota Level. If 
any changes must be made to the product spread, the quota owner 
must make the changes and reallocate the quota. Changes to 
product spreads can be made only for the current and future 
periods. For more information, see Chapter 5, "Quota Allocation".
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Prerequisites
A quota must have been allocated.

Steps
1. Log into Oracle Trade Management as Account Manager, and click Account 

Manager Dashboard.

2. Click the Quota Summary quick link.

The list of quotas that have been allocated to you will be displayed here.

3. Click the Account Allocation icon corresponding to the quota for which you 
would like to view the target allocation.

4. All the accounts that you are responsible for will be listed in the Target 
Allocations Worksheet page; you can see that targets have been automatically 
allocated to each of the accounts.

The allocation will be based on the sales figures during the same period in the 
previous year. If there is any unallocated target, it will be accounted for in the 
general category--Others.

5. To modify the allocation numbers, make the required changes and click 
Recalculate.

You can see that the allocation gets altered in such a way that the allocation 
numbers are equal to the quota numbers that have been allocated.

6. To remove a customer account or a bill-to or sold-to location of a customer 
account:

a. Click Update Account Selection.

b. Select the customer account that you would like to remove. To remove a 
bill-to or sold-to location of a customer account, first expand the customer 
account, and then select the bill-to or sold-to location that you would like to 
remove.

c. Click Next.

Note that the allocation numbers corresponding to the customer account or 
the bill-to or sold-to location that you removed, have been moved to the 
category--Unallocated.
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6.6.3 Viewing the Product Spread
Use the following procedure to view the product spread for a customer account or 
any of its bill-to or sold-to location.

Prerequisites
■ A quota must have been allocated.

■ Products must have been defined for the quota.

Steps
1. Log into Oracle Trade Management as Account Manager, and click Account 

Manager Dashboard.

2. Click the Quota Summary quick link.

The list of quotas that have been allocated to you will be displayed here.

3. Click the Account Allocation icon corresponding to the quota for which you 
would like to view the product spread.

4. All the accounts that you are responsible for will be listed in the Target 
Allocations Worksheet page. You can see that targets have been automatically 
allocated to each of the accounts.

5. Click the Product Spread icon corresponding to the Account whose product 
spread you would like to view. To view the product spread for a bill-to or 
sold-to location of a customer account, first expand the customer account and 
then click the Product Spread icon corresponding to the bill-to or sold-to 
location.

The product spread will be based on the sales figures during the same period in 
the previous year. If there are any unallocated products, they will be accounted 
for in the general category--Others.

6.7 Account Planning
The account plan of a customer gives you an overall view of the activities related to 
the customer account. You can access information such as trade promotions, 
outstanding claims, details of competitive products, and all other activities that are 
related to a customer account. You can also forecast, plan, create, and evaluate trade 
promotion activities such as offers and campaigns, and evaluate potential returns.

Topics included are:
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■ Section 6.7.1, "Overview"

■ Section 6.7.2, "Displaying Offers In the Form Of a Gantt Chart"

■ Section 6.7.3, "Viewing Sales Graphs Of an Account"

■ Section 6.7.4, "Updating Retail Pricing and Details of Competitors’ Products"

6.7.1 Overview
After the process of quota allocation is complete, along with the target allocation, 
account plans are automatically created for each account. An account plan of a 
customer account includes the customer details, quota details, activity summary 
report, information about the retailer’s performance, retail price points, and notes 
and attachments.

You can access the account plan for a customer by drilling down the customer 
account in the Account Manager Dashboard. The quota details that appear for each 
of the customers is based on the target allocation.

The Activities region in an account plan enables you to view all the offers and 
campaigns that are associated with the customer account. You can view the offer 
details, budget details, the forecasted units and the actual units of the products that 
have been sold.

The Activities sub tab includes two regions--Manufacturer’s Activities, and 
Retailer’s Performances. In the Manufacturer’s Activities region, you can access the 
offer evaluator and offer worksheet to create and evaluate offers to fetch the desired 
return on investments. You can view the Gantt charts for selected offers, and view 
the sales performance graph of the account. You can select one or more offers and 
export them as a .csv offer by clicking Export. See Section 6.3, "Account Manager 
Dashboard Regions" for more information on Offer Evaluator, Offer Worksheet, and 
the related procedures.

In the Retailer’s Performances region, you can view if there are any performance 
activities that are associated with the offer. If the performance requirements for an 
offer have been met, then you can mark the offer accordingly by checking the 
respective Activity Completed check box.

For example, you may have an agreement with a retailer whereby the retailer will 
be eligible for a lumpsum amount if the retailer displays a poster of your new 
product in the showroom for a month. Here, displaying the poster is the 
performance activity that has been agreed upon. After you verify that the retailer 
has performed according to the agreement, you can mark the offer as such.
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6.7.2 Displaying Offers In the Form Of a Gantt Chart
Use the following procedure to select offers and display them in the form of a Gantt 
Chart.

Prerequisites
■ Target allocation must be complete.

■ Customer accounts and offers must exist.

Steps
1. Log into Oracle Trade Management as Account Manager, and click Account 

Manager Dashboard.

2. In the My Accounts region, drill down the customer account.

The Account Plan for the selected customer appears. The Activity Summary sub 
tab displays the offers that are applicable to the customer’s account.

3. Select the offers that you would like to display in the form of a Gantt Chart.

4. Click Gantt Chart.

6.7.3 Viewing Sales Graphs Of an Account
During the target allocation process and offer creation process, you can view the 
sales performance of the account in the form of a graph. You can select various 
combinations based on the customer and ship-to sites, product categories and 
products, and the time (start date and end date). Use the following procedure to 
personalize and view sales graphs for a customer account.

Prerequisites
■ Target allocation must be complete.

■ Customer accounts and transactions must exist.

Steps
1. Oracle Trade Management as Account Manager, and click Account Manager 

Dashboard.

2. In the My Accounts region, drill down the customer account.

The Account Plan for the selected customer appears.

3. In the Activities sub tab, click Sales Analysis.
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4. Select the period for which you wish to generate the graph. If you wish to 
generate the graph for a specific date range, then select the From and To dates.

5. Select a Time Spread based on how you wish to display the graph.

For example, to generate a graph for the data on a monthly basis, select Time 
Spread = monthly.

6. Select from either Line or Bar graph type depending on how you wish to 
display the graph.

7. Select an Item Type and Account Type from the respective drop-down lists.

The item type and account type that you select here will determine the values 
for which you can generate the graphs. For example, if you select Item Type = 
Products, and Account Type = Accounts-Ship To, then all the products, and 
ship-to locations for the customer account will be listed. You can choose a 
combination of these values to generate the graph.

8. Choose a combination from the displayed values by checking the products/ 
product categories, and the accounts; the graph will be generated based on the 
values that you select here.

9. Click Apply.

6.7.4 Updating Retail Pricing and Details of Competitors’ Products
The Retail Price Points sub tab enables you record the retail prices at which a 
specific retailer sells your products. Retail price is the price at which a retailer sells 
your products to end-customers. Each retailer may sell your products at a different 
retail price. For example, Walmart may sell your product say, Product A at $10.00, 
whereas Bigmall may sell the same Product A at $12.00.

The Retail Price Points sub tab enables you to update information and keep track of 
competitive products and the prices at which they are sold. You can keep a track of 
the retail pricing information of your products as well as the pricing information of 
your competitors’ products. You can monitor the price changes of the competitors’ 
products, and act appropriately. You can also use this information to plan for offers 
and trade promotions in an optimal way. You can also access the Account Manager 
Dashboard from wireless laptops and capture retailer pricing information at the 
retailer’s location.

Use the following procedure to update retail pricing for your products, and to 
update details of competitors’ products.
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Prerequisites
Products must exist.

Steps
1. Log into Oracle Trade Management as Account Manager, and click Account 

Manager Dashboard.

2. In the My Accounts region, drill down the customer account.

The Account Plan for the selected customer appears.

3. Click the Retail Price Points sub tab, and click Update Retail Pricing.

4. To update retail pricing information for your products:

a. Enter the details as required.

b. Optionally click Add Another Row to add a new product, and select a 
product. Enter the details as required.

c. Click Apply.

5. To view and update competitor product details:

a. Click the Competitor icon corresponding to the product for which you 
would like to update the competitor information.

b. Modify the details as required.

c. Optionally click Add Another Row to add a new competitive product. 
Enter the details as required.

d. Click Apply.
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7
Trade Planning and Offers

This chapter gives an overview of Trade Planning and Offers, and explains how to 
plan, create, and manage offers in Oracle Trade Management.

Sections in this chapter include:

■ Section 7.1, "Overview"

■ Section 7.2, "Process Flow"

■ Section 7.3, "Offer Creation"

■ Section 7.4, "Offer Forecasting"

■ Section 7.5, "Offer Sourcing"

■ Section 7.6, "Offer Approval"

■ Section 7.7, "Offer Execution"
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7.1 Overview
Discount planning is an integral part of Trade Planning. It involves planning 
discounts in such a way that it encourages customers to buy products, and at the 
same time fetches the desired return on investments. By offering discounts, 
organizations can improve sales, achieve sales targets, and gain competitive 
advantage. Different types of discounts must be offered based on different business 
conditions and scenarios. Some of the challenges that organizations face are those of 
planning discounts based on realistic data, analyzing performance of offers, 
tracking usage of funds, and making real-time adjustments to offers.

Offers in Oracle Trade Management simplifies the process of discount planning, 
execution, and tracking. Offers enables you to plan and create different kinds of 
offers depending upon the requirements and the results to be achieved. You can 
associate offers with products or campaigns, predict the performance of new offers, 
and create adjustments to active offers. You can also track and monitor the costs and 
revenues for active offers.

7.2 Process Flow
Figure 7–1 illustrates the process flow for offers, starting from offer creation to offer 
execution.

Figure 7–1 Process Flow For Offers

Create Offer
Offers are created to offer discounts and promote sales. You can create different 
kinds of offers based on the sales objectives. You can also specify the discount 
levels, date qualifiers, and market eligibility for the offer.

Create Offer Forecast
Creating an offer forecast enables you to predict the performance of new offers by 
utilizing base sales data (sales data of the previous year). You can optionally create 
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offer forecasts at any time irrespective of the offer status.You cannot modify, update, 
or delete a forecast after it is frozen.

Request Funds
An offer must source funds from a budget or a campaign to offer discounts to the 
retailers and customers. An offer can source funds from multiple budgets, and a 
budget can fund multiple offers.

Approval
An offer must go through the offer approval process to become active. The offer 
approval process involves offer theme approval and budget approval. Offer theme 
approval is the process by which the offer plan gets approved. Budget approval is 
the process by which the budget owners approve the request to source funds from 
the budgets.

Execute Offer
After an offer becomes active, you can make it available to customers, and 
customers can place orders against it. Discounts are applied when customers place 
orders. Orders are created in Order Management.

The budgets from which the offer has been sourced are updated based on the orders 
and payments received from customers, and accruals that are paid. Customers may 
claim the discounts offered by submitting claims or by short paying invoices. These 
claims and deductions are handled through the Claims module.

7.3 Offer Creation
To create an offer, you must understand the different offer types, qualifiers, discount 
tiers, budget-offer validation, performance rules, promotional limits, offers 
evaluator, and offer worksheet, and offer payout dates and methods.

Topics included are:

■ Section 7.3.1, "Offer Types"

■ Section 7.3.2, "About Qualifiers"

■ Section 7.3.3, "About Discount Level and Discount Tiers"

■ Section 7.3.4, "Creating an Offer"

■ Section 7.3.5, "Defining Qualifiers and Discount Rules"
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■ Section 7.3.6, "About Market Eligibility"

■ Section 7.3.7, "Defining Market Eligibility for an Offer"

■ Section 7.3.8, "About Advanced Options"

■ Section 7.3.9, "About Offer Payout Dates and Methods"

■ Section 7.3.10, "Specifying Advanced Options and Offer Payout Dates and 
Methods"

■ Section 7.3.11, "About Performance Rules"

■ Section 7.3.12, "Specifying Performance Rules"

■ Section 7.3.13, "About Promotional Limits and Multiple Currency Price Lists"

■ Section 7.3.14, "Defining Promotional Limits for an Offer"

■ Section 7.3.15, "About Offer Adjustments"

■ Section 7.3.16, "Creating Offer Adjustments"

■ Section 7.3.17, "Approving Offer Adjustments"

■ Section 7.3.18, "About Copy Offer"

7.3.1 Offer Types
Offers refer to incentives that are given to customers to encourage them to purchase 
products or services. Offers are known as promotions or trade promotions, and 
trade deals depending on whether they target specific trade customers, or specific 
accounts.

A few examples of offers are:

■ Purchase a DVD player and get a free DVD

■ Buy $100 worth of items and get 20% off your entire order

■ Buy 2 get 1 free

Oracle Trade Management supports different types of offers that can be classified 
into the following categories:

■ Business to Business Offers (B2B Offers): Off-invoice, Order Value, Promotional 
Goods, Terms Upgrade, Accrual, Net Accrual, Volume, and Trade Deal.

■ Business to Customer Offers (B2C Offers): Lump sum and Scan Data.
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Accrual Offer
In an Accrual offer, delayed discounts are offered on purchases made over a specific 
period of time. The delayed discount that is offered gets accrued over a specified 
time period. Retailers can later obtain this money by submitting claims. This kind of 
discount is also known as rebate. Discounts can be tiered.

For example, an organization creates an accrual offer for Wal-Mart for the period 
March 1, 2004 through March 31, 2004. Wal-Mart gets $1.00 for every case of 
Product X that it sells to anyone (excluding themselves) in the USA. Therefore every 
case sold will create an accrual of $1.00 per case. At the end of the offer period (after 
April 1, 2004), Wal-Mart can raise a claim and request the organization to reimburse 
the accrued incentives. If Wal-Mart has sold 10 units of Product X during the offer 
period, then it is eligible to receive $10 ($1 * 10).

Lump sum Offer
Manufacturers may have agreements with retailers or customers to pay them if they 
carry out certain trade promotion activities on behalf of the manufacturer. Lump 
sum offers are created exclusively to offer incentives to customers or retailers if they 
perform tasks or actions that have been agreed upon. Promotional payments arising 
out of Lump sum offers are either accrued immediately, or over a period of time. 
When you create a Lump sum offer, it is mandatory to mention the time period 
within which the retailer must carry out activities that have been agreed upon. 
Lumpsum offers are customer-specific; they can target only one customer at a time.

A few examples for Lump sum offers are given below:

■ A manufacturer creates a Lump sum offer to offer an incentive to a retailer if the 
retailer displays the products in the showroom between January 1, 2004 and 
January 31, 2004.

■ A manufacturer creates a Lump sum offer for a customer conversion program 
whereby the manufacturer pays a lump sum amount to the customer as an 
incentive to do business with the manufacturer.

Lump sum offers may be with spread or without spread. In case of a Lump sum 
offer with spread, the incentive is spread over a period of time and is paid based on 
time periods. The incentive is divided by the number of days the retailer is expected 
to carry out the activities. If a Lump sum offer is without spread, then the incentive 
is accrued up front at once irrespective of the time period.

For example, you create a Lump sum offer to offer $5000 to a customer if the 
customer displays an in-store advertisement for 10 days.
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If the Lump sum offer is with spread, then because the offer lasts for 10 days, and 
the Lump sum offer is with spread, the retailer receives: 

■ $500 if he displays the in-store advertisement for 1 day

■ $1000 if he displays the in-store advertisement for 2 days

■ $5000 if he displays the in-store advertisement for 10 days

On the other hand, if the Lump sum offer is without spread, the entire incentive 
($5000) is accrued irrespective of the number of days for which the retailer displays 
the in-store advertisement.

Net Accrual Offer
Gross sales is the sales that is achieved based on the invoice value. Net sales can be 
defined as the sales that is achieved after subtracting the discounts, promotions, 
allowances, returns, and freight charges from the gross sales. In a Net Accrual offer, 
discounts are calculated based on the net sales. Net Accrual offers are used to create 
post sales accruals, and are created on top of accrual offers. Net Accrual offers can 
also be created with a start date before the current date.

For example, a manufacturer reduces the price of a product because of its poor 
performance. To compensate the retailers for the losses that were incurred in the 
previous purchases from this product, the manufacturer creates a Net Accrual offer 
with a start date before the current date and stipulates certain accrual percentage for 
the past product purchases. Discounts can be tiered.

A Net Accrual offer can also have limits such as the maximum accrual amount, and 
maximum accrual for a customer. The accrual rules determine the accrual 
calculation for Net Accrual offers. Accrual rules can be defined by the 
Administrator. See the Oracle Trade Management Implementation Guide for more 
information.

Off-invoice Offer
This is also known as On-invoice offer. In an Off-invoice offer, discount is offered on 
the invoice amount when customers purchase the specified quantity of a product. 
Customers will be eligible for the discount only if they buy the specified number of 
units of the specified product. For example, Buy 100 units of Product A and get 10% 
off on the purchase price.

The discounts and quantities can be tiered. For example, 

■ Buy 100 units of the product and get 5% discount

■ Buy 101-200 units of the product and get 10% discount
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■ Buy 201 or more units of the product and get 15% discount

Order Value Offer
In an Order Value offer, discount is offered on the entire order value, irrespective of 
the products that a customer purchases. The customer may purchase different 
products; the discount is offered on the total value (order amount) of these 
products.

The discounts can be tiered. For example:

■ Spend $100 to $499 and get 10% off on the total purchase price

■ Spend $500 or more and get 20% off on the total purchase price

Promotional Goods Offer
A Promotional Goods offer includes an additional product or service with the 
purchase of a specified product. When customers purchase certain goods or 
services, they are eligible for one of the following:

■ To receive additional goods or services at no extra charge. For example, 
purchase a Computer and get a free Printer.

■ To receive a percentage off on additional goods or services. For example, 
purchase a Refrigerator and get 50% discount on a Food Processor.

This offer type can be either on a recurring basis or non-recurring basis.

Assume that you have created Promotional Goods offer whereby the customers will 
get 1 unit of Product B absolutely free if they purchase 10 units of Product A. In this 
case:

■ If the offer is on a non-recurring basis, then a customer who purchases 20 units 
of Product A, gets 1 unit of Product B.

■ If the offer is on a recurring basis, then a customer who purchases 20 units of 
Product A, gets 2 units of Product B.

Scan Data Offer
Scan Data offers are commonly used in the Consumer Goods industry. These offers 
appear as manufacturer-sponsored coupons, consumer rebate programs, or 
discounts. Customers can redeem these coupons and avail discounts on certain 
products. The data is processed by third party clearing houses and passed to the 
manufacturer who reimburses the retailer. In some cases the retailer submits the 
data directly to the manufacturer who validates it and reimburses the retailer.
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Redemption data can be posted either when the offer is active, or after it is 
complete. Depending upon the posting method, reimbursement can occur either 
throughout the promotion or after the promotion is complete. For example, an 
organization issues a coupon for 25% off the retail price of its orange juice product. 
The coupon is valid for one year.

When the actual values of Scan Data offers exceed the committed amount or 
forecasted values, the claim automatically adjusts the scan data accruals as required, 
including the committed and utilized funds. The committed and utilized amounts 
in Scan Data offers are adjusted depending upon the fund utilization. See 
Chapter 10, "Claim and Deduction Management" for more information on Scan 
Data offer adjustments.

Terms Upgrade Offer
In a Terms Upgrade offer, discount is offered on costs that are associated with a 
purchase; the discount is related to the purchase. For example:

■ Purchase $100 worth of items and receive free shipping.

■ Purchase a car and receive four free service sessions for the car.

Oracle Trade Management supports the following types of terms upgrade:

■ Freight Terms

This type of terms upgrade enables you to specify the freight terms such as 
paying the freight charges on behalf of the customer and claiming it back from 
the customer at a later point of time; or waiving off the freight charges for the 
customer.

■ Payment Terms

Payment terms enables you to enter payment specifications such as extended 
payment period for the customer. For example, your organization may have a 
policy whereby the customers must make payments within 30 days of buying a 
product. By specifying payment terms, you can extend this payment period to 
60 days.

■ Shipping Terms

Shipping terms enable you to offer services such as free shipping or shipping at 
a discounted price.

For each of these options, you can enter the cost of the terms upgrade. For example, 
if you are extending the payment period for a customer, you can enter an estimate 
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of how much this may cost to the company. However, this field is for your 
information purposes only and has no functional impact.

Trade Deal
Trade Deals cover a wide variety of promotions and discounts. Off invoice as well 
as Accrual offers can exist within the same offer and this is the advantage of 
creating a Trade Deal.

Trade Deal enables you to create accrual discount rule as well as off-invoice 
discount rule within a same offer, without having to create two separate offers for 
the same purpose. 

When you create a Trade Deal you can either:

■ Apply only Accrual discount rules: customers accrue funds based on sales that 
they achieve.

■ Apply only Off-invoice discount rules: customers receive discounts on products 
that they purchase.

■ Apply Accrual discount rules as well as Off-invoice discount rules: customers 
accrue funds based on the sales that they achieve and receive discounts on 
products that they purchase. 

For example, an organization launches a new product. To promote the product, it 
creates a Trade Deal for retailers whereby they receive accruals for every unit of the 
product that they sell. Apart from this, the customers also receive an incentive if 
they feature and display the new product in the front of their store for one month.

In a Trade Deal the two discount rules coexist and get applied to the order on the 
item list price and not on the discounted value; where as if an Off-invoice offer and 
Accrual offer are applied separately to the same effect they would get applied on 
the order one after the other, depending on the discount buckets setup.

For example, the selling price of a product is $100. You create a trade deal that offers 
10% off-invoice and 10% accruals for the customer. When customers buy the 
product, they receive 10% off the invoice ($10) and receive 10% accruals ($10). 
Therefore the actual selling price will be $100 - $10 (off-invoice) - $10 (accruals) = 
$80.

If an Off-invoice offer and an Accrual offer are applied separately to give 10% 
off-invoice and 10% accruals, one of these two can be based on the net price. This 
means that either the Off-invoice offer or the Accrual offer will be applied first. The 
new price of the product will be $100 - $10 (off-invoice or accrual) = $90. Next, the 



Offer Creation

7-10 Oracle Trade Management User Guide

second offer will be further applied. The final selling price of the product will be $90 
- $9 (10% of 90) = $81.

Volume Offer
Volume offers are created to encourage customers to purchase higher quantities of 
products. In a Volume offer, the qualified retailers accrue funds based on their 
cumulative purchases spanning over a period of time. Volume accrual offer 
typically includes multiple performance tiers. Retailers approaching a new tier may 
be motivated to purchase more goods to receive a larger discount. Volume offers are 
customer-specific; they can target only one customer at a time.

The incentive can be applied to a retailer’s open invoices or a discretionary business 
fund either as a discount, or an accrual. It can also be used to develop revenue 
forecasts and inventory planning strategies.

For example, Purchase any of the following amounts of Products X, Y, and Z 
cumulatively between January 1, 2004 and December 31, 2004, and get the related 
discount.

$100,000—3% discount

$200,000—4% discount

$300,000—5% discount

In Volume offers, the Retroactive Flag determines whether past orders should also 
be adjusted based on the new accrual rate achieved. For example, a Volume accrual 
offer is set up for a customer to accrue funds based on the total volume of the 
product sold for the next 6 months, as follows:

Each unit is priced at $1.00. The first few orders from a customer look as follows:

0-1000 accrue 5%

1001-2000 accrue 8%

2001 or more accrue 10%

Order No. Quantity Purchased Accrual % Accrual

1 600 5% 30

2 400 5% 20

3 100 8% 8
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If the Retroactive Flag is on, then the system revisits order 1 and order 2 and makes 
a volume offer adjustment as follows:

The customer places another order:

More Volume offer adjustments are made:

The following occurs if the retroactive flag is off:

Order No.
Quantity 
Purchased Accrual % Accrual

Volume Offer 
Adjustment

Total 
Accruals

1 600 5% 30 600 * (8% - 5%) = 18 48

2 400 5% 20 400 * (8% - 5%) = 12 32

3 100 8% 8 -NA- 8

Total 1,100 -NA- -NA- -NA- 88

Order No. Quantity Purchased Accrual % Accrual

4 1,000 10% 100

Order 
No.

Quantity 
Purchased

Accrual 
% Accrual

Volume Offer 
Adjustment 1

Volume Offer 
Adjustment 2

Total 
Accruals

1 600 5% 30 600 * (8% - 5%) 
= 18

600 * (10% - 8%) 
= 12

60

2 400 5% 20 400 * (8% - 5%) 
= 12

400 * (10% - 8%) 
= 8

40

3 100 8% 8 -NA- 100 * (10% - 8%) 
= 2

10

4 1000 10% 100 -NA- -NA- 100

Total 2,100 -NA- -NA- -NA- -NA- 210

Order No. Quantity Purchased Accrual % Accrual

1 600 5% 30

Total 2,100 -NA- 158
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7.3.2 About Qualifiers
Qualifiers enable you to specify the date range for different qualifying attributes for 
an offer. You can specify the following qualifiers for an offer:

■ Order Dates

Order date is the date on which a customer or retailer places an order. 
Discounts are offered on orders that are placed in the specified date range.

For example, if you specify the date range for Order Dates as December 14, 2003 
and December 30, 2003, then customers who place orders between these dates 
will be eligible for discounts.

■ Ship Dates

Ship date is the date on which goods are shipped to the customer location. 
Discounts are offered on goods that are shipped in the specified date range.

For example, if you specify the date range for Ship Dates as December 14, 2003 
and December 30, 2003, then all goods that are shipped between these dates will 
be eligible for discounts.

2 400 5% 20

3 100 8% 8

4 1,000 10% 100

Note: In general, the offer types—Accrual, Net Accrual, Trade 
Deal, and Volume offers are referred to Accrual offers because all 
these offer types involve offering delayed discounts to customers.

Note: If you specify the Order Dates as well as the Ship Dates for 
an offer, then the offer will be applied only for those orders that are 
booked within specified Order Dates and also shipped within 
specified Ship Dates. If the order is shipped after the specified 
dates, then the offer will be re-evaluated.

Order No. Quantity Purchased Accrual % Accrual

Total 2,100 -NA- 158
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■ Performance Dates

Performance rules are the rules that a retailer or a customer must comply with 
to qualify for the discounts that are defined in an offer. Performance dates 
determine the time period within which retailers or customers must carry out 
the activities that are assigned to them in order to qualify for the discount. 
Performance dates are used to ensure that customers meet the performance 
criteria before a claim can be settled. Performance dates are not related to sales 
orders or product sales.

In case of performance requirements whereby retailers perform activities such 
as end-aisle display or poster display, you can add the attach digital 
photographs of the display to the offer. During claim settlement, the claims user 
can use this information as performance proof.

For example, you specify the date range for Performance Dates as December 14, 
2003 and December 30, 2003. You have an agreement with the retailer to display 
a poster in the showroom for a new product. The retailer displays the poster 
within this time period. You perform a physical inspection of the retailer’s 
showroom and take a photograph of the display. You convert the photograph 
into digital format and add it as an attachment to the offer. During claim 
settlement, the claims user can use this attachment as performance proof.

7.3.3 About Discount Level and Discount Tiers
Discount rules enable you to enter discount information for individual products 
and product lines in the offer. For an offer, you can select the discount level, and 
discount tier based on how you want to offer discounts.

Discount Level
The discount level can be either Line, or Group of Lines. Line enables you to apply 
the discount to each individual product in the offer, whereas Group of Lines enables 
you to apply the discount collectively to all the products in the offer.

For example, you create an Off-invoice offer to give 10% discount the following 
products:

■ Product A: $100

■ Product B: $75

■ Product C: $20 
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If you select Line as the discount level, then the customer gets 10% discount on each 
of the products individually. The new selling prices of the products will be as 
follows:

■ Product A: $100 - $10 = $90

■ Product B: $75 - $7.5 = $67.5

■ Product C: $20 - $2 = $18

If you select Group of Lines as the discount level, then the discount is collectively 
applied to the sum total of the selling prices of Product A, Product B, and Product 
C. The set of products costs $200 ($100+$75+$25). After applying discount, the set of 
products will cost $180 ($200-$20). Here, $20 is the discount that is offered on the 
sum total of selling prices of Product A, Product B, and Product C.

If you select Group of Lines as the discount level, it is mandatory that you specify 
the volume of the products. For more information on Discount Levels, see the Oracle 
Advanced Pricing User Guide.

Discount Tiers
Discount Tiers enable you to determine the manner in which you apply discounts to 
an offer.

Discount tiers are of the following two types:

■ Single-tier Discount

Single-tier Discount enables you to enter a single discount value against a 
product. For example, to offer 10% discount on every unit of Product A, you 
must select the tier type as Single and enter the discount value as 10%. 

■ Multiple-tier Discount

Multiple-tier Discount enables you to specify different levels of discounts based 
on the quantity of the product purchased. You can offer discounts based on the 
number of product units that the customers purchase.

For example, you can offer discounts for a product such that customers get:

■ 0 discount if they purchase less than 50 units

Note: Discount tiers are evaluated on a single-order basis only. 
Use Volume offers to evaluate discount tiers on a cumulative order 
basis.
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■ 5% discount if they purchase 50-100 units

■ 10% discount if they purchase more than 101 units

To do this, you must select the tier type as Multiple, and specify the discount 
values accordingly.

Discount tiers are supported only for Accrual, Trade Deal, Volume, Off-invoice, and 
Order Value offers.

7.3.4 Creating an Offer
Use the following procedure to create Accrual, Off-invoice, and Terms Upgrade 
offers. You can use it for the basics of creating other offer types as well. Table 7–1, 
"Other Offer Type Creation Conditions" includes the specific information you need 
to create other offer types.

Prerequisites
None.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Trade Planning > Offers.

2. Click Create.

3. From the Setup Type list, select the type of offer you want to create.

The page redraws and the fields may change depending upon the type of offer 
that you select.

4. Enter a unique name for the offer in the Offer Name field.

5. Select a customer from the Customer drop-down list, and select a customer 
name from the LOV.

6. Enter a unique code in the Offer Code field, or leave the field blank.

If left blank, a unique code is generated automatically.

7. If the customer must specifically state participation in the offer when 
submitting an order, then select the Request Only check box.

8. Select the Start date and End date for the offer.

9. If you must change the currency, then select a new value from the Currency 
drop-down list.
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10. Select one of the following from the Discount Level drop-down list:

– Line: applies the discount to the order line by order line.

– Group of lines: applies the discount to a group of lines in the order.

The offer type determines the choices you have for this field.

11. In the Activity field, open the list and select the activity that must be used to 
execute this offer.

12. If the funding source for this offer is an existing budget, then select the budget 
name.

13. In the Committed Amount field, enter the amount you want to commit for the 
offer.

14. If the committed amount is the maximum amount allowed for this offer, select 
Yes for Committed = Maximum.

If you select Yes, Oracle Trade Management automatically passes the committed 
amount to Advanced Pricing to ensure that the offer is limited to this amount.

15. In the Campaign field:

a. To associate the offer with a campaign, select a campaign. This does not 
mean that you will be sourcing funds for the offer from the campaign.

b. To fund the offer from this campaign, select the Source From Campaign 
check box. An offer can source funds from a campaign (ultimately the 
parent campaign) or from one or more budgets. For more details on 
sourcing from a campaign, see Section 7.5, "Offer Sourcing".

16. If the offer can be used for multiple campaigns, then select the Reusable check 
box.

17. To keep the offer confidential until it becomes active, select the Confidential 
check box. If selected, the offer will be visible only to the owner until the offer 
status changes to active.

Note: Offers are sourced from a campaign or from multiple 
budgets. If you select a budget here, you can select additional 
budgets later from the Offer Details page by clicking Budget in the 
side navigation bar, entering an initial budget estimate, clicking 
Update, then clicking Create Request. See Section 7.5, "Offer 
Sourcing" for more information.
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18. Optionally, in the Owner field, change the owner of the offer by deleting the 
current name, and selecting a new owner from the Resource Selector window.

19. In the Description field, type any additional information required for the offer.

20. Click Create.

As noted above, the steps in the preceding procedure are for creating Accrual, 
Off-invoice, and Terms Upgrade offers. To create other offer types, use these steps 
and the conditions listed in Table 7–1.

Table 7–1 Other Offer Type Creation Conditions

Offer Type Requirements

Lump sum You must enter a name for the offer.

You must also select a:

■ Customer.

■ Distribution Type. Select the distribution method from the list. 
What you select here determines how you might distribute the 
discount by line item on the Offer Details page.

■ Lumpsum Amount. Type the actual dollar amount in this field.

For example, if the lump sum amount is $100 and you select 
Percent as the distribution type, on the Offer Details page you 
might specify the following:

Line 1 receives a 25% discount
Line 2 receives a 50% discount
Line 3 receives a 25% discount

■ Payment Type. Open the list and select whether the earnings will 
be paid by issuing a check or whether they will be accrued.

Order Value You must enter a name for the offer.

You must also select a:

■ Discount Type (percent or terms upgrade)

■ Discount Level
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Promotional Goods You must enter a name for the offer.

You must select a Discount Level.

Optionally, you can select a Break Type (Point or Recurring.)

Point example: The offer condition is buy 10 units of product X and 
you will receive 1 unit of product Y. A customer buys 20 units of 
product X, but receives only one unit of product Y. 

Recurring example: The offer condition is buy 10 units of product X 
and you will receive 1 unit of product Y. A customer buys 20 units of 
product X, and receives two units of product Y.

Scan Data All fields for creating this type of offer are described in the 
procedure. Fields not displayed are not relevant to Scan Data offers.

Volume You must enter a name for the offer.

You must select:

■ A Customer.

■ An Incentive (off invoice or accrual.)

Off-invoice: the discount shows on the invoice.
Accrual: the discount accrues and is not seen on the invoice. It is 
settled later through a claim.

Optionally, you can make the offer Retroactive. If selected, past 
accruals are updated to the new rate once the new volume tier has 
been reached.

The discount level is always set to Line.

Trade Deal You must enter a name for the offer.

You must select a Customer.

Optionally, you can specify a Customer Reference and Buyer Name 
for informational purposes only.

Table 7–1 Other Offer Type Creation Conditions

Offer Type Requirements
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7.3.5 Defining Qualifiers and Discount Rules
Offer qualifiers and discount rules determine the behavior of the offer. Use the 
following procedure to set up qualifiers and discount rules.

Prerequisites
An offer must exist.

Steps

1. Log into Oracle Trade Management as Oracle Trade Management User and 
navigate to Trade Planning > Offers.

Net Accrual You must select a Tier Level. Tier Level can be either:

■ Offer: If you select this option, then the customer will be paid 
accruals based on the offers that the customer is eligible for.

■ Product: If you select this option, then the customer will be paid 
based on the quantity of products that the customer has sold.

■ You must select a Net Accrual Rule. Net Accrual rules are set to 
adjust the Total Sales figure for specific customers and products 
down to a Net Sales figure.

For example, a Sales Representative creates a deal with a 
customer such that the customer will receive 10% money back 
for all the purchases made in the last 3 months for a particular 
product. The Sales Representative finds that the total sales over 
the last 3 months for this customer this product were $1000. But, 
because this customer submitted claims for various reasons and 
was ultimately given credits back for $200,the Sales 
Representative does not want to give back 10% on $1000, but 
rather on $800. The $200 in credit memo should be a part of the 
net accrual rule.

Note: The following steps are written for Accrual offers. Use these 
instructions as a starting point for setting up qualifiers and 
discount rules for other offer types. See Table 7–2, "Qualifier and 
Discount Rule Set Up for Other Offer Types" for additional 
information. 

Table 7–1 Other Offer Type Creation Conditions

Offer Type Requirements
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2. Click the hyperlink of the offer.

3. To set up the qualifiers, scroll down to the Qualifiers region of the page, and 
select the order, ship and performance dates.

4. To set up the discount rules, scroll down to the Discount Rules region of the 
page. For each line, enter rules as follows:

a. From the Level list, select a product level: 

– Item Number (a specific product)

– Item Category (a product family such as batteries)

– ALL_ITEMS (all products)

– iStore Section (applicable only if using Oracle iStore).

b. Select a value from the Name LOV.

The list displayed is based on the value selected in the Level column.

c. Select a unit of measurement (UOM).

d. Select either Single or Multiple from the Tier Type drop-down list.

If you choose Multiple, then you must enter the tier information in another 
Offer Details page. To access this page, you must complete this procedure, 
click Update, and then click the Details icon.

e. To specify a Minimum Volume and Volume Type:

– In the Minimum Value field, type the minimum quantity that must be 
purchased to qualify for the offer.

– Select Amount or Quantity from the Volume Type drop-down list.

The volume type that you select qualifies the minimum volume. For 
example, if you enter 100 for the minimum volume and select quantity for 
the volume type, then the customer must purchase at least 100 units of the 
item. If you select amount for the volume type, then the customer must 
purchase at least $100 worth of the product.

f. Type a numerical value in the Discount field, and select a value from the 
Discount Type drop-down list.

The discount type qualifies the discount value. For example, if you enter 5 
for discount, then the following would result for the various discount types 
you could select.
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Amount = $5.00 off the price per unit
Percent = 5% off the price per unit
Lumpsum = a flat $5.00 off an order for that product regardless of quantity
New Price = the new price per unit is $5.00

5. Click Update.

Qualifier and Discount Rule Set Up for Other Offer Types
Table 7–2 is a supplement to the procedure listed above. Use these steps and the 
table below to set up qualifiers and discount rules for other offer types.

Table 7–2 Qualifier and Discount Rule Set Up for Other Offer Types

Offer Type Differences

Off Invoice Incentives are paid directly off the invoice as opposed to being accrued.

Trade Deal ■ Can have both accrual and off invoice components for each line item. 

■ Tiers are not supported.

Lump sum ■ Each line item must have a discount value based on the distribution 
type (amount, percentage, or quantity). 

■ If percentage is the distribution type, the total discount value (sum of 
all line items) must equal 100%. Otherwise, it must equal the total 
lump sum amount.

Volume Ranges can be in amount of quantity. Specify the unit of measure.

■ From – The minimum value required to qualify for a tier.

■ To – The maximum value allowed within a tier.

■ Discount – The corresponding discount or incentive that applies to 
values within the range of each tier. The value can be a percentage or 
an amount.

Select the product or product category (can have products excluded from 
the discount) from the Product Profile table.
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Scan Data ■ Level – Product or product family.

■ Name – Product or product family name.

■ UOM – Unit of measure. Available values are based on the item level 
and product name selected.

■ Scan Type – Select the values that represent the type of scan 
promotion vehicle utilized, for example, coupon or POS data feed.

■ Scan Value – Enter a value that corresponds with each item specified 
in the profile.

■ Scan Unit Forecast – enter one of the following values:

The amount of units that you anticipate will be sold during the offer. 
The value may be entered manually or may have values derived from 
the Offer Forecast function. This amount is editable while the offer 
status is Draft. Once the status is Active, the forecast cannot be 
changed.

The amount of coupon or rebate units that could potentially be 
redeemed.

■ Amount Value – The forecasted number of units in the UOM 
multiplied by the scan values entered for each line item. This value is 
automatically calculated.

■ Adjustment – Check this box to allow auto-adjustments for 
over-utilization. This option is displayed only when the offer status is 
Draft or Planned. Once the status is Active, this column is not 
displayed at the Offer Details level. 

Adjustment is available for each line level identified in the Scan Data 
Profile table at the Offer Details level. Budget adjustments are made 
automatically for committed and utilized amounts at each line level 
indicated.

■ Once the actual consumption or redemption data has been entered 
through the Claims module, you will see the actual redemption from 
this UI.

Terms 
Upgrade

Select a term (freight, payment or shipping) to be upgraded to another 
term and its associated cost at the line level. Each line can be associated 
with a product category, product, an iStore selection, or to all products.

Promotional 
Goods

■ Select the products that must be purchased (level, name, minimum 
value or quantity).

■ Select the products that will be discounted (level, name, quantity, 
discount value and type).

Table 7–2 Qualifier and Discount Rule Set Up for Other Offer Types

Offer Type Differences
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7.3.6 About Market Eligibility
Market eligibility enables you to define the customers or customer groups that an 
offer must target. By specifying market eligibility, you can determine what 
discounts apply to whom during what period of time.

When you request funds for an offer by submitting a budget request, the market 
eligibility specified in the offer is matched with the market eligibility and the 
product eligibility specified in the fixed budget. The offer can source funds from the 
budget only if these conditions match. This process of matching the conditions takes 
place in the background and is known as budget-offer validation. For more 
information on budget-offer validation, see Section 7.6.3.

To specify market eligibility for an offer, you must select the required attribute 
values such as customer segment, territory, list, order date, or order amount. 
Conditions such as Equal to, Between, and Not Equal to, enable you to indicate 
attribute values. See Section 9.3.8, "Market Eligibility and Product Eligibility" in the 
Budgets Chapter for more information on how you can use lists, segments, 
territories, and so on to define market eligibility. See Chapter 3, "Customers" for 
more information on lists. See the Oracle Marketing User Guide for more information 
on segments.

For example, you can set market eligibility for an offer as shown in the table below. 
Here, the offer will be valid if all the conditions specified below are met:

■ Orders must be received between March 14, 2003 and August 14, 2003.

■ Customers can belong to Gold segment and must place orders between $25,000 
and $50,000. They can also belong to Bronze segment and must place orders for 
$40,000 or more.

Order Value If the Discount Type is:

■ Percent, enter a percent.

■ Term Upgrade, enter a term upgrade (value and term type). 

Market 
Context

Context 
Attribute Condition

Attribute 
Value From

Attribute 
Value To

Group 
Number

Start 
Date

End 
Date

Customer Segments = Gold 
Customer

-NA- 2 -NA- -NA-

Table 7–2 Qualifier and Discount Rule Set Up for Other Offer Types

Offer Type Differences
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Group numbers are used to create combinations for market eligibility. Group 
numbers determine how the rows are combined with each other. Rows with the 
same group number are evaluated as an AND condition, where as rows with 
different numbers are evaluated as an OR condition. See the Oracle Trade 
Management Implementation Guide for more information on setting up groups.

In the above example, assume that Group Number 2 includes Customer A, 
Customer B, and Customer C, and all the three customers belong to the Gold 
Customer Segment. Then all the rows, which have the group number as 2 apply to 
these customers. It means that these customers will be eligible for the discount if 
they place orders between March 14th 2003 and August 14th 2003, and the order 
amount must be between $25,000 and $50,000.

To define market eligibility for offers that relate to Chargebacks and Third Party 
Accruals, you can select the seeded qualifier that is available in Market Eligibility. 
This indirect sales qualifier restricts the offer so that it applies only to the Indirect 
Sales POS data that is processed in Oracle Trade Management. For more 
information on Chargeback and Third Party Accruals, see Chapter 11, "Indirect 
Sales Management".

In offers, you can support beneficiary customers who are different from qualifying 
customers. This means that you can distinguish between the customer of the accrual 
source and the customer who receives the accrual earnings. The qualifying 
customer and the related beneficiary customer information is set up in the Trade 

Order Order Date Between March 14 
2003

August 14 
2003

2 -NA- -NA-

Volume Order 
Amount

Between $25000 $50000 2 -NA- -NA-

Customer Segments = Bronze -NA- 3 -NA- -NA-

Order Order Date Between March 14 
2003

August 14 
2003

3 -NA- -NA-

Volume Order 
Amount

= $40000 -NA- 3 -NA- -NA-

Note: For volume accrual offers, you can define market eligibility 
only for individual customers and buying groups.

Market 
Context

Context 
Attribute Condition

Attribute 
Value From

Attribute 
Value To

Group 
Number

Start 
Date

End 
Date
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Profile of the customer. You can also enter details of the qualifying customers and 
beneficiary customers in which case the data in the Trade Profile will be 
superseded.

7.3.7 Defining Market Eligibility for an Offer
Market eligibility enables you to define the customers or customer groups that an 
offer must target. By specifying market eligibility, you can determine what 
discounts apply to whom during what period of time. The market eligibility that 
you specify will also be used during budget-offer validation; whenever you request 
funds for an offer by submitting a budget request, the market eligibility specified in 
the offer is matched with the market eligibility and the product eligibility specified 
in the fixed budget. The offer can source funds from the budget only if these 
conditions match. Use the following procedure to define market eligibility for an 
offer.

Prerequisites
An offer must be created.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Trade Planning > Offers.

2. Click the hyperlink of the offer. 

3. Click the Execution side navigation link, and then click Market Eligibility.

4. For each customer type, complete a row in the table as follows:

a. Select a value from the Market Context drop-down list, and then select a 
value from the Context Attribute LOV. The Market context that you have 
selected will determine the values that are displayed in the Context 
Attribute LOV.

b. From the Condition column drop-down list, select one of the following 
operators:

– Between: to indicate a range of values. You can define the range by selecting 
values in the Attribute Value From and Attribute Value To columns.

– Equal To (=): to indicate a value equal to the one specified in the Value From 
column.
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– Not Equal To (Not =): to indicate a value that is not equal to the one 
specified in the Value From column.

c. Depending upon the conditions that you have selected, select values for the 
Attribute Value From and Attribute Value To columns as appropriate. The 
values that are displayed when you click the Search icon depend upon the 
Context Attribute that you have selected.

d. Type a value in the Group Number column.

Group determines how the rows are combined with each other. Rows with 
the same group number are evaluated as an AND condition; Rows with 
different numbers are evaluated as an OR condition. See Section 7.3.6, 
"About Market Eligibility" for more information on group numbers.

5. Click Update.

7.3.8 About Advanced Options
Advanced Options enables you to accurately control the behavior of offers. 
Advanced options is an Oracle Advanced Pricing feature that enables you to define 
groups of modifiers where the modifiers in a group are incompatible with each 
other. Modifiers in the same incompatibility group may not be used together on the 
same transaction. For more detailed examples and explanation, see the Oracle 
Advanced Pricing User Guide.

By using Advanced Options, you can specify the following for an offer:

■ Phases

This is an alternative method to precedence which is used to determine which 
modifier should be selected when multiple modifiers in the same exclusivity or 
incompatibility group are eligible to be applied to the same pricing line within a 
pricing phase. The modifier which gives the lowest price or most advantageous 
price to the customer on the given pricing line will be applied. In Oracle 
Advanced Pricing, the Pricing Engine looks at the phase when deciding which 
lists should be considered in a Pricing Event. You can determine the order event 
(unrelated to Marketing event) and phase to which discounts and promotions 
belong.

■ Buckets

Buckets determine how modifier price adjustments are applied to the list price 
of an item to calculate the selling price. Modifiers use the previous buckets 
sub-total for percentage calculation. Modifiers within the same bucket are 
Additive. This means that they are added together, and subtracted from the 
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previous buckets total. You can create unlimited amount of buckets to calculate 
selling price. For example, discounts associated with bucket 0 use list price as 
their calculation basis. Bucket 1 prices use the subtotal resulting from 
subtracting bucket 0 discounts from list price as their calculation. Bucket 2 uses 
the subtotal remaining after subtracting bucket 1 discounts from the bucket 0 
subtotal, and so on.

Pricing engine calculates different selling prices depending on how you group 
your discounts into buckets. You can plan your cascading discounts so that you 
can assign discounts to buckets based on the subtotal on which each discount 
must be applied.

■ Incompatibility Groups and Exclusivity

You can define modifier incompatibility. Modifiers with same incompatibility 
group and phase combination cannot be applied together. You can determine 
the pricing bands to which the various discounts and promotions belong to. 
You can also determine whether the discounts and promotions are incompatible 
or exclusive.

■ Print On Invoice

You can determine whether the offer or the discount should be printed on the 
invoice, or should automatically be adjusted in the unit price without showing 
the discount.

■ Precedence

Precedence is used to resolve incompatibility. Precedence controls the priority 
of modifiers and price lists. If a customer qualifies for multiple modifiers that 
are incompatible with each other, precedence determines the discount that the 
customer is eligible for based on the precedence level of the modifier. 
Precedence is the final tiebreaker for the determining which offer to apply. A 
lower value has higher precedence than a higher value.

7.3.9 About Offer Payout Dates and Methods
Offer payout dates and methods enable you to specify the payment date and 
methods for Accrual, Net Accrual, Trade Deal, and Volume offers. The Autopay 
program can automatically pay promotional accruals according to the payout dates 
and methods that you specify.
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You can specify offer payout dates and methods only if the Autopay program is 
running in the background. When run, the Autopay program accesses outstanding 
customer accrual balances, preferred method of settlement, payment frequency, and 
any performance criteria, and determines whether to automatically pay customers 
or not. When Autopay is run, claims need not be created manually to settle offers.

You can specify the following details during offer creation:

■ The payout date

You can set the payout date at the offer level to automatically pay accruals on a 
particular date. Alternately, you can enter the number of days after the offer end 
date after which accruals must be paid. Autopay creates a claim automatically 
and associates earnings from this specific offer to the claim.

However, if the customer is not eligible for Autopay at the Trade Profile level, 
then this setting at offers level will be overridden. If you are the Sales 
Administrator, you can override the setting in the Trade Profile by using 
Advanced options.

■ The payout method

You can select the payment method for the offer, and choose to pay the accruals 
either through Check or On-account credit.

The payout method that you specify in the offer is passed to Autopay. The claim 
is automatically is settled through this method. If you do not specify the payout 
method, the default payment method will be on-account credit. For more 
information on payment methods see Chapter 10, "Claim and Deduction 
Management".

■ The payout party (beneficiary party)

When you create an offer you can specify market eligibility and define the 
eligible customer (source). Apart from this, you can specify the customer 
(payout party) to whom accruals will be paid. The source can be different from 
the party to whom accruals are paid.

Note: An additional autopay option is available for Lump sum 
offers at the offer level. You can specify the number of days after 
the offer end date after which accruals must be paid, and also 
specify a frequency for payments (weekly, monthly, quarterly, and 
so on).
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For example, you create an accrual offer for Wal-Mart for the period March 1, 
2004 through March 31, 2004. Wal-Mart receives $1.00 for every case of product 
"X" sold to anyone (excluding themselves) in the USA. Therefore every case sold 
will create an accrual of $1.00 per case. Whenever customers buy the product, 
they receive accruals. In this case, Wal-Mart is the source and the customers 
who buy the products are payout parties. If Autopay is enabled, it 
automatically creates a claim on behalf of the customers (payout parties).

The payout party can be a Buying group, or a bill-to customer, or a ship-to 
customer. If you do not specify the payout party, the eligible customer will 
automatically earn the accruals.

The Administrator must perform the following to enable you specify the offer 
payout dates and methods:

■ Run Autopay as a background process, and run it by scheduling.

■ Set the customer Trade Profile as Eligible for Autopay.

Depending upon how Autopay is implemented in your organization, the system 
sends an automatic alert to the offer owner to indicate that the payment has been 
sent. A reference number (either a check number in the case of check, or credit 
memo number in the case of on-account credit) is included in the notification.

7.3.10 Specifying Advanced Options and Offer Payout Dates and Methods
Advanced Options enables you to accurately control the behavior of offers. 
Advanced options is an Oracle Advanced Pricing feature that enables you to define 
groups of modifiers where the modifiers in a group are incompatible with each 
other. For more detailed examples and explanation, see the Oracle Advanced Pricing 
User Guide. Offer payout dates and methods enable you to determine the payment 
date and methods for accrual offers, which includes Accrual, Net Accrual, Trade 
Deal, and Volume offers. Use the following procedure to specify advanced options, 
and offer payout dates and methods for an offer.

Prerequisites
An existing offer.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Trade Planning > Offers.

2. Click the hyperlink of the offer.
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3. Click the Advanced Options side navigation link.

4. Select the options as required.

5. To specify the offer payout dates and methods, scroll down to the Autopay 
Rules region, and follow the steps mentioned below:

a. Check Autopay enabled to enable Autopay for the offer.

b. In the Wait for Days field, enter the number of days after the offer comes to 
end, after which the payment must be made.

c. Select a settlement method from the Settlement Method drop-down list. 
Settlement method can be either Account Credit, or Issue Check.

d. Select a value from the Beneficiary Party drop-down list, and select a value 
from the Beneficiary LOV.

The beneficiary party can be Customer Bill-to, Customer Ship-to, or 
Customer Sold-to. The list of values that appears in the Beneficiary LOV 
depends on the beneficiary party that you have selected.

6. Click Update.

7.3.11 About Performance Rules
Performance rules are rules that a retailer or a customer must comply with to 
qualify for discounts that are defined in an offer. Performance rules enable you to 
define performance requirements for various products irrespective of whether they 
are associated with an offer or not. You can specify detailed performance 
information and multiple execution dates for different products within the range of 
the offer duration. For example, you can create a performance rule for a product 
whereby retailers get paid if they achieve 80% sales within a quarter.

In the above example, retailers get paid if they achieve 80% sales. Therefore, here 
you are specifying performance rules only based on the value of the product. Apart 
from specifying value-based performance rules, you can also specify volume-based 
performance rules or requirements by which you can set performance conditions 
based on volume as well as quantity.

For example, you set up a deal for a customer whereby the customer will accrue 
$2.00 for every unit of product sold in the month of October. You can specify a 
volume-based performance requirement whereby the deal will be valid only if the 
volume of the products sold exceeds 3,000 product units.

By specifying volume-based performance requirements, you can create incentives 
that have a quantifiable objective. This increases the predictability of an offer. When 
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you specify volume-based performance rules, the retailer or customer gets paid 
only if the volume as well as the value of the product sales that is achieved meets 
the terms of the offer. Volume-based performance requirements are applicable to 
Accrual, Lump sum, Trade Deal, and Volume offers.

The accrual engine tracks performance requirements against the orders placed. It 
checks for volume or value, based on the requirement type. After you specify 
performance requirements, the accrual engine calculates and stores the value and 
quantity of ordered products on an everyday basis. The payment will not be made 
until the accruals that are created between the start date and the end date for the 
product specified is greater or equal to the value or volume entered as a part of 
performance requirement specifications. If the volume requirement fails, then an 
alert is sent to the offer owner indicating that the volume check has failed. If the 
performance requirements are met, then the funds that are accrued over a period of 
time are paid to retailers or customers.

However, automatic checks do not work for certain trade promotion activities 
related to advertising and marketing whereby the retailers are supposed to perform 
actions such as poster display, product display, and so on. These performance 
activities can be defined for each item, item category, or for all items. In such cases 
you may attach the digital photographs of the store display to the offer as proof of 
performance. A performance verified check box is available in the claims page to 
imply that the customer has met the performance specified in the offer. The claims 
user makes use of this as performance proof while settling the claim. The claims 
user can access all the details of the performance requirements before associating an 
offer and settling the claim.

Figure 7–2 illustrates the process by which customers get paid based on the 
volume-based performance requirements.
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Figure 7–2 Volume-based Performance Requirements Flow

Before funds are paid to the retailer or customer, the system checks whether the 
retailer or customer has adhered to performance rules specifications. If the retailer 
has not adhered to performance requirements, the system sends notifications to the 
offer owner. The offer owner can skip the performance rule and make payments 
only if a site level profile option has been implemented to override performance 
requirements. See the Oracle Trade Management Implementation Guide for more 
information on setting up this option.

7.3.12 Specifying Performance Rules
Performance rules are rules that a retailer or a customer must comply with to 
qualify for discounts that are defined in an offer. Performance rules enable you to 
define performance requirements for various products irrespective of whether they 
are associated with an offer or not. You can specify detailed performance 
information and multiple execution dates for different products within the range of 
the offer duration. Use the following procedure to specify performance 
requirements for an offer.
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Prerequisites
An offer must be created.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Trade Planning > Offers.

2. Click the hyperlink of the offer. 

3. Click the Planning side navigation link, and then click Performance.

If any performance rules have already been defined, then these rules are 
automatically displayed on the page, and new rows appear at the bottom of the 
table.

4. For each performance requirement, do the following to complete a row in the 
table:

a. Select values for the Product Level, Name, and Trade Medium. In the Level 
column, open the list and select the product level.

b. Select the Start and End dates for the performance requirement.

c. Select Amount or Quantity from the Requirement Type drop-down list. This 
depends whether the performance requirement is value based or volume 
based. See Section 7.3.11, "About Performance Rules" for more information.

d. In the Estimated Value column, you can enter the amount (sales revenue) or 
number of product units depending on whether you have selected amount 
or quantity in the Requirement Type drop-down list.

5. If the performance requirement is mandatory, then select the Required check 
box.

If Required is selected, earnings will not be paid out until the claims user 
verifies and determines that the performance requirements have been met.

6. Click Update.

7. Enter the details for each performance requirement by clicking the Notes icon, 
and typing the requirements into the text field.

8. Click Update.
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7.3.13 About Promotional Limits and Multiple Currency Price Lists
Promotional limits refer to the maximum limits that you can specify for an offer in 
terms of amount and unit for each promotion. You can define the following 
promotional limits for an offer:

■ Maximum number of units of products for an offer

This is the maximum units of products that the offer can support. For example, 
if you specify the maximum number of product units for an offer as 1,000, then 
the offer can accept orders only for a maximum of 1,000 units of the particular 
product.

■ Maximum number of units that a customer can buy

This is the maximum number of units of a product that a customer can buy. You 
can define different limits for different customers. For example, if you specify 
the maximum number of units for a customer as 100, then the customer can 
place an order against the offer only for 100 units or lesser.

■ Maximum number of orders that a customer can place

This is the maximum number of orders that a customer can place against the 
offer. For example, if you specify the maximum number of orders for an offer as 
10, then the customer can place only 10 orders or less against the offer.

■ Maximum quantity in units for each discount rule

An offer can have multiple discount rules. You can specify the maximum 
quantity in units for each discount rule.

■ Maximum committed order amount for each discount rule

Order amount is the total amount of all the products for which the order has 
been placed. You can specifying the maximum total amount for which orders 
can be placed. For example, if you specify the maximum committed amount for 
a discount rule as $10,000, then orders for more than $10,000 worth of products 
will not be accepted.

You can set the above limits for any of the discount lines. You can apply these limits 
to either one discount line or all of the discount lines.

When the promotional limits are violated, one of the following actions take place:

■ Hard - Adjust Benefit Amount: Adjusts the order benefit amount so that the 
order meets but does not exceed the promotional limit. For example, if a 
customer close to their promotional limit places a new order that exceeds the 
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limit amount, the customer receives the benefit only until the amount is 
reached.

■ Soft - Full Benefit Amount: Applies the full benefit to the order and then sends a 
status message to place a promotional hold on the order. For example, if a 
customer close to their promotional limit places a new order that exceeds their 
limit amount, under a soft limit, the customer gets the full promotion benefit 
applied to the order. A status message is sent to Oracle Trade Management that 
the limit has been exceeded.

Multiple currency price lists enables you to create price lists in different currencies 
other than the functional currency. If you have global customers or do pricing in 
different currencies, this feature enables you to maintain a single price list for 
multiple currencies. You can set up and maintain multiple currency conversion 
rates for a base currency in a single list which can be attached to multiple price lists 
or agreements. Price list maintenance is reduced because only one currency 
conversion definition can be attached to multiple base currency price lists. If prices 
change, you only need to update the base price list.

When a pricing request is made, the pricing engine converts the price on the base 
price list to the ordering currency and returns the new price in the ordering 
currency (including any markup values).

See the Oracle Advanced Pricing User Guide and the Oracle Trade Management 
Implementation Guide for more information on promotional limits and multiple 
currency price lists.

7.3.14 Defining Promotional Limits for an Offer
Promotional limit refers to the maximum limits that you can specify for an offer in 
terms of amount and unit for each promotion. Use the following procedure to 
define promotional limits for an offer.

Prerequisites
An existing offer.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Trade Planning > Offers.

2. Click the hyperlink of the offer.
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3. Scroll down to the Discount Rules region, and click the Details icon against the 
discount rule that is applied for the offer.

4. In the Maximum Caps region, enter the following details as required:

– Maximum Units Per Order: this is the maximum number of product units 
that a customer can buy against an order.

– Maximum Units Per Customer: this is the total number of product units 
that a customer can buy for all the orders put together.

– Maximum Orders Per Customer: this is the maximum number of orders 
that a customer can place.

– Maximum Quantity Per Discount Rule: this is the maximum quantity in 
units for each discount rule.

– Maximum Committed Amount Per Discount Rule: this is the maximum 
committed order amount for each discount rule.

5. Click Update.

7.3.15 About Offer Adjustments
Offer adjustments enables you to modify active offers. Adjustments that are made 
are sent to the offer approval process, and are applied to the offer after they are 
approved.

Different offers types have different rules that govern the adjustments. Table 7–3 
describes the offer adjustment rules based on which you can make a few or all of the 
following adjustments to offers:

■ Modify discounts

You can change the date for the new discount to be effective from a future date 
or from a past date. You can perform either single-tier adjustments or 
multiple-tier adjustments to discounts depending on whether you have 
specified single-tier discount or multiple-tier discount for the offer.

■ Add or remove products

Note: You cannot make any offer adjustments for Terms Upgrade 
and Lump Sum offers.
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You can add products that are valid for the offer based on budget-offer 
validation. You can also remove products. The discounts that have been 
specified will get reconfigured based on the changes that you make.

■ Specify the settlement method for the offer

You can specify offer payout dates and methods. Payout methods include 
paying through check or account credit. For offers with accrual-- Accrual, Lump 
sum, Trade Deal, Volume, and Scan Data, you can specify the payout date, 
payment method, and payout party.

■ Backdating Offers

Trade commitments with customers may span months, quarters, or even an 
entire calendar year. Because of the number of parameters that are involved and 
business areas that are impacted, the terms of some trade commitments can take 
months to finalize. In the meantime, you continue to ship products to your 
customers under a temporary agreement, knowing that final terms of the deal 
may change. If the terms change, you can use the backdating functionality to 
modify the active offer. The modifications you can make include changing 
discount terms and the products involved. You can also change the start date, 
and end date of the offer. Changes that are made to the offer are reflected in the 
offer utilization adjustment.

Table 7–3 Offer Adjustment Rules

Offer Type Adjustment Rules

Off Invoice Offer You may modify the discount amount or percent value. You 
may backdate the request or have the new values commence 
on a specific date, or both.

Accrual Offer You may modify the accrual amount or percent value. You 
may backdate the request or have the new values commence 
on a specific date, or both.

Net Accrual Offer No adjustments can be made to Net Accrual offers.

Order Value Offer You may modify the discount amount or percent values as 
they pertain to each line defined in the Offer. You cannot 
modify the Order Value "From" and Order Value "To" values. 
You may backdate the amount or percent values modification, 
or have the new values commence on a specific date, or both.

Promotional Goods Offer You may modify the discount amount or percent value for the 
products detailed for the "Get" condition only. You may 
backdate the request, or have the new values commence on a 
specific date, or both.
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7.3.16 Creating Offer Adjustments
Offer adjustments enables you to modify active offers. Adjustments that are made 
are sent to the offer approval process, and are applied to the offer after they are 
approved. Use the following procedure to create offer adjustments.

Prerequisites
An active offer.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Trade Planning > Offers.

2. Click the hyperlink of the offer.

3. Click the Adjustments side navigation link.

The summary of all the existing adjustments to that particular offer are listed. 
You can either create a new Adjustment or modify the existing Adjustment.

Volume Offer You may modify the discount amount or percent values as 
they pertain to each volume "tier" defined in the Volume Offer. 
You cannot modify the Volume "From" and the Volume "To" 
tier values. The user may backdate the amount or percent 
values modification or have the new values commence on a 
specific date, or both.

Trade Deal Off Invoice Component - You may modify the discount 
amount or percent value. You may backdate the request or 
have the new values commence on a specific date, or both.

Accrual Component - You may modify the accrual amount or 
percent value. You may backdate the request or have the new 
values commence on a specific date, or both. For Trade deal 
offers the effective date for backdating or commencement of 
modified values, or both must be the same for both the 
Off-invoice component and the Accrual Component. Effective 
dates for both the components cannot differ.

Note: Offer Adjustments are not available for Terms Upgrade and 
Lump Sum Offer types.

Table 7–3 Offer Adjustment Rules

Offer Type Adjustment Rules
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4. Click Create to create a new adjustment.

You can create a new adjustment only if your are creating the adjustment for the 
first time, or if all the existing adjustments are either approved or rejected.

5. Enter a name for this adjustment record.

6. In case of backdated offers, to settle the difference in discount for products that 
have already been discharged in case of backdated offers, select the settlement 
method as either check or accrue the credit on account.

7. Enter the Effective Date.

This date must be within the start date and end date range, and the new 
discount (based on the existing discount rules).

8. Optionally type your comments in the Comments field.

9. In the Discount Rules region, you can add new discount lines, or modify the 
existing discount rules. See Section 7.3.5, "Defining Qualifiers and Discount 
Rules" for detailed steps.

10. Click Update.

The offer status changes to Active. The change in the status initiates a workflow 
for Offer Adjustment approval depending on the status order rule. During the 
process, the status first changes to Pending Approval initially, and later changes 
to either Approved or Rejected.

7.3.17 Approving Offer Adjustments
Offer adjustments that have been made are sent to the offer approval process, and 
are applied to the offer after they are approved. The budget request approver will 
be the person responsible for approving an offer. Use the following procedure to 
approve an offer.

Prerequisites
Offer adjustments have been made.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User, 

and navigate to Workflow > Worklist. You can also launch the worklist by 
navigating to Home > Tools > View Notification Work List.

The list of open notifications is displayed.
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2. Select the notification that corresponds to the offer adjustments that must be 
approved.

3. Click Approve.

7.3.18 About Copy Offer
Copy Offer enables you to create a new offer by copying information from an old 
offer. For example, you can create a copy of the yearly offer that repeats the same 
essential information each year, and update it. The new offer will be of the same 
offer type as the old offer.

7.4 Offer Forecasting
Offer forecasting enables you to predict the performance of new offers by utilizing 
base sales (sales data of the previous year). The base sales or historical sales data is 
segmented into three dimensions--time range, product, and market (account). By 
analyzing this data, you can set realistic sales targets and acceptable return on 
investment (ROI) for the your organization as well as the retailer.

Topics included are:

■ Section 7.4.1, "About Offer Forecasts"

■ Section 7.4.2, "Creating and Editing a Forecast"

■ Section 7.4.3, "Creating a Forecast Version"

■ Section 7.4.4, "About the Manufacturer’s ROI Calculator"

■ Section 7.4.5, "Viewing the Manufacturer’s ROI Calculator"

7.4.1 About Offer Forecasts
Offer forecasting enables you to predict the overall performance of campaigns and 
offers. Offer forecasting simplifies the process of planning account-specific 
contributions to a campaign.

Offer forecasts are based on quantities and not the monetary value. To create a 
forecast, an offer must target at least one customer and one product. Multiple 
customers and products are also supported. You can create offer forecasts for all 
types of offers except Order Value because no products are specified in Order Value 
offers. You can create an offer forecast at the following levels:
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■ Offer level: forecast is based on the historical sales data for customers and 
products for that particular offer

■ Campaign level: forecast is based on the sum of customer and product data for 
all offers that are sourced by that campaign

You can create offer forecasts at any time irrespective of the offer status. After 
creating a forecast, you can also freeze it. After you freeze a forecast, the forecast 
data cannot be modified, updated, or deleted. Data such as the customer or product 
selection cannot be changed. Freezing a forecast ensures that the forecast data 
remains accurate. The other users will not be able to change the forecasted data. 
This ensures that wrong data is not used for your offer, and the offer performance is 
not affected. If you wish to change the data in a forecast after it is frozen, you can 
create a new forecast from a frozen forecast, and then modify or change the data in 
the new forecast.

7.4.2 Creating and Editing a Forecast
You can create an offer forecast to evaluate and consider historical data when you 
design a promotional offer. The Manufacturer’s ROI Calculator enables you to 
perform cost-benefit analysis to determine the best product, price, and promotion 
proposition for a specific customer target. Use the following procedure to create and 
edit a forecast.

Prerequisites
■ An existing offer.

■ The Administrator must have performed the following activities:

■ The concurrent manager program, AMS-TM: Refresh of Base Sales 
Materialized View, must be set to run and must be completed successfully 
at least once; otherwise, the Base Volume will be zero.

■ The AMS-TM Default Forecast UOM profile must be completed. This 
profile determines the default Unit of Measure (UOM) used for calculating 
the Forecast. If historical sales data are in different UOMs, they will all be 
converted into this profile UOM.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Trade Planning > Offers.

2. Click the hyperlink of the offer, and verify the following:
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– One or more products are selected.

– The Start and End Dates are past. Dates are used to reference historical 
values.

– One or more customers are selected. Do this by navigating to Execution > 
Market Eligibility.

3. Return to the Offer Details page and click the Forecast side navigation link.

4. Click Create.

5. Leave the Freeze check box unselected, and optionally change the Unit of 
Measure (UOM) by deleting the current value, and selecting a new value.

6. Select a price list from the Price List field.

7. Enter a value in the appropriate unit of measurement in the Total Forecast field.

The Total Forecast is the quantity to be forecasted over the product and 
customer combinations. It must be inclusive of the Forward Buy quantity.

8. Enter a value in the appropriate the unit of measurement in the Forward Buy 
field.

The Forward Buy is the quantity you expect will be purchased during the offer 
specifically to take advantage of the offer.

9. Open the Automatic Spread list and select a value.

– Baseline Ratio: The Base Volume is divided across the products in the same 
ratio as the relative sales volume. For example, if Product A sold 800 units 
and Product B sold 400 units, and the Total Forecast is 3000 units, then the 
default forecast is 2000 units of Product A and 1000 units of Product B.

– Across All Evenly: The Base Volume is divided evenly across all products. 
For example, if Product A sold 800 units and Product B sold 400 units, then 
the default forecast would be 1500 units of Product A and 1500 units of 
Product B.

– Buy-Get Ratio: Available for promotional goods offers only. Used for 
calculating the default product forecast for these offer types.

For example, an offer is defined as Buy 2 Units of Product A and Get 1 Unit 
of Product B at X discount. If the total forecast is 300, then the forecast for 
Product A will be 200 and Product B will be 100.

If the get product is free (in other words, if it has a 100% discount), then the 
forecast for Product A will be 300 and Product B will be 300. You do not 
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need to forecast free products. The application assumes that free products 
are always included when the corresponding buy product is sold.

10. Select a value from the Period View list, and in the Comments box, type any 
additional information you would like to add to this forecast.

11. Under Forecast Order, do the following:

a. Select your first dimension for the forecast from the Forecast By list:

– Product: Selecting Product as the first dimension spreads the Total Forecast 
over the Products first.

– Market: Selecting Market as the first dimension spreads the Total Forecast 
over Eligible Markets first.

– Time: Selecting Time as the first dimension spreads the Total Forecast over 
time first. This is calculated on the Period View. The total time period for 
the offer is divided by the Period View to give a number of periods. This 
number is rounded up to the nearest whole number. For example, if the 
offer is good for 30 days and the Period View is one week, the number of 
periods will be 30 days/7 days = 4.29 rounded up to 5.

b. Click Calculate.

The page redraws, and the then by dimension appears. The first dimension 
spread is listed in a table at the bottom of the page.

c. Optionally open the list and select a second dimension, and then click 
Calculate.

d. Click Details to view the second and third dimension spreads, if any. The 
page redraws and displays the spreads.

12. Click Total Forecast to freeze the Forecast.

13. Select the Freeze check box and click Update.

Note: For information on the base volume, see About Base 
Volume and Base Volume Source below.
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About Base Volume and Base Volume Source
The Base Volume is completed for you. Base Volume is the historical sales data from 
Order Management, based on all closed order lines for the selected customers and 
products of the offer during the time period specified by the Base Volume Source.

The Base Volume Source defaults to Last Year Same Period. Forecasts are always 
based on the sales during the period one year prior to the current offer begin and 
end dates.

7.4.3 Creating a Forecast Version
After a Forecast is frozen, it cannot be modified. A new version must be created. 
Use the following procedure to create a forecast version.

Prerequisites
A frozen forecast.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Trade Planning > Offers.

2. Click the hyperlink of the offer.

3. Click the Forecast side navigation link in the Offer Details page.

4. Click Create Next Version.

All the details from the most recent version of the Forecast are copied into the 
new Forecast.

5. Modify the fields of the next version as desired.

6. Click Update.

7. Select the Freeze check box if you are ready to freeze the forecast.

Note: A forecast cannot be changed after it is frozen. If changes 
are made to the Offer in either products or market eligibility, you 
must recreate the existing forecast by creating a forecast version to 
reflect the changes.
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7.4.4 About the Manufacturer’s ROI Calculator
Return on Investments (ROI) in general can be defined as (revenue - cost) / cost. 
Cost in Oracle Trade Management refers to the cost of goods sold, promotional 
amount, or other costs that can be custom calculated. The Manufacturers ROI 
Calculator is tightly integrated with the offer forecasting functionality and is 
designed to provide the trade user a multi-functional planning tool that will aid in 
the initial analysis, strategic planning and execution of any promotional offer or 
activity. Additionally, the Manufacturer’s ROI Calculator serves as a tracking and 
monitoring tool for revenue and costs for active promotional offers.

Depending upon the status of a promotional activity, the Manufacturer’s ROI 
Calculator may serve as a planning worksheet for the user or as a barometer that 
measures the effects of an offer as performance actually occurs. With access to actual 
performance and expenses as they occur, the user may measure updated returns 
against forecasted sales revenue and associated costs. In turn, trade users may plan, 
and execute accordingly.

7.4.5 Viewing the Manufacturer’s ROI Calculator
You can generate an ROI table from a forecast. This table takes the information from 
the forecast and calculates the ROI by using the unit cost for the various products, 
and the discount information from the Offer. Use the following procedure to view 
the Manufacturer’s ROI Calculator.

Prerequisites
A completed forecast.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Trade Planning > Offers.

2. Click the hyperlink of the offer.

3. Click the Forecast side navigation link in the Offer Details page.

4. Select the appropriate forecast version, enter a price list, and click Save.

The price list that you select here will be used to Calculate the ROI based on the 
selling prices. The price list can also be defaulted.

5. Click Manufacturer’s ROI.
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6. The default view will be for the forecast. Choose Forecast vs. Actuals view from 
the drop-down list. The selected view is displayed.

7. Click Calculate ROI to complete the table with the ROI information. The values 
that can be displayed in the table are:

– Product List Price is the price of the product based on the Price List selected 
above.

– Discount can be Percent, Amount, New Price, or Lump Sum based on the 
offer itself.

– Value is the numeric value of the discount per unit. For example, if the 
discount was 10% and the list price $100, then the value will be $10.

– Selling Price = List Price - Discount Value (Exception: For discount type 
Accrual, the selling price is same as list price).

– Unit Cost is the unit cost of goods, and the number is returned from 
Costing.

– Margin Amount = Selling Price – Unit Cost.

– Margin % = (Margin Amount/Selling Price) * 100.

– Forecast Units are taken from the Forecast itself.

– Forecast Revenue = Forecast Units * Selling Price.

– Forecast Costs = Forecast Units * (Unit Cost + Discount Value).

– Forecast ROI = (List Price – (Unit Cost + Discount Value)) / (Unit Cost + 
Discount Value).

– Total Forecast Units = sum of all lines.

– Total Forecast Value = sum of all lines.

7.5 Offer Sourcing
Offers are created to increase sales by offering discounts on products. Organizations 
often treat discounts as reductions in revenue. Therefore, an offer must source funds 
from either a budget or a campaign to offer these discounts.

Topics included are:

■ Section 7.5.1, "About Offer Sourcing"

■ Section 7.5.2, "Requesting Funding For an Offer"
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■ Section 7.5.3, "Creating a Budget Transfer From an Offer"

7.5.1 About Offer Sourcing
Sourcing an offer involves specifying the funding source for the offer. You can 
source funds for an offer from a parent campaign, budget, or from multiple 
budgets. When you select a parent campaign as the funding source, the campaign 
behaves like a mini-budget. The offer can source up to the maximum amount 
available for the campaign. When you source funds from multiple budgets, you 
must specify the amount that you would like to withdraw from each budget. There 
is no rule for the proportion in which you can withdraw funds from each budget. 
However, when you source funds from a budget, you can request only up to the 
maximum amount that is available in the budget.

For example, you source an offer from three budgets. The offer has a committed 
amount of $10,000. You decide to withdraw this amount from the three budgets in 
the following manner.

■ Budget 1- $3000

■ Budget 2 -$3000

■ Budget 3 - $4000

After specifying the funding source, you can submit the offer for approval. An offer 
becomes active after all approvers approve the offer. See Section 7.6.1 for more 
information on the offer approval process.

7.5.2 Requesting Funding For an Offer
An offer must source funds from one or more budgets to offer discounts. Use the 
following procedure to request funding for an offer.

Prerequisites
■ An offer must be created, and you must have access to the Budget Request page 

for the offer.

■ An active budget must exist.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Trade Planning > Offers.

2. Click the hyperlink of the offer. 
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3. Click the Budget side navigation link. 

4. In the Initial Estimated Budget field, enter an amount.

5. Click Update.

6. Click Create Request.

7. In the Budget Source region:

a. Select either Budget (the actual budget) or Person (the individual who will 
determine the budget to be used for the offer) from the Source Type 
drop-down list.

b. Select a budget or a person from the Source Name LOV.

If budget was selected as the source type, then you will see only the active 
budgets that you have access to. After you have selected a budget, the 
budget number and owner are displayed.

8. The information in the Budget Recipient region of the page is automatically 
populated. It is based on the initial estimated budget, and the offer type, name, 
code, and owner.

9. In the Request Details region:

a. Optionally, in the Required By field, select the date by which you require 
approval for the funds. This field is for information purposes only. It allows 
the approver to see the urgency of the request.

b. In the Requested Amount field, enter the amount that you require.

c. Optionally select Partner or Vendor from the Holding Owner drop-down 
list, and optionally select a transfer reason from the Transfer Reason 
drop-down list.

d. Optionally type a justification in the justification text field. This field is for 
information purposes only. You might want to explain the reason for the 
budget request or how the money will be used.

10. Click Create.

11. To request funding from another budget (to source the offer from multiple 
budgets), click Create Request and repeat these steps.

Note: You cannot request approval for your offer until you have 
specified an initial estimated budget.
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7.5.3 Creating a Budget Transfer From an Offer
An offer can source funds from multiple budgets. Sometimes, in situations when an 
offer does not perform well, or when the offer does not need all the amount that is 
committed to it, you can transfer funds from the offer back to the funding budget. 
By creating a budget transfer, you can move the committed money from the offer 
back to the budget. Use the following procedure to create a budget transfer from an 
offer.

Prerequisites
■ The offer must be in the active status.

■ Funds must be committed to the offer.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Trade Planning > Offers.

2. Click the hyperlink of the offer. 

3. Click the Budget side navigation link. 

4. Click Create Transfer.

5. In the Budget Recipient region, select Budget from the Recipient Type 
drop-down list, and select a Recipient Name from the LOV. Values for Number, 
and Owner will default in.

This is the budget to which funds will be transferred.

6. In the Transfer Details region, enter the amount that you would like to transfer, 
and optionally select a Holding Owner and Transfer Reason.

7. Optionally, in the Justification field, write why you wish to transfer funds.

8. Click Create.

7.6 Offer Approval
The approval process for offers includes offer theme approval and budget approval. 
For an offer to become active, the offer plan must first be approved. After the offer 
plan is approved, you must submit it for budget approval to request funds for the 
offer.

Topics included are:
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■ Section 7.6.1, "Understanding the Offer Approval Process"

■ Section 7.6.2, "Offer Statuses"

■ Section 7.6.3, "About Budget-offer Validation"

■ Section 7.6.4, "Submitting an Offer for Approval"

■ Section 7.6.5, "Approving an Offer"

7.6.1 Understanding the Offer Approval Process
An offer must be approved by the designated approvers before it can become active. 
An offer can be used to offer discounts only after it becomes active.

If the offer owner and the budget owner are different, then the offer must first 
obtain the offer theme approval, and then the budget approval. When you create an 
offer, you define the offer plan by specifying the product, discounts, and the market 
that the offer must target. Offer theme approval is the process by which the offer 
plan gets approved.

During offer theme approval, the Sales Management reviews the offer, and it may 
approve or reject the request. If the request is rejected, you can modify the offer and 
resubmit it for offer theme approval. You can also cancel the offer if required. If the 
Sales Management approves the request, the offer proceeds to the budget approval 
stage.

Budget approval is the process by which a budget owner approves the request for 
funding. Budget owner is the owner of the budget from which you request for 
funds to execute the offer. Budget owner is also known as the fund source owner. If 
an offer sources funds from more than one budget, then the offer becomes active 
only after all the budget owners approve the request.

For example, you create an offer to source funds from three budgets--Budget A, 
Budget B, and Budget C. You first submit the offer for offer theme approval. The 
Sales Management reviews the offer and approves it. Next, the offer passes on to the 
budget approval stage. The request is sent to each of the budget owners. The offer 
becomes active after the budget owners approve the request.

If you are the offer owner as well as the budget owner, then the offer will go 
through an approval process only if the amount requested in the offer is not within 
your spending limit. For example, if you create an offer for $40,000 whereas your 
spending limit is $30,000, then the offer must go through an offer approval process, 
and the request will be sent to the defined approver. However, if your spending 
limit is more than the requested offer amount, then the offer does not require any 
approvals.
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7.6.2 Offer Statuses
Offer status enables you to know the exact status of an offer at any point of time. 
The status of an offer changes along with the approval flow. 

Table 7–4 describes different statuses that an offer may go through during offer 
theme approval and budget approval, and the behavior of the offer at different 
statuses.

Note: Offer theme approval and budget approval are optional 
features that your organization may implement. Your organization 
can choose to have only offer theme approval, or only budget 
approval, or both. If neither of them are implemented, the offer 
does not go through any approval process. Instead the offer status 
directly changes to Active.

Table 7–4 Offer Statuses

Offer Status Description

Draft The offer status appears as Draft when the offer is in the planning 
stage. When the offer is in the Draft status, you can:

■ Change any offer parameter

■ Cancel the offer

■ Request for offer theme approval

The offer status changes to Submitted-Theme Approval after it is 
submitted for offer theme approval.

Submitted-Theme 
Approval 

The offer status appears as Submitted-Theme Approval after you 
submit the offer for theme approval.

The offer status changes to Planning if the offer theme approval is 
approved. It means that the offer has reached the budget approval 
stage.

The offer status changes to Draft if offer theme approval is rejected. 
The user may modify the offer and resubmit it for offer theme 
approval.
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Planning The offer status appears as Planning when it is in the budget 
approval stage.

From Planning, the offer status may change either to Active, On 
Hold, or Rejected.

The offer is read-only when it is in the Planning status. No 
parameters can be changed.

Rejected The offer status appears as Rejected if one or more funding source 
owners reject the offer.

An offer cannot be activated when it is in the Rejected status. But it 
can be modified and resubmitted for approval.

Pending validation When the offer status appears as Pending Validation, it means that 
the offer is being checked automatically for budget-offer 
validation. This status appears only if offer theme approval and 
budget approval have not been set up.

Active The offer status appears as Active after it is approved by the fund 
source owners. It means that the offer is ready to be executed.

The information that you can edit at this point of time depends on 
the implementation setups. In any case, you cannot add or modify 
discount rules.

On Hold On Hold is an interim status, which means that the offer has been 
approved, but is not yet ready to be executed.

From On Hold, the offer status may change to Active.

Terminated The offer status appears as Terminated if it is cancelled before the 
original completion date.

From Terminated, the offer status may change to either Active or 
On Hold.

Completed The offer status appears as Complete after the offer reaches the end 
date, and all associated activities are complete.

From Complete, the offer status may change to either Active, On 
Hold, or Closed.

Closed The offer status appears as Closed after all the funds committed for 
the offer are utilized and the offer reaches the end date. You cannot 
change this offer status.

Table 7–4 Offer Statuses

Offer Status Description
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7.6.3 About Budget-offer Validation
Budget-offer validation ensures that funds planned for certain customers and 
products are used as intended. If the budget-offer validation is implemented in 
your organization, the customer and product targets specified in the source budget 
are matched whenever you create an offer and submit it for approval. The offer 
cannot source funds from a budget if these conditions do not match.

For example, a budget has been created to source funds for trade promotion 
activities for California retailers and Orange Juice. If the budget-offer validation 
option is turned on, then an offer created for Oregon retailers and milk will not be 
allowed to source from this budget.

If budget-offer validation fails, the offer status changes from Submitted or Pending, 
back to the previous status. At the same time, a notification is sent to the offer 
owner. For more information on budget-offer validation, see Chapter 9, "Budget 
Management". 

7.6.4 Submitting an Offer for Approval
An offer must be approved before you can make it available to the customers. Use 
the following procedure to initiate offer approval.

Prerequisites
The offer must be in the Draft status.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Trade Planning > Offers.

2. Click the hyperlink of the offer.

3. Verify the details in the Offer Details page.

4. Click Request Approval.

5. Verify the approver details, and click Confirm.

7.6.5 Approving an Offer
After an offer has been submitted for approval, it goes through the offer theme 
approval and budget approval processes. The designated approvers according to 
the approval rules must approve the offer theme, where as the budget owner must 



Offer Execution

7-54 Oracle Trade Management User Guide

approve the budget request. Use the following procedure to approve an offer 
theme.

Prerequisites
An offer must be submitted for approval.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User, 

and navigate to Workflow > Worklist. You can also launch the worklist by 
navigating to Home > Tools > View Notification Work List.

The list of open notifications is displayed.

2. Select the notification that corresponds to the offer that must be approved.

3. Click Approve.

The offer proceeds to the budget approval stage.

7.7 Offer Execution
After an offer becomes active, you can start offering discounts to customers. 
Whenever customers place orders against the offer, the funding budget gets 
updated accordingly.

An offer cannot be used if:

■ the offer reaches the end date and all the associated activities are complete

■ the funds in the offer are completely utilized 

■ the offer is manually closed because there are no orders received against the 
offer

See Chapter 9, "Budget Management" for more information on budget utilization 
and the manner in which a budget gets updated for different offer types.
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8
Campaigns and Programs

A campaign is a marketing activity, which primarily aims at promoting product 
sales and advertising products in the market to increase customer awareness. It is a 
used to plan, manage and budget marketing activities, and is set of campaign 
schedules. Programs are umbrella objects that are used to combine different 
Campaigns, Events, Deals, Promotions and other objects into one entity.

Campaigns and Programs are key features of Oracle Marketing, but you can also 
access campaigns and programs from within Oracle Trade Management. This 
integration with Oracle Marketing enables the sales and marketing departments in 
your organization to effectively coordinate with each other to facilitate marketing 
and trade promotion activities. For example, the marketing department may plan 
for a campaign to advertise a new product. During campaign execution, they may 
also create offers to sell the product at a discounted price. Thus, you can use 
campaigns, and programs along with offers in business scenarios where the 
marketing and sales activities co-exist.

This chapter gives you only an overview of campaigns and programs. For more 
information on campaigns and programs, see the Oracle Marketing User Guide.

Sections in this chapter include:

■ Section 8.1, "Understanding Campaigns"

■ Section 8.2, "Working with Campaigns"

■ Section 8.3, "Understanding Programs"

■ Section 8.4, "Working With Programs"
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8.1 Understanding Campaigns
In Oracle Marketing, a campaign is a collection of marketing activities that are 
designed to support a goal. A campaign is the medium for putting information 
about an organization’s products, services, offers, and spreading messages to 
existing and potential customers.

Topics included are:

■ Section 8.1.1, "Overview"

■ Section 8.1.2, "Campaign Processes"

8.1.1 Overview
A marketing campaign consists of the campaign and its schedules. A schedule 
determines where, when, and how a campaign activity is executed. A campaign 
may have multiple schedules for different marketing channels, and for execution of 
a campaign over a period of time.

For example, Vision Mobile wants to promote their new wireless instant messaging. 
They create a campaign called “Wireless IM Promotion” and they add schedules 
under that campaign. They may add an outbound telemarketing component in 
which Telemarketing Representatives talk a list of people to see if they want the 
new service. They may have a banner advertisement that promotes the service and 
directs people to a web registration page. They may also have an e-mail blast that 
goes out to a list of contacts, who can then click on a link to reach a Web registration 
page.

Through its life cycle, a campaign goes through a number of status 
transitions--Planned, New, Pending Theme Approval, Pending Budget Approval, 
Active, and so on. For more details, see the Oracle Trade Management Implementation 
Guide.

Some of the attributes that you can set for a campaign include:

■ Associate it to a business unit. This is particularly useful for tracking marketing 
activities in a multi-unit organization.

■ Associate it to an objective to enable focussed marketing. For example, you can 
create a campaign, the objective of which will be to improve the brand 
awareness.

■ Set it to be a Global campaign so that it can be deployed across different 
geographies.
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■ Set the Confidential flag to ensure that only you and your team can access it.

■ Associate teams or users to whom you wish to assign access rights.

■ Set it to be a template. You can then use this campaign as a template to easily 
create other campaigns.

■ Version it for easy tracking. Only one version of a campaign can be active at a 
time. 

■ Associate it to a program (an umbrella object) so that costs, revenues, and other 
metric details can roll up to allow effective business tracking.

■ Set a priority for it. Priority is used to define approval rules for the campaign. 
Based on the priority, approvals are routed to appropriate approvers. The 
priority may appear on Workflow notifications to approvers to convey any 
urgency for approvals.

■ Associate it to a budget. The budget must then be approved by an assigned 
approver.

■ Associate products that you want to promote.

■ Associate relevant costs, revenues, and metrics that you want to track.

■ Associate deliverables and messages that must reach the customers. For 
example, you may want to include product punch lines or a product data sheet 
for the marketing activities associated with the campaign.

8.1.2 Campaign Processes
Campaigns are constructed using a wide variety of marketing objects. The basic 
components of campaigns are its theme, funding (budgets), execution (schedules), 
target audience (lists and marketing mediums), cost (costs), and effectiveness 
measuring devices (metrics). A campaign in Oracle Marketing is a planning tool, 
and you can create campaign schedules to execute it.

Figure 8–1 illustrates the process flow for campaign planning and execution.
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Figure 8–1 Campaign Planning and Execution

A basic marketing campaign can be divided into several processes as illustrated in 
Figure 8–1. The logical process flow for a campaign is as follows:

1. Planning a Campaign, which includes:

■ Creating the campaign

■ Defining the geography

■ Associating products, offers, and deliverables

■ Determining the budget

■ Obtaining theme and budget approvals

■ Associating costs, revenues, and other metrics

2. Executing a campaign, which includes:

■ Creating a Campaign Schedule
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■ Creating a Target List

■ Associating triggers

3. Tracking a campaign, which includes viewing costs, revenues, and other 
metrics.

8.2 Working with Campaigns
Topics included are:

■ Section 8.2.1, "Creating a Campaign"

■ Section 8.2.2, "Sourcing Budgets for a Campaign"

8.2.1 Creating a Campaign
Use the following procedure to create a new campaign.

Prerequisites
Required Custom Setups.

Steps
1. Log into Oracle Trade Management as a Oracle Trade Management Super User 

and navigate to Trade Planning > Campaigns.

2. Click Create.

3. From the Setup type drop-down list, select the type of campaign that you 
would like to create. 

Selecting a type determines the fields and side navigation links that will be 
available to you. These types are set up by your Administrator.

4. Enter a name for the campaign according to naming conventions for your 
organization, if any.

5. Select a program with which you would like to associate this campaign.

This enables costs, revenues, and other metric details to roll up to a program, 
and allows effective business tracking.

6. Enter a unique source code. Optionally, you can leave the source code field 
blank and the system will generate a unique code after the campaign is created.

7. Select a business unit if yours is a multi-unit organization.
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8. Enter a number to indicate the campaign version.

If multiple versions for a campaign exist, only one version can be active at any 
given time.

9. Select the purpose for the campaign from the drop-down list. 

Selecting a purpose for the campaign will be useful in aligning it with the 
organization goals.

10. Select a start period and end period for the campaign.

11. Select the start and end dates for the campaign.

12. Select a currency, priority, owner, country, and language for the campaign.

13. Select applicable check boxes:

– Global: indicates that the campaign is relevant for multiple locations

– Confidential: restricts access to this campaign to a particular team.

– Template: indicates that the campaign can be used as a template to base 
other campaigns on.

14. Enter a description for your campaign.

15. Click Create.

You will receive confirmation on the creation of the new campaign.

16. To modify a campaign’s details, click the hyperlink of the campaign, enter or 
modify the details as required, and click Update.

17. To copy a campaign, click Copy in the Campaigns page, enter the necessary 
details in the Copy Campaign page, and click Copy.

To create a campaign that is similar to an existing campaign, you can copy the 
existing one and modify it rather than create a new one.

18. To download the list to a .csv file, click the Download to CSV File icon on the 
campaigns page and click Save in the File Download dialog box. Use the 
Windows Save As dialog box to navigate to the destination folder and click 
Save.

19. To request approval for a campaign, click the hyperlink of the campaign, and 
click Request Approval in the Campaign Details page.
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8.2.2 Sourcing Budgets for a Campaign
You must associate a campaign with a budget in order to source funds for the 
campaign. Use the following procedure to associate a campaign to a budget and to 
create a budget request.

Prerequisites
As existing marketing campaign.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to Trade Planning > Campaigns.

2. Click the hyperlink of the campaign, and navigate to Planning > Budget.

3. For a new campaign, enter the Initial Estimated Budget in the currency 
indicated and click Update.

4. To create a budget request, click Create Request.

5. Enter the necessary details in the Budget Source and Request Details regions.

The budget recipient information is automatically displayed.

6. Click Create to save the request details.
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8.3 Understanding Programs
Programs are umbrella objects that are used to combine different Campaigns, 
Events, Deals, Promotions and other objects into one entity. In a hierarchy of 
marketing objects, a program is at the top. All other objects can be a part of the 
program. In this way, a new product launch may have events, campaigns, 
promotions, advertising, trade management deals and more, all coordinated from 
one point in Oracle Trade Management.

Parent Program
A program can be or have a parent program. For example, you want to launch a 
marketing activity for a product launch in America, Europe, and Asia Pacific. 
Accordingly, programs with a customized set of campaigns and events addressing 
specific interests based on geography are created. All these programs can be 
grouped under a single program called Global Launch. In this example, program 
Global Launch is the parent program.

Messages in a Program
Messages are deliverables associated with a product. Examples of a message are 
product brochures, white papers, and so on. You can associate the messages 
relevant to the components of a program.

Costs, Revenues, and Metrics
A program’s costs, revenues, and metrics are based on the costs, revenues, and 
metrics associated with the individual components of the program, such as 
campaigns, campaign schedules, events or event schedules. These are rolled up to 
display the program’s costs, revenues, and metrics.

8.4 Working With Programs
Topics included are:

■ Section 8.4.1, "Creating a Program"

■ Section 8.4.2, "Adding Components to a Program"

8.4.1 Creating a Program
Use the following procedure to create a program.
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Prerequisites
None

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to Trade Planning > Programs.

2. Click Create.

3. Enter the program name, and select a parent for the program.

4. Enter a short name, a business unit, and a purpose for the program.

5. Select a owner. 

The owner by default will be the person who is creating the program.

6. Select the start and end periods, start and end dates, and a currency.

If the start and end period is chosen from a LOV, the start and end dates are 
entered automatically.

7. Select a country for the program.

8. Click the Global check box if this is a program across geographies.

9. Click the Confidential check box if you want to restrict access to this program to 
members within your team till the program is in the Active status.

Note: By using the Team side navigation link, you can select the individual 
members to grant access to.

10. Enter a description for the program.

11. Click Create.

The program is created. Next, you must select the components for this program.

8.4.2 Adding Components to a Program
Use this procedure to add various marketing objects to a Program. Components 
include campaigns, events, and one-off events.

Prerequisites
An existing Program and a campaign, event, or one-off event
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Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to Trade Planning > Campaigns.

2. Click the hyperlink of the program.

3. Click the Components side navigation link in the Program Details page.

4. From the Type column, select a marketing object type.

5. Select an object.

6. Click Update.

The marketing object is added to the program, and other details of the new 
components are displayed. The messages, metrics, costs, and revenues from this 
object are also added to the Program.
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9
Budget Management

This chapter gives an overview of Budgets and explains how to create and manage 
Budgets in Oracle Trade Management.

Sections in this chapter include:

■ Section 9.1, "Overview"

■ Section 9.2, "Process Flow"

■ Section 9.3, "Budget Creation"

■ Section 9.4, "Budget Approval"

■ Section 9.5, "Budget Allocation"

■ Section 9.6, "Budget Utilization"

■ Section 9.7, "Budget Reconciliation"

■ Section 9.8, "Budget Tracking"
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9.1 Overview
The primary objective of any organization is to achieve sales goals by optimally 
utilizing funds and resources through effective budget management. A budget is a 
repository of funds that can be used to execute sales and trade promotion activities. 
Budget management involves budget planning, allocating budgets for the right 
activities, budget accounting, and tracking fund utilization. These are also some of 
the challenges faced by organizations today.

Budgets in Oracle Trade Management provides centralized information of all the 
sales and trade promotion activities, and fund usages. This enables you to plan and 
track fund usage and ensure that resources are deployed effectively. It offers access 
to historical sales and pricing information, which you can use to plan for budgets 
based on facts. 

By using Budgets, you can:

■ Create a budget, transfer funds between budgets, allocate a budget, accrue 
budget based on sales, and perform budget adjustments

■ Define market eligibility and product eligibility for the budget, and ensure that 
a budget is used only for the specified purpose

■ Track budget utilization at any point of time by using checkbook views and 
reports

■ View payment details and statuses of all the trade promotion activities that are 
associated with a budget

The budgets functionality also supports the Oracle Partner Management business 
flow. Special pricing, Soft Funds, and Referral compensation requests that are 
created in Oracle Partner Management can source funds from budgets in Oracle 
Trade Management. Fund utilization for these requests are tracked through budgets 
in Oracle Trade Management. For more information, see Chapter 11, "Indirect Sales 
Management", and the Oracle Partner Management User Guide.

A budget can be controlled either by a Finance Manager, Sales Manager, or a 
Marketing Manager. In this document, the terms "budget" and "fund" are used 
interchangeably.

9.2 Process Flow
Figure 9–1 illustrates the process flow for budgets, starting from budget creation to 
budget reconciliation.
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Figure 9–1 Process Flow for Budgets

Budget Creation
A budget is a pool of funds that you can use to execute trade promotion activities 
such as offers and campaigns. Budgets are generally created by the Sales Managers. 
If you are the Sales Manager, then based on your business requirements, you can 
create either a fixed budget or a fully accrued budget. You can also define the 
market eligibility and product eligibility for the budget to ensure that a budget is 
used only for the specified purpose. After creating a budget, you must submit it for 
approval. A budget becomes active only after it is approved by the designated 
approvers. However, a budget does not require approval if you are the creator, and 
the approver according to the approval rules.

Budget Approval
Budget approval is the process by which the designated approvers approve the 
budget. During the budget approval process, the approvers may approve, reject, or 
put the request on hold. The budget becomes active if the approvers approve the 
budget. A budget can start funding trade promotion activities only after it is active. 
As the next step, you can allocate the budget down the territory hierarchy.

Budget Allocation
Budget allocation involves distributing funds from the budget across sales 
territories and regions. Budget allocation is usually done by the sales management. 
If you are a sales management member such as the Sales Manager, then you can 
allocate a budget down a territory hierarchy. After the initial allocation is complete, 
the Sales Representatives of the territories may offer their inputs for the fund 
allocation. You can revise the allocation and reallocate funds based on these inputs. 
The fund allocation must be approved before the Sales Representatives can start 
using the budget to fund trade promotion activities in their territories.
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Utilize Budget
A budget gets utilized through budget requests and budget transfers. Budget 
request is a request to source funds from a budget to execute offers and campaigns. 
A budget transfer involves transferring funds from one budget to another.

When a budget request is submitted for approval, budget-offer validation happens 
in the background. If budget-offer validation fails, then the requestor is notified. If it 
passes, the request is routed to the budget owner. The budget owner may approve 
or reject the request. If the request is approved, funds are committed to the activity.

The columns in the budget get updated according to the fund usage.

Reconcile Budget
If you are the budget owner, then you can reconcile a budget after all the offers that 
are associated with a budget are closed, and a budget is no longer required. If there 
are any active offers that are associated, the offers must be closed before reconciling 
the budget.

Funds Tracking
After offers are associated with the offer, depending upon the orders received, 
shipped, and the claims that are settled, the Committed, Utilized, Earned, and Paid 
columns in a budget get updated accordingly. These columns also get updated 
whenever there is an transfer of funds. The following views enable you to track the 
funds and activities related to a budget:

■ Budget checkbook view: displays the total fund usage for a budget.

■ Offer checkbook view: displays the fund usage for a specific offer.

■ Customer checkbook view: displays the fund usage for a specific customer.

9.3 Budget Creation
Budget creation involves planning the scope of the budget, and the manner in 
which it will be utilized. It includes deciding on the budget type and category, and 
the market and products that the budget must target. Budgets are in general created 
and controlled Finance Managers, Sales Managers, or Marketing Managers.

Topics included are:

■ Section 9.3.1, "Fixed Budget"

■ Section 9.3.2, "Fully Accrued Budget"
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■ Section 9.3.3, "Budget Category"

■ Section 9.3.4, "About Budget Thresholds"

■ Section 9.3.5, "Creating a Fixed Budget or a Fully Accrued Budget"

■ Section 9.3.6, "Adding Budget Thresholds and Updating Accounting Details"

■ Section 9.3.7, "Releasing or Reserving Holdback Amount"

■ Section 9.3.8, "Market Eligibility and Product Eligibility"

■ Section 9.3.9, "About Budget-offer Validation"

■ Section 9.3.10, "Defining Market Eligibility for a Fixed Budget"

■ Section 9.3.11, "Defining Market Eligibility for a Fully Accrued Budget"

■ Section 9.3.12, "Updating Products for a Fixed Budget"

■ Section 9.3.13, "Updating Products for a Fully Accrued Budget"

■ Section 9.3.14, "About Copy Budget and Budget Delete"

9.3.1 Fixed Budget
A fixed budget is a pool of money, with value greater than zero. When you create a 
fixed budget, you must up front decide the maximum funds that it can include. 
Fixed budgets provide better budget estimates in advance.You can define fixed 
budgets for different customer and product attributes. You can allocate fixed 
budgets based on territories that are set up for Oracle Trade Management. 
Territories are set up in the Oracle E-Business Suite Territory Management module.

You can utilize a fixed budget in a number of ways including but not limited to the 
following:

■ Accrual Offers (also known as rebate in Europe and other regions)

■ Off-invoice Offers (also known as On-invoice in Europe and other regions)

■ Lump sum Offers

Other core trade promotion activities such as campaigns and offers can also utilize 
funds from a fixed budget. For information on offers and offer types, see Chapter 7, 
"Trade Planning and Offers".

The following example shows how a fixed budget gets updated when you source 
an accrual offer from the budget.
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A manufacturer, Goodway sets up a fixed budget for all its sales and trade 
promotion activities in USA. The fixed budget has committed funds of $1 million. 
USA is divided into four regions. The Sales Manager of US West region gets an 
allocation of $500,000. A Sales Representative from the region decides to give a 
promotion to one of the customers whereby the customer accrues 10% of the price 
of the product everytime he buys a unit of product X. Goodway may later pay back 
these accruals to the customer through a claim (settled with a check or a credit 
memo) or a deduction (settled by a credit memo). The Sales Representative requests 
the Sales Manager for $10,000 to fund the offer. When this fund request is approved, 
the US West budget looks as follows:

A customer places an order for 50 units of the product which has a regular price of 
$100. An accrual of $100 * 50 * 10% = $500 is created. The Funds Accrual Engine, 
which is a concurrent process that is scheduled to run in the background gets the 
accrual information and updates the budget as follows:

9.3.2 Fully Accrued Budget
A fully accrued budget starts with zero funds when it is created. It is also called a 
live fund. The benefits of using a fully accrued budget are that organizations do not 
have to spend time and resources to perform rigorous budget planning. They can 
accrue budgets based on real time sales data. Fully accrued budgets can be created 
to accrue funds for customer, or accrue funds for sales activities.

■ Accrue funds for Customers

When you create accrual budgets to accrue funds for customers, you use the 
accrued funds for promotional activities such as offering incentives to retailers 
based on their performance. The money thus earned by the retailers is 
accumulated over a period of time; they can later claim this amount by 
submitting claims or short paying invoices.

For example, you create a fully accrued budget to offer incentives to retailers. 
The retailers receive $10 for every unit of Product A that they sell. Each unit of 
the product costs $100. The number of units that the retailers sell are tracked, 

Total Committed Utilized Earned Paid

5,00,000 10,000 0 0 0

Total Committed Utilized Earned Paid

5,00,000 10,000 500 500 0
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and accruals are paid on a quarterly basis. At the end of the quarter, the fully 
accrued budget includes the sum total of all funds that must be paid to the 
retailers. A particular retailer sells 100 units of the product, and therefore 
accrues $1000 ($10*100). At the end of the quarter, the fully accrued budget 
includes $1000, which the retailer can claim.

You can create any number of fully accrued budgets for customers. Buying 
group related accounts are also supported. For example, an organization can set 
up a fully accrued budget for all its customers. It can also establish a second 
fully accrued budget for a specific customer group such as all the customers in a 
particular territory, or for selling items from specific product areas such as 
paper and janitorial supplies.

■ Accrue Funds for Sales

Apart from creating fully accrued budgets to offer incentives and discounts to 
dealers and customers, you can also create fully accrued budget accrued to sales 
level to accrue funds for a sales person. This kind of fully accrued budget 
enables the Sales Representatives to spend funds at their discretion. The total 
budget amount that the Sales Representative can spend depends on the sales 
achieved and the amount that is accrued in the budget. The accrued amount 
gets updated in the Total budget column, and drilling down on the total budget 
amount shows details of all the accrual records that make up the total budget 
amount. The Sales Representative can use this amount to create other offers. 
The utilized and earned columns get updated when orders against these offers 
are booked and shipped.

For example, you create a fully accrued budget, accrued to sales, to give 10% 
discount on a product. The product costs $100. If a customer places an order for 
20 units of the product, then the accrued amount as per the discount offered is 
$200. Because the fully accrued budget is created to accrue funds for the Sales 
Representative, this $200 is not paid to the customer. Instead, the Sales 
Representative will use this amount to create other offers for any of the other 
customers.

After the funds are accrued, the Sales Representative uses $200 that is 
accumulated in the budget to create an Accrual offer to give 5% discount for the 
customers every time they place an order for a product. The product costs $100. 
A customer places an order for 10 units of the product and accrues $50 [10 * $5 
(5% of $100)] according to the discount offered. At the end of the month, the 
customer raises a claim and the Sales Representative pays this amount to the 
customer. The utilized and earned columns in the fully accrued budget, accrue 
to sales show $50 after the order is booked and shipped.
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The funds in a fully accrued budget increase based on the accrual parameters that 
are specified in the budget. Accrual parameters are conditions based on which 
accruals take place and the customers placing orders earn accruals; for example, 
accrue 3% for product X.

A fully accrued budget can have multiple accrual parameters for products or 
product families just like in offers.

For example, you may define one fully accrued budget which states that:

■ if a customer buys product X then accrue 3%

■ if a customer buys product Y then accrue 4%

■ if a customer buys product Z then accrue 5%

After you define accrual parameters, they are automatically passed to Oracle 
Advanced Pricing. In the background, a fully accrued budget actually creates an 
Accrual Offer.

The manner in which an Accrual offer updates a fixed budget is different from how 
it updates a fully accrued budget.

If you source an accrual offer from a fixed budget:

1. The committed column in the budget increases after the funding is approved

2. The utilized column increases after sales takes place and accruals are created

On the other hand, if you source the accrual offer from a fully accrued budget, the 
columns in the budget gets updated according to how it is set up as explained in the 
table below. These two accrual types are separate activities and can even occur 
simultaneously on the same order transaction.

You can create fully accrued budgets to accrue to different levels:

Accrue to 
Level

Liability 
Flag

Budget Columns 
Updated Comments

Customer On Total, Committed, 
Utilized

A customer purchases products and 
accrues funds. The customer can 
later claim accruals or deduct the 
amount from payments
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Depending on the industry, the use of fixed budgets versus fully accrued budgets is 
different. For example, the consumer goods sector may have an average of 40:60 
(40% of their budgets on a fixed basis, 60% on a fully accrued basis); while the more 
traditional food and beverage may have an average of 10:90 (10% of their budgets 
on a fixed basis, 90% on a fully accrued basis).

9.3.3 Budget Category
Budget categories serve the purpose of classification, determining the approval 
rules, and determining the Accounts to which the GL Postings must be made.

Customer Off Total A customer purchases products. 
Money is accrued but the customer 
is not entitled to receive payments 
immediately. The money accrued in 
this manner can be used to pay for 
negotiated discounts, sales and trade 
promotion costs and rebates.

For example, a customer 
organization may need to perform 
additional activities such as a special 
in-store display of the product for 
which they can earn money; You can 
create a Lump sum offer with the 
performance requirement for special 
in-store display proofs and source 
the offer from the budget.

Sales On -NA- Not applicable; Not supported

Sales Off Total A customer purchases products. 
Money is accrued but is given to the 
sales person (budget owner) who 
can then spend it with discretion. 
The customer does not know about 
this kind of accrual. The sales person 
can then turn around and use the 
money to fund any of his 
promotions to any of his customers.
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■ A budget category is a configurable way to classify a budget. A category can be 
for any sales or trade promotion purpose. Categories can be arranged in 
hierarchies.

For example, a budget category--Trade Promotion can be created for Sales 
Promotion, Advertising Funds, Partner Marketing Funds, and so on. The 
budget category--Sales Promotion, in turn may have multiple sub-categories 
such as Partner Marketing, and New Product Introduction.

■ Budget categories determine the approval rules. Each budget category has an 
approver who is responsible for approving or rejecting the budgets related to 
the category. All the budget requests that related to a particular category are 
routed to the designated approver.

For example, you create a budget to source a sales promotional activity, and 
select the budget category--"Sales promotion". When you submit the budget for 
approval, the request is routed to the approver who is responsible for 
approving or rejecting the budgets that are related to this category.

■ Budget categories are also used to default the base General Ledger accounts (GL 
accounts) to account entries.

9.3.4 About Budget Thresholds
Budget Thresholds enable you to monitor the activities of a budget, and recognize 
inconsistencies such as over spending and non-adherence to budget norms. The 
Administrator can set different rules to send out alert notifications to inform you 
about the fund usage and depletion at various levels. A budget threshold contains a 
set of rules. The Administrator sets up a budget threshold rule and then assigns it to 
a budget.

For example, a budget threshold can be created with 4 lines--one for each quarter. 
Each line can different condition and frequency such that notifications will be sent 
to alert a user if the budget utilization for:

■ The first quarter is more than 25% of the committed amount. 

■ The second quarter is more than 50% of the committed amount.

■ The third quarter is more than 65% of the committed amount.

■ The fourth quarter is more than 75% of the committed amount.
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9.3.5 Creating a Fixed Budget or a Fully Accrued Budget
A budget is a pool of money, which you can use to execute trade promotion 
activities such as offers and campaigns. Based on your business requirements, you 
can create either a fixed budget or a fully accrued budget. For a fixed budget, you 
must up front decide the maximum funds that it can include. A fully accrued 
budget on the other hand starts with zero funds; funds in the fully accrued budget 
increase according to the sales achieved. See Section 9.3.1, "Fixed Budget" and 
Section 9.3.2, "Fully Accrued Budget" for more information.

Use the following procedure to create a fixed budget or a fully accrued budget.

Prerequisites
A set of books must be defined. A set of books determines the functional currency, 
account structure, and accounting calendar for a company. To report on your 
account balances in multiple currencies, you should set up an additional set of 
books for each reporting currency. See the Oracle Trade Management Implementation 
Guide for more information.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to Budget > Budgets.

2. Click Create.

3. Depending on which type of budget you wish to create, select either Fixed 
Budget or Fully Accrued Budget from the Setup Type drop-down list.

4. Enter a budget name and a budget number.

If you leave the budget number field empty, then a unique budget number is 
automatically generated. The budget name and budget number will be used to 
identify the budget.

5. Select a business unit.

Business units are organizations, which are set up in Oracle Human Resources 
with Type = Business Unit. It is used here mainly for classification purpose. It 
can also affect the approval rules.

6. Optionally select a parent budget name.

Selecting a parent budget name will make the current budget a child of the 
parent budget, thus establishing a budget hierarchy.

7. The type of the budget defaults from Setup Type.
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For example, if you have selected the Setup Type as Fixed budget, then the 
value “Fixed” will be defaulted here.

8. Select a budget category from the Category drop-down list.

Budget categories are set up in Administration and can be used to classify the 
budget. If any GL accounts are associated, and if a profile for showing GL 
accounts on screen is set, those GL accounts will default on to the budget. In 
addition, an approval rule for a budget may use budget category as one of its 
criteria.

9. In the Budget Amount field:

– If it is a fixed budget, then enter the amount of money that will be set aside 
for this budget.

– If it is a fully accrued budget, then verify that the budget amount is zero. 
This is because a fully accrued budget starts with zero funds.

10. The Currency field, will by default display the functional currency of the set of 
books. You may change it to another currency.

11. Optionally, in the Holdback Amount field:

– If it is a fixed budget, then enter the amount that you would like to reserve 
and not allocate down to lower levels. You may choose to reserve or release 
the holdback amount at any time. To release the holdback amount at a later 
point of time, you can manually reduce the amount that you had originally 
entered as holdback amount, and click Update.

– If it is a fully accrued budget, then verify that the holdback amount is zero. 
This is because a fully accrued budget starts with zero and there will be no 
funds that you can holdback.

12. The Owner field, will by default display the name of the user entering the 
budget details.

13. Optionally select the Start Period and End Period.

These dates will be mapped in the GL calendars, and will limit the start and end 
dates of the budget.

14. Select the Start Date, and the End Date, and optionally enter a description for 
the budget.

15. Perform the following additional steps if you are creating a fully accrued 
budget:
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a. Select either Customer or Sales from the Accrue To drop-down list. This 
field determines if the fully accrued budget accrues to the customer or to 
the Sales Representative.

b. Select an Accrual Basis.

c. Optionally select the values for the Market, and Territory Level.

d. Optionally check the Retroactive Flag if the accrual basis is cumulative 
order volume.

e. Optionally check the Liability Flag if the accrual offer is created to accrue 
funds for customer. If checked, the committed, utilized, and earned 
columns get updated along with the total and available columns.

f. Select the Discount Level.

16. Click Create.

9.3.6 Adding Budget Thresholds and Updating Accounting Details
A budget threshold contains a set of threshold rules. Budget thresholds are created 
by the Administrator. When you add thresholds to a budget, alert notifications are 
automatically sent to inform you about the fund usage and depletion at various 
levels. Use the following procedure to add an existing budget threshold rule to an 
existing budget, and to update accounting details.

Prerequisites
A draft budget must have been created.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to Budget > Budgets.

2. Click the hyperlink of the budget.

3. In the Budget Details page, select a threshold rule from the Threshold LOV.

4. Scroll down to the Accounting Details section and select a Sales/ Expense/ 
Charge Account, and Accrual Liability Account.

5. Click Update.
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9.3.7 Releasing or Reserving Holdback Amount
Holdback amount is the amount that has is reserved and not allocated down to 
lower levels. You may choose to reserve or release the holdback amount from a 
fixed budget any time. Use the following procedure to reserve or release holdback 
amount.

Prerequisites
An existing fixed budget.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to Budget > Budgets.

2. Click the hyperlink of the budget.

3. Click Holdback in the Budget Details page.

4. Enter an amount in the Requested Amount field, and select either of the 
following from the Transfer Type drop-down list:

– Release: to release the requested amount from the holdback amount.

– Reserve: to reserve the requested amount as the holdback amount.

5. Optionally enter any form of free text in the Notes field, and click Create.

9.3.8 Market Eligibility and Product Eligibility
Defining the market eligibility and product eligibility for a budget, ensures that the 
budget is reserved to fund trade promotions only for:

■ regions and territories that you have specified in the market eligibility

■ products and product categories that you have specified in the product 
eligibility

When an offer sources funds from a budget, the market eligibility and product 
eligibility of an offer are matched with the market eligibility and product eligibility 
of the budget. The offer can source funds from the budget only if these conditions 
match. This process by which the conditions are matched is known as budget-offer 
validation. For more information, see Section 9.3.9, "About Budget-offer Validation".
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Market Eligibility
Market eligibility defines the customers or customer groups that a budget must 
target. For a fixed budget, defining market eligibility enables you to classify and 
validate a budget to ensure that a trade promotion activity matches the purpose of 
the budget. For example, you create a budget for all the customers in the US West 
region. If a Sales Representative creates an offer for a customer in the US East 
region, then the validation fails, and the offer will not be able to source funds from 
the budget.

Eligibility for a fixed budget can be defined for the following:

■ Individual customers

Individual customers include sold-to, bill-to, or ship-to customers. Bill-to and 
ship-to customers are different divisions of the sold-to customer. A sold-to 
customer can have multiple bill-to and ship-to locations. These are the customer 
accounts in Oracle’s Trading Architecture Community (TCA).

For example, an organization places an order for certain goods. The 
organization requests you to ship the goods to the Development division, and 
send the invoice to the Accounts division for processing. Here:

■ The parent organization is the sold-to location

■ The Development division is the ship-to location because it is the location to 
which you ship the goods

■ The Accounts division is the bill-to location because you send the invoice to 
this division for processing

■ Buying Groups

Buying Groups are organizations that are formed when organizations group 
themselves together to leverage on higher purchase volume achieved as a 
group. This enables them to negotiate better prices and discounts when they 
purchase goods from the manufacturer. To form Buying Groups, various TCA 
parties are linked together based on a pre-determined party relationship.

For example, a customer Organization A has sub units--Organization B, and 
Organization C, which are different legal entities. Organization A and its legal 
entities can form a Buying Group and be treated like a single customer. If they 
choose to have different accounts with your organization, then they will be 
treated like individual customers, and not a Buying Group.

■ Lists
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Lists are groups of customers or customer contacts created based on specific 
criteria. The criteria can be specified using Oracle Discoverer workbooks or 
queries. For example, you can search for all customers who have purchased 
something from your organization in the last two months, and save the results 
as a list. For more information on lists, see Chapter 3, "Customers".

■ Segments

Segments are similar to lists. They are groups of customers or customer 
contacts. Like lists, they are also created based on user-specified criteria through 
Oracle Discoverer workbooks or writing queries. For example, you can query 
for customers with revenue more than $100, and save the results as a segment.

The difference between a list and a segment is that a list is static, whereas a 
segment is dynamic. A list always contains the same number of customers. A 
segment on the other hand may vary. In the above example, the query may 
fetch 100 customers for this month, but in the next month, there may be only 75 
customers who achieve this revenue.

For more information on segments, see the Oracle Marketing User Guide.

■ Territories

Territories are yet another way to group customers together. They are created in 
the Oracle E-Business Suite Territory Management module. You can create 
territories based on various customer and geographical attributes. For example, 
you create a territory called US West and include all the customers in the US 
Western states under it.

For a fully accrued budget, you can define market eligibility by using the highly 
configurable qualifier contexts and attributes that are set up in Oracle Advanced 
Pricing. By using qualifier contexts and attributes, you can set up market eligibility 
for a fully accrued budget in a manner that is similar to setting up market eligibility 
for a fixed budget. You can define market eligibility for customers, buying groups, 
lists, segments, and territories.

If a fully accrued budget either accrues to the sales level, or to the customer level 
with the liability flag off, then you can use the amount in the fully accrued budget 
to fund offers just like a regular fixed budget. In such cases, the eligibility validation 
described for fixed budgets also applies to fully accrued budgets.

Product Eligibility
Product eligibility defines the product or product families or groups that a budget 
must target. Products are items in the Inventory System. Product categories contain 
products. Defining product eligibility enables you to:
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■ classify budgets and reserve them for specific products or product categories

■ validate whether the purpose of an offer matches with the purpose of the 
budget

Validation for market eligibility and product eligibility happens simultaneously. For 
example, if a budget is created for the US West region and Toy products, and an 
offer is created for a customer in the US West region but for Games products, then 
the validation fails.

For a fixed budget, you can define product eligibility for product categories and 
products.While defining product eligibility, you can either include or exclude 
products from the product category. The following example shows how you can 
exclude a product from a product category.

Computer Devices is a product category, which includes the products Monitor, 
Keyboard, Mouse, Printers, and Speakers. You wish to create budget to give 15% 
discount on all the products except Speakers. To thus define the product eligibility, 
you must select the product category as Computer Devices. The list of all the 
products that belong to this category are displayed. From this list, you must exclude 
Speakers. Doing this applies the product eligibility only to Monitors, Keyboards, 
Mouse Devices, and Printers, and only those offers that are created to promote these 
devices will be able to source funds from the budget. On the other hand, because 
you have excluded Speakers from the product eligibility, an offer for Speakers will 
not be able to source funds from this budget.

For a fully accrued budget, you can define product eligibility by using the product 
contexts and attributes that are set up in Oracle Advanced Pricing.

9.3.9 About Budget-offer Validation
Budget-offer validation ensures that funds from a budget are utilized only for the 
specified purpose. When you create a budget, you define market eligibility and 
product eligibility for a budget. Market eligibility and product eligibility are also 
defined for offers. If the budget-validation offer option is turned on, whenever there 
a request is submitted to source funds from a budget, the market eligibility and 
product eligibility of the budget and offer are matched. If the conditions do not 
match, then the budget request is rejected and the offer will not be able to source 
funds from the budget.

For example, you create a budget for US West Region and Computer Devices. If a 
Sales Representative creates an offer for US East Region and Beverages, and submits 
a budget request, then the validation fails, and the offer will not be able to source 
funds from the budget.
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The above example shows how budget-offer validation works when an offer is 
sourced from one budget. Sometimes, an offer or a campaign may source funds 
from multiple budgets. For example, budgets may be allocated to different Sales 
Managers who are responsible for different customer segments. When a new 
product is introduced, an offer created for that new product may receive funding 
from multiple budgets that have been created for different customer segments.

Depending upon the setups in your organization, one of the following takes place 
when an offer or campaign sources funds from multiple budgets:

■ No validation for customers and products

The market eligibility and product eligibility of the offer and the sourcing 
budgets will not be matched; budget-offer validation does not take place.

■ Validate customer and products by each budget

The market eligibility and product eligibility of the offer and the sourcing 
budgets will be matched. The offer will be able to source funds only from those 
budgets with which the conditions match.

■ Validate customer by each budget, product by all budgets (Relax Product)

If this option is implemented, then:

■ The individual market eligibility of each sourcing budget must match with 
the market eligibility of the offer.

■ The combined product eligibility of all the sourcing budgets must match 
with the product eligibility of the offer.

For example, an offer has been created for US West region for the 
products--Monitors, Keyboards, and Printers. The offer requests funding from 
two budgets with the following market and product eligibilities.

Here, both the budgets have US West as the market eligibility and the combined 
product eligibility of the budgets matches with the product eligibility of the offer. 
Therefore, budget-offer validation passes and the offer will be able to source funds 
from Budget A and Budget B.

■ Validate product by each budget, customer by all budgets (Relax Customer)

Budget Name Market Eligibility Product Eligibility

Budget A US West Monitors

Budget B US West Keyboards, Printers
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If this option is implemented, then:

■ The individual product eligibility of each sourcing budget must match with 
the product eligibility of the offer.

■ The combined market eligibility of all the sourcing budgets must match 
with the market eligibility of the offer.

For example, an offer has been created for US West region for the 
products--Toys, and Games. The offer requests funding from two budgets with 
the following market and product eligibilities.

Here, both the budgets have Toys and Games as the product eligibility, and the 
combined market eligibility of the budgets match with the market eligibility of 
the offer because California and Oregon are parts of US West. Therefore, 
budget-offer validation passes and the offer will be able to source funds from 
Budget A and Budget B.

GL Postings for the budgets occur based on how budget-offer validation is 
implemented in your organization.

9.3.10 Defining Market Eligibility for a Fixed Budget
Defining market eligibility for a fixed budget enables you to specify the customers 
or customer groups that a budget must target. By defining market eligibility, you 
can classify and validate a budget to ensure that a trade promotion activity matches 
the purpose of the budget. You can define market eligibility for customers, buying 
groups, lists, segments, and territories. Use the following procedure to define 
market eligibility for a fixed budget.

Prerequisites
A draft fixed budget must have been created.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to Budget > Budgets.

Budget Name Market Eligibility Product Eligibility

Budget A California Toys, Games

Budget B Oregon Toys, Games
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2. Click the hyperlink of the budget.

3. In the Budget Details page, click the Market Eligibility side navigation link.

4. Select a value for the Eligibility Context, and then select the Eligibility Name 
based on the Eligibility Context.

For example, if Customer – Bill-to was selected as the context, select a specific 
Customer – Bill-to name here; if Buying Group was selected as the context, 
select a specific Buying Group name here.

5. Click Update.

9.3.11 Defining Market Eligibility for a Fully Accrued Budget
For a fully accrued budget, market eligibility can be defined by fully using the 
highly configurable Qualifier Contexts and Attributes as set up in Oracle Advanced 
Pricing. Use the following procedure to define market eligibility for a fully accrued 
budget.

Prerequisites
A draft fully accrued budget must have been created.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to Budget > Budgets.

2. Click the hyperlink of the budget.

3. To update information on the Budget Details page, change the information as 
desired, and click Update.

4. To update Accrual Parameter Details:

a. Click Accrual Parameter Details.

b. Click the Execution side navigation link.

c. In the Offer Details - Market Eligibility page, enter or modify information as 
desired.

d. Click Update.
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9.3.12 Updating Products for a Fixed Budget
Defining product eligibility enables you to specify the products or product families 
or groups that a budget must target. Products are items in the Inventory System. 
Product categories contain products. Use the following procedure to define product 
eligibility for a fixed budget.

Prerequisites
A draft fully accrued budget must have been created.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to Budget > Budgets.

2. Click the hyperlink of the budget.

3. Click the Products side navigation link.

4. In the Product Family region, select the product category set and category.

a. Select a category set from the Category Set drop-down list, and then select a 
category from the Description LOV.

b. Optionally check the Primary Category check box.

c. Repeat the previous three steps to include additional product categories as 
required.

5. In the Products region, select the products you would like to include or exclude 
from the category set that you have selected.

a. From the Product Number LOV, select the product number that must be 
included or excluded. The Product Name defaults in.

b. To exclude a product from the product category, check the Exclude check 
box.

c. Repeat the previous two steps to include or exclude additional products as 
required.

6. Click Update.

9.3.13 Updating Products for a Fully Accrued Budget
For a fully accrued budget, product eligibility can be defined by fully using the 
highly configurable Qualifier Contexts and Attributes as set up in Oracle Advanced 
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Pricing. Use the following procedure to define product eligibility for a fully accrued 
budget.

Prerequisites
A draft fully accrued budget must have been created.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to Budget > Budgets.

2. Click the hyperlink of the budget.

3. Click Accrual Parameters Details.

4. Enter all the products that are eligible for the budget.

5. Click Update.

For more information, see the Oracle Advanced Pricing User Guide.

9.3.14 About Copy Budget and Budget Delete
Copy Budget enables you to create a new budget by copying information from an 
old budget. For example, you can create a copy of the yearly budget that repeats the 
same essential information each year, and update it.

You can delete a budget if it is in the Draft, Cancelled, or Archived status. After a 
budget is deleted, you will not be able to search and find the budget in Oracle Trade 
Management.

9.4 Budget Approval
After creating a budget, you must submit it for approval. A budget has to be 
approved to become active. After a budget becomes active, it can start funding 
trade promotion activities.

Topics included are:

■ Section 9.4.1, "Understanding the Budget Approval Process"

■ Section 9.4.2, "Initiating Budget Approval"

■ Section 9.4.3, "Approving a Budget"
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9.4.1 Understanding the Budget Approval Process
The budget approval process involves reviewing, and approving or rejecting 
budgets. A budget becomes active after it is approved by the designated approvers. 
If the budget is approved, you can source funds for various trade promotion 
activities from the budgets. On the other hand, if the budget is rejected, you will not 
be able to withdraw funds from the budget. In a budget hierarchy, child budgets 
can become active only if the parent budget has been approved and made active. 
The only instance where a budget does not require approval is when the budget 
owner is the one and only approver according to the approval rule setups.

After a budget is submitted for approval, the approval rules determine the approval 
flow. Approval rules can be configured, and multiple rules can be created based on 
the characteristics of the budget. Approval rules are of two types:

■ Root budget approval rules: to determine the person who will be responsible 
for approving a budget itself.

■ Budget approval rules: to determine the person who will be responsible for 
approving an offer, a campaign, an event, or any request to source funds from a 
budget.

The approver may approve, reject, or put the budget on hold. The budget status 
changes accordingly and appears on the screen. This enables you to know the exact 
status of a budget at any point of time. Budget status is also known as system 
status. Table 9–1 describes the different statuses that a budget may go through.

Table 9–1 Budget Statuses

Status Description

Draft The budget status appears as Draft when the budget has not 
yet been submitted for approval. A budget in the Draft status 
can be updated any time. From Draft, the budget status may 
change either to Pending Approval or Cancelled. If you are the 
budget owner and also the owner of the parent budget, you 
can directly change the status to Active.

Pending Approval The budget status appears as Pending Approval if the budget 
is awaiting approval. The budget status may change to either 
Active or On Hold if all the approvers respond positively. The 
budget status changes to Rejected if the approvers reject the 
budget.

On Hold On Hold is an interim status, which means that the budget has 
already obtained approval, but is not completely ready to be 
made active. From On Hold, the budget status may change to 
either Active or Closed.
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Apart from system statuses, there are user statuses that enable multiple users to 
review a budget before it is submitted for approval. For example, a team of finance 
executives administers a budget. Each individual in the team must review a budget 
before submitting it for approval. So there may be multiple user statuses created as 
follows:

Rejected The budget status appears as Rejected if the approvers reject 
the budget. From Rejected, the status can be changed back to 
Draft.

Active The budget status appears as Active after the budget has been 
approved. This means that the budget has been approved, and 
is ready to fund various activities and promotions. From 
Active, the status may change to either Closed and Cancelled.

Cancelled The budget status appears as Cancelled if it has been aborted. 
You cannot cancel a budget if there is an approved offer 
associated with it. You must first cancel all the associated 
offers, and then cancel the budget. If you cancel a budget with 
existing offers in the approval process, the system sends an 
alert to the offer owner stating that the offer must either be 
cancelled, or funded by an alternate budget. From Cancelled, 
the status can only change to Archived.

Archived When the budget status appears as Archived, the budget can 
no longer be used. This status cannot change to any other 
status.

Completed The budget status appears as Completed after all the activities 
that are associated with the budget are complete and all the 
funds in the budget are utilized.

Closed The budget status appears as Closed after budget has ended 
and is no longer available to fund activities, and offers.

System Status User Status

Draft First Reviewer

Draft Second Reviewer

Draft Third Reviewer

Draft Final Reviewer

Table 9–1 Budget Statuses

Status Description
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The budget is initially in the "Draft - First User" status. The First Reviewer reviews 
the budget, and puts it in “Draft - Second Reviewer” status. This serves the purpose 
of letting everyone know that the budget has been reviewed and handed over to the 
Second Reviewer. Here, the system status is "Draft" where as the user statuses are 
"Draft-First Approver" and "Draft-Second Approver". Because the underlying 
system status is "Draft", the budget has all the behaviors of a draft budget. This 
means that the budget can be updated and funds cannot be withdrawn. Thus, the 
user status enables everyone in the team to know the state of the budget.

9.4.2 Initiating Budget Approval
After you have entered all the necessary information for a budget, you can initiate 
the activation of a budget by requesting for budget approval. Use the following 
procedure to initiate budget approval.

Prerequisites
A draft budget must have been created.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to Budget > Budgets.

2. Click the hyperlink of the budget.

3. Click Request Approval.

4. Review the approver details, and click Confirm.

The request will be sent to the designated approvers. The approval status 
changes to Pending Approval. You can view the approval status by clicking 
View Approval. The View Approval button appears only until the request is in 
the Pending Approval status.

9.4.3 Approving a Budget
A budget must be approved before it can become active. When a budget owner 
submits a budget for approval, you will receive a workflow notification if you are 
the designated approver. Use this procedure to approve a budget.

Prerequisites
A budget must have been submitted for approval.
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Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User, 

and navigate to Workflow > Worklist. You can also launch the worklist by 
navigating to Home > Tools > View Notification Work List.

The list of open notifications is displayed.

2. Select the notification that corresponds to the budget that must be approved.

3. Click Approve.

9.5  Budget Allocation
Budget allocation is the process of allocating a budget across territories. Budget 
allocation can be done only after a budget is approved and is active. After the 
budget is allocated, each territory receives its share of the budget, which it can use 
to execute trade promotion activities.

Topics included are:

■ Section 9.5.1, "Understanding the Budget Allocation Process"

■ Section 9.5.2, "About Top-down Bottom-up Budgeting"

■ Section 9.5.3, "Creating a Budget Allocation"

■ Section 9.5.4, "Submitting a Change Request During Top-down, Bottom-up 
Budgeting"

■ Section 9.5.5, "Approving or Rejecting a Request Submission"

■ Section 9.5.6, "Activating a Budget Allocation"

9.5.1 Understanding the Budget Allocation Process
Sales activities of organizations may span different territories and regions 
(geographic locations). After a budget is approved and active, you can distribute 
funds down the sales territory hierarchy. This process of allocating funds down the 
territory hierarchy is known as budget allocation. Each of the levels in the sales 
territory hierarchy can use their share of funds to execute trade promotion activities 
in their geographic location.

For example, an active budget has $75,000. The sales activities span 3 territories. The 
Sales Representatives of each of the territories require funds to execute sales 
promotion activities. You can allocate funds among these territories based on the 
demand for the products in each of these territories.
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Figure 9–2 Budget Allocation

Territories can be arranged in a hierarchy. For example, a sales territory--US West 
can in turn include California and Oregon territories. You can allocate a fixed 
budget down a particular territory hierarchy. Budget allocation enables you to 
establish a top-level value for your budget or allocation funds and distribute the 
roll-down values to the lowest hierarchy levels, based on the sales data (shipped 
order amounts) from the previous year. When the allocation is complete, a budget 
hierarchy, which is similar to the territory hierarchy is created. The primary person 
in each territory becomes the budget owner. The other team members in the 
territory become team members of the budget.

During budget allocation, you can perform the following actions:

■ Specify holdback amounts or holdback percentage

■ Edit allocations

■ Transfer funds

■ Release holdback funds

Note: Holdback amount takes precedence over holdback 
percentage. Holdback percentage is considered only when the 
holdback amount is not specified.
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After creating a budget allocation, you must submit it for approval. The Sales 
Representatives can start utilizing funds from the budget only after the approvers 
approve the allocation.

The following example shows how a budget can be allocated down a sales territory 
hierarchy.

The following is a sales territory hierarchy:

US West

California

Oregon

The individual sales that was achieved in each of these territories is as follows.

US West territory: $300K (independent of the sales of its child territories)

California: $500K

Oregon: $200K

The total sales that was achieved in the prior year was $1 million.

A budget--Sales Budget 2003 with total funds of $10,000 is allocated down this 
hierarchy without holding back any funds. The allocation is based on the sales 
achieved in the previous year. A budget hierarchy is created by the allocation as 
follows:

Sales Budget 2003

Sales Budget 2003 - US West

Sales Budget 2003 - California

Sales Budget 2003 - Oregon

The budget balances for each of these territories will be as follows:

Sales Budget 2003 - $0

Sales Budget 2003 - US West: $3K

Sales Budget 2003 - California: $5K

Sales Budget 2003 - Oregon: $2K

The roll-up view of this budget hierarchy will be as follows:

Sales Budget 2003 - $10K

Sales Budget 2003 - US West: $10K
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Sales Budget 2003 - California: $5K

Sales Budget 2003 - Oregon: $2K

After the process of budget allocation is complete, the owner of Sales Budget 2003 
can automatically access all the three budgets in the hierarchy. The owner of Sales 
Budget 2003 - US West can access Sales Budget 2003 - California, and Sales Budget 
2003 - Oregon.

See Section 9.8.2 for information on budget roll-up view and budget self view.

9.5.2 About Top-down Bottom-up Budgeting
Sales activities in an organization begin with analysis, forecasting, and allocation of 
funds down the hierarchies. During the planning phase, based on the sales figures 
of previous years, the Sales Management can allocate funds without taking inputs 
from the lower levels. This type of budget allocation is known as top-down 
budgeting.

In a bottom-up budgeting process, budget amounts are rolled up from the lower 
levels to the Sales Management. After funds are allocated, lower levels may offer 
their inputs to the Sales Management, and allocations can be altered accordingly.

Top-down bottom-up budgeting is performed by first allocating budgets based on 
some criteria such as prior year sales, then by accepting input from lower levels. 
Multiple such top-down and bottom-up cycles may continue until the budget 
numbers are finalized.

Figure 9–3 illustrates the top-down bottom-up budgeting process.

Note: Territories are created in Oracle E-Business Suite Territory 
Management module and provide a means of grouping customers. 
Territories may be created based on various customer and 
geographical attributes - customer name, account code, customer 
category, account hierarchy, city, country, county, postal code, 
province, state, account classification, party relation, site, 
classification, customer profile, or sales channel.



Budget Allocation

9-30 Oracle Trade Management User Guide

Figure 9–3 Top-down Bottom-up Budgeting

A top budget owner may be a sales or marketing executive. A mid budget owner 
may be a sales manager or a marketing manager. A bottom budget owner may be a 
marketing team member or a field sales person. Each level of management will see 
the roll-up numbers for the budget and the child budgets for which they are 
responsible.

9.5.3 Creating a Budget Allocation
After the budget is approved and active, you can allocate the Budget to the Sales 
Representatives in the territory hierarchy. Budget allocation determines the share of 
the budget that each of the territories and regions in the sales team hierarchy will 
receive. Use the following procedure to create a budget allocation.

Prerequisites
An approved budget.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to Budget > Budgets.

2. Click the hyperlink of the budget.

3. Click the Allocation side navigation link, and then click Create.

4. From the Action drop-down list, select either of the following:

– Add on to Existing Budget Hierarchy: the hierarchy that has been defined 
for the budget will be used.
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– Create New Budget from this Allocation: you must define the hierarchy for 
the allocation by specifying the Start Level and End Level.

5. Select the Start Point, and optionally check Exclude Start Node from this 
Allocation.

If you check the Exclude Start Node from this Allocation option, then funds will 
not be allocated to the top level of the hierarchy. For example, in the hierarchy 
US West > California > San Francisco, you must allocate funds only to 
California and San Francisco and exclude US West. You can exclude US West 
from the allocation by checking this option.

6. Select the Active From Date, and Active To Date.

7. Select an allocation method from the Method drop-down list. The values that 
are available are:

– Even Distribution: Allocates funds equally across all the territories

– Manual: You must manually enter the amount that must be allocated to 
each territory

– Prior Year Sales Total in Amount: Allocates funds based on the sales figures 
of the previous years

8. Select the Basis Year if you select the method as Prior Year Total Sales Total in 
Amount. Funds will be allocated based on the sales figures of the basis year that 
you select.

9. Enter the Allocation Amount, and click Generate.

10. Optionally enter the Holdback Amount and Holdback Percentage for each 
level. This is the amount that you do not wish to allocate immediately.

11. Click Worksheet.

The worksheet shows the distribution of the budget across the hierarchy that 
you created. If you wish to make changes in the allocation, you can make the 
changes here.

12. Click Update, and then click Publish.

The allocation status changes to Planned.

13. To update an existing allocation:

a. Navigate to Budget > Budgets.

b. Click the hyperlink of the budget.
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c. Click the Allocation side navigation link.

d. The list of allocations that have been created from the selected budget is 
displayed.

e. Click the Allocation Number, and modify the information as desired.

f. Click Update.

9.5.4 Submitting a Change Request During Top-down, Bottom-up Budgeting
After the Sales Management allocates funds, if you are the Sales Representative who 
is the recipient of the allocation, you will receive a workflow notification. You can 
review the amount that has been allocated to you, and if you require a different 
amount than what has been allocated, you can suggest a new amount for the 
allocation. Use this procedure to request for changes to be made in the original 
allocation.

Prerequisites
■ A draft or active fixed budget has been created and an allocation has been 

initiated.

■ You are the recipient of the allocation.

■ The allocation is not active yet.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Budget > Budgets.

2. Click the hyperlink of the budget.

3. Click the Allocation side navigation link.

The list of all the allocations that have been created from the selected budget is 
displayed.

4. In the Worksheet column, click the link corresponding to the allocation for 
which you would like to offer inputs.

5. In the Rollup Total field, enter the new amount that you would like to 
recommend.

6. Optionally enter an amount that you would like to reserve from the allocation.
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7. Optionally enter any form of free text in the Notes field to justify why you 
require a different amount that what was originally allocated.

8. Optionally attach any supporting files (.doc, .pdf, .xls, and so on).

9. Click Submit.

The Sales Management may either accept or reject the request. If the request is 
rejected, then you must resubmit the request. Repeat the steps in this procedure 
to resubmit a request.

9.5.5 Approving or Rejecting a Request Submission
You may accept or reject the request submissions that have been made by the Sales 
Representatives. Use this procedure to accept or reject a request submission.

Prerequisites
■ A draft or active fixed budget has been created and an allocation has been 

initiated, and the allocation is not active yet.

■ You are the creator of the allocation.

■ The recipient has made a request submission.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to Budget > Budgets.

2. Click the hyperlink of the budget.

3. Click the Allocation side navigation link.

The list of all the allocations that have been created from the selected budget is 
displayed.

4. In the Worksheet column, click the link corresponding to the allocation for 
which the request submission has been made.

The list of all the territory hierarchies are displayed. To identify the territory 
that has submitted the request, check the Requested Amount, and the 
Allocation Status columns. The Requested Amount column shows the details of 
the total amount that has been requested by the territory, and the allocation 
status appears as Submitted.

5. Select an option from the Action Required drop-down list depending on 
whether you wish to approve or reject the request. If you reject the request, the 
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allocation status changes to Rejected. The submitter may make changes in the 
request and resubmit it.

6. Optionally repeat the previous step to accept or reject another request 
submission.

7. Click Update.

9.5.6 Activating a Budget Allocation
Sales Representatives can start using funds to execute trade promotion activities in 
their respective territories only after the budget allocation is made active. Use this 
procedure to activate a budget allocation.

Prerequisites
A planned budget allocation.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to Budget > Budgets.

2. Click the hyperlink of the budget.

3. Click the Allocation side navigation link.

4. Click Worksheet.

The worksheet shows the distribution of the budget across the territory 
hierarchy.

5. Change the allocation status to Active, and click Update.

9.6 Budget Utilization
A budget can fund many trade promotion activities. Funds from the budget are 
committed against each of these trade promotion activities, and are utilized over a 
period of time. The budget checkbook gives the status of the funds in a budget 
including the total, committed, utilized, earned, paid amounts, and the GL posting 
details of the budget.

Topics included are:

■ Section 9.6.1, "About Budget Utilization"

■ Section 9.6.2, "About Budget Request and Budget Transfer"
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■ Section 9.6.5, "Approving or Rejecting a Budget Request"

■ Section 9.6.4, "Creating a Budget Transfer"

■ Section 9.6.6, "About Budget Mass Transfer"

■ Section 9.6.7, "About Recalculated Committed"

■ Section 9.6.8, "Viewing Recalculated Committed"

■ Section 9.6.9, "Budget Adjustment Types"

■ Section 9.6.10, "Creating a Budget Adjustment"

■ Section 9.6.11, "Integration to Sales Orders (Off-invoice Offers)"

■ Section 9.6.12, "Integration to Sales Orders (Accrual Offers)"

■ Section 9.6.13, "GL Postings for Off-invoice Offers"

■ Section 9.6.14, "Basic General Ledger Integration"

■ Section 9.6.15, "Advanced General Ledger Integration"

9.6.1 About Budget Utilization
A budget is utilized whenever you withdraw funds to execute trade promotion 
activities. The utilized, earned, and paid columns in the budget are updated during 
various stages of offer execution, and these columns enable you to track fund 
utilization.

The utilized column records integration of the budget to sales orders, regardless of 
the order channel. The following types of records are stored in this column:

■ Costs from the trade promotion activities including Off-invoice offers

■ Accruals that are created from offers

■ Adjustments that created in the budget checkbook

When an order is placed, the utilized column gets updated to show all the funds 
that are likely to be utilized for the order. This however, does not give you the exact 
earnings based on the goods shipped. The earned column records the amount that 
is accrued based on the goods that are actually shipped.

The paid column records all of the payment information of the budget by:

■ Off-invoice kind of offers

■ Claims that are settled through credit memos or checks
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■ Deductions that are settled through credit memos

For example, you create an offer for $10,000 to give 10% discount on a product. 
After the offer is approved, the committed column in the budget shows $10,000. The 
cost of the product is $100. A customer places an order for 10 units of the product. 
Therefore, the total order value is $1,000, and after discount, it is $900. The discount 
offered is $100, which is the amount utilized from the budget.

You however decide to ship only 5 units of the product initially, and ship the 
remaining units next month. Because only 5 units of the product are shipped, the 
customer is eligible to claim only $50. This is the amount that is earned from the 
budget.

You settle the claim and pay $50 to the customer, and you make this payment 
through a cheque. This is the amount that is paid, and the paid column gets 
updated accordingly.

Therefore, the budget checkbook gets updated as shown below:

In the above example:

■ The total column shows the entire amount in the budget.

■ The committed column shows the amount that is committed to all approved 
trade promotion activities that source funds from the budget. In this case, the 
committed column shows $10,000 after the offer has been approved.

■ The utilized column gets updated after orders are placed against the offers. In 
this case, the utilized column gets updated to $100 after the customer places an 
order against the offer and the orders are booked.

■ The earned column gets updated after the products are shipped. It shows the 
total amount spent from the budget based on the goods that are actually 
shipped. In this case, the earned column shows $50 after you ship 5 units of the 
product.

■ The paid column shows the total amount that is paid towards settling all the 
claim requests. In this case, the paid column gets updated to $50 after you settle 
the claim raised by the customer.

Total Committed Utilized Earned Paid

5,00,000 10,000 100 50 50
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9.6.2 About Budget Request and Budget Transfer
Funds are utilized from budgets when budget requests or budget transfers are 
approved. A budget request a request to withdraw and use funds from a 
budget to execute trade promotion activities such as offers and campaigns. A 
budget transfer involves transferring funds from one budget to another; it 
involves moving money from one budget to another.

Budget Request

Figure 9–4 Budget Request

Budget Request is an explicit request to withdraw funds from a budget to execute 
trade promotion activities such as offers and campaigns.You may submit a budget 
request to give an offer to customers. A budget request may also be submitted by 
the owner of another budget.

For example, you plan to execute a campaign--New Product Introduction to 
introduce a new product into the market. You must submit a budget request to 
source funds for this activity. You can also submit a request to source funds from a 
budget owned by another person.

Budget requests must be approved before the money is transferred. The 
Administrator configures approval rules to route different requests to different 
approvers. A budget may fund multiple trade promotion activities, and a trade 
promotion activity can source funds from multiple budgets. For more information 
and procedures related to sourcing offers from a budget, see Chapter 7, "Trade 
Planning and Offers". 
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Budget Transfer

Figure 9–5 Budget Transfer

Budget Transfer involves transferring funds from one budget to another. To create a 
budget transfer, both the budgets must be approved and active. For example, “New 
Product Introduction” fund may not need as much money as originally forecasted 
because the new product does not perform well. You can transfer money out of it 
into other budgets so that the money can be spent somewhere else.

You cannot transfer funds from budgets that are cancelled, closed, or archived. Also, 
if a child budget is cancelled, you cannot transfer funds from the child budget to the 
parent budget. To transfer funds from a child budget, after the budget is complete, 
you must first make a manual a negative adjustment for the amount which is 
committed and but not paid. You must then accordingly decrease the committed 
amount, and then transfer the remaining funds to another budget and then close it.

If an offer or a budget that requests funds from another budget uses a different 
currency, then conversion can be done automatically if the profile AMS: Currency 
Conversion Type has been implemented in your organization.

All movements of money in and out of any given budget are tracked to provide 
complete audit control.

9.6.3 Creating Budget Request from a Budget
If you are the budget owner who wants to request for funds from another budget, 
then you can do so by submitting a budget request. After you submit a budget 
transfer request, the granting budget owner may review your request and either 
accept or reject it. Use the following procedure to submit a budget request.

Note: Budget requests for offers are created by the offers users. 
See Chapter 7, "Trade Planning and Offers" for the detailed 
procedure on creating a budget request to source funds for an offer.
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Prerequisites
Both the granting and the receiving budgets must be active.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to Budget > Budget Transfer.

2. Click Create Request.

3. In the Budget Source region, select the sourcing budget from the Source Name 
LOV.

This is the granting budget. After you select the sourcing budget, the Number, 
Owner, and Budget Amount will automatically default in.

4. In the Budget Recipient region, select the receiving budget from the Recipient 
Name LOV.

This is the budget into which funds will be transferred. After you select the 
receiving budget, the Number and Owner fields will automatically default in.

5. In the Request Details region:

a. Enter the amount that you would like to request from sourcing budget.

b. Optionally enter the other details as required.

6. Click Create.

The status of the request changes to Planning.

After you submit the request, the granting budget owner will be notified.

Note: The budget amount that defaults in is the total amount that 
is available in the budget, and not the amount that will be 
transferred into the receiving budget. You must specify the transfer 
amount in the Transfer Details region.

Note: The Required By field indicates the date by which you 
require the funds to be transferred. It is a way of letting the 
granting budget owner know the urgency of the request; it has no 
functional impact.
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9.6.4 Creating a Budget Transfer
When there are requests for funds transfer, you will workflow notifications if you 
are the owner of the granting budgets. You can transfer funds from your budget to 
the receiving budget by creating a budget transfer. A budget transfer involves 
transferring funds from one budget to another. Use this procedure to create a 
budget transfer.

Prerequisites
Both the granting and the receiving budgets must be active.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to Budget > Budget Transfer.

2. Click Create Transfer.

3. In the Budget Source region, select the sourcing budget from the Source Name 
LOV.

This is the granting budget. After you select the sourcing budget, the Number, 
Owner, and Budget Amount will automatically default in.

4. In the Budget Recipient region, select the receiving budget from the Recipient 
Name LOV.

This is the budget into which funds will be transferred. After you select the 
receiving budget, the Number and Owner fields will automatically default in.

5. In the Transfer Details region:

a. Enter the amount that you would like to transfer from the sourcing budget 
to the receiving budget.

b. Optionally enter the other details as required.

6. Click Create.

Note: The budget amount that defaults in is the total amount that 
is available in the budget, and not the amount that will be 
transferred into the receiving budget. You must specify the transfer 
amount in the Transfer Details region.
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9.6.5 Approving or Rejecting a Budget Request
Budget requests for offers are created by the offers users. Whenever there are 
budget requests to source funds for offers, you will receive workflow notifications if 
you are the owner of the granting budgets. You can either approve or reject the 
request. If you approve the requests, the offers users will be able to utilize funds 
from the budget to offer discounts and execute trade promotion activities. Use the 
following procedure to either accept or reject a budget request.

Prerequisites
A budget request has been submitted.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User, 

and navigate to Workflow > Worklist. You can also launch the worklist by 
navigating to Home > Tools > View Notification Work List.

The list of open notifications is displayed.

2. Select the notification that corresponds to the budget request that must be 
approved.

3. Click Approve.

9.6.6 About Budget Mass Transfer
Promotional offers to customers may remain active for multiple fund periods. When 
an offer sources funds from a budget, funds are committed to the offer. During 
changeover of fund periods, new budgets will be established whereas old budgets 
will be closed. Some of the orders that have been placed against offers in the old 
fund period remain active even though the old budgets get closed. The payments 
against these orders that are earned in the new period must be tracked in the 
budgets in the new period. These committed but unearned funds can be tracked by 
mass transferring them from the old budget to the new budget.

When a customer places an order, initially only the utilized column in the budget 
gets updated. The earned columns get updated only after the order is shipped and 
the customer pays for the order. In between, if there is a changeover of fiscal 
periods, then the old budget closes and a new budget is established. The offer must 
start sourcing funds from the new budget, and all payments that are received in the 
new period must be tracked in the new budget.
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For example, an offer is active between June and December. The offer closes on 1st 
January. A customer places an order on 31st December. Goods are dispatched 
during February and the customer pays for the goods in the month of March. In this 
case, even though the order has been placed when the old offer was active, the 
actual earnings are received only in the new fund period. To track these earnings in 
the budget for the new fund period, all the committed but unearned funds must 
transferred from the old budget to the new budget.

Committed, but unearned funds can be transferred from the old budget to the new 
budget by creating a new budget and linking it to the old budget by a concurrent 
process automatically.

For example, a budget--Trade Promotion Budget 2003 is active between 1st January 
2003 and 31st December 2003. You create a new budget called Trade Promotion 
Budget 2004 to continue executing the same set of activities for the forthcoming 
year. In this case, you must transfer all the funds from Trade Promotion Budget 2003 
to Trade Promotion Budget 2004. The old budget can be linked to the new budget 
by running a concurrent process, and funds are transferred automatically.

The Administrator in your organization must run this concurrent request for you. 
See the Oracle Trade Management Implementation Guide for more information.

When the old budget and the new budget are thus linked, funds from the old 
budget are automatically transferred to the new budget. However, the start date of 
the new budget must be later than the start date of the old budget.

9.6.7 About Recalculated Committed
Recalculated committed enables you to spend money based on the available funds. 
When an offer or a campaign is sourced from a budget, the requested amount is 
committed to the activity. The offer may receive many orders, and sometimes the 
amount spent may be more than the committed amount or less than the committed 
amount. If recalculated committed is implemented in your organization, the 
committed funds are automatically increased or decreased based on the 
performance of the offer.

Organizations generally establish offers for a set period of time. For example, an 
offer may remain active for 6 weeks to 1 year. Even though organizations create 
forecasts for fund usages, the actual fund usages depend upon the performance of 
the offer. When organizations commit more funds than necessary to meet the actual 
requirements, it results in money un-utilized at year-end. If recalculated committed 
is implemented, based on the offer performance, it automatically performs real-time 
adjustments to the committed funds and ensures that there are no un-utilized funds 
at the year-end.
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Recalculated committed is based on comparing the average committed amount 
against the actual utilized amount. While the committed amount determines the 
maximum of what the utilized amount can be, the relationship is reversed for 
recalculated committed. If recalculated committed is implemented, then the utilized 
amount determines the recalculated committed amount. Recalculated committed 
cannot be used for offers with the maximum committed indicator--Terms Upgrade 
or Lump sum offers.

Recalculated committed enables you to measure and account differences between 
the expected performance and the actual performance. You can perform 
adjustments to the budgets on an ongoing basis, and use budgets effectively. The 
Administrator sets the frequency (daily, weekly, or monthly) for these adjustments. 
The adjustments occur on a timely basis and enables you to establish new deals 
within an acceptable time period.

For example, a promotion is established for a full year with an original committed 
amount of $200,000. In this example, by utilizing the simple methodology, 
adjustments are done on a monthly basis and the committed and utilized amounts 
are updated accordingly.

Month
Number of 
Days

Daily 
Forecast

Monthly 
Forecast

Actual 
Monthly 
Usage

Adjustments 
on Monthly 
Basis

January 31 $547.95 $16,986.30 $20,000 $3,014

February 28 $547.95 $15,342.47 $12,000 $3,3,42

March 31 $547.95 $16,986.30 $16,500 $486

April 30 $547.95 $16,438.36 $17,750 $1,312

May 31 $547.95 $16,986.30 $12,220 $4,766

June 30 $547.95 $16,438.36 $19,750 $3,312

July 31 $547.95 $16,986.30 $21,000 $4,014

August 31 $547.95 $16,986.30 $13,300 $3,656

September 30 $547.95 $16,438.36 $18,850 $2,412

October 31 $547.95 $16,986.30 $16,000 $986

November 30 $547.95 $16,438.36 $12,450 $3,988

December 31 $547.95 $16,986.30 $10,000 $6,896

Total 365 -NA- $2,00,000 $1,89,850 $10,150
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9.6.8 Viewing Recalculated Committed
Recalculated committed enables you to spend money based on the available funds. 
If recalculated committed is implemented in your organization, the committed 
funds are automatically increased or decreased based on the performance of the 
offer. Use the following procedure to view recalculated committed.

Prerequisites
Recalculated Committed must be implemented in your organization.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to Budget > Budgets.

2. Click Personalize.

3. Select and move Recalculated Committed from the Available Columns to the 
Displayed Columns.

4. Click Save, or Save and Apply.

5. Click the Recalculated Committed amount.

9.6.9 Budget Adjustment Types
Budget adjustments enable you to manually decrease or increase the committed and 
utilized amounts in a budget. You may need to perform budget adjustments to 
rectify erroneous entries, and to incorporate differences in invoicing and pricing 
information.

You can make the following four types of adjustments to a budget:

Note: This example shows how adjustments can be done on a 
monthly basis. Recalculated committed can also be implemented to 
make adjustments on a weekly, or daily basis. The frequency of 
adjustments is based on a profile option setting. For more details, 
see the Oracle Trade Management Implementation Guide.

Note: If the recalculated committed function is not implemented, 
then the amount that is displayed is the same as the committed 
amount.
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■ Increase committed

By using this option, you can increase the amount that is committed to a trade 
promotion activity.

For example, you source $10,000 for a campaign to introduce a new product 
into the market. Later, you realize that the committed funds are not sufficient to 
fund the campaign, and you need $5000 more. You can increase the committed 
amount to $15,000.

■ Decrease committed

By using this option, you can decrease the amount that is committed to a trade 
promotion activity.

For example, you source funds for a campaign and commit $10,000 to the 
activity. The campaign does not perform well and the amount utilized is only 
$4000. You can decrease the committed amount to $4000.

■ Increase committed and utilized

By using this option, you can increase the amount that is utilized for a trade 
promotion activity.

Sometimes, there may be mismatches between the amount entered and the 
actual amount utilized from the budget. This could occur due to a various 
reasons such as erroneous entries, or when there are differences between the 
entered amount and the invoice amount. In such cases, you may want to change 
the utilized amount. If the amount that was originally entered is less than the 
actual amount utilized, you can increase the utilized amount by using this 
option. When you increase the utilized amount, the committed amount 
increases accordingly.

For example, you source funds for a campaign, and you appoint an agency to 
execute the activities. The agency initially gives you an invoice for $8,000, which 
you enter as the utilized amount. Later the agency submits another invoice for 
$10,000 because there was a mistake in the first invoice. You can increase the 
utilized amount to $10,000.

■ Decrease committed and utilized

By using this option, you can increase the amount utilized for a trade 
promotion activity. Decrease utilized, like the increase utilized option, can be 
used to perform adjustments to the amount utilized from a budget. If the 
utilized amount entered is less than the actual amount utilized, you can 
decrease the utilized amount by using this option. When you decrease the 
utilized amount, the committed amount decreases accordingly.
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For example, you source funds for a campaign, and you appoint an agency to 
execute the activities. The agency gives you an invoice for $8,000, which you 
wrongly enter as $10,000. Later you realize that you made a mistake while 
entering the utilized amount. You can decrease the utilized amount to $8,000.

If a budget adjustment reference includes a product, then the entire adjustment is 
applied to the specified product. If the adjustment references a campaign or an offer, 
the adjustment is applied equally to all the products in the offer.

Accounting entries are created in the General Ledger by taking Base General Ledger 
accounts from the budget, budget category, or system parameters. The Account 
Generator, if implemented, replaces the General Ledger product segment account 
information with the product segment of the COGS account (from inventory item 
based on which accrual is made). If an inventory item cannot be determined for the 
utilization, then the base General Ledger account is used. See the Oracle Trade 
Management Implementation Guide for more information.

In addition to the adjustments mentioned above, the system creates the following 
automatic adjustments:

■ Recalculated Committed Increase

■ Recalculated Committed Decrease

■ Volume Offer Adjustment Increase

■ Volume Offer Adjustment Decrease

■ Scan Data Offer Committed Increase

■ Scan Data Offer Utilized Increase

For more information on Volume and Scan Data offer adjustments, see 
Section 9.6.12, "Integration to Sales Orders (Accrual Offers)".

9.6.10 Creating a Budget Adjustment
Budget adjustments enable you to manually decrease or increase the committed and 
utilized amounts in a budget. You may need to perform budget adjustments to 
rectify erroneous entries, and to incorporate differences in invoicing and pricing 
information. Use the following procedure to create a budget adjustment.

Prerequisites
You must be able to access the budget adjustment functions.
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Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to Budget > Budgets.

2. Click the hyperlink of the budget.

3. Navigate to Checkbook, and click Adjustments.

4. From the Type LOV, select the type of adjustment that you would like to make. 

After you select the Type, a description of the adjustment type is displayed in 
the Description field. The name and description of your adjustment types is 
determined by your organization. They are all based on one of the adjustment 
types--Decrease committed, Increase committed, Decrease committed and 
utilized, and Increase committed and utilized.

5. Type the adjustment amount in the Amount field.

6. Optionally, in the Date field, select the date on which you want the adjustment 
to be recorded.

7. Optionally, in the GL field and select a date if you want to specify the date for 
the GL postings to occur. If a date is not selected, a default date is used by the 
system.

8. From the Activity Type drop-down list, select the type of activity to which this 
adjustment is related.

The available activity types are campaign, event, deliverable and offer.

9. From the Activity Name LOV, select the name of the activity that is associated 
with this adjustment.

10. From the Schedule LOV, select the schedule that corresponds to the activity.

11. Optionally associate a document with the adjustment by selecting the document 
type and document number.

The values that are displayed in the Document Number LOV are determined by 
the document type that you have selected.

12. Specify the customer by selecting either Customer or Buying Group from the 
Customer drop-down list, and selecting the name of the customer or a buying 
group.

13. Optionally enter the other details as required.

14. Click Create.
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9.6.11 Integration to Sales Orders (Off-invoice Offers)
Off-invoice offers include Off-invoice, Order value, Promotional goods, and Terms 
upgrade offers. When Off-invoice offers are applied, it gives certain discounts and 
reduces the amount that the customers have to pay. When you source Off-invoice 
offers from a budget and execute the offers, the utilized and paid columns in the 
budget get updated simultaneously.

For example, the selling price of a product is $100. You create an off-invoice offer to 
give 10% discount on the product, and you source the offer from a budget. The 
committed amount for the offer is $10,000. A customer places an order for 10 units 
of the product. Because the discount offered is 10%, the customer has to pay only 
$900 instead of $1000. In this case, the amount the utilized, earned, and paid 
columns in the budget both simultaneously get updated to $100.

9.6.12 Integration to Sales Orders (Accrual Offers)
Accrual offers include Accrual, Lump sum, Scan data, and Volume offers. When an 
accrual offer is applied, it gives certain discounts, but does not reduce the amount 
that the customers have to pay. Instead, accruals are created for customers and the 
accruals are tracked in the background. The customers get paid back either by 
submitting a claim or through deductions.

In case of accrual offers, the utilized, earned, and paid columns are updated based 
on the accrual offer type. The manner in which these columns are updated for each 
of the accrual offer types is discussed in the following sections.

Accrual Offer
In an Accrual offer, the incentives are based on cumulative purchases made over a 
specific period of time. Funds are accrued over a period of time before it is paid to 
the customer. Therefore, only the utilized column gets updated when the customer 
books an order. The earned column gets updated when the order is shipped, and 
the paid column gets updated after the claim raised by the customer is settled.

For example, an accrual offer has a committed amount of $10,000, and gives 10% 
discount on a product. The selling price of the product is $100. Each time customers 
place orders for the product, they get 10% accrual on each unit of the product 
purchased. A customer places an order for 5 units of the product, and accrues $50 
based on the discount. The budget gets updated as follows:

Total Committed Utilized Earned Paid

5,00,000 10,000 100 100 100
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Here, the earned and paid columns are updated after you settle the claim raised by 
the customer.

Lump sum Offer
In case of Lump sum offers, the utilized, earned, and paid columns get updated 
based on whether the Lump sum offer is with spread or without spread. For 
example, a Lump sum offer is created to offer $5000 to a customer if he displays an 
in-store advertisement.

If the Lump sum offer is without spread, then as soon as the offer starts, the 
organization recognizes the whole amount as money utilized. The budget gets 
updated as follows:

If the Lump sum offer is with spread, then the amount is spread over a period of 
time and is utilized based on the time periods specified.

Assume that the offer lasts for 10 days. The budget utilization on the first day will 
be as follows:

The budget utilization on the second day will be as follows:

The entire amount committed to the offer will be utilized on the tenth day, and the 
budget utilization on the tenth day will be as follows:

Total Committed Utilized Earned Paid

5,00,000 10,000 50 0 0

Total Committed Utilized Earned Paid

5,00,000 5,000 5,000 5,000 0

Total Committed Utilized Earned Paid

5,00,000 5,000 500 500 0

Total Committed Utilized Earned Paid

5,00,000 5,000 1,000 1,000 0
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Scan Data Offer
Scan Data offers usually take the form of coupons. Customers can exchange these 
coupons and avail discounts on certain products. When a Scan Data offer is created, 
forecasts are made regarding the scan units and values. In case of a Scan Data offer, 
the committed amount and the utilized amount are updated simultaneously.

The actual data for the offer is received through claims. If the actual amount exceeds 
the forecasted amount, an automatic adjustment gets created to adjust the original 
accrual created based on forecasts. The committed and utilized columns are 
adjusted based on the comparison between the actual amount and the forecasted 
amount. Adjustments are created only up to the available amount in the budget.

For example, a Scan Data Offer has the following forecasted details:

The actual scan data shows the following for the two lines:

Based on the comparison between the actual utilization and the forecasted 
utilization, adjustments must be created to increase the Committed as well as 
Utilized amounts.

Adjust committed [(Actual utilization - forecast utilization) - (committed - forecast 
utilization)] = [(13,000 - 8,000) - (10,000 - 8,000)] = 3,000

Adjust utilized (Actual - Forecast) for each line:

Adjust line 1 (8,000 - 5,000) = 3,000

Adjust line 2 by (5,000 - 3,000) = 2,000

When adjustments are made to the utilization, the GL entries Debit Sales or Expense 
and Credit Liability are also created.

Total Committed Utilized Earned Paid

5,00,000 5,000 5,000 5,000 0

Total Committed Total Utilized Utilized - Offer 1 Utilized - Offer 2

10,000 8,000 5,000 3,000

Total Committed Total Utilized
Actual Utilized - 
Offer 1

Actual Utilized - 
Offer 2

1,000 8,000 8,000 5,000
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If Recalculated Committed is implemented, and the profile to allow the committed 
amount to be more than the available budget is set to "Yes", then adjustments up 
can be created without conditions. Recalculated committed skips making any 
adjustments for Scan Data offers. This is because of the automatic adjustments 
which happen for Scan Data offers when the actual amount is greater than the 
forecasted amount.

If Recalculated committed is not implemented, adjustments can be created only up 
to the available amount in the budget. For more information on Scan Data offer 
adjustments, see Chapter 10, "Claim and Deduction Management".

Volume Accrual Offer
A Volume accrual offer or a volume rebate is an offer where in the qualified 
customers accrue funds based on their cumulative purchase amounts spanning over 
a period of time. The retroactive flag determines whether past orders should also be 
adjusted based on the new accrual rate achieved.

For example, a Volume accrual offer is set up for a customer to accrue based on total 
volume of the product sold for the next 6 months as follows:

Each unit is priced at $1.00.

The first couple of orders from a customer look as follows:

If the Retroactive Flag is on, the system revisits order 1 and order 2 and makes a 
volume offer adjustment as follows:

0 - 1000 accrue 5%

1001 - 2000 accrue 8%

2001 or more accrue 10%

Order No. Quantity Purchased Accrual % Accrual

1 600 5% 30

2 400 5% 20

3 100 8% 8
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The customer places another order:

More Volume offer adjustments are made:

The following occurs if the retroactive flag is off:

Order No.
Quantity 
Purchased Accrual % Accrual

Volume Offer 
Adjustment

Total 
Accruals

1 600 5% 30 600 * (8% - 5%) = 18 48

2 400 5% 20 400 * (8% - 5%) = 12 32

3 100 8% 8 100 * 8% 8

Total 1,100 -NA- -NA- -NA- 88

Order No. Quantity Purchased Accrual% Accrual

4 1,000 10% 100

Order 
No.

Quantity 
Purchased

Accrual 
% Accrual

Volume Offer 
Adjustment 1

Volume Offer 
Adjustment 2

Total 
Accruals

1 600 5% 30 600 * (8% - 5%) 
= 18

600 * (10% - 8%) 
= 12

60

2 400 5% 20 400 * (8% - 5%) 
= 12

400 * (10% - 8%) 
= 8

40

3 100 8% 8 100 * 8% = 8 100 * (10% - 8%) 
= 2

10

4 1,000 10% 100 -NA- 1000 * 10% = 100 100

Total 2,100 -NA- -NA- -NA- -NA- 210

Order No. Quantity Purchased Accrual % Accrual

1 600 5% 30

2 400 5% 20

3 100 8% 8

4 1,000 10% 100

Total 2,100 -NA- 158
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9.6.13 GL Postings for Off-invoice Offers
Off-invoice discounts include Off-invoice, Promotional goods, Order Value and 
Terms Upgrade offers. These discounts are treated as reductions in revenue. These 
discounts can be treated as expenses by setting an option in System Parameters.

For example, you create an Off-invoice offer whereby a customer gets 10% off on a 
$100 item. When a customer places an order, Order Management takes $10 off each 
unit of the item, and pass $90 of revenue to Oracle Receivables which then creates 
GL entries, crediting revenue with $90. This treats the $10 as a reduction in revenue. 
If the option is set to create GL entries for Off-invoice discounts, the $10 is treated as 
an expense instead of reductions in revenue.

In System Parameters, the Administrator can specify whether GL entries must be 
created for Off-invoice discounts. If the option is checked, the Funds Accrual engine 
evaluates whether to create entries for such discounts or not. All the orders that are 
placed against Off-invoice offers will have GL entries created.

The following GL entries are created whenever the order data is passed to Order 
Management:

■ Debit Sales or Expense or Charge (set up in Oracle Trade Management)

■ Credit Revenue (set up in Oracle Receivables)

The Base Sales or Expense or Charge GL account is taken from setups done in the 
following order:

■ Budget which funds the offer

■ System Parameters

The Administrator may use the Account Generator workflow to configure this 
account.

Credit entries are made to the Revenue account that is used by Oracle Receivables 
on the invoice line of the sales order line with the offer applied.

For Off-invoice offers (Off-invoice, Order Value, Promotional Goods, Terms 
Upgrade, and Volume offers), the Utilized column gets updated after the offer is 
applied on the order. The Earned column gets updated as determined by the profile 

Note: Volume tier adjustments occur based on the shipped 
products. Budget adjustments are created when the customer 
reaches the next tier level based on shipped quantity.
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option--AMS-TM: Create GL Entries for Orders. The GL entries get created when 
the sales order line with the offer applied has been invoiced. See the Oracle Trade 
Management Implementation Guide for more details.

9.6.14 Basic General Ledger Integration
When accruals are created either from a Lump sum, Accrual, Scan Data or Volume 
offer, such accruals may be treated as liabilities by some organizations. These 
accruals are tracked in the General Ledger by creating the following accounting 
entries.

■ Debit Sales or Expense or Charge

A debit entry reduces the balance in the Sales or Expense or Charge account 
selected. If the account selected is a Sales account, the accrual is treated as a 
reduction in the sales revenue. If the account selected is an Expense or Charge 
account, the accrual is treated as a promotional expense. The account type that 
you may select depends upon the accounting policies in your organization.

■ Credit Liability

A credit entry increases the balance in the Liability account that you select while 
creating the entry.

Sales or Expenses or Charges are called Equity accounts. These two entries are 
created to maintain the basic accounting principle that states that the following 
equation must always hold true:

Asset = Liability + Equity

For example, an accrual offer is set up to accrue 10% for every unit of a product 
sold. The product price is $200. When a customer places an order for 5 units of this 
product, the following accrual and accounting entries are created:

Accrual amount: $200 x 5 x 10% = $100

Debit Sales or Expense or Charge $100
Credit Liability $100

Asset: Unaffected

Liability: Credit $100 (Increase by % $100)

Equity: Debit $100 (Increase by $100)

The accounting entries created during accrual use the GL accounts from the 
following setups:
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■ GL accounts as defined for the budget itself, along with any Account Generator 
workflow updates

■ GL accounts as defined for a budget category, along with any Account 
Generator workflow updates

■ GL accounts as defined in the System Parameters, along with any Account 
Generator workflow updates

When claims or deductions are settled with the promotional earnings associated, 
the liabilities are reversed and a Receivables Clearing or Payables Clearing account 
is credited. For more details on claims and deductions, see Chapter 10, "Claim and 
Deduction Management".

All the General Ledger entries associated with Oracle Trade Management are 
created with a source called Marketing in the General Ledger. The GL categories 
that are used for journal entries that are created during accrual are:

■ Fixed Budgets (for accruals created for Accrual offers, Lump sum offers, Scan 
Data offers and Volume offers which source funds from a fixed budget)

■ Accrual Budgets (for accruals created by fully accrued budget)

9.6.15 Advanced General Ledger Integration
The base GL accounts are generally taken from either a budget, budget category, or 
System Parameters. Apart from this, you can modify the Account Generator 
workflow to configure GL accounts dynamically. By using the Workflow 
Administration tool, you can modify the Account Generator workflow, and change 
the values of various segments for each account.

For example, the GL account structure of an organization is as follows:

Company-Account Type-Customer-Product-Others 

The base liability account as set up with the budget is 01-0001-0002-0000-000

If this is an accrual created because an accrual offer is applied on a sales order, you 
can find the customer and product attributes from the order and derive the 
account--01-0001-8888-2344-000, where the segment value:

■ 8888 is used to track a certain customer

■ 2344 is used to track a certain product

Seeded information that you can use to derive these segment value changes 
are--order header ID, order category, order type ID, price adjustment ID, order line 
ID, line commitment ID, salesrep ID, organization ID, sold to customer account ID, 
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chart of accounts ID, operating unit, budget ID, offer ID, inventory item ID, item 
category ID. But the configuration of the GL accounts is not limited to these pieces 
of information only.

For example, you can use the value--offer ID to find the custom setup or any other 
information about the offer. You may use all this information to configure GL 
accounts.

9.7 Budget Reconciliation
A budget can fund multiple trade promotion activities. After a trade promotion 
activity comes to an end, the funds committed to the activity are no longer used. 
Budget reconciliation enables you to return the remaining money at the end of a 
trade promotion.

Reconcile Un-utilized
Even after a trade promotion activity comes to an end or even after it is cancelled, it 
may have committed funds that are not utilized. The "Reconcile Un-utilized option 
enables you to return back money that has been committed, but not utilized. When 
you reconcile a budget by choosing this option, the previously committed, but 
unutilized funds, are transferred from the Committed column to the Available 
column.

For example, a budget has an total amount of $50,000 out of which $10,000 is 
committed to an offer called "New Product Promotion". The amount that is utilized, 
earned, and paid from the offer is $8,000. The columns in the budget appear as 
shown below.

The offer has reached its end date. The Sales Representative decides that there will 
be no more orders against the offer and decides to return back the remaining 
money, which is $2,000 (Committed - Utilized). The Sales Representative performs a 
budget reconciliation and choose the option "Reconcile Un-utilized". This decreases 
the committed amount and increases the available amount in the budget. The 
columns in the budget appear as shown below.

Total Available Committed Utilized Earned Paid

50,000 40,000 10,000 8,000 8,000 8,000
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Notice that the amount in the Available column has increased by $2,000, whereas 
the amount in the Committed column has decreased by $2000.

Reconcile Un-utilized and Unpaid Earnings
If you choose the "Reconcile un-utilized and unpaid earnings" option, the 
committed, utilized, and earned amounts get decreased by the amount of (Utilized - 
Paid). This amount is transferred from the committed column to the available 
column. If General Ledger integration is implemented, then the GL entries--Debit 
Liability and Credit Sales or Expense are created when the utilized is decreased.

The "Reconcile un-utilized and unpaid earnings" option is used for accrual based 
offers such as Accrual, Lump sum, Scan Data and Volume offers. For these offers, 
even after an offer ends, customers can still submit claims. But after some time, 
when the organization believes that no more claims will be coming in for the offer, it 
can close the offer and reduce the outstanding accruals.

For example, a budget has an accrued amount of $10,000. The actual amount that is 
utilized, and earned from the budget is $7,000 whereas the amount that is paid from 
the budget is $6,000. The columns in the budget appear as shown below.

The offer has reached the end date and a few days have passed. The Management 
conducts a review of this offer and believes that no more claims will come in. An 
offer user manually changes the offer status from Active to Completed. The offer 
user chooses reconciles the associated budget by choosing "Reconcile Un-Utilized 
and Un-Paid Earnings". An adjustment for $1000 (Utilized- Paid) is made to the 
sourcing budget, and this amount is transferred to the Available column. The 
committed, earned and utilized funds in the budget are decreased. The columns in 
the budget appear as shown below.

Total Available Committed Utilized Earned Paid

50,000 42,000 8,000 8,000 8,000 8,000

Total Available Committed Utilized Earned Paid

10,000 3,000 7,000 7,000 7,000 6,000

Total Available Committed Utilized Earned Paid

10,000 4,000 6,000 6,000 6,000 6,000



Budget Reconciliation

9-58 Oracle Trade Management User Guide

Notice that the amount in the Available column has increased by $1000, whereas the 
amounts in the Committed, Utilized, and Earned columns have decreased by $1000.

The reconcile button appears only if a trade promotion reaches the end date and 
status is completed or closed. If the trade promotion has no end date, the status 
should be either Completed or Closed. A budget can be reconciled automatically 
based on a concurrent process that takes a pre-defined grace period into account. 
For some organizations, this grace period can range widely from a month to more 
than a year. For such organizations, this grace period is not systematic and therefore 
they can reconcile budgets at any point of time.

You can reconcile a budget only if you have the access permissions and 
responsibilities as defined in the Custom setup, and Responsibility setup.

9.7.1 Reconciling a Budget
Funds that are committed to a trade promotion activity such as an offer or a 
campaign are not utilized after the activity comes to an end. Budget reconciliation 
enables you to return the remaining amount back to the sourcing budget. Use the 
following procedure to reconcile a budget.

Prerequisites
The offer or campaign that is associated with the budget must have reached its end 
date and its status must be either completed or closed.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to the Offer.

2. Click the Budget side navigation link.

The Reconciliation section at the bottom of the page appears if the offer status 
appears as either Completed or Closed.

3. Select a reconciliation option. There are two options are:

– Un-Utilized, which is applicable for trade promotion purpose

– Un-Utilized and Un-Paid Earnings, which is not applicable for trade 
promotion purposes. Un-Utilized amount = Committed – Utilized.

4. Click Reconcile.

During reconciliation, the committed amount in the budget is reduced, whereas the 
available amount increases accordingly. For example, an offer has committed = 
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$10K, utilized = $8K. This kind of reconciliation will decrease the committed from 
$10K to $8K and increase the budget’s available by $2K.

9.8 Budget Tracking
Oracle Trade Management includes tools and techniques that enable you to obtain 
relevant information about any budget at any point of time. These tools and 
drill-down facilities provide detailed reports regarding the budget, and provide 
information such as:

■ Available, committed, and utilized funds in the budget

■ List of trade promotion activities that are sourced from the budget

■ Status of each of the trade promotion activities

■ Available, committed, and utilized funds against each of the trade promotion 
activities

Topics included are:

■ Section 9.8.1, "Budget Checkbook View"

■ Section 9.8.2, "Roll-up View and Self View"

■ Section 9.8.3, "Budget Transaction and Budget Details Checkbooks"

■ Section 9.8.4, "Offer Checkbook"

■ Section 9.8.5, "Customer Budget View"

■ Section 9.8.6, "Transaction Drill Down"

9.8.1 Budget Checkbook View
Budget checkbooks are used to track the usage of funds in a budget, and enable you 
to track funds that are available, committed, utilized, transferred, and paid.

Table 9–2 describes the information that a budget checkbook provides.

Table 9–2 Budget Checkbook Views

View Description

Total For a Fixed Budget, the total column shows the total funds 
that are committed for the budget

For a Fully Accrued Budget, the total column shows the total 
funds that are utilized for trade promotion activities.
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See Section 9.3.2, "Fully Accrued Budget" for detailed information on how the Total, 
Committed, and Utilized columns get updated for Fixed Budgets, Fully Accrued 
Budgets, and Fully Accrued Budgets that accrue to sales.

9.8.2 Roll-up View and Self View
Roll-up view shows the total funds in a budget including the sum of all its child 
budgets.

Transferred-in The amount transferred into the budget from another budget

Total budget amount includes the transferred-in amount 

Transferred-out The amount transferred out of the budget into another budget

Transferred-out amount is excluded from the total budget 
amount

Holdback The amount reserved in the budget

Available The amount available to fund trade promotion activities

Available = Total - Holdback

Planned Total amount of all the budget requests that are waiting for 
approval

Recalculated Committed The committed amount based on the actual sales and 
utilization

Committed Total amount of all the approved budget requests

Utilized The amount that is utilized from the budget based on the 
orders that are booked

Earned The amount that is utilized from the budget based on the 
goods that are shipped

When any manual or automatic adjustments are made to the 
earned column, the utilized column gets updated accordingly

Paid The amount that is paid to settle all the claims raised by the 
customers. This amount also includes promotional deductions 
and off-invoice updates.

Balance The balance budget amount

Balance = Available - Committed

Table 9–2 Budget Checkbook Views

View Description
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For example, for a budget that has three hierarchy levels USA, Western Region, and 
California, the roll-up view of USA will be the total of the budgets committed for 
USA, Western Region, and California.

If the committed amount for USA, Western Region, and California are $15,000, 
$10,000, and $5000 respectively, then the roll-up view for each of the levels is as 
follows:

■ USA = $15000 + $10,000 +$5000 (committed funds for USA+Western 
Region+California)

■ Western Region = $10,000 + $5000 (committed funds for Western 
Region+California)

■ California = $5000 (committed funds for California)

The following profile options must be implemented to support multi-currency 
conversion for Roll-up views:

■ AMS: Currency Conversion Type - to set the rate that will be used for automatic 
conversions

■ JTF_Profile_Default_Currency at user level - to support roll-up budget views

■ AMS: Universal Currency at site level - to store all the budget currencies, and 
the transaction and functional currencies for budget roll-up conversions

For example, a company has this budget hierarchy:

Global

North America (N.A.)

EMEA

France

England

Budget owners in each operation want to see roll-up views in their own currency, 
For example, Euro for EMEA, pounds for England, and so on. The Global budget 
owner wants the roll-up view in U.S. dollars. To accomplish this, the JTF_Profile_
Default_Currency profile must be set for England to pounds, to Euro for EMEA, to 
Francs for France, to U.S. dollars for N.A. and Global.

Users in a budget hierarchy can see a real time roll-up view based on their user 
profile currency.
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For example, a Manager in Canada may prefer to see the roll-up view of the budget 
in CAD, whereas a Manager in US who owns the same budget, may prefer to see 
the roll-up view in USD.

By setting the user profile currency, the Managers can see the roll-up view in the 
currency that they prefer. Sets of books are used in Oracle Trade Management for 
setting the functional currency.

Self view only shows the transactions and activities that the budget directly funds.

In the above example, the budget self view for the committed amount of the each of 
the hierarchy levels is same as their committed funds. Thus, the budget self view 
for:

■ USA = $15,000

■ Western Region = $10,000

■ California = $5,000

9.8.3 Budget Transaction and Budget Details Checkbooks
The budget transaction and budget details checkbooks enable you to know the fund 
transactions for a budget such as the budget requests and budget transfers that have 
been created, details of the offers that source funds from the budget, and so on. You 
can also view the transaction amounts in different currencies if the transaction 
currency is different from the budget currency.

For example, if the transaction currency is in pounds and the budget currency is in 
dollars, you can view the appropriate amounts in the appropriate currencies.

■ Budget Transaction Checkbook

Drill down the Total amount in the budget summary page to view the Budget 
Transaction Checkbook. This checkbook gives a comprehensive view of how 
funds have been utilized from the budget. It shows the details of all the budget 
requests and budget transfers that have been created.

■ Budget Planned Checkbook and Budget Committed Checkbook

Drill down the Planned and Committed amounts in the budget summary page 
to view the Budget Planned Checkbook and the Budget Committed checkbook 
respectively. These checkbooks give you a list of all the trade promotion 
activities that source funds from the budget. Click the hyperlink of the offer or 
campaign to view the details of the trade promotion activity.

■ Budget Utilized Checkbook
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Drill down the Utilized amount in the budget summary page to view the 
Budget Utilized Checkbook. Utilized amount is the amount that is utilized from 
the budget based on the orders that are booked. In case of a campaign that 
sources funds from the budget, the Budget Utilized Checkbook enables you to 
view the actual cost that is posted to the budget, or an adjustment that has been 
made. For an offer, the amount utilized may represent an adjustment, an 
accrual, or a utilization line from an off-invoice type discount. You can also 
view the order details from the checkbook.

■ Budget Earned Checkbook and Budget Paid Checkbook

Drill down the Earned and Paid amounts in the budget summary page to view 
the Budget Earned Checkbook, and the Budget Paid Checkbook respectively.

Earned amount is the amount that is utilized from the budget based on the 
goods that are shipped. For an offer, the earned amount may also represent an 
adjustment, an accrual, or a utilization line from an off-invoice type discount. 
The Budget Earned Checkbook enables you to view records of all the offers, 
order details, and GL posting details.

Paid amount is the amount that is paid from the budget for the associated sales 
promotion activities. In addition to the records of all the offers, and order 
details, and GL posting details, the Budget Paid Checkbook enables you to view 
the claim and payment details.

■ To view the order details, click the corresponding number in the Document 
column.

■ To view details of a payment method, click the corresponding hyperlink of 
the payment method.

■ To view the GL posting details, click the corresponding GL Details icon.

9.8.4 Offer Checkbook
An offer checkbook summarizes the funds that the offer has utilized from the 
budget.

Table 9–3 describes the information that an offer checkbook provides.

Table 9–3 Offer Checkbook Views

View Description

Offer name The name of the offer along with the source code, start and 
end dates, currency, and the committed amount
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9.8.5 Customer Budget View
Customer budget view enables you to view the budget usages with respect to either 
one or many customers. To visit a customer checkbook, you can look at the 

Budget name Name of the budget that funds the offer

Clicking on the budget name gives the details of the budget

Budget number The budget number

Every budget has a unique number

Planned amount Total amount that is planned to be spent on the offer

Committed amount The amount that is committed to the offer

Clicking on the committed amount gives a summary of all the 
committed amounts for the budget

Recalculated committed The committed amount based on actual sales and utilization

Clicking on the recalculated committed amount gives a 
summary of all the recalculated committed amounts for the 
offer

Amount utilized The amount that is utilized from the budget based on the 
orders that are booked

For a campaign, this is the actual cost that is posted to the 
budget, or an adjustment made

For an offer, the amount utilized may represent an adjustment, 
an accrual, or a utilization line from an off-invoice type 
discount

Amount earned The amount that is utilized from the budget based on the 
goods that are shipped

Amount paid The amount paid from the budget

Gives a summary of all the amount that is paid from the 
budget for the associated sales promotion activities

For an offer, this can be a utilization line from an off-invoice 
type discount or the information from a claim

Balance The amount remaining in the budget to fund the offer. This is 
based on the funds that are committed to the offer and not the 
total amount in the budget.

Balance = Available - Committed

Table 9–3 Offer Checkbook Views

View Description
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“Customer Budget View.” A profile option determines if you can access the budget 
view with respect to all the customers or only those customers with respect to your 
budget.

Use the following procedure to view the customer checkbook:

Prerequisites
An active budget from which funds have been withdrawn for a trade promotion 
object.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Budget > Budgets.

2. Click Customer Budget View.

3. Optionally select View By. The options are:

– My Customer: This looks at the customers inside only those budgets that 
you have access to. The balances shown are therefore only summed up for 
all the budgets which you have access to.

– All Customers: Based on a profile option, you may be able to see the total 
budget balances for all the customer budgets including those which you 
does not have access to.

4. Optionally search for a particular customer.

The following information is displayed:

Field Description

Customer Customer Name

Currency The budget currency

Total after Holdback Total amount if the budget minus the holdback amount

Planned Total amount of the budget requests that have not yet been 
approved

Committed Total amount of all the approved budget requests

Recalculated Committed The amount of commitment calculated based on actual 
utilization. If recalculated committed is implemented, the 
amount here displays the real committed funds

Utilized Amount that has been utilized or earned



Budget Tracking

9-66 Oracle Trade Management User Guide

9.8.6 Transaction Drill Down
Transaction drill down enables you to drill down from the Budget Summary page to 
view the transaction details of a budget. Transaction details include information 
such as the products purchased, shipment details, the quantity, and amount of each 
line, invoice information, and GL Posting details. If you are the approver of a 
budget, you can review the transaction details, and make adjustments before you 
approve the budget.

Transaction drill down enables you to view the budget information in the following 
order:

1. Budget Earned: to view the budget earned, click the earned number in the 
Budget Summary page.

2. Order Details: to view the order details, click the order number in the Budget 
Earned page.

3. Shipment Details: to view the shipment details, click the details link in the 
Order Details page.

4. Invoice Details: to view the invoice details, click the details link in the Shipment 
Details page.

5. GL Posting Details: GL Posting is an official transaction entry in the General 
Ledger. You can view the GL posting details from the Invoice Details page.

Paid Amount that has been paid

Balance Holdback - Committed

Field Description
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10
Claim and Deduction Management

This chapter gives an overview of Claims and explains how to create and manage 
claims, deductions, and overpayments in Oracle Trade Management.

Sections in this chapter include:

■ Section 10.1, "Overview"

■ Section 10.2, "Process Flow"

■ Section 10.3, "Claim Creation"

■ Section 10.4, "Claim Assignment"

■ Section 10.5, "Claim Approval"

■ Section 10.6, "Claim Research"

■ Section 10.7, "Claim Settlement"

■ Section 10.8, "Reports"
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10.1 Overview
Business-to-Business operations (B2B operations) involve complex business 
activities and relationships between manufacturers and retailers. Claims and 
deductions form an important aspect of B2B operations. Customers raise claims or 
take deductions for many reasons such as to claim compensation for damaged 
goods and to claim promotional accruals that they are eligible to receive. Settling 
claims and deductions involves determining whether a claim is valid or invalid, 
validating proofs, and tracking them. Sometimes, valid claims and deductions may 
not have the requisite proofs. Even in such cases, it is essential to settle these claims. 
These activities require resources, time, and effort. Customers may also submit 
invalid claims and deductions. While the claims remain unresolved, shipping and 
invoicing continue, thus giving interest-free credit to the retailers. Some of the 
challenges that organizations face today are those of settling deductions on time, 
and recognizing and preventing unauthorized claims and deductions.

Claims in Oracle Trade Management enables organizations to shorten the 
claims-processing cycle, and reduce claims and the associated costs. Information 
related to all the claims is stored in a centralized manner. This makes it possible for 
you to access accurate views of promotional spending and other variable costs. You 
can research, validate, and settle deductions, charge backs, and claims. You can also 
identify invalid and duplicate claims and prevent unauthorized claims and 
deductions.

10.2 Process Flow
Figure 10–1 illustrates the process flow for claims, starting from claim creation to 
claim research and settlement.

Figure 10–1 Process Flow for Claims

Create Claim
Customers may submit claims for many reasons such as damaged goods, and to 
claim discounts. To settle these claims, you can create claims and debit claims. You 
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can also handle situations where customers pay less or more than the invoice 
amounts. If customers make any short payments or overpayments, deductions and 
overpayments are automatically created in Oracle Receivables, and you can view 
and settle these deductions and overpayments in Oracle Trade Management.

Assign Claim Owners
After you create a claim, you must assign owners to the claim. Claim owners are 
responsible for claim settlement and resolving related issues. You can assign 
ownership either to individual members or teams.

Approval
A claim must be approved before you settle it. After you submit the claim for 
approval, the approver receives a notification. The approval rules determine the 
approval flow. The approver may approve or reject the claim.You can research and 
settle a claim after it is approved.

Research
Before settling a claim, you can:

■ Determine whether a claim or deduction is valid or invalid.

■ Determine the various reasons for which a claim is submitted, split the claim 
accordingly, and specify different settlement methods for each portion of the 
claim.

■ Find duplicate claims and remove such claims from the system.

Claim history enables you to record various changes made to a claim during the 
course of investigation. You can also use Oracle Discoverer to extract customer 
information, and use it for research purposes.

Settlement
The claim settlements methods that are available in Oracle Trade Management are 
check, on-account credit memo, previous on-account credit memo, debit memo, 
Return Materials Authorization (RMA), automatic write-off, invoice credit memo, 
and contra charge. The settlement method that you can use depends upon the claim 
type. You can settle claims for individual customers and buying groups.

Reports
The following reports enable you to view the claim details during and after 
settlement:
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■ Claim Report: summary of essential claim details such as customer details, 
claim lines, payment details, and settlement methods.

■ Claim Aging View: summary of claims and deductions by customer and by 
days due. Claim Aging View enables you to determine which customer has had 
outstanding claims for the longest period time and work on those claims.

■ Claim Settlement History: summary of all information that is related to the 
settlement of a claim.

■ Customer 360 Degree View: summary of all transactions of the selected 
customer including all the orders, invoices, debit memos and charge backs.

10.3 Claim Creation
Customers may submit claims to claim overpayments, compensation for damaged 
goods, or promotional accruals. Other situations involve customers taking illegal 
deductions, or paying more than what they owe your organization. You can create 
different types of claims based on the nature of claims that must be settled.

When a claim is created, all the information necessary to process the claim is 
recorded. This information includes the claim type, reason for the claim, customer 
information, contact information, broker and sales representative details, the 
amount, and currency type. The Mass Create functionality enables you to create 
multiple claims and debit claims on one screen. You can import claims based on 
data from legacy or third party systems by using Import Interface. You can also 
create claims and debit claims from any system by using a Public API. Claims can 
be imported from a legacy system either through claims import or through the 
claims API. For information on how to create claims and debit claims by using a 
Public API, see the Oracle Marketing API User Guide.

To create claims, you must understand the different claim types, classes, reasons, 
claim lines, and customer-reason code mapping.

Topics included are:

■ Section 10.3.1, "Claim Classes"

■ Section 10.3.2, "Claim Types and Reasons"

■ Section 10.3.3, "Customer Reason"

■ Section 10.3.4, "Buying Groups and Related Customer Accounts"

■ Section 10.3.5, "Claim Lines and Associated Earnings"

■ Section 10.3.7, "About Actions"
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■ Section 10.3.8, "Third Party Accruals and Pricing Simulations"

■ Section 10.3.9, "About Lockbox Integration"

■ Section 10.3.10, "Creating a Claim or a Debit Claim"

■ Section 10.3.11, "Mass Creating Claims and Debit Claims"

■ Section 10.3.12, "Creating a Transaction Related Deduction"

■ Section 10.3.13, "Creating a Non-transaction Related Deduction"

■ Section 10.3.14, "Creating an Overpayment"

■ Section 10.3.15, "Viewing Source"

■ Section 10.3.16, "Creating Claim Lines"

■ Section 10.3.17, "Entering Detail Information for Claim Lines"

■ Section 10.3.18, "Associating Earnings With Claim Lines"

10.3.1 Claim Classes
Claim, Debit claim, Deduction, and Overpayment are the four different claim 
classes that are available in Oracle Trade Management. The settlement methods and 
processing is different for each claim class.

■ Claim

Customers may submit reimbursement requests for a number of reasons such 
as to claim compensation for damaged goods, payment for services, and so on. 
Claims are created in Oracle Trade Management to handle these reimbursement 
requests. Claims may or may not be promotion-related. Promotion-related 
claims have promotional earnings (accruals) associated with them. You can 
view this in the Associate Earnings page. The settlement methods for claims 
include check, credit memo, or Return Materials Authorization (RMA).

■ Debit Claim

Debit claims are created in Oracle Trade Management to charge back customers 
who have been overpaid. Debit claims are settled through debit memos.

For example, a customer earns $10,000; you issue a check for that amount. Later 
on, the same customer returns $1,000 worth of merchandise from a previous 
order, thus decreasing the true accrual to $9,000. To handle this situation, you 
can create a debit claim for $1,000, and settle the claim by generating a debit 
memo.
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■ Deduction

Deductions are created in Oracle Receivables and you can view and settle these 
deductions in Oracle Trade Management. Deductions are used to handle 
situations where customers short pay invoices for various reasons such as to 
claim compensation for shipping errors, pricing errors, and to claim 
promotional earnings. When a deduction is created, all the pertinent 
information such as receipt numbers, dates and amounts, customer and 
transaction information, customer debit memo numbers and claim reasons, 
which is entered in Oracle Receivables, is available in Oracle Trade 
Management.

For example, you send an invoice for $10,000 to a customer. But the customer 
remits only $8,000 for this invoice, citing a deduction of $2,000 for promotional 
earnings that the customer has not received. A deduction for $2,000 is 
automatically created in Oracle Receivables. You can view and settle this 
deduction in Oracle Trade Management.

Deductions can be of one of the following types:

■ Transaction-related: deductions can be traced back to a specific transaction 
such as an invoice, a debit memo or a charge back. Transaction-related 
deductions have associated proofs.

■ Non transaction-related: deductions cannot be traced back to a specific 
transaction and do not have any associated proofs.

■ Promotion-related: deductions have associated promotional earnings. 
Customers make these deductions to claim discounts that are accrued when 
they place orders against offers.

Settlement methods for deductions include invoice credit memo, on-account 
credit memo, previous on-account credit memo, write-off, charge back, RMA, 
and contra charge.

For more information on transaction types and adjustments for deductions, see 
the Oracle Receivables User Guide and the Oracle Order Management User Guide.

■ Overpayment

Overpayments are created in Oracle Receivables when customers overpay what 
they owe your organization. Settlement methods for overpayments include 
debit memo, write-off, and on-account credit.

Claims and Debit Claims are created in Oracle Trade Management. Deductions 
and Overpayments are created from Oracle Receivables. Oracle Receivables 
users can create deductions or overpayments when they find mismatches 
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between the applied transaction amount and the receipt amount from the 
Receipt Application window. If the payment is directly applied to a transaction 
and a short pay is recognized, then a deduction can be created based on the 
transaction, or a claim investigation can be created for the customer. If Oracle 
Receivables users identify that a customer has overpaid, then a claim 
investigation can be created for the customer on receipt and is distinguished as 
an overpayment claim class in Oracle Trade Management. All the transaction 
and receipt information from Oracle Receivables is carried over to Oracle Trade 
Management as source information for claim research.

See Section 10.7.17, "Settling Claims, Debit Claims, Deductions, and Overpayments" 
for procedures related to settling claims, debit claims, deductions, and 
overpayments.

Apart from regular claims, deductions, and overpayments, claims are also created 
automatically in Oracle Trade Management as a result of the integration between 
Oracle Trade Management and Oracle Partner Management. Whenever any 
requests related to Special Pricing, Soft Funds, and Referrals are created and 
approved in Oracle Partner Management, offers and claims are automatically 
created in Oracle Trade Management. These claims are settled by the claim users. 
For information on settling claims related to Special Pricing, Soft Funds, and 
Referrals, see Chapter 11, "Indirect Sales Management". See the Oracle Partner 
Management User Guide for more information on Special Pricing, Soft Funds, and 
Referrals.

10.3.2 Claim Types and Reasons
Customers submit claims for various reasons such as to claim compensation from 
your organization for losses caused due to shipping problems, invoice errors, or 
quality issues. Sometimes, the reasons may be unknown. You can have internal 
claim types and reasons to identify the reason for which the claims have been raised 
and classify these claims. Claim types and reasons also enable you to integrate the 
claims processing and settlement, and to analyze claim problems. Depending on the 
claim type or reason, the process of claim research and resolution may be 
different.You can have any number of internal claim types and reasons. The 
Administrator sets up claim types and reasons based on your business needs.

Note: Throughout this document, the term "Claim" is used 
generically to encompass claims, debit claims, deductions, and 
overpayments.
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Claim types and reasons together enable you to classify claims, and identify 
problem areas that need improvement. For example, you may have a large number 
of claims with the type--shipping and the reason--damaged goods. With this 
knowledge, you can improve your shipping methods and reduce the number of 
shipping claims arising due to damaged goods.

Claim Types
Claim types serve the following specific purposes:

■ Setups for integration purpose

Organizations can store setups required for creating transactions or adjustments 
in Oracle Receivables as well as in Order Management. The Oracle Receivables 
setups mainly drive the accounting, while the Order Management setups drive 
the workflow of a Return Material Authorization (RMA). These setups are as 
follows:

Transaction Type Description

Credit Memo Used when a claim or a deduction must be settled with a 
new credit memo.

Must be set up in Oracle Receivables.

Debit Memo Used when a debit claim or an overpayment must be 
settled with new debit memo.

Must be set up in Oracle Receivables.

Chargeback Used when a deduction must be settled with a 
chargeback.

Must be set up in Oracle Receivables.

RMA Used when a claim or deduction must be settled with an 
RMA (return order).

Must be set up in Order Management with a workflow 
tied to it. The workflow must have Invoicing Activity to 
generate a credit memo to close out the claim or 
deduction.

Write-off Adjustment Receivable 
Activity

Used when a deduction must be settled with a write-off.

Must be set up in Oracle Receivables as an adjustment 
type receivable activity.
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■ Default Receivable Clearing Accounts

When accruals are created either from a Lump sum, Accrual, Net Accrual, Scan 
data or Volume offer, such accruals may be treated as liabilities by some 
companies. These liabilities must be tracked in the General Ledger. Oracle Trade 
Management enables GL integration by creating Debit Sales or Expense, and 
Credit Liabilities accounting entries.

If a claim or deduction is associated to such accruals and the settlement method 
is a credit memo, then Oracle Trade Management creates entries for Debit 
Liabilities and Credit Receivables.

The debit entry for the liabilities account reverses the liabilities created when 
the accruals were created. Because the claim is being settled for such accruals, 
and the customer will be paid by a credit memo, these liabilities must be 
reduced. The credit entry for Oracle Receivables clearing account offsets the 
debit entry that the credit memo creates to reduce revenue of the customer 
account.

■ Default Vendor Clearing Accounts

If a promotional claim must be settled by a check instead of a credit memo, then 
accounting entries for Debit Liabilities and Credit Vendor Clearing will be 
created. The liabilities account used will be the same as the account used when 
accruals were created. The Oracle Receivables or Oracle Payables Clearing 
accounts that will be used during claim settlement will be taken from the 
following setups:

■ As defined in the Claim Type, and the Account Generator workflow 
updates if any.

■ As defined in System Parameters, and Account Generator workflow 
updates if any.

Claim Reasons
Claim Reasons serve the following specific purposes:

Receipt Write-off Receivable 
Activity

Used when an overpayment must be settled with a 
receipt write-off.

Must be set up in Oracle Receivables as a receipt 
write-off type receivable activity.

Transaction Type Description



Claim Creation

10-10 Oracle Trade Management User Guide

■ Action Default

Action is a template of tasks. Based on the claim reason, certain repetitive tasks 
may need to be performed every time. Such tasks are defaulted automatically 
based on the claim reason. Therefore, you need not enter the tasks manually 
every time.

■ Setups for Integration Points

When a chargeback is created to settle a deduction, the chargeback reason must 
be passed from Oracle Trade Management to Oracle Receivables for integration 
purposes. Optionally, credit memo reasons can also be passed from claims in 
Oracle Trade Management to credit memos in Oracle Receivables.

For information on creating claim types and reasons, and application integration, 
see the Oracle Trade Management Implementation Guide.

10.3.3 Customer Reason
Customer reasons are the codes by which customers identify the claims that they 
submit. These customer reason codes may be different from the internal reason 
codes that your organization uses. The Administrator in your organization can 
create mappings for customer reason codes and the internal reason codes that are 
used by your organization. If these codes are mapped, then whenever a customer 
submits a claim, the customer's original reason is captured and automatically 
converted to the internal reason code. This simplifies the claim research process.

Figure 10–2 Customer Reason Code Mapping

For example, a retailer--Bigmart maintains more than 3,500 reason codes for 
deduction against its manufacturers. One of the manufacturers--Toy House 
maintains only 30 internal reason codes to analyze deduction patterns and route 
them to different departments for investigation. Bigmart remits payments to Toy 
House. On those remittances Bigmart indicates on multiple lines their deductions 
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and their reasons for deducting. The reason codes used by Bigmart are converted to 
internal reason codes. The amount that is deducted is adjusted and converted into 
deductions in Oracle Trade Management.

The processing of claims depends upon the manner in which the customers remit 
payments. Customers can make payments either through:

■ Electronic remittance (through bank or EDI file)

If it is an electronic remittance, then the information goes through the Quick 
Cash User Interface of Oracle Receivables. A Post Batch process then updates 
the customer balances and turns such information into receipts. During the Post 
Batch process, any amounts deducted or claimed will be adjusted in Oracle 
Trade Management and claims will be created. Customer reason codes are 
converted to internal reason codes during this process.

■ Manual remittance

If it is a manual remittance, then the Oracle Receivables user enters the relevant 
information. Customer reason codes are converted to internal reason codes 
during this process. Claims are created in Oracle Trade Management and 
receipts are issued.

During claim creation, you can enter one of the following:

■ Enter only the customer reason code

If you enter only the customer reason without entering the internal reason code, 
then based on the customer reason code, the system searches and changes the 
code to the corresponding internal claim reason. If customer reason codes have 
not been mapped, then the system takes the internal reason from System 
Parameters.

■ Enter customer reason code and internal reason code

If you enter the customer reason code and the internal claim reason code, then 
the customer reason code takes precedence and it is converted to the right 
internal claim reason.

■ Enter only the internal claim reason code

If you enter only the internal claim reason, then the customer reason field will 
be empty by default.

After a customer reason code is converted to the internal reason code, you may still 
make use of the customer reason code to refer to the claim.
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10.3.4 Buying Groups and Related Customer Accounts
Buying groups are formed when organizations group themselves to leverage their 
buying power.

For example, you create a promotion for a buying group. When buying group 
members place orders, accruals for each member are tracked individually, even 
though the buying group entity may be handling all the invoices and claims for the 
group. During claim settlement, you can view the buying group member accruals 
and decide whether to issue payment to the buying group, or directly to one of its 
members.

Related Customer accounts are set up with relationships. Common relationships 
include bill-to and ship-to.

For example, the headquarters of an organization may be set up as the bill-to 
account and location for multiple retail stores. Each retail store can be set up as a 
ship-to account and location. In addition, the headquarters office may be handling 
all the claims for retail stores, but these retail stores may ultimately receive their 
payment directly.

10.3.5 Claim Lines and Associated Earnings
Claim lines serve the purposes of recording the details of a claim. Claim lines 
contain transaction details such as the product details, price, unit of measurement, 
and so on. Claim lines are used for associating offers or campaigns with a specific 
claim. For example, if a claim or deduction is promotion-related, it may be tied to 
multiple offers and hence will have multiple Claim lines.

When you associate one or more offers to a claim, it means that you are settling the 
claim to pay the accruals that are created from these offers. From the claim lines 
page, you can access the Associate Earnings Summary page. Here you can see all 
the offers that are applicable to the customer or buying group on the claim and its 
related accounts, including any outstanding (unpaid) promotional accruals. You can 
perform a search on accruals by offer, customer, order, invoice and products, and so 
on.
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Figure 10–3 Earnings Association

The Associate Earnings page includes all outstanding (unpaid) promotional offer 
accruals that are related to a specific customer and claim. By using the search 
function, you can view all offers that are applicable to each claim for customers and 
related accounts, and buying groups and buying group members. You can use 
associated earnings for claim research and settlement.

Some examples of how you can use associated earnings for claim research and 
settlement are given below. For each example, you can assume that the following 
has already occurred:

■ A claim has been created.

■ At least one claim line was created, and earnings were associated with it.

Example 1: Accruals
A customer submits a deduction for $20,000. You first look at the customer 
checkbook and see the following:

Next, you look at the customer’s associated earnings information for this claim and 
see the following.

Offer Utilized Paid

Offer 1 $100K $40K

Offer 2 $15K $9K

Offer 3 $8K $5K

Offer Amount Available

Offer 1 $100K $60K

Offer 2 $15K $9K
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Let us assume that you have determined that the deduction is related to all three 
offers, and you have selected credit memo as the settlement method. In the Line 
Amount field in the Associate Earnings page, you enter the values in the Line 
Amount column as shown below:

When the credit memo is issued, $9K is withdrawn from the accruals for Offer 1, 
$6K from Offer 2, and $5K from Offer 3. The following GL accounting entries are 
created:

The customer’s budget checkbook is updated automatically to:

When the next claim for this customer is created, the associated earnings page will 
show the following details:

Offer 3 $8K $5K

Offer Amount Amount Available Line Amount

Offer 1 $100K $40K $9K

Offer 2 $15K $9K $6K

Offer 3 $8K $3K $5K

GL Entry Offer 1 Offer 2 Offer 3

Debit Liabilities $9K $6K $5K

Credit Receivables Clearing $9K $6K $5K

Offer Utilized Paid

Offer 1 $100K $49K

Offer 2 $15K $15K

Offer 3 $8K $8

Offer Amount Amount available

Offer 1 $100K $51

Offer Amount Available
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Example 2: Buying Group
A Buying Group offers its members a deal whereby each unit of product that they 
purchase is eligible for a 10% accrual. Member A places an order and accrues $10K. 
The $10K is tracked in the utilized column of the budget for Member A.

The Buying Group handles the invoicing and claim processing for all its members. 
It submits a claim on behalf of Member A for $10K. Being the claim owner, you 
create a claim with at least one claim line, and associate earnings with that claim 
line.

When you view the Associate Earnings page, you do not at first see the $10K in 
accruals because the Buying Group did not place the order directly. To research this 
claim further, you use the search function to view all of the accruals for all the 
buying group members. You can then associate the $10K in accruals to the claim 
and either pay Member A directly or pay the Buying Group, who will disburse the 
payment to Member A.

10.3.6 About Proportionately Associating Earnings by Products
In general, when you associate earnings to an offer on the claim line, the claim 
amount gets associated to the entire offer on a first-in-first-out basis irrespective of 
the item or product categorization on the offer. This means that the earliest order 
line with accrual is cleared first. However, some organizations may have a policy of 
clearing their claims periodically, say on a monthly basis, and they may not 
necessarily clear the oldest liability first. Alternately, because of the many product 
lines involved in one single offer, when a claim comes in that partially relieves the 
offer's accruals, they may prefer to proportionately pay the accruals for the offer 
lines.

For example, the total accrual for an offer is $1000, out of which $200 has been paid 
out for previous claims. The Outstanding accrual balance of $800 is broken up by 
products, and when a claim is created for $500, and the user associates the whole 
$500 to this offer, the system automatically splits the associated earnings by product 
as follows:

Product A for $500 * (500 / 800) = $312.5

Product B for $500 * (200 / 800) = $125

Product C for $500 * (100 / 800) = $62.5

If the offer sources funds from multiple budgets, the accruals are proportionately 
relieved from the budgets. For example, in the above scenario, if the offer sources 
funds from two different budgets--Budget A and Budget B, then due to product 
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eligibility validation, each budget may track the accruals for some of the products 
or all. Assume that the accruals for Product A, Product B, and Product C are tracked 
as shown in the following table.

When the claim is created for $500, and the associated earnings are split 
proportionately by product. The funding budgets are also split proportionately and 
the associated earnings for the products will be sourced as below:

■ The associated earnings for Product A ($312.5) is split between Budget A and B 
as shown below:

■ Budget A: $312.5 x (300 / 500) = $187.5

■ Budget B: $312.5 x (200 / 500) = $125

■ The associated earnings for Product B ($125) is sourced entirely from Budget A.

■ The associated earnings for Product C ($62.5) is sourced entirely from Budget B.

An option in the System Parameters determines whether the system will prorate the 
earnings based on product or not. If the option is checked, then by default, all the 
earnings of the offer will be broken up proportionately based on the products. See 
the Oracle Trade Management Implementation Guide for more information on setting 
up this option.

10.3.7 About Actions
As an option, you can select an action when creating a claim. Each action typically 
has a series of associated tasks. These tasks enable you to research and settle claims. 
For more information on tasks, see Chapter 12, "Common Components".

For example, a shipping claim may have an action called Shipping Claim Tasks. The 
series of tasks might include:

1. Review invoices for shipped products and amounts.

2. Contact shipping department for verification.

3. Obtain proof of delivery.

Product Budget A Budget B Total

Product A $300 $200 $500

Product B $200 -NA- $200

Product C -NA- $100 $100
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The Administrator sets up actions based on the business needs of your 
organization. For more information on actions, see the Oracle Trade Management 
Implementation Guide.

10.3.8 Third Party Accruals and Pricing Simulations
Manufacturers often deal with their customers directly or indirectly or both through 
distributors. If this is the case with your organization, you may want to offer 
promotions to customers both directly and through distributors who also sell to the 
same customers. Oracle Trade Management can take indirect purchase data for 
direct customers, run a pricing simulation, and determine what promotions the 
customer is entitled to.

For example, an organization sells directly to Customer X. The organization also 
sells its products to a distributor who resells to Customer X as well as to other 
customers that you do not deal with directly. The distributor periodically sends in 
sales data to help you calculate accruals for all of the customers.

For this example, assume that the data consists of the following:

Based on the information provided from the distributor including the data, 
customer and product information, order number and date, quantity, price, 
shipment date, invoice number and date, and so on, Oracle Trade Management 
simulates the price and promotion that Customer X would have received had they 
dealt directly with you for a particular order.

If the pricing simulation indicates the customer would have received a better price 
or promotion dealing directly with you (say a $10K difference for this example), 
Oracle Trade Management automatically creates an accrual for this customer. The 
$10K is tracked in the customer budget, and can be paid later to the customer by a 
claim or deduction.

The data for Customers Y and Z will be saved and stored separately, so that you can 
offer promotions to these indirect customers in the future.

Customer Relationship Sales Amount

X Direct and Indirect $100K

Y Indirect $80K

Z Indirect $70K
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10.3.9 About Lockbox Integration
AutoLockbox (or Lockbox) is a service that commercial banks offer corporate 
customers to enable them to outsource their accounts receivable payment 
processing. An AutoLockbox operation can process millions of transactions a 
month. AutoLockbox eliminates manual data entry by automatically processing 
receipts that are sent directly to your bank. The Oracle Receivables user can specify 
how this information must be transmitted and Oracle Receivables ensures that the 
data is valid before creating QuickCash receipt batches. The customer who has 
remitted the receipt can be automatically identified, and the AutoCash rules may be 
optionally used to determine how to apply the receipts to your customer’s 
outstanding debit items. See the Oracle Receivables User Guide for more information 
on AutoLockbox.

During AutoLockbox and Post QuickCash processing, Oracle Receivables can 
automatically prepare eligible remittance lines for claim creation in Oracle Trade 
Management. AutoLockbox can initiate claim creation for eligible remittances. 
Deductions and overpayments can be created from the PostBatch process when 
customers' remittances come from the Oracle Receivables Lockbox. All the relevant 
customer information including customer reason and reference number is passed to 
Oracle Trade Management. These claims can be settled through Oracle Trade 
Management. See Section 10.7.17, "Settling Claims, Debit Claims, Deductions, and 
Overpayments" for information on how to settle claims.

10.3.10 Creating a Claim or a Debit Claim
Customers may submit reimbursement requests for a number of reasons such as to 
claim compensation for damaged goods, payment for services, and so on. Debit 
claims can be used to charge back customers who have been overpaid. Use the 
following procedure to create a claim or a debit claim.

Prerequisites
None.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click Create.

3. Enter a unique value in the Claim Number field.
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If you leave this field blank, then a unique claim number will be generated 
automatically when the claim is created.

4. Select a Claim Type and Claim Reason.

5. Select a customer name in the Customer Name field, and optionally select a 
location in the Bill-To field.

The Customer Name determines the claiming customer. The available customer 
names and bill-to locations are customer accounts set up in the TCA.

6. Optionally change the currency by selecting a new value from the Currency 
Code drop-down list.

7. In the Amount field, enter a positive value if it is a claim, or enter a negative 
value if it is a debit claim.

8. Optionally select a value from the Exchange Type drop-down list.

If a claim comes in with a currency that is different from the functional 
currency, then currency conversion must take place. Exchange Type defines the 
type of exchange rate. For example, a Corporate exchange type may have a set 
of rates determined after every month-end market close.

9. Optionally select an Exchange Date, and enter an Exchange Rate.

Rates may differ based on the exchange date that you enter. Based on the 
Exchange Type and Exchange Date entered, an exchange rate may populate this 
field. If it is a user-defined exchange type, you can enter a different rate. For 
example, if Sterling Pound is the currency type and 2 is the exchange rate, then 
the value for Amount is converted at a rate of 2 Sterling Pounds:1 US dollar.

10. Click Create.

10.3.11 Mass Creating Claims and Debit Claims
The Mass Create function enables you to create multiple claims and debit claims on 
one screen. All the basic information for claims can be captured quickly so that they 
can be routed to the proper owners in a timely fashion. This functionality enables 

Note: The Exchange Type, Rate, Currency and Amount fields are 
used only when the transaction and accounted currencies are 
different. The value for this field must be used to perform an 
exchange rate conversion.
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you to handle the massive volume of claims data that your company has to deal 
with, and enables you to expedite the claims process.

Prerequisites
None.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click Mass Create.

3. Enter the following information for each row:

– Optionally, in the Claim Number field, enter a unique claim number or 
leave the field blank. If the field is left blank, then a unique claim number is 
automatically generated.

– Select a Claim Type and Claim Reason.

– Select a Customer, and select a Bill-to location.

– Select a currency from the Currency Code drop-down list.

– Enter the claim amount. If the amount is greater than zero, then a claim is 
created; otherwise, a debit claim is created.

– If the currency for the claim is different than the functional currency, select 
an Exchange Type, Exchange Date, and Exchange Rate.

4. Click Create.

If an error occurs, then the row with the problem is highlighted. All the claims that 
you entered in the table are created.

10.3.12 Creating a Transaction Related Deduction
Transaction related deductions are those which can be traced back to a transaction 
(invoice, chargeback, or debit memo). In case of a transaction related deduction, all 
the information such as the receipt number, receipt date, receipt amount, customer 
information and transaction information is captured from Oracle Receivables and 
passed to Oracle Trade Management. Customer debit memo numbers and claim 
reasons may also be passed to Oracle Trade Management. Deductions support 
related customer accounts and buying group promotions. Transaction related 
deductions are created in Oracle Receivables.
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Prerequisites
A deduction that can be traced back to a specific transaction.

Steps

1. Log in to Oracle Receivables as Oracle Receivables User, and navigate to 
Receipts > Receipts.

2. Enter a receipt number in the Receipt Number field. If required, change the 
Receipt Type to Cash, and change the Currency Code.

The receipt number can be the customer check number or any other reference 
number.

3. Enter a Receipt Amount. If required, change the Receipt Date, and the GL date.

The receipt amount is the amount the customer has paid.

4. Select a Payment Method.

5. Enter the Customer Name, and optionally enter a Reference and enter 
Comments.

This information is passed to Oracle Trade Management when the deduction is 
created.

6. Click Applications.

7. Select a value for Apply To.

This field determines what the customer is paying for.

8. Enter the Amount Applied, and view the Balance Due.

Balance Due is the balance of the transaction after the customer’s payment. The 
balance due will be positive for deductions.

9. Select Oracle Trade Management Claim in the Reference Type field, and select a 
reason in the Reference Reason field.

The values that are available here are the same as in Oracle Trade Management. 
If a customer indicates the reason for which they have made the deduction, then 

Note: The Oracle Receivables user may need to perform 
additional data entry tasks.
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this information can be captured when the cash application is created in Oracle 
Receivables; this information can be passed to Oracle Trade Management.

10. Enter a Customer Reference.

If the customer indicates an internal debit memo number, it can be captured 
here and passed to Oracle Trade Management.

11. Click Save.

Notice that a deduction number appears in the Reference Number field. At this 
point, a transaction-related deduction is created. The transaction will also have 
a dispute on it. To verify the dispute, navigate to Transactions > Transactions > 
[transaction name] > More > Disputed Amount.

10.3.13 Creating a Non-transaction Related Deduction
Non-transaction related deductions are those which cannot be traced back to a 
transaction. Non-transaction related deductions occur when instead of submitting 
claims, customers deduct money from their payments to manufacturers. In case of a 
non-transaction related deduction, all the information such as the receipt number, 
receipt date, receipt amount, customer information and transaction information is 
captured from Oracle Receivables and passed to Oracle Trade Management. 
Customer debit memo numbers and claim reasons may also be passed to Oracle 
Trade Management. Deductions support related customer accounts and buying 
group promotions. Non-transaction related deductions are created in Oracle 
Receivables.

Prerequisites
A deduction that can be traced back to a specific transaction.

Steps

1. Log in to Oracle Receivables as Oracle Receivables user and navigate to 
Receipts > Receipts.

Note: As part of the cash application process, the Oracle 
Receivables user may need to perform additional data entry tasks. 
These steps present only one way to enter a non-transaction related 
deduction. See the Oracle Receivables User Guide for information on 
the different ways of entering non-transaction deductions.
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2. Enter a Receipt Number. If necessary, change the Receipt Type to Cash, and 
change the Currency Code.

The receipt number can be the customer check number or other reference 
number.

3. Enter a Receipt Amount. If necessary, change the Receipt Date and the GL date.

Receipt amount is the amount the customer has paid.

4. Select a Payment Method.

5. Enter the Customer Name, and optionally enter a Reference and enter 
Comments.

This information is passed to Oracle Trade Management when the deduction is 
created.

6. Click Applications.

7. Select Claim Investigation in the Apply To field.

The available values are open transactions and some seeded Oracle Receivables 
activities. Claim Investigation is seeded specifically to create non-transaction 
related deductions (or overpayments) in Oracle Trade Management. If the 
customer has referenced an internal debit memo number, you can record this as 
a Claim Investigation line and enter the debit memo number in the customer 
reference field.

8. Enter the deduction amount as a negative number in the Amount Applied field.

9. If necessary, select Oracle Trade Management Claim in the Reference Type field.

10. Select a reason in the Reference Reason field.

The values available here are the same values that are available in Oracle Trade 
Management. If a customer indicates the reason for which they have made the 
deduction, this information can be captured when the cash application is 
created in Oracle Receivables, and be passed to Oracle Trade Management.

11. Enter a Customer Reference.

If the customer indicates an internal debit memo number, it can be captured 
here and passed to Oracle Trade Management.

12. Select an Activity.

The activity selected here drives the GL entries to account for the discrepancy 
between the cash received and the receivables amount. For example, Receipt = 
$10K; Total balance of multiple invoices that the customer is paying for is $15K. 
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A non-transaction related deduction is created for $5K. The following 
accounting entries are created:

Debit Cash $10K
Debit Claim Investigation Activity $5K
Credit Receivables $15K

13. Click Save.

Notice that a deduction number appears in the Reference Number field.

10.3.14 Creating an Overpayment
Due to the high volume of transactions going on between manufacturers and their 
customers, customers may make overpayments for various reasons. In such cases, 
Oracle Receivables can create overpayment claims in Oracle Trade Management.

Prerequisites
An overpayment.

Steps

1. Log in to Oracle Receivables as Oracle Receivables User and navigate to 
Receipts > Receipts.

2. Enter a receipt number in the Receipt Number field.

This number can be the customer check number or any other reference number.

3. If necessary, change the Receipt Type to Cash, and change the Currency Code.

4. Enter a Receipt Amount. If necessary, change the Receipt Date, and the GL date.

Receipt amount is the amount that the customer has paid.

5. Select a Payment Method.

Note: As part of the cash application process, the Oracle 
Receivables user may need to perform additional data entry tasks. 
These steps present only one way to enter an overpayment. See the 
Oracle Receivables User Guide for information on the different ways 
of entering overpayments.
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6. Enter the Customer Name, and optionally enter a Reference, and enter 
Comments.

This information is passed to Oracle Trade Management when the deduction is 
created.

7. Click Applications.

8. Select Claim Investigation in the Apply To field.

The available values are open transactions and some seeded receivables 
activities. Claim Investigation is seeded specifically to create non-transaction 
related overpayments (or deductions) in Oracle Trade Management.

9. Enter the overpayment amount as a positive number in the Amount Applied 
field.

10. If necessary, select Oracle Trade Management Claim in the Reference Type field, 
and select a reason in the Reference Reason field.

The values that are available here are the same as in Oracle Trade Management.

11. Enter a Customer Reference.

12. Select an Activity.

The activity selected here drives the GL entries to account for the overpayment.

13. Click Save.

Notice that an overpayment number appears in the Reference Number field.

10.3.15 Viewing Source
Source displays the Oracle Receivables receipt and transaction information that 
originally created a deduction or overpayment. Source enables you to refer back to 
the documents in Oracle Receivables.

Prerequisites
A deduction or overpayment has been created.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click the hyperlink of the claim.
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3. Click the Source side navigation link.

The following data are displayed:

– Receipt: the record created in Oracle Receivables when a company receives 
a customer payment.

– Receipt Date: the date the payment is received.

– Receipt Amount: the amount the customer is paying.

– Currency Code: the currency in which the customer is paying.

– Receipt Reference: this may be any reference information.

– Receipt Comments: this may be any of the comments entered by the Oracle 
Receivables clerk.

– Source Type: this appears only for a transaction related deduction. Values 
are invoice, debit memo and chargeback.

– Source Number: this only displays for a transaction related deduction. This 
is the number of the transaction – invoice, debit memo or chargeback.

– Source Date: this only displays for a transaction related deduction. This is 
the date of the transaction. 

– Source Amount: this only displays for a transaction related deduction. This 
is the amount of the transaction.

4. In the Receipt Application region, click the hyperlink of the event to view more 
details about the subsequent receipt application.

10.3.16 Creating Claim Lines
Claim Lines enable you to tie the claim amount to chargeback, debit memo, credit 
memo, offer, order, invoice, or third party accruals. For example, if you select the 
type as order, it means that the claim is being created to settle an amount that is 
associated with that order. A claim can have multiple claim lines. Use the following 
procedure to create claim lines.

Prerequisites
An existing claim.
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Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Click the Lines side navigation link in the Claim Details page.

4. In the Claim Lines page, if the settlement method is known, then optionally 
select a Settlement Method, an RMA Transaction Type, and a Tax Code.

The settlement method that you select will determine the tax codes that are 
displayed. If you selected Check or Contra Charge, you will see Oracle Payables 
Tax Codes. For all the other methods, you will see Oracle Receivables Tax 
Codes. The Tax Code selected here is the default for all claim line items, unless 
it is overridden for an individual line.

5. Scroll down the page and select a Line Type.

Line Type is used to associate a claim to a chargeback, debit memo, credit 
memo, offer, order, invoice, or third party accrual data. The Line Type 
determines the transaction that the claim amount is related to.

6. Select the Name from the Transaction LOV.

The values that are displayed in the list depend upon the Line Type that you 
selected. For example, if you select the Line Type as Order, then all the order 
numbers are listed here.

7. Select the Item Type, and select a product in the Line/ Product field.

Notice that the Price field now shows the unit price for the product.

8. In the Quantity field, enter the number of items purchased, and select the Unit 
of Measurement (UOM) if one is not already displayed.

If a product is chosen in the Line/Product field, then the Unit of Measurement 
field defaults to the proper UOM for that product.

9. Enter the Price; the Amount defaults in.

10. Optionally select the tax code.

To change the Tax Code for a particular line, first delete the current tax code, 
and then select a new tax code.

11. Click Update.
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After clicking update, notice that a value is entered in the Amount field for each 
line you created.

10.3.17 Entering Detail Information for Claim Lines
The claim line detail is used to associate promotional activities and documentation 
to the specified claim.

Prerequisites
An existing claim with completed claim lines.

Steps
1. Navigate to Claim and select a claim number.

2. Navigate to Lines.

3. Locate the line you want to add details for, and click the icon in the Detail 
column.

4. To indicate the claim is valid, select the Valid check box. 

This check box has no functional impact. 

5. To indicate that performance on the part of the customer has been verified, 
select the Performance Verified check box. 

This check box is added as a note to the claim and has no functional impact.

6. To indicate that proof of performance has been attached to the Claim, select the 
Performance Attached check box. 

This check box is added as a note to the claim and has no functional impact.

7. Select the promotional activity as follows:

a. Select an Activity Type from the drop-down list.

b. Select an Activity, and an activity name.

c. Select a schedule, and a schedule name.

8. Enter the appropriate documentation information as follows:

a. Select a Class from the drop-down list.

b. Select a Number. 

This number is the reference number of the document.
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c. Select a Product Name.

Notice that the Part Number field is populated automatically if a Product 
Name is selected.

d. Select a Line.

e. Optionally, enter a Quantity.

If a quantity was entered on the Lines page, this field is automatically 
populated.

f. Optionally, select a UOM. 

UOM is populated automatically if a UOM was selected on the Lines page.

g. Enter a Price if necessary.

Price is populated automatically if a price was entered on the Lines page.

9. Verify the information in the Amount section.

Claim Currency Amount is the amount shown in the Claim currency regardless 
of the promotional activity currency.

10. Optionally, select a Tax Code.

Tax Code is populated automatically if a Tax Code was selected on the Lines 
page.

11. In the Comments box, type any additional comments you have regarding the 
claim line details.

12. Click Update.

10.3.18 Associating Earnings With Claim Lines
Use Associate Earnings to associate a claim line with earnings accrued in the 
checkbook. Associating earnings is mandatory for promotional claim types. Two 
procedures have been included for associating earnings with claims. The first 
procedure lists the steps for searching promotional accrual information. The second 
procedure provides instructions for associating earnings with the accrual 
information.

Prerequisites
A claim with completed claim lines.
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Steps
Follow these steps for searching promotional accrual information.

1. Log into Oracle Trade Management as Oracle Trade Management User and 
navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Click the Lines side navigation link in the Claim Details page.

4. In the Associate Earnings column, click the Search icon for the appropriate line.

5. In the Associate Earnings Summary page, enter search criteria in one or more of 
the fields in the Accruals Search Criteria section of the page. The fields are 
described below.

– Relationship and Related Customer: Select a value from the Relationship 
drop-down list, and select a customer. These fields reflect account 
relationships that have been set up in TCA.

– Buying Group and Display Children: By selecting a buying group and the 
Display Children check box, you can search for the accruals for that 
particular buying group and its members.

– Activity Type, Activity, and Schedule: Use these fields to search for a 
particular offer and its accruals. Alternatively, you can search by campaign 
schedule to find its related offers and accruals.

– Document Class and Document Number: Use these fields to search for 
accrual records for specific document types, such as orders and invoices.

– Product: Use this field to search for the accrual records for a specific 
product.

– Summary View: Use this field to specify an Activity, Document Class or 
Product view.

– Performance Verified: Select this check box to indicate that you have 
verified the customer or buying group has met the performance criteria for 
a promotion.

6. Click Search.

The results are displayed.

Follow these steps for associating earnings:

1. Type a value in the Line Amount field.
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2. If you have a scan data promotion, enter the actual scan data units and values 
in the Scan Promotion Accruals table.

3. Click Update.

4. To return to the Lines page, click Line Summary.

Notice that the Associate Earnings icon has changed to a check mark.

10.4 Claim Assignment
Claim assignment involves assigning the right owners to claims. Claim owners are 
responsible for settling claims and resolving claim-related issues.

Topics included are:

■ Section 10.4.1, "About Claim Ownership and Auto Assign Owner"

■ Section 10.4.2, "Reassigning Claim Owners By Using Auto Assign Owner"

10.4.1 About Claim Ownership and Auto Assign Owner
Every claim must have an owner. Owners are assigned either manually or 
automatically during claim creation. Automatic assignment occurs if Auto Assign 
Owner has been implemented in your organization.

A claim owner can be either an individual or a team. Teams can consist of multiple 
individuals and pre-defined groups of individuals. When a claim is owned by a 
team, one individual is always designated as the primary owner. The name of the 
primary owner appears in the Owner field on the Claim Detail page. The primary 
owner can add and remove team members, and also reassign claim ownership to 
another individual.

Team ownership enables you to manage scenarios where a specific claim owner is 
not easily determined during claim creation. In such cases, collective ownership and 
collaborative investigation may be required. See the Oracle Trade Management 
Implementation Guide for information on setting up teams.

Assigning a team to such claims enable you to:

■ Avoid settlement delays that may occur if you assign a wrong owner.

For example, a claim that is assigned to a wrong owner may remain in a 
pending state for a lengthy period of time before it is reassigned to the proper 
owner.

■ Avoid creating many complex territories to handle every business scenario.
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For example, based on the customer’s address, an organization knows that 
Claim #1020 should be assigned to a team member in the California territory. 
However, there is not enough information available to select a specific team 
member. The claim is therefore assigned to a team in the California territory. 
One of the team members recognizes that it is their responsibility and takes 
ownership of the claim.

If the Auto Assign Owner feature has been implemented in your organization, a 
claim owner is assigned automatically whenever a claim is created in Oracle Trade 
Management or in Oracle Receivables. You can initiate owner reassignment by 
selecting the Auto Assign check box on the Claim Detail page.

For example, a claim with the reason--Shipping was initially assigned to John. Upon 
investigation, John determines that the claim is a pricing error. John changes the 
claim reason to Pricing Error. Because he is not sure who should be working on this 
claim, he checks the Auto Assign Owner box and clicks Update. The system assigns 
a new owner based on the new claim reason.

As a prerequisite to enable assignment of owners, the Administrator must perform 
the following:

■ Set up pre-defined groups in Oracle Resource Manager.

■ Set up automatic assignment of an individual or a team in Oracle Territory 
Manager.

Claims supports the use of Oracle Territory Management to define territories and 
assign claim owners based on multiple customer, product, and geographical 
attributes, and claim type and reason.

For more information on CRM Resource Manager and Oracle Territory Manager, 
see the Oracle Trade Management Implementation Guide and the Oracle CRM 
Application Foundation Concepts and Procedures Guide.

10.4.2 Reassigning Claim Owners By Using Auto Assign Owner
If the Auto Assign Owner feature has been implemented, a claim owner is assigned 
automatically whenever a claim is created in Trade Management or in Oracle 
Receivables. Owner re-assignment is triggered by selecting the Auto Assign check 
box on the Claim Detail page.

Prerequisites
■ Assignment Manager must be implemented. See the Oracle Marketing 

Implementation Guide for instructions on implementing this feature.
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■ Territories must have been set up for assignment purposes.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Select the Auto Assign Owner check box.

4. Click Update.

10.5 Claim Approval
After creating and assigning a claim, you must submit the claim for approval. A 
claim can be settled only after it is approved by the designated approvers.

Topics included are:

■ Section 10.5.1, "Understanding the Claim Approval Process"

■ Section 10.5.2, "Submitting a Claim for Approval"

■ Section 10.5.3, "Approving a Claim"

10.5.1 Understanding the Claim Approval Process
The claim settlement process begins after you submit a claim for approval. The 
claim approval rules determine the approval flow, and the submitted claim is 
routed to the designated approvers. The claim approvers may approve or reject a 
claim.

The claim status changes along with the approval flow. Claim statuses enable you to 
know the exact status of the claim at any point of time. You can know where exactly 
a particular claim is pending and take the necessary actions.

Table 10–1 describes the various statuses that a claim may go through.

Table 10–1 Claim Statuses

Claim Status Description

New The claim status appears as New when it is created in Oracle 
Trade Management, but has not yet been researched upon.

When a claim is created in Oracle Receivables, by default the 
claim status appears as Open.
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Open The claim status appears as Open when a you start the claim 
research process.

The claim status may change to Complete, Pending Approval, 
or Pending Close.

Complete You may manually change the claim status from Open to 
Complete. No approval is required to change the claim status 
from Open to Complete. It means that you have completed 
most of the research, but do not want to settle the claim 
immediately.

When the claim status is Complete, you can request approval 
for the claim and initiate the settlement process.

The claim status may change to either Pending Approval or 
Pending Close.

Pending Approval You may request approval when the claim status is either 
Open or Complete. After you submit the claim for approval, if 
the approvers do not respond to the request, the claim status 
appears as Pending Approval.

Depending on whether the approvers approve or reject the 
request, the claim status may change to either Approved, or 
Rejected.

You cannot change this status to any other status.

Approved The claim status changes to Approved after all the approvers 
approve the claim. This is a temporary status because the 
settlement process begins immediately after the claim is 
approved.

The claim status may change to either Closed or Pending 
Close.

Rejected The claim status changes to Rejected if the approvers reject the 
claim.

You may manually change the status to Open and resubmit it 
for approval.

Pending Close After a claim is approved, the claim status appears as Pending 
Close if the settlement process is not automated real time, but 
requires some concurrent process such as the Claim Settlement 
Fetcher to finish the claim processing.

After the processing is complete, the claim status changes to 
Closed.

Closed The claim status appears as Closed after the claim is settled.

Table 10–1 Claim Statuses

Claim Status Description
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10.5.2 Submitting a Claim for Approval
A claim must be approved before it can be settled. Use the following procedure to 
submit a claim for approval.

Prerequisites
An existing open claim.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Verify the details, and click Request Approval.

4. Verify the details, and click Confirm.

After you submit the claim for approval, the claim approval rules determine the 
approval flow, and the submitted claim is routed to the designated approvers and 
they will receive a workflow notification.

10.5.3 Approving a Claim
Whenever claims are submitted for approval, you will receive workflow 
notifications if you are the claim approver according to the approval rules. Use the 
following procedure to approve a claim.

Prerequisites
A claim must have been submitted for approval.

Cancelled The claim status can be updated to Cancelled only from Oracle 
Receivables and not from Oracle Trade Management.

A claim cannot be settled when it is in the Cancelled status.

Table 10–1 Claim Statuses

Claim Status Description
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Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User, 

and navigate to Workflow > Worklist. You can also launch the worklist by 
navigating to Home > Tools > View Notification Work List.

The list of open notifications is displayed.

2. Select the notification that corresponds to the claim that must be approved.

3. Click Approve.

10.6 Claim Research
Oracle Trade Management provides claim research tools, which you can use to 
obtain information about customers, transactions, and accruals that are associated 
with claims. You can view claim details, identify duplicate claims, split a claim and 
find the cause for the claim.

Topics included are:

■ Section 10.6.1, "Viewing Claim Details"

■ Section 10.6.2, "About Claim Split"

■ Section 10.6.3, "Splitting a Claim"

■ Section 10.6.4, "About Duplicate Claims and Related Documents"

■ Section 10.6.5, "Marking a Claim as Duplicate"

■ Section 10.6.6, "Integration With Oracle Discoverer"

■ Section 10.6.7, "About Claim History and History Rules"

10.6.1 Viewing Claim Details
The claim details page includes the following information:

■ Basic information including the claim number, date, type, reason, action, owner 
and status.

■ Customer information including the customer name, account number, bill-to 
and ship-to addresses, contact, broker, sales representative, reference (customer 
debit memo) and reference date.

■ Amount information including the claim amount, in both functional currency 
and transaction currency, and exchange rate information.
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■ Duplicate claim information that consists of a list of claims that might be 
duplicates of the claim that you are researching. If duplicate claims are 
discovered, then you can mark them as duplicate. Claims marked as duplicates 
are automatically closed. See Section 10.6.4, "About Duplicate Claims and 
Related Documents" for more information on duplicate claims.

■ Auto assign owner information that includes details of owners who were 
automatically assigned to the claim based on the modifications made to the 
claim information.

10.6.2 About Claim Split
Claim split enables you to split a claim into multiple smaller claims and facilitates 
the process of research and settlement. Split claims share the same master claim 
number, with the addition of a suffix as an identifier. When a claim is split, you can 
see the balance and the running total of the amount that is assigned to the new 
claims. If the entire amount of the claim is not allocated to the split claims, then the 
unassigned balance remains on the original claim. Some of the cases where splitting 
a claim might be useful are listed below.

■ To settle part of a claim only

For example, a customer submits a claim for $10K, but you can validate only 
$5K. You split this claim into two claims, validate and settle one of them, and 
keep the remaining claim open for further investigation.

■ To facilitate the investigation of a claim caused by multiple reasons

For example, a customer submits a claim for $100K that is based on an audit of 
their records. After the initial investigation, you determine that it comprises of 
three earlier claims that the customer believes they never received payment for. 
To further investigate the claim, you split it into three claims to investigate each 
reason separately.

■ Only a part of a claim is valid

Sometimes, customers may submit claims where only a part of the claim is 
valid. You can split such claims, verify, and settle the part you have verified. 
The other part of the claim may be left open for further investigation, or it may 
be charged back to the customer.

For example, a customer submits a claim for a short shipment and to claim 
promotional discount. The promotional discount part is valid, but the short 
shipment part requires further investigation. You can split the claim into two 
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claims, settle the one for the promotional discount, and leave the other claim 
open for further investigation.

The following example shows in more detail how a claim with multiple reasons 
might be split.

You send an invoice to a customer for $100K. You receive a check for $20K that 
includes an $80K deduction. Because the customer does not give any reason for 
the deduction, you create a deduction in Oracle Receivables by using the 
default reason--Unknown.

After some investigation, you determine that the customer has deducted $30K 
for promotions, $40K due to shipping errors, and $10K due to pricing errors. 
You may split the claim one of two ways:

Notice that each claim number includes the original number of DED1. This number 
is used in Oracle Receivables for tracking purposes. All the outstanding balances 
and amounts that are processed for the root claim and each of the split claims are 
tracked in Oracle Trade Management.

Deduction Number Status Amount Reason

DED1 Cancelled $0K Unknown

DED1_1 Open $30K Promotions

DED1_2 Open $40K Shipping Errors

DED1_3 Open $10K Pricing Errors

Deduction Number Status Amount Reason

DED1 Open $30K Promotions

DED1_1 Open $40K Shipping Errors

DED1_2 Open $10K Pricing Errors

Note: After a claim is split, the parent and the child claim are 
treated as separate claims during claim research. The fund balances 
in a child claim cannot be modified.
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Rules for Splitting Claims with Claim Lines
The following guidelines and examples will help you split claims with claim lines. 
For the application to automatically split a line, the line amount must be for the full 
amount of the claim. In this example, the line is for less than the full amount; 
therefore, you must manually assign the line amount to the split claims.

For example, assume the total amount of a claim is $400.

■ If there are no claim lines, then the claim can be split any way as long as the 
amounts still total $400.

■ If there is a claim line for $300, then you can split the claim as follows:

■ Split it into two claims where Claim 1 = $350 and includes the claim line for 
$300, and Claim 2 = $50 with no claim line.

■ Split it into two claims where Claim 1 = $60 and has no claim line, and 
Claim 2 = $340 and includes the claim line for $300.

■ If there is a Claim line for $400 (the claim total), then you can split claim line 
automatically as follows:

■ Split it into two claims where Claim 1 = $300 with a claim line of amount 
$300, and Claim 2 = $100 with a claim line of amount $100. You can do this 
by just giving the split claim amount $300 and $100 from the UI. You cannot 
use this functionality if the claim line has already been associated with 
earnings. If there are any associated earnings, you must manually adjust the 
association and split claim line first.

■ Split it into two claims where Claim 1 = $0 and has no claim line, and Claim 
2 = $400 and includes the claim line for $400.

■ If you have multiple claim lines whose sum is less than the total claim amount 
(for example Line 1 = $300 and Line 2 = $40), then you can split the claim as 
follows:

■ Split it into two claims where Claim 1 = $380 and includes Line 1 for $300 
and Line 2 for $40, and Claim 2 = $20 with no claim lines.

■ Split it into two claims where Claim 1 = $350 and includes Line 1 for $300, 
and Claim 2 = $50 and includes Line 2 for $40.

■ Split it into two claims where Claim 1 = $30 and has no claim line, and 
Claim 2 = $370 and includes Line 1 for $300 and Line 2 for $40.

■ If you have multiple claim lines whose sum equals the total claim amount (for 
example Line 1 = $300 and Line 2 = $100), then you can split the claim into two 
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claims where Claim 1 = $100 and includes Line 2, and Claim 2 = $300 and 
includes Line 1.

10.6.3 Splitting a Claim
Splitting a claim into multiple smaller claims facilitates the process of research and 
settlement. You can split claims to settle only a portion of a claim, and to facilitate 
the investigation of a claim caused by multiple reasons. Split claims share the same 
master claim number, with the addition of a suffix as an identifier. When a claim is 
split, you can see the balance and the running total of the amount that is assigned to 
the new claims. If the entire amount of the claim is not allocated to the split claims, 
then the unassigned balance remains on the original claim. Use the following 
procedure to split a claim.

Prerequisites
■ An existing claim.

■ The status of the claim is Open.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Click the Split side navigation link in the Claim Details page.

4. Enter the information for each split claim on a row in the table as follows:

a. Optionally select a Claim Type and a Reason.

If no selection is made, the type and reason default to the parent type.

b. In the Amount column, type an amount for the split claim.

c. Select a Line Amount if the claim has:

– Multiple line amounts

– A single line that is for less than the total claim amount

You must explicitly assign line amounts to be split along with the claim. For 
information on rules for splitting claims with claim lines, see Section 10.6.3, 
"Splitting a Claim".

5. Click Update.
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The new claims will be generated.

10.6.4 About Duplicate Claims and Related Documents
Sometimes, customers may raise multiple claims for the same transaction. There 
may also be multiple deductions referring to the same offer or invoice. These claims 
and deductions are termed as duplicate claims. Before settling a claim, you can 
search for duplicate claims and deductions based on the reference numbers or 
names. After you identify a duplicate claim, you can mark it as duplicate after 
which the duplicate claim is removed. You can also mark multiple claims as 
duplicate. Both the deduction and claim serve as a reference to each other for future 
audits.

The Related Documents side navigation link enables you to automatically search for 
related claims and gives you a summary view of all claims with similar or same 
customer debit memo numbers or invoice numbers, thus allowing you to identify 
duplicate or invalid customer claims more quickly.

For example, a customer deducts, and references the debit memo number as 
DM0123. Due to an error, the customer again deducts using the same debit memo 
but this time the number is read as DMO123 (the letter O instead of the number 
zero). When you access the Related Documents function, you can automatically see 
a listing all the claims with similar customer debit memo numbers. You can drill 
down into each of them and determine further if they are really duplicates.

10.6.5 Marking a Claim as Duplicate
Duplicate claims are multiple claims and deductions, which the customers raise 
against the same transactions and invoices. Before settling a claim, you can search 
for duplicate claims and deductions based on the reference numbers or names. 
After you identify a duplicate claim, you can mark it as duplicate after which the 
duplicate claim is removed. Both the deduction and claim serve as a reference to 
each other for future audits. Use this procedure to mark a claim as duplicate.

Prerequisites
An existing claim with duplicates.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click the hyperlink of the claim.
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3. Click the Related Documents side navigation link.

4. If any duplicate claims exist, they are displayed here. Verify if the information is 
duplicate and make a note of the claim numbers that have duplicate 
information.

5. Click Main.

6. Select the duplicate claim number from the Duplicate LOV.

7. Click Update.

10.6.6 Integration With Oracle Discoverer
Oracle Discoverer is a tool that you can access from Oracle Trade Management. 
Depending upon how Discoverer is implemented in your organization, it can be 
used as either:

■ A query tool that enables you to create and view user workbooks to extract all 
the customer information from the database.

■ A page with pre-defined reports that you select to run and refresh whenever 
reports must be updated.

The Oracle Workbook formats include:

■ Simple table: data is displayed in columns

■ Cross tab: data is displayed in rows and columns

■ Page-detail table: data is displayed in columns and is grouped by items on the 
page axis

■ Page-detail cross tab formats: data is displayed in both rows and columns and 
is grouped by items on page axis

You can view information from Oracle Discoverer only from the business areas and 
folders for which you have access. Claims users can typically access information 
from the Oracle Trade Management business area and the Claim Research folder. 
The seeded folder includes information such as Returns, Order Headers, Order Line 
Details, Checks, Invoice Payments, Deductions, Receivable Transactions, and 
Payables Invoices.

Discoverer supports many functions that enable you to manipulate your reports. 
These functions include filtering by conditions, sorting, calculations and functions 
such as sum, average, count, minimum and maximum, standard deviation and 
variance. The advanced features include graphing and scheduling. You can save a 
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workbook in the database or export it as an HTML report or an Excel file. For 
information on working with Discoverer, see the Oracle Discoverer User Guide.

10.6.7 About Claim History and History Rules
Claim history enables you to record various changes made to a claim during the 
course of investigation. The Administrator sets up history rules to define the fields 
and information that must be captured in Claim history. After the history rules are 
set up, the system records all the changes that are made to the selected fields, and 
enables you to trace back all the changes that have been made to the claim. Thus, 
every claim can have a complete audit trail. If a customer conducts post-audit 
activities and disputes the resolution of different claims, then the organization can 
produce complete documentation of all the changes that were made to the claim 
and perhaps be able to resolve some of the disputes.

For example, History Rules may be created for a customer contact point. Every time 
the customer contact is changed, it is captured in Claim history. You are assigned to 
the claim and you interact with the customer contact--John during research and 
obtain certain information. Later on, John leaves the customer organization, and the 
new customer contact is Mary. You change the Contact field on the claim from John 
to Mary. Because this field is set up with History Rules, the change is automatically 
captured in the History of a claim. In future, if any disagreement arises over the 
information supplied by the customer, you can trace back that the information had 
come from the original contact person John.

10.7 Claim Settlement
Claim settlement is the process by which claims, deductions, and overpayments are 
settled. The claim settlement functions automate a majority of claim and deduction 
scenarios. For a claim created in Oracle Trade Management, checks and credit 
memos can be automatically created in the Oracle Payables and Oracle Receivables 
respectively for settlement. With Auto-Resolution, organizations can automatically 
close out deductions, create corresponding Receivables transactions, apply the 
transactions, and enter accurate accounting entries as soon as the claim is settled in 
Oracle Trade Management. If the currency of the claim differs from the currency 
used by your organization to post accounting entries, then Oracle Trade 
Management can convert the claim amount to the proper currency. You can settle 
claims for Buying Groups and Related Customer Accounts.
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Topics included are:

■ Section 10.7.1, "Understanding Scan Data Offer Adjustments"

■ Section 10.7.2, "About Promotional Payments"

■ Section 10.7.3, "Searching for Accruals from the Promotional Payments Tab"

■ Section 10.7.4, "Creating and Settling Claims From the Promotional Payments 
Tab"

■ Section 10.7.5, "About Paying Over Earnings by Thresholds"

■ Section 10.7.6, "Approving Requests For Unearned Payments"

■ Section 10.7.7, "Understanding Mass Settlement (Netting of Overpayments)"

■ Section 10.7.8, "Netting Overpayments and Deductions With Debit Items"

■ Section 10.7.9, "About Autopay"

■ Section 10.7.10, "Running and Scheduling Autopay"

■ Section 10.7.11, "Viewing Autopay Request and Autopay Log"

■ Section 10.7.12, "Understanding Automatic Write-off"

■ Section 10.7.13, "Viewing Claims Eligible for Automatic Write-off"

■ Section 10.7.14, "About Updating Deductions Based On Subsequent Receipts"

■ Section 10.7.15, "Claim Settlement Methods"

■ Section 10.7.16, "About Standard Memo Lines"

■ Section 10.7.17, "Settling Claims, Debit Claims, Deductions, and Overpayments"

10.7.1 Understanding Scan Data Offer Adjustments
The Claims module is critical in managing the payment of Scan Data offers because 
the actual scan data is entered through claims. When the actual values of Scan Data 
offers exceed the committed amount or forecast values, the claim automatically 
adjusts the Scan Data accruals as required, including the committed and utilized 

Note:  If payout methods have been specified for an offer during 
offer creation, then you need not create a claim manually and 
specify the payment method. Such offers are settled automatically 
by the Autopay program.
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funds. The committed and utilized amounts in Scan Data offers are adjusted 
depending upon the fund utilization. Following are the types of automatic 
adjustments:

■ Adjustments to Committed and Utilized

■ Adjustments to Utilized Only

■ Scan Data Offer With No Adjustments

Adjustments to Committed and Utilized 
Funds are committed to offers during offer creation. However, the amount that is 
utilized from the offer may be more than the committed amount. When the actual 
data is submitted, you create a claim with at least one claim line. You associate the 
earnings from the claim line to the Scan Data offer, and enter the actual data in the 
appropriate Scan Data offer field. For the increase in the utilized amount, the GL 
entries--Debit Sales, and Credit Liabilities are created and the committed and 
utilized amounts are updated to show the new values.

For example, assume that a Scan Data offer was created for an organization as 
follows:

The committed amount for this offer was $180K. At the time the offer is created, the 
following accounting entries are made:

Debit Sales or Expense (Product A) $100K
Credit Liabilities (Product A) $100K

Debit Sales or Expense (Product B) $80K
Credit Liabilities (Product B) $80K

The Offer Checkbook looks as follows:

Product Forecast Total Scan Value

Product A $100K

Product B $80K

Committed Utilized Paid

$180K $180K $0K
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When the actual data is submitted, you create a claim with at least one claim line. 
You associate the earnings from the claim line to the scan data offer, and enter the 
actual data in the appropriate scan data offer field.

For this claim, the calculated actual units and values are as follows:

These numbers represent a $30K increase to both the committed and utilized 
amounts. The following GL entries are created to account for the increase in the 
utilized amount:

Debit Sales or Expenses (Product A) $20K
Credit Liabilities (Product A) $20K

Debit Sales or Expenses (Product B) $10K
Credit Liabilities (Product B) $10K

When the claim is settled, automatic adjustments are made to the committed and 
utilized amounts. The Offer Checkbook looks as follows:

Adjustments to Utilized Only
The forecasted values for Scan Data offers may be less than the committed values. 
When the actual fund utilization of a Scan Data offer exceeds the forecasted values, 
the claim automatically adjusts utilized funds.

For example, assume that the following Scan Data offer has been created:

The committed amount for this offer was $200K, whereas the forecasted total us 
$180K. The Offer Checkbook looks as follows:

Product Forecast Total Scan Value Actual Total Scan Value

Product A $100K $120K

Product B $80K $90K

Committed Utilized Paid

$210K $210K $210K

Product Forecast Total Scan Value

Product A $100K

Product B $80K
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When the actual data is submitted, you enter the data in a claim. The calculated 
actual units and values are as follows:

This data represents no change in the committed amount, and an increase of the 
utilized amount by $15K. GL postings are created for the $15K. When the claim is 
settled, an automatic adjustment is made to the utilized amount, and the Offer 
Checkbook looks as follows:

Scan Data Offer With No Adjustments
The fund utilization in a Scan Data offer may be less than the committed and 
forecasted amount. In such cases, when you create a claim, no adjustments are 
made to the committed and utilized amounts. More data for the offer can be 
submitted at a later date. In cases where there is true under utilization, adjustments 
are made only if the Sales Management determines that no more actual data is 
expected and closes the offer. If this occurs, then you can reconcile the budget. 

For example, assume that the following scan data offer has been created:

The committed amount for this offer is $200K. The Offer Checkbook looks as 
follows:

Committed Utilized Paid

$200K $180K $0K

Product Forecast Total Scan Value Actual Total Scan Value

Product A $100K $110K

Product B $80K $85K

Committed Utilized Paid

$200K $195K $195K

Product Forecast Total Scan Value

Product A $100K

Product B $80K
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When actual data is submitted, you enter the data in a claim. The calculated actual 
units and values are:

This data represents no change to the committed and utilized amounts. No GL 
entries are created because no adjustments are required. When the claim is settled, 
the Offer Checkbook looks as follows:

10.7.2 About Promotional Payments
The Promotional Payments tab gives a summary of the accumulated promotional 
accruals for all the customers that your organization deals with. Promotional 
accruals are the accruals that are created when customers place orders against 
offers. These are the discounts that the customers are eligible to receive. Customers 
may claim these accruals either by submitting claims or taking deductions.

By using the Promotional Payments tab, you can:

■ Search for accruals that are related to a particular offer type.

■ Search for accruals that are related to direct sales or indirect sales.

■ Search for accruals by customer name, product category, and for a given date 
range.

■ Compare the current earned, paid, and balance amounts with the respective 
amounts in the previous year.

■ Create claims and initiate payment for selected customers.

Table 10–2 describes the columns that are displayed in the Promotional Payments 
page. All of this information is displayed for each customer.

Committed Utilized Paid

$200K $180K $0K

Product Forecast Total Scan Value Actual Total Scan Value

Product A $100K $70K

Product B $80K $40K

Committed Utilized Paid

$200K $180K $110K
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10.7.3 Searching for Accruals from the Promotional Payments Tab
From the Promotional Payments tab, you can search for the total promotional 
accruals for all customers for specific criteria such as Offer Type, Activity Type, 
Channel of Sales, Product Category, Customer, Start Date, and End Date. Use the 
following procedure to search for accruals for a specific criteria.

Prerequisites
Existing customers and business transactions.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Promotional Payments.

2. In the Search region, select values for the fields depending upon what you wish 
to search for. For example, to search for all the accruals related to all offers of a 
specific offer type, say Lump sum offers, select Lumpsum from the Offer Type 
drop-down list.

3. Click Go.

The list of claims that match the specified criteria are displayed.

4. Click Save Search to save the search results.

5. Enter the required details in the General Properties region.

Table 10–2 Promotional Payment Views

Column Description

Earned Total amount that the customer has earned.

Paid Total amount corresponding to the customer’s claims that 
have been settled and paid.

Balance This is the amount that is payable to the customer. Balance = 
Earned - Paid.

Open Claims Total amount corresponding to the customer’s claims that are 
still in the process of settlement.

Last Year Same Period 
Earned

Total amount that the customer has earned in the same period 
in the previous year.

Last Year Total Earned Total amount that the customer has earned during the 
previous year.
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6. In the Search Query to Filter Data in the Table region, enter a query to filter the 
search results and display them.

7. Click Apply.

10.7.4 Creating and Settling Claims From the Promotional Payments Tab
You can create claims from the promotional payments tab in the following two 
ways:

■ By drilling down the Open Claims link against the customer for whom you 
would like to create the claim.

■ By clicking the Pay button.

The following procedure explains how to create claims in both these ways. It 
includes steps to create claims as well as to initiate payments.

Prerequisites
Existing customers and transactions.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Promotional Payments.

2. To create claims for a single customer:

a. Click the link in the corresponding Open Claims column against the 
customer whom you would like to create claims for.

b. Click Create in the Claims page.

c. In the Create Claim page, enter the required information and click Create.

3. To create claims on a single screen for a single customer or multiple customers:

a. Check the respective check boxes to select the customers for whom you 
would like to create claims.

b. Click Pay.

The Earnings Payment page appears. You can find out from here details 
such as the payment frequency (Annual, Quarterly, monthly, and so on), 
Last Paid Date, and also find out whether the customers are eligible to 
receive payments or not.
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c. Check the respective check boxes to select the customers for whom you 
would like to create claims.

d. For each customer, select the payment method from the Payment Method 
drop-down list.

e. Click Continue.

f. Review the information in the Earnings Payment: Review page and select 
the Initiate Payment option and Create Claim option to create claims and 
initiate payment.

g. Click Finish.

The claims will be created and workflow notifications will be sent to the designated 
approvers. Payments will be made after the approvers approve the requests.

To view the claims that have been created, drill down the Open Claims link against 
the customer for whom you have created the claims. All the existing claims and the 
new claims that you have created will be listed here.

10.7.5 About Paying Over Earnings by Thresholds
Promotional accruals are paid to customers through claims or deductions. When the 
payments are authorized, GL entries are created to reduce the accumulated 
promotional liabilities. Depending on the nature of the business, some customers 
may get paid more what they have accrued. The extra funds that are paid are know 
as unearned funds. This happens in cases where customers have long-term ongoing 
business deals with the manufacturer. Depending on how Oracle Trade 
Management is implemented in your organization, and the Trade Profile settings for 
individual customers, you can pay customers more than what they have earned. 
You can track such payments so that customer balances are reflected accurately.

For example, a manufacturer creates a budget and gives an offer to a customer. The 
customer and the manufacturer have a long-term business relationship. The 
customer performs according to the offer terms and conditions, and accrues some 
earnings. The budget looks as follows:

The customer knows that the offer is ending in a few days, and plans to book some 
more orders in the next few days before the offer ends, and anticipates to earn 

Available Committed Utilized Earned Paid

$10,00,000 $10,000 $9,000 $9,000 0
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another $1,000. In the meantime, the customer sends payments to the manufacturer, 
and deducts a total of $10,000.

The claims user in the manufacturing organization gets this deduction of $10,000. 
Because of the long-term business relationship that the customer and the 
manufacturer have, the user decides to pay the customer. The budget looks as 
follows:

The Administrator can set up thresholds for such payments. Thresholds may be in 
terms of amounts based on various factors including the customer's last year same 
period sales performance, earnings on a similar offer on similar products, or the 
current year-to-date sales. Thresholds may also be a percentage of payments above 
the earned funds. If claims are within the thresholds, then you can settle them like 
any other regular promotional claims.

If unearned payments exceed the threshold amount or percentage, then depending 
upon the implementation setups, they may require approval. If approval is 
required, then you cannot settle a claim until the approvers approve the request for 
unearned payments.

10.7.6 Approving Requests For Unearned Payments
Whenever the request for unearned payments exceeds the threshold amount or 
percentage, then depending upon the implementation setups, they may require 
approval. If you are the approver according to the approval rules, then you will 
receive a workflow notification when there are requests for unearned payments. 
The claims user cannot settle the claim until you approve the request.

Use the following procedure to approve the request.

Prerequisites
An request for unearned payments must have been submitted for approval.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User, 

and navigate to Workflow > Worklist. You can also launch the worklist by 
navigating to Home > Tools > View Notification Work List.

Available Committed Utilized Earned Paid

$10,00,000 $10,000 $9,000 $9,000 $10,000
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The list of open notifications is displayed.

2. Select the notification that corresponds to the unearned payments that must be 
approved.

3. Click Approve.

10.7.7 Understanding Mass Settlement (Netting of Overpayments)
In B2B businesses, manufacturers and retailers have complex ongoing business 
transactions. Sometimes when the customers make payments, it may be difficult to 
know the exact reason they are making the payment for. In some cases such as 
when the transaction number is wrong, overpayments may be created. When these 
overpayments are investigated, you may find that the overpaid amounts were 
meant to pay back for some transactions (debit items). The Mass Settlement 
function enables you to apply the overpaid amounts to such debit items.

For example, a customer receives an Invoice with the number 100080. However, the 
remittance amount refers to the invoice as 10008O. When your organization receives 
this payment, this invoice number will not be identified in Oracle Receivables, and 
therefore an overpayment will be created. You then realize that the invoice has been 
wrongly entered as 10008O instead of 100080. You can settle the overpayment claim 
by applying the "overpaid" amount to the debit item 100080.

The Mass Settlement functionality enables you to create groups out of 
overpayments and deductions related to a customer, apply them to the customer’s 
open transactions, and settle the overpayments and deductions on one screen. You 
can also specify multiple payment methods.

After netting a claim with the debit items, transactions, or other Oracle Receivables 
items, there may still be some remaining amount that must be settled.

For example, a customer may deduct for returns. During investigation, you may 
find that multiple credit memos have already been issued as a result of the RMAs 
that have been entered in Order Management. You can close the deduction by 

Note:

■ During netting, the overpayments can be applied only up to the 
balance of the item.

■ You cannot use the Mass Settlement function to settle 
deductions with associated earnings.
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netting the credit memos to the deduction. However, there may still be some 
balance amount.

If the balance is an overpayment balance, then you can settle it through credit- on 
account, or write-off. If the balance is a deduction balance, then you can settle it 
through chargeback, or write-off.

You can perform netting and settling of balances at different times depending on 
how you investigate or how long it takes you to investigate the claim. The netted 
amount must however be approved by the designated approvers, according to the 
setups in your organization.

10.7.8 Netting Overpayments and Deductions With Debit Items
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Mass Settlement.

2. Click Create.

3. In the Search region of the page, select the customer for whom you would like 
to net the overpayments.

4. Search for Open Claims by selecting the Claim Type, Reason, Source Object 
Number, Receipt Number, or the Claim Number.

All the open claims that match with the selected attributes will be listed in the 
Open Claims region.

5. Search for Open Transactions by selecting the Batch Source, Transaction Class, 
Transaction Type, and Transaction Number.

All the open transactions that match with the selected attributes will be listed in 
the Open Transactions region. Sometimes, when you search for open 
transactions, the list of invoices may appear. You can display open transactions 
such as debit memos by further conducting a search.

6. In the open claims region, select the transactions that you would like to settle.

When you select an open claim, the amount field gets populated with the 
amount that must be settled. You can also enter a partial amount from the 
transaction. For example, the remaining amount from a deduction may be 
$1000, but you can choose to settle only $600.

7. After selecting the transaction lines and amounts that must be settled, click 
Calculate to calculate the sub total of the open claims that you have selected for 
settlement.
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8. In the open transaction region, select the transaction or debit item with which 
you would like to settle the claims, and click Calculate.

This calculates the sub total for the open transactions as well as the net amount 
of the settlement group. It is the sub total of open claims minus the sub total of 
open transactions. If there is any remaining amount, the amount must be split 
during settlement.

9. In the Settlement region, you can either settle the entire amount, or split the 
amount and choose different settlement methods.

a. Select either chargeback or write-off from the Settlement Method 
drop-down list.

b. Select a write-off activity if you selected the settlement method as write-off.

c. Select a GL date for the activity.

d. Click Update.

10. Optionally select a Claim Type and Reason.

11. Click Submit.

12. Click Confirm.

10.7.9 About Autopay
Autopay enables you to automate payments for promotional accruals. When 
autopay is set up, it automatically creates claims, associates claims with the 
customer’s accruals, and settles the claims as designated (credit memo or check).

For example, you request your Administrator to set up autopay to issue a credit 
memo for promotional accruals to a customer every two weeks. Every two weeks, 
autopay checks the customer’s accrual balance. The balance for this period is 
$1,00,000 utilized and $80,000 paid, leaving an outstanding balance of $20,000. 
Autopay automatically creates a claim for the customer, associates it with the 
$20,000 balance, selects credit memo as the settlement method, and initiates the 
settlement process. The settlement process begins with claim approval and ends 
with the generation of a credit memo for $20,000 and closure of the claim. Because 

Note: Complete the following steps for each row to split the net 
amount and settle each portion with a different settlement method.
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the customer knows that the organization issues a credit memo every two weeks, it 
is less likely that the customer will deduct from payments to your organization.

If Autopay is setup, before creating claims and making payments, it checks whether 
payments must be made according to the payout dates specified in the offer, or 
according to the dates and frequency set up in the regular Autopay schedule. It also 
checks if any payment methods and payment preference in terms of time have been 
specified in the offer, and makes payments accordingly.

If performance requirements have been specified for offers, Autopay creates and 
processes claims only for those offers for which performance has been verified. 
Performance proof may be in the form of electronic files, images or based on 
physical inspection of the retailer’s premises. Upon verifying performance, you can 
update the performance flags in an offer. Where there are multiple performance 
criteria, Autopay processes payments for the offer only after you verify all the 
performance requirements.

Customers will be eligible for autopay depending if the Autopay option is checked 
in the individual Trade Profiles.

10.7.10 Running and Scheduling Autopay
When you run autopay, claims are automatically created and associated with the 
customer’s accruals. The claims are settled as designated (credit memo or check). 
Use the following procedure to run Autopay.

Prerequisites
■ Claims with the status of Open or Completed must exist.

■ Autopay must be implemented.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Autopay.

2. Click the Submit Request side navigation link.

3. Enter a name for the request, and click Next.

You can use this name to identify this request at a later point of time.

4. Enter the following details in the Parameters page:

a. Select a Run Mode from the LOV. The values that are available are:
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– All Offers: All the offers will be settled.

– Offers with Autopay: Only those offers for which Autopay has been 
marked will be settled.

– Offers without Autopay: Only those offers for which Autopay has not been 
marked will be settled.

b. Optionally select a customer name; values for Relationship, Related 
Customer, Buying Group and Members, Include All Member Earnings, and 
Pay To fields will default in.

Based on the value that you select from the Run Mode LOV, all offers for 
the selected customer will be settled, or only those offers for which 
Autopay has been marked or not marked will be settled.

c. Optionally select a Fund Name, and an Activity Type.

The Activity Type that you select determines the reason for which the claim 
is being settled.

d. Optionally select a Product Category, and an End Date.

5. Click Next.

To manually specify the schedule for running the request, perform the next two 
steps. If you wish to run the request based on a pre-set schedule, then skip the 
next two steps.

6. In the Start Date region, choose from either of the following options:

– As soon as possible: the request will be run immediately.

– Start at specific date: the request will be run on the specified date. If you 
select this option, then select the Start Date and the Start Time for the 
request to run.

7. In the Recurrence region, choose from either of the following options:

– Never Repeat: the request will be run only once.

– Repeat: the request will be run based on the frequency that you specify. If 
you select this option, then select the frequency from the drop-down list, 
and optionally select the End Date and End Time.

8. To run the request based on a pre-set schedule, select the schedule in the 
Schedule Name region. The request will be run based on the settings that have 
been made in the schedule.

9. Optionally check the Increment Date Parameters check box.
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If you check this option, the recurring date parameters will be incremented by 
the repeat interval.

10. Click Next.

11. Optionally select the people or teams that you would like to notify when the 
request is run, and click Next.

12. Optionally, to print the request details, specify the print style, printer, and the 
number of copies that must be printed, and click Next.

13. Review the information and click Submit if you are ready to submit the request.

A confirmation message is displayed.

10.7.11 Viewing Autopay Request and Autopay Log
After running Autopay, you can view the Autopay Request and the Autopay Log to 
know if there were any errors encountered in the process. Use the following 
procedure to view Autopay Request and Autopay Log.

Prerequisites
An Autopay request must have been submitted.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Autopay.

2. Click the View Request side navigation link.

The list of all the Autopay requests that have been submitted will be displayed.

3. Click the Details icon corresponding to the request, the details or log of which 
you would like to view.

The Request Details page gives you a summary of the request including the 
parameters that were set while running the request, notifications if any, and 
other details.

4. Click View Log to view the Autopay Log.

10.7.12 Understanding Automatic Write-off
When customers submit claims or take deductions, they may charge more than 
what they are supposed to claim or deduct. But the differences in the amount may 
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be so small that it may not be worth spending time and resources to research them. 
You can decide not to spend time on researching the claim, and settle it with a 
write-off. When you settle claims with a write-off, it means that your organization is 
absorbing these costs as expenses.

Automatic write-off enables you to automatically identify claims, deductions, or 
overpayments that are eligible for write-off. The Administrator sets threshold limits 
for deductions as well as overpayments. Whenever a customer deducts or overpays, 
if the claim amount falls within the threshold limits, then the claims are 
automatically checked for automatic write-off. If required, you can manually 
uncheck these claims and investigate them, or settle them later.

For example, a manufacturer creates an automatic write-off threshold for $200. 
Claims with differences of less than $200 are checked automatically for write-off. 
The claims manager reviews these claims and notices that a particular customer has 
massive deductions slightly below the threshold, and unchecks these claims for 
automatic write-off to investigate them.

Claims that are originally over the threshold limit, but for various reasons have 
their amounts reduced, will not be automatically checked for write-off. Even if you 
manually check such claims, they are still treated as claims over the thresholds, and 
they require approval. Claims that are originally over the threshold limit, but have 
been split later on to smaller pieces, are still treated as claims over the threshold 
limit.

For example, in an organization, the write-off threshold for deduction is $200. A 
deduction comes in for $300. This deduction is then split into $100, $150 and $50. 
These split deductions are still treated as over the threshold limit. You can manually 
check these claims for automatic write-off, but they require approval.

The process of settling claims through write-off depends upon the type of claim or 
deduction.

■ Transaction related deductions

A write-off adjustment is created in Oracle Receivables. The disputed amount   
on the transaction is reduced and the claim is closed.

■ Non-transaction related deductions

A negative write-off line is created in Oracle Receivables. The claim is closed in 
Oracle Trade Management. 

■ Overpayments 
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A positive write-off line is created in Oracle Receivables. The claim is closed in 
Oracle Trade Management After the claim is settled, the auto write-off check 
box will be read-only.

■ Special cases

After you uncheck claims that are under the thresholds, they will not be 
automatically checked again. You may however manually recheck these claims 
for automatic write-off as long as the claim status is Open. These claims are 
treated as claims that are under the threshold limits. After investigation, if you 
wish to still settle the claim with a write-off, then you must settle the claim 
through the claim settlement page.

When a claim is settled through a write-off, the expenses may need to be absorbed 
by different departments. On the claim settlement page, you can select the 
department to which a claim belongs to and the write-off amount is posted to the 
specified GL account.

10.7.13 Viewing Claims Eligible for Automatic Write-off
Whenever a customer deducts or overpays, if the claim amount falls within the 
threshold limits, then the claims are automatically checked for automatic write-off. 
If required, you can manually uncheck these claims and investigate them, or settle 
them later. Use the following procedure to view claims that are eligible for 
automatic write-off, and manually update the write-off flag against these claims.

Prerequisites
Claims must exist.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. In the Claims page, click Personalize.

The Claim Advanced Search page appears. In the Display Options region of the 
page, you can see the list of Available Columns and Displayed Columns.

3. Scroll down the Available Column, and move Write-off Flag to the Displayed 
Column.

4. In the Save Search As region, enter a name for the search.

5. Click Save and Apply.
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The Claims page appears. All the claims that are eligible for automatic write-off 
would have been marked.

6. Optionally, to update the write-off flags for claims, manually check or uncheck 
the corresponding check boxes.

10.7.14 About Updating Deductions Based On Subsequent Receipts
When customers make subsequent payments for a single invoice, then the original 
deduction is updated based on the subsequent payments received. However, the 
manner in which the deduction gets updated depends on whether the deduction is 
transaction-related or non-transaction related, and the status of the previous 
deduction.

Topics included are:

■ Section 10.7.14.1, "Transaction-related Deduction Without Splits"

■ Section 10.7.14.2, "Transaction-related Deduction With Splits"

10.7.14.1 Transaction-related Deduction Without Splits
Transaction-related deductions can be traced back to an invoice, order, or an offer. If 
a previous deduction exists for the transaction and is not split, then the process will 
be different depending on the status of the previous deduction. The manner in 
which subsequent payments are processed during different statuses of the original 
claim is as follows:

■ Open

When the claim or deduction status is open, the remaining amount in the 
deduction is reduced by the subsequent receipt amount. The corresponding 
disputed amount on the transaction is also reduced.

For example, an invoice is created for $500. The customer initially pays $350. 
This creates a deduction for $150 in Oracle Trade Management. The customer 
then pays $100 towards the same invoice, and the status of the original 
deduction is Open. Now, the original deduction that was created for $150 gets 
updated accordingly and shows $50 ($150 - $100) as the deduction amount. This 
means that the customer owes only $50.

Note: You can update the write-off flags only for Claims that are 
in the Open status. The write-off check box will be disabled for 
claims that are in the other statuses; you cannot update these.
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When the remaining amount in the deduction is reduced to zero, the status 
changes to Cancelled. Even if the subsequent payments made by the customer 
sum up to more than the invoice amount, the deduction will not be converted 
into an overpayment because the status changes to Cancelled as soon as the 
deduction amount is reduced to zero.

■ Complete

If subsequent payments are received when the status of the original deduction 
is Complete, then the status of the deduction changes from Complete to Open. 
After the status changes to Open, the remaining amount in the deduction is 
reduced by the subsequent receipt amount. The corresponding disputed 
amount on the transaction is also reduced. When the remaining amount in the 
deduction is reduced to zero, the status changes to Cancelled.

■ Rejected

If subsequent payments are received when the status of the original deduction 
is Rejected, then the status of the deduction changes from Rejected to Open. 
After the status changes to Open, the remaining amount in the deduction is 
reduced by the subsequent receipt amount. The corresponding disputed 
amount on the transaction is also reduced. When the remaining amount in the 
deduction is reduced to zero, the status changes to Cancelled.

When the claim is resubmitted for approval and the settlement is restarted, the 
current amount and details of the claim are used to find the appropriate 
approvers.

For example, the original deduction was for $10000. It was sent to the Director 
for approval, and was rejected. The claim status changes to Rejected. A 
subsequent receipt amount is later applied to the deduction. The claim status 
changes from Rejected to Open, and the deduction amount reduces to $8000. 
The claims user restarts the approval and settlement process. Based on the fact 
that the deduction is now only $8000, it requires a lower level of approval and is 
only sent to the Manager for approval instead of the Director.

■ Pending Approval or Approved

If subsequent payments are received when the status of the original deduction 
is Pending Approval, then the status of the deduction changes from Pending 
Approval to Open. If the payments are received when the status is Approved, 
the status changes from Approved to Open. After the status changes to Open, 
the remaining amount in the deduction is reduced by the subsequent receipt 
amount. The corresponding disputed amount on the transaction is also 
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reduced. When the remaining amount in the deduction is reduced to zero, the 
status changes to Cancelled.

When the claim is resubmitted for approval and the settlement is restarted, the 
current amount and details of the claim are used to find the appropriate 
approvers.

If any approver has already approved the deduction before this happens, these 
approvers receive notifications.

■ Pending Close

The original deduction is not updated when the status of the deduction is 
Pending Approval. This is because when the claim status is Pending Close, it 
means that the deduction has already been approved, and is currently 
undergoing the settlement process

For example, a credit memo may already have been generated through the 
AutoInvoice program. In such cases, if a subsequent receipt is applied to the 
original transaction, the customer will be over credited.

■ Closed or Cancelled

The original deduction is not updated when the status of the deduction is 
Closed or Cancelled.

When the status of the original claim changes to Open (in cases where the status is 
Complete, Rejected, Pending Approval, or Approved), the re-open flag is checked 
to inform users that due to some changes to the transaction and deduction balance, 
the claim status has been modified. This enables users to know that the claim details 
have changed since the last time they worked on it.

Every time a customer makes subsequent payments, the claim owner receives a 
workflow notification. You can drill down back to the Claim Details page by 
clicking the claim number in the notification. The deduction keeps an audit trail of 
all receipts affecting it at any point of time.

10.7.14.2 Transaction-related Deduction With Splits
If a previous deduction exists for a transaction and has been split, the original 
deduction or root deduction, which is still referenced in Oracle Receivables and the 
child deductions, which are not referenced in Oracle Receivables but maintained in 
Trade Management) may be at various statuses. Therefore, when subsequent 
receipts are received for a deduction that has been split, the balances of multiple 
deductions may need to be reduced. The manner in which these child deductions 
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get processed will be determined by their statuses. However, the sequence in which 
the amount will be reduced will be prioritized based on status as follows:

1. Open

2. Complete

3. Rejected

4. Pending Approval

5. Approved

In the following example, the root deduction has not been completely split out and 
is still in Open status.

Receipt 1. A root deduction DED1 of $10,000 is created, originally of unknown 
reason, was found to be due to different causes upon investigations, and was 
therefore split into multiple child deductions.

Receipt 2. After the deduction was created and split, subsequently, another receipt is 
applied on the transaction for $3,000. Based on the status prioritization, therefore, it 
will only reduce the balances for the following deductions in the following order:

1. DED1

2. DED 1_3

3. DED 1_2

The balances in each of the deductions is reduced as follows. The claim status 
changes accordingly.

Deduction Claim Reason Remaining Amount Status

DED 1 Unknown $2000 Open

DED 1_1 Shipping $5000 Pending Close

DED 1_2 Promotions $2500 Pending Approval

DED 1_3 Pricing Errors $500 Open

Deduction Claim Reason Remaining Amount Status

DED 1 Unknown $0 Cancelled

DED 1_1 Shipping $5000 Pending Close



Claim Settlement

Claim and Deduction Management 10-65

Receipt 3. Another receipt for $1,000 comes in and is applied on the transaction. 
Now only DED1_2 will be updated.

If there are no more subsequent receipts, DED 1_2 will be processed further and will 
be submitted for approval. The status changes along with the approval flow. No 
subsequent receipts can be applied after the status changes to Pending Close.

10.7.15 Claim Settlement Methods
There are various claim settlement methods that are available in Oracle Trade 
Management. The settlement method that you can use depends upon the claim 
type. Table 10–3 describes the various settlement methods that are available in 
Oracle Trade Management.

DED 1_2 Promotions $2000 Open

DED 1_3 Pricing Errors $0 Cancelled

Deduction Claim Reason Remaining Amount Status

DED 1 Unknown $0 Cancelled

DED 1_1 Shipping $5000 Pending Close

DED 1_2 Promotions $1000 Open

DED 1_3 Pricing Errors $0 Cancelled

Note: When a claim is not related to any promotions, and you 
wish to settle the claim with a credit memo or a debit memo, you 
can use memo lines to settle the claim. See Section 10.7.16, "About 
Standard Memo Lines" for more information.

Table 10–3 Claim Settlement Methods

Settlement Method Description

Check Claim is settled by issuing a check to the customer.

Invoice credit memo Invoice credit memos reduce a customer’s invoice balance to 
settle a valid deduction.

Deduction Claim Reason Remaining Amount Status
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10.7.16 About Standard Memo Lines
When a claim or deduction is not related to any promotions, and upon validations, 
you wish to settle it with a credit memo or debit memo, Oracle Trade Management 
integrates with Oracle Receivables to account these transactions. The Autoinvoice 
program in Oracle Receivables depends on the autoaccounting setups to find the 
correct GL accounts.

Standard memo lines are commonly used by companies in auto-accounting setups 
for items which are not part of their normal inventory. You can pass a memo line to 
Oracle Receivables, thereby enabling the auto accounting setups. Memo lines can be 
used when you settle claims with either a credit memo or a debit memo. Standard 
Memo Lines can be an input into autoaccounting in Oracle Receivables to account 
for freight, revenue, autoinvoice clearing, tax, unbilled receivable, and unearned 
revenue.

On-account credit memo On-account credit memos reduce a customer’s account balance 
to settle a valid deduction.

Previous on-account 
credit memo

Previous on-account credit memo is an on-account credit 
memo that exists in Oracle Receivables, and is still open. If 
there is an existing credit memo, then you need not create a 
new credit memo. You can instead select the existing credit 
memo to reduce a customer’s balance and settle a valid 
deduction.

Write-off Write-off enables you to settle valid deductions and 
overpayments. You can write off deductions if they are so 
small that it is not worth to spend time and resources to 
research them. When you settle a deduction with a write-off, it 
means that your organization is absorbing the claim amount 
or deduction as an expense. On the other hand, you can settle 
an overpayment with a write-off, when the overpayment is 
significantly small. In this case, customers will lose the amount 
that they have overpaid.

Return Material 
Authorization (RMA)

RMA is issued to handle valid product returns (damaged 
goods, faulty equipment, and so on). When you create an 
RMA, a credit memo is generated to settle the deduction.

Contra charge Contra charge enables you to settle valid deductions made by 
customers who are also vendors. When you settle a deduction 
with a contra charge, the customer’s balance is adjusted in 
Oracle Receivables and Oracle Payables.

Table 10–3 Claim Settlement Methods

Settlement Method Description
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To settle claim or a deduction with a standard memo line, you must select "Memo 
Lines" from the setup type drop-down list in the Claim Creation page. You can view 
the list of all the active memo lines that have been created for the operating unit of 
the claim. After you select a particular memo line, the other fields on the same claim 
line will be affected:

■ If the memo line was set up with any Unit List Price, the price will default into 
the Price field on the claim line. You can override this.

■ The "Line/Product" LOV becomes blank.

You can still access Associate Earnings from this claim line, but if earnings have 
been associated, then the memo line information is replaced by the associated 
earnings information. For example, the claim line may show the inventory item 
number instead of the memo line.

Validation
The validation process for standard memo lines includes the following:

Validation of Associate Earnings

■ Where standard lines are used in Autoaccounting setups for the revenue 
account the following may occur:

■ If the "Post to GL" flag is checked in System Parameters, and a claim line 
has associated earnings, then the Oracle Receivables Clearing account from 
the Claim Type or System Parameters will be passed to Oracle Receivables 
as the "Revenue" account when the credit memo and debit memo are 
created through Autoinvoice. Memo lines are not used or passed in such 
cases.

■ If the "Post to GL" flag is not checked in System Parameters, but a claim line 
has associated earnings, then the claim line references an inventory item. If 
not, the system gives an error message.

■ Validation of Autoaccounting Setup

From Autoaccounting setups, if the memo line is used to derive the revenue 
account, then when you initiate claim settlement by submitting it for 
approval, each of the claim lines are validated to check if either an 
inventory item or a memo line has been selected. If any of the claim lines 
does not contain either of these, the system gives an error message.
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10.7.17 Settling Claims, Debit Claims, Deductions, and Overpayments
Topics included are:

■ Section 10.7.17.1, "Settling Claims for Related Customer Accounts"

■ Section 10.7.17.2, "Settling Promotional Claims for Buying Groups"

■ Section 10.7.17.3, "Settling a Claim or a Deduction With an On-account Credit 
Memo"

■ Section 10.7.17.4, "Settling a Claim With a Contra Charge"

■ Section 10.7.17.5, "Settling a Claim With a Check"

■ Section 10.7.17.6, "Settling a Claim With Invoice Credit"

■ Section 10.7.17.7, "Settling a Debit Claim or an Overpayment With a Debit 
Memo"

■ Section 10.7.17.8, "Settling a Deduction With a Previous Credit Memo"

■ Section 10.7.17.9, "Settling a Deduction With an Invoice Credit or an Invoice 
Line Credit"

■ Section 10.7.17.10, "Settling a Deduction With an Invoice Tax Only Credit"

■ Section 10.7.17.11, "Settling a Deduction With a Chargeback"

■ Section 10.7.17.12, "Settling a Deduction With a Write-off"

■ Section 10.7.17.13, "Settling a Deduction With a Return Materials Authorization"

■ Section 10.7.17.14, "Settling an Overpayment With A Previous Debit Memo"

■ Section 10.7.17.15, "Settling an Overpayment With A Receipt Write-off"

■ Section 10.7.17.16, "Settling an Overpayment With an On-account Cash 
Application"

10.7.17.1 Settling Claims for Related Customer Accounts
Sometimes you may want to settle claims for accounts that are related to the 
customer. Related Customer accounts are set up with relationships; common 
relationships include bill-to and ship-to. For example, the headquarters of an 
organization may be set up as the bill-to account and location for multiple retail 
stores. Each retail store can be set up as a ship-to account and location. In addition, 
the headquarters office may be handling all the claims for retail stores, but these 
retail stores may ultimately receive their payment directly. Use this procedure to 
settle claims for related customer accounts.
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Prerequisites
An existing claim with a status of Open or Complete.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Click the Settlement side navigation link in the Claim Details page.

4. In the Claim Settlement page, optionally select the Effective Date of settlement, 
Settlement Method, and the GL Date.

5. Optionally select the Previous Open Credit Memo number to settle the claim 
with an open credit memo.

6. Optionally select the RMA Transaction Type to settle the claim with an RMA.

7. Select the Pay Related Customer check box, and select the Relationship Type 
(parent, reciprocal, or all), the Related Customer, and the Related Site.

8. complete any additional fields in the Claim Settlement page.

9. Click Request Approval.

10. Click Confirm.

10.7.17.2 Settling Promotional Claims for Buying Groups
Buying groups are formed when organizations group themselves to leverage their 
buying power. For example, you create a promotion for a buying group. When 
buying group members place orders, accruals for each member are tracked 
individually, even though the buying group entity may be handling all the invoices 
and claims for the group. During claim settlement, you can view the buying group 
member accruals and decide whether to issue payment to the buying group, or 
directly to one of its members. Use the following procedures to settle promotional 
claims for buying groups.

Prerequisites
■ Buying groups and members must be set up.

■ A promotional claim for a buying group with a status of Open or Complete.
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Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Click the Lines side navigation link in the Claim Details page.

4. Create claim lines as necessary.

See Section 10.3.16, "Creating Claim Lines" for information on creating claim 
lines.

5. Click Update.

6. Click the corresponding Associate Earnings icon.

7. Select a Buying Group.

The values that are available depend upon where the customer is in the buying 
group hierarchy.

8. Select Display Children.

The accruals for the buying group members are displayed.

9. Proceed to associate earnings.

10. After associating earnings, click the Settlement side navigation link.

11. In the Claim Settlement page, select Credit Memo - On Account as settlement 
method, and complete any additional fields as required.

12. Click Request Approval.

13. Click Confirm.

10.7.17.3 Settling a Claim or a Deduction With an On-account Credit Memo
You can use an on account credit memo to settle a claim or deduction. The claim or 
deduction does not have to be related to a promotion. Deductions may or may not 
be transaction-related. Use the following procedure to settle a claim or a deduction 
with an on-account credit memo.

Prerequisites
■ An existing claim or deduction with a status of Open or Complete.

■ Oracle Receivables has been set up.
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Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Click the Lines side navigation link in the Claim Details page.

4. Select Credit Memo - On Account from the Settlement Method drop-down list, 
and optionally select a tax code.

5. Verify that at least one claim line with a positive value exists.

If a claim line does not exist, create one now. See Section 10.3.16, "Creating 
Claim Lines" for information on creating claim lines. The sum of the claim lines 
can be less than the total claim amount, because taxes will be added. For 
example, you have a claim for $1000, but the claim lines total $950. When the 
credit memo is created, $90 in taxes is added, thus creating a credit memo for 
$1040. The claim is settled for $1000.

The difference of $40 is compared to your write-off threshold. If the difference is 
less than the threshold, it is written off. If the difference is more than the 
threshold, a split claim for $40 is created.

6. Optionally, if products are entered on the lines, enter a quantity, UOM, and 
price.

All of this information is passed to the credit memo.

7. Optionally, check to see if earnings have been associated to the claim line.

You will see a check mark in the Associate Earnings column.

8. Click the Settlement side navigation link.

9. As required, complete any additional fields in the Claim Settlement page.

10. Click Request Approval.

11. Click Confirm.

10.7.17.4 Settling a Claim With a Contra Charge
A contra charge is a European-specific settlement whereby if a customer has 
balances in Oracle Receivables as well as Oracle Payables, then these balances can 
be offset by the deduction settlement. Use the following procedure to settle a claim 
with a contra charge.
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Prerequisites
Oracle Receivables and Oracle Payables must have been set up.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Click the Lines side navigation link in the Claim Details page.

4. Select Contra Charge from the Settlement Method drop-down list.

5. Verify that at least one claim line with a positive value exists. If a claim line does 
not exist, create one now. The sum of the claim lines must equal the total claim 
amount.

6. Click the Settlement side navigation link.

7. As required, complete any additional fields in the Claim Settlement page.

8. Click Request Approval.

9. Click Confirm.

10.7.17.5 Settling a Claim With a Check
You can issue a check to settle a claim. Use the following procedure to settle a claim 
with a check.

Prerequisites
A claim with the status of Open or Completed.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Click the Lines side navigation link in the Claim Details page.

4. Select Check from the Settlement Method drop-down list, and optionally select 
a tax code.
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5. Verify that at least one claim line with a positive value exists. If a claim line does 
not exist, create one now. Because taxes will be added, the sum of the claim 
lines can be less than the total amount of the claim.

6. Optionally, check to see if earnings have been associated to the claim line.

You will see a check mark in the Associate Earnings column.

7. Click the Settlement side navigation link.

8. As required, complete any additional fields in the Claim Settlement page.

9. Click Request Approval.

10. Click Confirm.

10.7.17.6 Settling a Claim With Invoice Credit
An invoice credit reduces the balance of an invoice. Use the following procedure to 
settle a claim with invoice credit.

Prerequisites
■ A claim with a status of Open or Completed.

■ Integration with Oracle Receivables and Oracle Payables must be set up.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Click the Lines side navigation link in the Claim Details page.

4. Select Credit Memo - Invoice from the Settlement Method drop-down list. The 
tax code used is the one used on the invoice.

5. Verify that an invoice number is entered in a claim line.

6. Click the Settlement side navigation link.

7. As required, complete any additional fields in the Claim Settlement page.

8. Click Request Approval.

9. Click Confirm.
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10.7.17.7 Settling a Debit Claim or an Overpayment With a Debit Memo
Debit memos are used to settle debit claims.You can also use a debit memo to settle 
an overpayment for various reasons. For example, a customer took a deduction that 
was not valid, but was still issued a credit. Later, the customer decides to pay back 
the credit. This payment results in an overpayment claim that can be settled with a 
debit memo. Use the following procedure to settle a debit claim or an overpayment.

Prerequisites
Oracle Receivables must be set up.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Click the Lines side navigation link in the Claim Details page.

4. Select Debit Memo from the Settlement Method drop-down list, and optionally 
select a tax code.

5. Verify that at least one claim line with a negative value exists. If a claim line 
does not exist, create one now. Because taxes will be added, the sum of the 
claim lines can be less than the total amount of the claim.

For example, we have a claim for $1000. The claim lines total $950. When the 
debit memo is created, $90 in taxes is added, thus creating a debit memo for 
$1040. The claim is settled for $1000. The difference of $40 is compared to your 
write-off threshold. If the difference is less than the threshold, it is written off. If 
the difference is more than the threshold, a split claim for $40 is created.

6. Optionally, if products are entered on the lines, enter a quantity, UOM and 
price.

All of this information is passed to the debit memo.

7. Optionally, check to see if earnings have been associated to the claim line.

You will see a check mark in the Associate Earnings column. For a debit claim, 
the Associate Earnings page will display negative accruals.

8. Click the Settlement side navigation link.

9. As required, complete any additional fields in the Claim Settlement page.

10. Click Request Approval.
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11. Click Confirm.

10.7.17.8 Settling a Deduction With a Previous Credit Memo
Previous credit memo is an existing credit memo, which you can use to settle a 
deduction. The credit memo might already exist because of a previous RMA, or 
perhaps as a result of data imported from third party or legacy systems. The 
deduction may or may not be transaction-related. Use the following procedure to 
settle a deduction with a previous credit memo.

Prerequisites
■ A deduction with the status of Open or Completed.

■ An existing credit memo, which can be used to settle the deduction.

■ Oracle Receivables must be set up.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Click the Lines side navigation link in the Claim Details page.

4. Select Credit Memo - On Account from the Settlement Method drop-down list.

5. Verify that at least one claim line with a positive value exists. If a claim line does 
not exist, create one now. The sum of the claim lines must equal the total claim 
amount.

6. Click the Settlement side navigation link.

7. From the Previous Open Credit Memo LOV, select a credit memo with a large 
enough balance to offset the deduction.

8. Use the transaction number, transaction type, location, source, or reference to 
search for the credit memo. Notice that you can see the balance due, GL date, 
and transaction dates for the credit memos.

9. As required, complete any additional fields in the Claim Settlement page.

10. Click Request Approval.

11. Click Confirm.
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10.7.17.9 Settling a Deduction With an Invoice Credit or an Invoice Line Credit
An invoice credit reduces the balance of an invoice, whereas an on account credit 
memo reduces the customer balance. You can use an invoice credit to settle a 
deduction whether it is transaction-related or not. Currently, an invoice credit 
cannot be used to settle a promotion-related deduction. Use an on-account credit 
memo for this purpose.

You can use an invoice line credit to settle a transaction-related deduction that has 
occurred because of a reason that can be traced back to a particular invoice line 
item. The deduction cannot be promotion related. Use the following procedure to 
settle a deduction with an invoice credit or an invoice line credit.

Prerequisites
Oracle Receivables must be set up.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Click the Lines side navigation link in the Claim Details page.

4. Select Credit Memo - Invoice from the Settlement Method drop-down list. The 
tax code used is the one used on the invoice.

5. If this is an invoice credit, then verify that an invoice number is entered in a 
claim line. Otherwise, proceed to the next step.

If this is not an invoice credit, then create a claim line now. For a 
transaction-related deduction, this invoice number must be the same as the one 
on which the deduction was created. For a non-transaction-related deduction, 
this invoice number must be on the same receipt as the deduction. If the invoice 
numbers do not match, then the settlement is not automated. Instead, a manual 
settlement workflow is initiated and notification is sent to any Oracle 
Receivables user with the Receivables Role responsibility.

6. If this is an invoice line credit, then verify that an invoice number is entered in a 
claim line, the invoice line is selected, and the line amount is a positive value.

Multiple invoice lines can be entered, each as a separate claim line. The sum of 
the claim line amounts must equal the total claim amount.

7. Click the Settlement side navigation link.
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8. As required, complete any additional fields in the Claim Settlement page.

9. Click Request Approval.

10. Click Confirm.

10.7.17.10 Settling a Deduction With an Invoice Tax Only Credit
You can use a tax only credit to settle a deduction that occurred because of tax 
calculation errors. The deduction can be transaction-related; it cannot be related to a 
promotion. Use the following procedure to settle a deduction with an invoice tax 
only credit.

Prerequisites
Oracle Receivables must be set up.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Click the Lines side navigation link in the Claim Details page.

4. Select Credit Memo - Invoice from the Settlement Method drop-down list.

5. Verify that an invoice number is entered in a claim line. If not, select an invoice 
number now.

6. Select Tax from the Credit To drop-down list.

For a transaction-related deduction, this invoice number must be the same as 
the one on which the deduction was created. If it is not, the settlement process is 
not automated. A manual settlement workflow is initiated and notification is 
sent to any Oracle Receivables user with the Receivables Role responsibility.

7. Verify that the line amount is a positive value. The sum of the claim line 
amounts must equal the total claim amount.

8. Click the Settlement side navigation link.

9. From the Previous Open Credit Memo LOV, select a credit memo with a large 
enough balance to offset the deduction.

10. Use the transaction number, transaction type, location, source, or reference to 
search for the credit memo.
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Notice that you can see the balance due, GL date, and transaction dates for the 
credit memos.

11. As required, complete any additional fields in the Claim Settlement page.

12. Click Request Approval.

13. Click Confirm.

10.7.17.11 Settling a Deduction With a Chargeback
If you determine that a deduction is not valid, then you can charge the customer 
back. For a transaction-related deduction, the customer on the original transaction is 
charged. For non-transaction related deductions, the customer on the receipt is 
charged back. Use the following procedure to settle a deduction with a chargeback.

Prerequisites
Oracle Receivables must be set up.

Steps

1. Log into Oracle Trade Management as Oracle Trade Management User and 
navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Click the Lines side navigation link in the Claim Details page.

4. Select Chargeback from the Settlement Method drop-down list.

5. Verify that at least one claim line with a positive value exists. The sum of the 
claim line amounts must equal the total claim amount.

6. Click the Settlement side navigation link.

7. As required, complete any additional fields in the Claim Settlement page.

8. Click Request Approval.

9. Click Confirm.

Note: The tax code is not used or passed by Oracle Trade 
Management.
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10.7.17.12 Settling a Deduction With a Write-off
The deduction must be transaction-related for the write off settlement to be 
automated. In the deduction is non transaction-related, a settlement workflow 
notification is sent to Oracle Receivables. The Oracle Receivables individual must 
create some form of adjustment. When complete, the Oracle Receivables individual 
updates the notification with the adjustment record, and the deduction closed in 
Oracle Trade Management.

Prerequisites
Oracle Receivables must be set up.

Steps

1. Log into Oracle Trade Management as Oracle Trade Management User and 
navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Click the Lines side navigation link in the Claim Details page.

4. Select Write-off from the Settlement Method drop-down list.

5. Verify that at least one claim line with a positive value exists. If a claim line does 
not exist, create one now. The sum of the claim lines must equal the total claim 
amount.

6. Click the Settlement side navigation link.

7. As required, complete any additional fields in the Claim Settlement page.

8. Click Request Approval.

9. Click Confirm.

10.7.17.13 Settling a Deduction With a Return Materials Authorization
When a customer returns a product, you can use the RMA settlement method in 
Oracle Trade Management to settle the deduction. When the return is processed and 
a credit memo is generated, Oracle Trade Management automatically tracks the 

Note: The tax code is not used or passed by Oracle Trade 
Management.
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credit memo and uses it to close the deduction. Use the following procedure to 
settle a deduction with an RMA.

Prerequisites
Order Management and Oracle Receivables must be set up.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Click the Lines side navigation link in the Claim Details page.

4. Select RMA from the Settlement Method drop-down list, and select a value 
from the RMA Transaction Type LOV.

The RMA transaction types are set up with return order workflows which drive 
all of the processes that the return order must go through.

5. Verify that at least one claim line with a positive value exists. If a claim line does 
not exist, create one now. The sum of the claim lines can be less than the total 
claim amount, because taxes will be added.

For example, you have a claim for $1000, but the claim lines total $950. When 
the credit memo is created, $90 in taxes is added, thus creating a credit memo 
for $1040. The claim is settled for $1000. The difference of $40 is compared to 
your write-off threshold. If the difference is less than the threshold, it is written 
off. If the difference is more than the threshold, a split claim for $40 is created.

6. Select or type values as appropriate for the Line/Product, Quantity, UOM and 
Price fields.

7. Click the Settlement side navigation link.

8. As required, complete any additional fields in the Claim Settlement page.

9. Click Request Approval.

10. Click Confirm.

10.7.17.14 Settling an Overpayment With A Previous Debit Memo
Use a debit memo to settle an overpayment claim. In certain cases, a debit memo 
may already exist, perhaps because of data imported for third party or legacy 
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systems. In these cases, use the open debit memo for settlement rather than creating 
a new one.

Prerequisites
■ An overpayment with the status of Open or Completed must exist

■ Integration with Oracle Receivables must be set up.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management and navigate 

to Claim > Claims.

2. Click the hyperlink of the claim.

3. Click the Lines side navigation link.

4. Select Debit Memo from the Settlement Method drop-down list.

5. Verify that at least one claim line with a negative value exists.

If a claim line does not exist, create one now. The sum of the claim lines must 
equal the total claim amount.

6. Click the Settlement side navigation link.

7. In the Previous Open Debit Memo field, select a debit memo with a large 
enough balance to offset the overpayment.

Use the transaction number, transaction type, location, source, or reference to 
search for the debit memo. Notice that you can see the balance due, GL date, 
and transaction dates for the debit memos.

8. As required, complete any additional fields in the Claim Settlement page.

9. Click Request Approval.

10. Click Confirm.

10.7.17.15 Settling an Overpayment With A Receipt Write-off
Use the following procedure to settle an overpayment with a receipt write-off.

Prerequisites
Oracle Receivables and Oracle Payables have been set up.
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Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Click the Lines side navigation link.

4. Select Write off from the Settlement Method drop-down list.

5. Verify that at least one claim line with a negative value exists. If a claim line 
does not exist, create one now. The sum of the claim lines must equal the total 
claim amount.

6. Click the Settlement side navigation link.

7. As required, complete any additional fields in the Claim Settlement page.

8. Click Request Approval.

9. Click Confirm.

10.7.17.16 Settling an Overpayment With an On-account Cash Application
When a customer has overpaid for various reasons, the overpayment can be placed 
on account. The overpayment amount can be applied to the customer’s 
transactions. Use the following procedure to settle an overpayment with an 
on-account cash application.

Prerequisites
■ An overpayment with the status of Open or Completed.

■ Oracle Receivables must be set up.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Click the Lines side navigation link in the Claim Details page.

4. Select On Account Credit from the Settlement Method drop-down list.

5. Verify that at least one claim line with a negative value exists. If a claim line 
does not exist, create one now. The sum of the claim lines must equal the total 
claim amount.
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6. Click the Settlement side navigation link.

7. As required, complete any additional fields in the Claim Settlement page.

8. Click Request Approval.

9. Click Confirm.

10.8 Reports
Topics included are:

■ Section 10.8.1, "Claim Report"

■ Section 10.8.2, "Claim Aging View"

■ Section 10.8.3, "Claim Settlement History"

10.8.1 Claim Report
Claim Report is a summary of essential claim details that can be printed without 
having to navigate to different screens. The claim report includes the Customer 
Details, information on the Adjusted amount, settled amount, and the currency 
type, Settlement method, Payment details, Vendor details, and Claim lines. Use the 
following procedure to view the claim report of a claim.

Prerequisites
An existing claim.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Click the Report side navigation link in the Claim Details page.

10.8.2 Claim Aging View
Claim Aging View gives a summary of claims and deductions by customer and by 
days due. It adheres to the bucket definitions in Oracle Receivables, but centralizes 
all claims and deductions by customer for easy viewing. From this view, you can 
determine which customer has had outstanding claims for the longest period time 
and work on those claims. You can optionally create claims, update write-off flags, 
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and settle claims from the Claims Aging View. Aging buckets can also be configured 
in Oracle Receivables for claim and deduction purposes. Use the following 
procedure to view claims aging.

Prerequisites
Open claims must exist.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims Aging.

The summary of all claims and deductions by customer and by days due is 
displayed.

2. To view the outstanding claims for a customer, drill down the amount in the 
corresponding columns.

For example, to view all the claims that have been outstanding for a customer 
for 31-60 days, drill down the corresponding amount in 31-60 Days Past Due 
column. The list of all claims that have been outstanding for 31-60 days, for the 
selected customer, is displayed.

10.8.3 Claim Settlement History
The Claim Settlement History report enables you to view all the information that is 
related to the settlement of a claim.

The Claim History Settlement page displays the following information:

■ Claim number, date, class, type, amount, status

■ Customer Name

■ Effective Date of the settlement

■ Settlement Method

■ GL Date

■ Related Customer

If this field is empty when a claim is closed, then it is not displayed on the 
Claim History Settlement page.

■ Relationship Type with the Related Customer.

■ Related Site (the Related Customer’s bill-to site)
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■ Vendor and vendor site (Vendor’s physical location)

■ Comments

Use the following procedure to view the claim history.

Prerequisites
An existing claim.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Claim > Claims.

2. Click the hyperlink of the claim.

3. Click the History side navigation link in the Claim Details page.

The Claim History page appears and this page displays all history records of 
the claim.
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11
Indirect Sales Management

Sections in this chapter include:

■ Section 11.1, "Overview"

■ Section 11.2, "Chargeback and Third Party Accruals"

■ Section 11.3, "Indirect Inventory Tracking"

■ Section 11.4, "Special Pricing and Soft Funds"

■ Section 11.5, "Referrals"
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11.1 Overview
Indirect Sales Management is the process by which a manufacturer validates 
requests, and manages and tracks funds when trade promotion activities are 
executed indirectly through retailers and wholesalers (or dealers and distributors). 
The Indirect Sales Management functionality includes the following features:

■ Chargeback

The manufacturer may have different pricing agreements with some 
end-customers who buy products indirectly through distributors. Sometimes, 
distributors may have to sell products to these end-customers at a price that is 
lesser than their acquisition cost. In such cases, they may chargeback the 
manufacturer to claim the difference amount.

■ Third Party Accruals

Third party accruals include discounts and accruals that are applicable to 
retailers, or other channel partners. Wholesalers may track this data and submit 
requests on behalf of the retailers to claim these accruals.

■ Special Pricing

Retailers or wholesalers request the manufacturer for a special price or discount 
to dispose existing inventory, meet a competitor’s price, or to win a deal for an 
existing customer.

■ Soft Funds

Retailers or wholesalers execute trade promotion activities on behalf of the 
manufacturer, and request for a budget to execute these activities.

■ Referral Management

Retailers or wholesalers refer a business prospect, lead, or an opportunity to a 
manufacturer. If the referral results in an order, they can claim incentive for the 
referral.

Chargeback and Third Party Accrual data are managed in Oracle Trade 
Management whereas Special Pricing, Soft Funds, and Referrals are features that are 
available in Oracle Partner Management. When there are approved requests related 
to Special Pricing, Soft Funds, or Referrals, offers and claims are automatically 
generated in Oracle Trade Management; these claims are settled by the claims user.
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11.2 Chargeback and Third Party Accruals
Retailers or end-customers may buy products directly from the manufacturer, or 
through wholesalers. Sometimes, to honor agreements that manufacturers have 
with individual customers or buying groups, the wholesalers sell products at a price 
that is lesser than their acquisition cost. Wholesalers submit claims to claim back the 
difference amount from the manufacturer. These claims are known as chargebacks.

Third Party Accruals are payments that must be made to the end-customer. The 
accrual may be a discount or incentive that the manufacturer wants to give to the 
end-customer, or it may be a result of the end-customer buying the products from a 
wholesaler who charges a price higher than the price agreement between the 
manufacturer and end-customer. This amount is accrued and paid to the 
end-customer.

Topics included are:

■ Section 11.2.1, "Understanding Chargebacks"

■ Section 11.2.2, "Understanding Third Party Accruals"

■ Section 11.2.3, "Working With Chargeback and Third Party Accrual 
Transactions"

11.2.1 Understanding Chargebacks
Topics included are:

■ Section 11.2.1.1, "Overview"

■ Section 11.2.1.2, "Process Flow"

■ Section 11.2.1.3, "Chargeback Submission"

■ Section 11.2.1.4, "Chargeback Validation"

■ Section 11.2.1.5, "Chargeback Tolerances"

■ Section 11.2.1.6, "Chargeback Reconciliation"

■ Section 11.2.1.7, "Chargeback Settlement"

Note: chargebacks are claimed by wholesalers, whereas third 
party accruals can be claimed either directly by the retailer or 
end-customer, or the wholesaler on behalf of the retailer or 
end-customer.
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■ Section 11.2.1.8, "Chargeback Statuses"

11.2.1.1 Overview
Manufacturing organizations face the challenge of handling rebates and chargeback 
claims for their customers and wholesaler networks. These organizations pay 
accruals to indirect and direct customers. Chargeback in Oracle Trade Management 
enables organizations to accurately create and report accruals, and efficiently 
validate and process the monthly chargeback claims that they receive from 
wholesalers.

In the scenario above, the manufacturer has different pricing agreements with the 
wholesaler and the retailer. If the manufacturer sells products to the retailer through 
a wholesaler, then the wholesaler purchases products from the manufacturer at an 
agreed price. This price can be higher than the price agreement that the 
manufacturer has with the retailer. The wholesaler then resells the products to the 
retailer according to the pricing agreement that the manufacturer has with the 
retailer.

The manufacturer incurs a chargeback for this transaction as below:

1. Manufacturer sells to the wholesaler at $100

2. Wholesaler resells to end-customers at $60

3. Wholesaler submits a chargeback of $40 to the manufacturer

Depending upon how Oracle Trade Management is implemented in your 
organization, the chargeback data may be used for third party accruals and indirect 
inventory tracking for wholesalers.
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11.2.1.2 Process Flow
Figure 11–1 illustrates the process flow for chargebacks, starting from chargeback 
submission to chargeback settlement.

Figure 11–1 Process Flow for Chargebacks

Chargeback Submission
Wholesalers or distributors may send chargeback data and claims through the 
Oracle XML Gateway. Oracle Trade Management supports EDI 844 and EDI 867 
formats. See the Oracle XML Gateway User Guide for more information. The 
chargeback process automatically runs, and in the meantime, you can see the status 
as "Processing".

They may also send the data in the form of paper documents. You can upload this 
into Oracle Trade Management, and process it further. If wholesalers want to 
change certain information in the chargebacks that were originally submitted, they 
can resubmit them.

Validate Chargeback
The system checks whether the wholesaler is a valid party in Oracle Trading 
Community Architecture (TCA), and automatically performs inventory verification, 
item verification, and price agreement verification. If any of these validations fail, 
then the system will not process the chargebacks. Notifications are sent to the 
submitter.

Reconcile Chargeback
If the chargeback is valid, then the chargeback amount for each chargeback line is 
posted against a budget. The Administrator specifies the budget source as a profile 
value. The amount in the utilized and earned columns of the budget increase.

Settle Chargeback
A single chargeback claim is automatically created against the chargeback 
transaction. If there are any disputes regarding the chargeback transaction, then the 
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Administrator can initiate the claim for the chargeback lines without disputes. All 
chargeback earnings are automatically associated to the claim.

11.2.1.3 Chargeback Submission
Wholesalers may submit chargebacks in one of the following ways:

■ Flat Files (.csv files)

Wholesalers may send chargebacks in the form of .csv files. You can import 
these files into Oracle Trade Management by using the upload tool provided by 
WebADI.

■ Paper documents

Wholesalers may submit chargebacks in the form of paper documents such as 
paper receipts. You can manually convert these paper documents into electronic 
format and upload the data by using the upload tool provided by WebADI.

■ XML Gateway

Wholesalers or distributors may send chargeback data and claims through the 
Oracle XML Gateway. Oracle Trade Management supports EDI 844 and EDI 867 
formats. See the Oracle XML Gateway User Guide for more information. The 
chargeback process automatically runs, and in the meantime, you can see the 
status as "Processing".

The submitted chargeback may have one or more associated chargeback lines. 
Chargeback lines include transaction-related information such as Customer ID, 
Product ID, Sale price and wholesaler acquisition price, Quantity of the product 
purchased, Customer contract, Customer authorization, Order number and order 
date, and the Differential amount (the amount charged back).

For example, a wholesaler submits a chargeback as follows:

Here, the individual rows are the chargeback lines.

Customer 
ID

Product 
ID

Sale 
Price

Acquisition 
Price

Quantity 
Purchased

Order 
No.

Order 
Date

Chargeback 
amount

A X $40 $50 100 123 Jan 1 $1000

A Y $25 $30 50 245 Jan 30 $250

B Y $20 $30 80 624 Jan 15 $800

C X $45 $50 100 254 Jan 25 $500
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Chargeback Resubmission
After wholesalers submit chargebacks, if they wish to change information in 
chargebacks that were originally submitted, they can make changes and resubmit 
them. They may:

■ Resubmit a transaction multiple times

A wholesaler may try to resubmit a chargeback repeatedly. If a wholesaler tries 
to submit the same chargeback twice, the transaction is rejected because the 
transaction lines will be exactly the same. The submitter gets notified 
accordingly.

■ Resubmit a transaction to handle corrections and disputes

Disputes may occur if wholesalers submit erroneous or incorrect chargebacks. 
In such cases, the manufacturer can inform the wholesaler about the errors and 
disputes, and the wholesaler can resend the transaction with corrections. 
During resubmission, if the original submission has been paid, then the 
chargeback engine reprocesses these lines and reverses the old accruals. The 
system creates new accruals, but associates only the difference amount to the 
claim.

For example, Goodway submits a chargeback a transaction for $1000. You, the 
manufacturer find that Goodway is eligible to chargeback only $500, and you 
make a payment for $500. The chargeback engine creates accruals for $500. 
However, Goodway feels that it is eligible to receive $1000 and not $500, and 
resubmits the chargeback transaction with the corrected data. You accept that 
Goodway is eligible to receive $1000, and make another payment for $500. The 
chargeback engine now reverses the $500 accruals that were created during the 
first submission, and creates new accruals for $1,000.

If the original submission has not been paid, then the submission is treated as a 
new one, and amount for the corrected lines is paid.

■ Resubmit the same transaction with additional chargeback lines

A wholesaler may resubmit a chargeback with added chargeback lines. In these 
cases the chargeback engine processes only the new lines. If wholesalers 
resubmit the same transaction with additional chargeback lines, they must 
explicitly flag the lines that must be reprocessed. A combination of the 
wholesaler number, customer number, order number, order or invoice date, 
product number, and transaction code is used to determine whether the 
transaction has been processed before, and to identify duplicate chargeback 
lines.



Chargeback and Third Party Accruals

11-8 Oracle Trade Management User Guide

You can view chargeback lines and the associated errors, and make manual 
corrections to the claim in the Chargeback Transaction Data Management page. All 
the transaction data is maintained to ensure accuracy and resolve future disputes. 
End-customer sales information such as product number, and price is captured and 
stored for reporting and auditing capabilities. The Administrator in your 
organization can also implement an option whereby you can create relationships 
between the end-customer and the wholesaler.

Information regarding the end-customers such as sales, identification, product 
number and price is captured and stored for reporting and auditing capabilities. 
These indirect customers are created as parties and accounts in TCA. They can 
optionally have a "Customer of" relationship with the wholesaler. During 
chargeback submission, an API call is made to the Data Quality Management 
(DQM) application in TCA. Based on data checking rules that are set up in DQM, 
the chargeback system finds the corresponding party ID that has been set up in 
TCA. If the party does not exist, a new party will automatically be created in TCA.

The Administrator can configure different rules in DQM. The required options must 
be set in System Parameters for the chargeback system to pass to DQM different 
rules. See the Oracle Trade Management Implementation Guide for more information.

11.2.1.4 Chargeback Validation
When a wholesaler submits chargebacks, validation is automatically done to check 
if the end-customer is a valid party in Oracle Trading Community Architecture 
(TCA). Depending upon how Oracle Trade Management is implemented in your 
organization, one or more of the following validations take place:

■ Wholesaler inventory verification

The wholesaler's chargeback volume is validated against the inventory level of 
your products that the wholesaler possesses. The wholesaler's inventory level 
may be automatically tracked in Oracle Trade Management. This tracks 
quantity of the products that a wholesaler purchases from your organization 
and quantity of products that the wholesaler has sold. See Section 11.3, "Indirect 
Inventory Tracking" for more information.

If the quantity of products that the wholesaler claims to have sold is more than 
the quantity of products in his inventory, then the chargeback transaction is not 
processed. 

For example, a wholesaler submits chargeback for product X for different 
periods:
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Validation is done to ensure that the wholesaler had 10,000 or more in quantity 
for Product X on Mar 1, 2004. Chargeback is not paid for more than 10,000 units. 
This validation also ensures that the wholesaler does not charge back for a 
product that was bought from a different manufacturer.

■ Item verification

Codes and IDs that a wholesaler uses for the chargeback data (whether coming 
through EDI, XML gateway or by flat files) may not correspond to the internal 
codes and IDs that are used by your organization. The Administrator in your 
organization can map reference information such as wholesaler item numbers, 
unit of measurement, wholesaler’s end-customer number, price agreement 
number, and the corresponding internal codes and IDs. After the information is 
mapped, whenever a wholesaler submits a chargeback transaction, the 
chargeback engine automatically looks up the corresponding internal 
information.

■ Acquisition cost verification

A wholesaler may buy products from the manufacturer at an agreed price, and 
sell it at a different price to the end-customer. When a wholesaler submits a 
chargeback to claim this difference amount, validation is done to check whether 
this difference amount is accurate. This is done by checking the price, which the 
wholesaler has originally paid for the products that he has purchased from the 
manufacturer. Validation is automatically done and the calculated chargeback is 
displayed. You can summarize the calculated chargeback by Product, 
Agreement, or Customer. You may process the chargeback based on these 
calculations, or you may change the calculated chargeback and then process it 
further.

■ Price list verification

A price list specifies the price that must be offered to a customer. Chargeback 
lines refer to the price list that is used to calculate and offer the selling price to 
the customer. If the chargeback transaction does not quote any list, then the 
chargeback is not processed. However, if the chargeback line includes a price 
list, verifications are automatically made to check whether the:

Order Order Date Quantity

1 March 1, 2004 10,000

2 April 20, 2004 20,000

3 May 15, 2004 10,000
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■ List is valid on the invoice date indicated on the chargeback data

■ Customer is specified in the chargeback, and the sale price is valid

The market eligibility of the agreement lists all members who are eligible for the 
price. Price Lists can be directly linked to an end-customer or with a buying 
group to which the customer belongs.

11.2.1.5 Chargeback Tolerances
The Administrator can set thresholds limits for discrepancies in chargeback 
submissions. When a wholesaler submits a chargeback transaction, the Processing 
Engine checks whether the chargeback amount sent by the wholesaler matches the 
amount that is calculated by your organization. If the discrepancy is within the 
tolerance levels set, then the chargeback is paid. If the difference is more than the 
tolerance level, then the chargeback transaction is considered as a disputed one, and 
is not processed. Tolerances can be set up for individual wholesalers in their Trade 
Profiles. Tolerances can also be set in System Parameters whereby the same 
tolerance level will be applicable to all wholesalers who deal with your 
organization.

Tolerances can be set in terms of either a percentage or an amount for every 
chargeback transaction (header tolerance), and every chargeback line (line 
tolerance) in a chargeback transaction. Chargeback tolerances can be either:

■ Positive: amount claimed by the wholesaler is more than the manufacturer’s 
calculation

■ Negative: amount claimed by the wholesaler is less than the manufacturer’s 
calculation

Depending upon the implementation setups in your organization, you may 
override chargeback tolerances while processing the transaction. When you 
override a tolerance, the system tracks the action and keeps a record of the tolerance 
being overridden.

Tolerances are used as follows:

■ After a wholesaler submits a chargeback transaction, chargeback lines are 
checked against line tolerance.

■ After all the lines are checked, the amount for all those lines which are marked 
as within tolerance, are added. This amount is again checked against header 
tolerance.

■ If the total amount is still within header tolerance, all lines that are marked as 
below header tolerance will be processed. If the total amount is greater than 
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header tolerance, you must uncheck some of the chargeback lines to be 
processed even though the lines may fall within line tolerance.

For example, in a manufacturing organization, tolerance levels are set as follows:

Header tolerance = $100
Line tolerance = $50

A wholesaler submits a chargeback transaction with three lines as shown below:

In this case, the total lines marked as within line tolerance = $150 ($50+$100). This is 
greater than header tolerance of $100. This means that the wholesaler is claiming 
lesser than the manufacturer’s calculation (Negative tolerance). Therefore, the batch 
will be considered as disputed. However, if users in the manufacturing organization 
have an option to override the tolerance level, they can override header tolerance 
and make payment.

11.2.1.6 Chargeback Reconciliation
After a chargeback is validated, chargeback processing occurs based on the 
implementation setups in your organization.

■ The Administrator can set the option in System Parameters to accrue funds for 
chargebacks. This option determines whether chargebacks will debit up front 
accruals (created by offers or fully accrued budgets), or will simply calculate 
payment during chargeback processing. This option enables you to forecast the 
chargeback amount and accrue for it up front when sales orders are shipped to 
a wholesaler.

For example, the previous year total sales of an organization was $10 million. 
The organization finds that for a particular wholesaler, the chargeback total was 
$1 million in the previous year. It therefore estimates that about 10% of this 
year's sales will again be claimed by the same wholesaler as chargebacks. To do 
this, the organization creates an accrual offer, or a fully accrued budget with a 
rate of 10% that gets calculated and accrued every time the wholesaler makes 
purchases in the current year. This pool of accruals will be used to make 
payments to the wholesaler.

Wholesaler’s claim Manufacturer’s calculation Difference Amount

$300 $350 $50

$450 $550 $100

$400 $400 -NA-
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If this option is implemented, then:

■ The Utilized and Earned columns in the Budget increase whenever 
automatic adjustments are made.

■ The Paid column increases for the amount of the chargeback claim after 
approval.

 To accrue funds for chargeback, you can create either of the following:

■ Accrual offers (Accrual offers, Volume offers, Lump sum offers, or Scan 
Data offers).

■ Fully Accrued Budget. While creating the budget, you must set the fully 
accrued budget to "Accrue to Customers" and check the Liability flag. 

After the chargeback process, when payment is initiated for the chargeback 
submission, based on this option being checked, the following occur:

1. The system checks for existing accruals for these offers or fully accrued 
budgets.

2. If it finds chargeback accruals, then the market and product eligibility of the 
submitted chargeback transactions are matched with those of the offer. 
Payment is initiated only if these conditions match.

3. If there are multiple accrual records, then the oldest accruals are paid first.

For example, the system tracks the following accrual records for a 
wholesaler:

If the wholesaler submits a chargeback transaction for $250 for Product A, 
then $100 is paid against Order 1, and $150 is paid against Order 2. If the 
wholesaler submits a chargeback transaction for $400 for Product B, then 
$400 is paid against Order 2 only.

Automatic adjustments are made if funds in the accrual offer or the fully 
accrued budget are not sufficient to pay the chargeback amount. In the above 
example, if the wholesaler submits a second chargeback transaction for $500 for 

Order Number Order Date Product Amount

1 September 1, 2003 Product A $100

2 September 2, 2003 Product A
Product B

$200
$500

3 September 3, 2003 Product B $300
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Product A, then because the balance accruals available for Product A is $50, an 
automatic adjustment up of $450 is made before creating the chargeback 
payment claim record.

However, if accruals are created by Lump sum offers with spread, then 
adjustments are made only if the chargeback amount is above the total lump 
sum amount.

For example, a Lump sum offer with spread is created for $100 for 100 days. 
Therefore an amount of $1 is accrued on a daily basis. The amount accrued on 
the 50th day will be $50. A wholesaler submits a claim for $100 on the 50th day 
of the offer, and the payment is made even though the amount is more than 
what has been accrued on the 50th day. However, if on the 60th day the 
wholesaler submits another chargeback transaction for $20, then because that 
total payment has already exceeded the total lump sum amount, an adjustment 
of $20 is made automatically.

However, if the amount claimed in the form of chargeback claims is lesser than 
the amount in the accrual offer or fully accrued budget, no automatic 
adjustments are made to decrease the amount in the offer or budget because 
additional chargeback claims may come in the future.

For example, if the available accruals for a product are $500 and a chargeback 
claim comes in for $200, no adjustments are made to decrease the available 
accruals.

All the claims, accruals, and adjustments that are created will have references to 
the chargeback transaction and lines to enable you to make reverse adjustments 
if required.

■ If the option to accrue funds for chargebacks is not implemented, then the 
Administrator can specify the budget source as a profile value. Accruals for the 
chargebacks are created and associated on the claim payment record. The 
amount for each chargeback line is posted against the budget. The Utilized and 
Earned columns are increased accordingly. The Paid column gets updated after 
the claim is approved.

Irrespective of the implementation setups, the budget posting contains the 
following information which can be used to refer back in case of disputes:

■ Wholesaler number (internal account number in TCA)

■ Order number and order date
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11.2.1.7 Chargeback Settlement
If chargeback validation is completed successfully, a single chargeback claim is 
automatically created against the chargeback transaction. In the Chargeback Claim 
page, you can view the claim that is created to settle the transaction. If there are any 
disputes, the Administrator can initiate a claim for lines that are without disputes. 
Chargeback earnings are automatically associated to the claim.

For example, a wholesaler submits the following chargeback claim:

As the first step, the chargeback engine processes this transaction and posts 
adjustments against the budget as follows:

As the next step, a chargeback claim is created and earnings shown in the above 
table are automatically associated to claim lines. A credit memo is raised to settle 
the claim.

The settled claim looks as shown below along with other details such as the Claim 
number, Name of the Wholesaler organization, and Credit Memo number.

Customer Product Requested Amount

A X $1000

B X $800

A Y $200

B X $1200

Customer Product
Requested 
Amount

Processed 
Amount

Budget 
Utilization 
(Earned and 
Utilized)

A X $1000 $1000 $1000

B X $800 $800 $800

A Y $200 $200 $200

B X $1200 $1200 $1200
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If there are any typing errors in the claim or any disputed lines, they can be 
corrected, and the chargeback transactions can be reprocessed. If they are 
reprocessed after settlement, then a new claim is created and the previous budget 
adjustments are adjusted and accounted accordingly.

The claims, accruals, and adjustments that are created have references to chargeback 
transactions. This enables you to create reverse adjustments. The accrual 
adjustments that are created include references to the chargeback. Claim lines are 
automatically associated to the chargeback accruals. You can view details of the 
chargeback submission from the claim.

After the claim is settled, the system generates a message that includes information 
on adjusted lines, lines with errors, credit memo number, and claim number. 
Depending upon the System Parameters setting in your organization, one of the 
following occurs:

■ The message is automatically sent to the wholesaler

■ You can manually send the message to the wholesaler by clicking Send 
Outbound Messages

However, irrespective of the System Parameters setting, automatic messages are 
sent to wholesalers when chargeback claims are created.

Transaction data is maintained to ensure accuracy and to resolve disputes in future.

11.2.1.8 Chargeback Statuses
The following table describes the various statuses that a chargeback transaction 
may go through during the chargeback processing cycle.

Product Amount Associated Earnings

X $3000 $1000
$1200
$800

Y $200 $200

Table 11–1 Chargeback Statuses

Status Description

Open The chargeback transaction has been imported and is ready to 
be processed.
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11.2.2 Understanding Third Party Accruals
Topics included are:

■ Section 11.2.2.1, "Overview"

■ Section 11.2.2.2, "Process Flow"

11.2.2.1 Overview
Third party accruals supports indirect accruals for end-customers in cases of 
promotional accruals and price differences. Third Party Accruals refer to the 
amount that is claimed in the following situations:

■ Manufacturers deal indirectly with the retailers, who are the end-customers. 
Manufacturers may use third party accruals to offer incentives to promote sales 
to these indirect customers.

■ Manufacturers may sometimes sell directly to the retailers (end-customers). But 
sometimes, when the manufacturer is out of stock, the retailers may have to buy 
products from a wholesaler. As a result of this, the end-customers must be 
compensated for the promotions they would have qualified for had they bought 
directly from the manufacturer.

Disputed After the chargeback transaction has been imported, if the 
information is not accurate in any of the chargeback lines, the 
chargeback status appears as Disputed. You can modify the 
data in the disputed lines and process them. After you modify 
the data. the chargeback status changes from Disputed to 
Open.

Processing and Processed After you initiate data processing, the chargeback status 
changes to Processing and then to Processed. This means that 
the chargeback submission has been processed successfully 
and the funding budget has been updated. You can initiate 
payment for the chargeback transaction only when it is in the 
Processed status.

Closed The chargeback status changes to Closed after you initiate 
payment for the chargeback. A claim will be automatically 
created, and the claims user will receive a notification.

Table 11–1 Chargeback Statuses

Status Description
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In the scenario above, a retailer buys a product for $60 from a manufacturer through 
a wholesaler. The price agreement between the manufacturer and the retailer is $50 
for every unit of the product. The price agreement between the manufacturer and 
the wholesaler is $100 for every unit of the product.

The manufacturer incurs a chargeback for this transaction as below:

1. Wholesaler sells products at $60 to the retailer

2. Retailer has a price agreement with the manufacturer for $50

3. Pay back to retailer equals $10

Apart from these direct accruals, some of these purchases may be eligible for 
accruals if they had been directly purchased from the manufacturer. These accruals 
are posted against the customers. These indirect accruals are used against future 
deductions from end-customers.

11.2.2.2 Process Flow
Figure 11–2 illustrates the process flow for Third Party Accruals starting from 
request submission to request settlement.

Note: The submission and reconciliation processes, and tolerances 
are the same for Third Party Accrual data and Chargeback data. 
This section highlights the differences in the data processing for 
Third Party Accruals. For more information on submission, 
validation, tolerances, and reconciliation see Section 11.2.1, 
"Understanding Chargebacks".
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Figure 11–2 Process Flow for Third Party Accruals

Submission
Retailers may submit third party accrual requests (reimbursement requests) in the 
form of delimited files such as .csv files. You can import this data to into Oracle 
Trade Management by using the tool provided by WebADI, and process it further. If 
retailers want to change certain information in the third party accrual requests that 
were originally submitted, they can resubmit them.

Information regarding the end-customers such as sales, identification, product 
number and price is captured and stored for reporting and auditing capabilities. 
These indirect customers are created as parties and accounts in TCA. They can 
optionally have a "Customer of" relationship with the wholesaler. During third 
party accrual request submission, an API call is made to the Data Quality 
Management (DQM) application in TCA. Based on data checking rules that are set 
up in DQM, the chargeback system finds the corresponding party ID that has been 
set up in TCA. If the party does not exist, a new party will automatically be created 
in TCA.

The Administrator can configure different rules in DQM. The required options must 
be set in System Parameters for the chargeback system to pass to DQM different 
rules. See the Oracle Trade Management Implementation Guide for more information.

Validation
After the third party accrual request submission is uploaded to Oracle Trade 
Management, the system checks whether the retailer is a valid party in Oracle 
Trading Community Architecture (TCA), and performs the following validations 
automatically:

■ Item verification - The codes and IDs that a retailer uses for the third party 
accrual request may not correspond to the internal codes and IDs that are used 
by your organization. If reference information is mapped, then whenever a 
wholesaler or end-customer submits a third party accrual request, the 
chargeback engine automatically looks up the corresponding internal 
information.
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■ Price list verification - Verifications are automatically made to check whether 
the price list is valid on the invoice date indicated on the transaction data, and 
the buying price is valid.

■ Offer verification - Third party accruals are created when the customers are 
eligible to receive accruals or incentives as specified in the offers that they are 
eligible for. If the retailer or end-customer has submitted the request, then 
validation is done to check if the end-customer is included in the market 
eligibility of the offer. If wholesalers have submitted the request on behalf of the 
retailer, then validation is done to check if the end-customers have been 
included in the market eligibility of an offer, and the wholesaler is the payout 
party. An indirect sales qualifier is available in the Market Eligibility section in 
offers, which restricts offers so that they apply only to indirect sales from the 
POS data that is received.

If any of these validations fail, the system will not process the third party accrual 
requests. Notifications are sent to the submitter.

Reconciliation and Settlement
If third party accrual request validation is successful, then the offers against which 
the third party accruals are claimed, are picked up by the pricing simulations of the 
Third Party Accrual concurrent process, and created as accruals against their 
respective sourcing budgets. The chargeback amount for each line is posted against 
a budget. The Administrator specifies the budget source as a profile value. 
Chargebacks are posted to this budget. The utilized and earned amounts of the 
budget are increased.

A third party accrual claim is automatically created against the request transaction. 
If there are any disputes regarding the third party accrual request transaction, the 
Administrator can initiate a claim for lines that are without disputes. Third party 
accrual request earnings are automatically associated to the claim.

You can tripper payment for accruals on a monthly basis. You can also setup 
Autopay rules to trigger these payments automatically based on the time criteria set 
up in the trade profile auto payment rules. See the Oracle Trade Management 
Implementation Guide for more information.
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11.2.3 Working With Chargeback and Third Party Accrual Transactions

Topics included are:

■ Section 11.2.3.1, "Importing a Transaction Through WebADI"

■ Section 11.2.3.2, "Viewing and Updating Lines"

■ Section 11.2.3.3, "Accepting Disputed Lines and Processing a Submission"

■ Section 11.2.3.4, "Initiating Payment for a Transaction"

11.2.3.1 Importing a Transaction Through WebADI
Wholesalers or retailers (in case of third party accruals) may send chargebacks or 
third party accrual transactions in the form of .csv files. They may also submit the 
transactions in the form of paper documents such as paper receipts. You can 
manually convert these paper documents into electronic format and upload the data 
by using the upload tool provided by WebADI. Use the following procedure to 
import a transaction through WebADI.

Prerequisites
Customers must have submitted chargeback or third party accrual data.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management and navigate 

to Indirect Sales Management > Chargeback.

2. Click Import Batch in the Chargeback Submissions page.

3. Select Trade Management: Resale Layout from the Layout drop-down list and 
click Next.

4. Select None from the Content drop-down list and click Next.

5. Review the details and click Create Document.

Wait until the Excel document gets created. The Excel document that is 
generated appears as a template. The document will have two regions--the 
header region to enter the header information for the chargeback or third party 

Note: Throughout this section, the terms "submission", and 
"transaction" are used for representing both chargeback and third 
party accrual submissions.
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accrual transaction; and a region below the header region where you can enter 
information for the individual lines. A transaction can have any number of 
lines.

6. In the header region, enter the Batch Number, and select a Batch Type from the 
Batch Type drop-down list. Select Chargeback to create a chargeback 
transaction. Select Third Party Accrual to create a third party accrual 
transaction. The other options that are available are:

– Ship and Debit: To upload Special Pricing data.

– Tracing: If you select this option, the data will not be processed by the 
chargeback engine for validations, data conversions, or chargeback 
calculation. It will be used only for indirect inventory tracking purposes.

7. Enter the Batch Count.

This is the number of lines that the transaction will have. For example, if you 
enter the Batch Count as 5, then you must create 5 lines for the transaction.

8. Enter the other details as required in the header region.

9. In the region below the header region, complete a row each for individual lines 
by entering the required details such as the Resale Transfer Type, Transfer 
Movement Type, Transfer Date, and the other wholesaler details, end-customer 
details, and invoice and order details.

10. After entering all the information, in the Menubar, click Oracle > Upload.

A confirmation message that says that the Upload is in progress is displayed. 
You can cancel the process at any point of time by clicking Cancel. Another 
confirmation message is displayed after the document gets uploaded 
successfully.

11. Click Close.

12. Navigate to Indirect Sales Management > Chargeback.

You will see the transaction with the batch number that you had assigned to it 
while creating it. The transaction status appears as Open.

11.2.3.2 Viewing and Updating Lines
After uploading a transaction, you can view the associated lines, and modify them. 
You can also view the associated claims, and add notes and attachments to the 
transaction. Sometimes, the transaction information may not be accurate. For 
example, the order number may be missing, or you may have selected a wrong 
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pricelist. In such cases, the lines with inaccurate information are automatically 
marked as disputed. The transaction status appears as disputed if any of the lines 
are disputed. You can modify the data in the disputed lines and process them. Use 
the following procedure to view and update lines in a chargeback or third party 
accrual transaction.

Prerequisites
■ Existing chargeback or third party accrual submissions with the status of either 

Open or Disputed.

■ The submissions must have associated lines.

Steps
1. Log into Oracle Trade Management and navigate to Indirect Sales Management 

> Chargeback.

2. Click the batch number corresponding to the transaction.

3. Click View Lines.

All the chargeback lines are displayed. For each chargeback line, you can see 
details such as the Dispute Code, Transfer Type, Invoice Date, Invoice Number 
and so on.

4. If any of the lines are disputed, you can optionally add dispute codes to them. 
You can also edit the other fields as required.

5. Click Apply to save the changes that you have made.

6. Optionally, to view only the processed lines or only the disputed links, click the 
Processed Lines or Disputed Lines sub tabs respectively.

7. Optionally, click the Claims sub tab to view the claims that are associated with 
the chargeback transaction.

8. Optionally, to view existing notes, or to add new notes to the chargeback 
transaction:

a. Click the Notes sub tab.

Note: You can personalize the chargeback batch lines view to 
display specific columns on the screen. Click Personalize to 
personalize the chargeback lines view.
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If there are any existing notes, they will be displayed in the List of Notes 
region.

b. To add a new note, in the Add Notes region, select a note type from the 
Type drop-down list.

c. Optionally select a status from the Status drop-down list. See Chapter 12, 
"Common Components" for more information on note statuses.

d. Enter any form of free text, and click Add to Notes.

9. Optionally to add attachments to the chargeback or third party accrual 
transaction:

a. Click the Attachments sub tab.

b. From the Add drop-down list, select Desktop File/ Text/ URL to add a file, 
text, or URL, and click Go.

c. Enter a description for the attachment in the Attachment Summary 
Information region.

d. In the Define Attachment region, to add file as an attachment, click Browse 
and select the file that you would like to add. To add a URL or text, type the 
URL or the text in the respective fields.

e. Click Apply to add the attachment, or click Add Another to add another 
attachment.

f. Click Save.

11.2.3.3 Accepting Disputed Lines and Processing a Submission
After you have verified that all the lines are accurate, you can process a chargeback 
or third party accrual submission. If there are any disputed lines, you can accept 
them, and process the submission. The associated budget gets updated accordingly. 
Use the following procedure to process a chargeback or third party accrual 
transaction.

Prerequisites
Existing submissions with the status of either Open or Disputed.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to Indirect Sales Management > Chargeback.
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2. Click the batch number corresponding to the transaction.

3. If the transaction has any disputed lines, you must first accept the disputed 
lines:

a. Click View Lines.

b. All the lines will be displayed. The disputed lines will be marked 
accordingly.

c. Click either Accept Claimed Amount or Accept Calculated Amount.

Claimed Amount is the amount that the customer has claimed. Calculated 
Amount is the amount that you owe the customer as calculated by the 
system based on the chargeback engine validations. After you accept either 
amount, the chargeback lines will no longer be considered as disputed. The 
chargeback status changes from Disputed to Open.

4. If a transaction does not have any disputed lines, click Process to process the 
transaction.

The transaction status first changes to Processing and then to Processed. The 
Utilized column in the associated budget gets updated accordingly. You can 
review the budget by navigating to Budget > Budgets, and selecting the 
associated Budget.

11.2.3.4 Initiating Payment for a Transaction
You can initiate payment for a chargeback or third party accrual transaction after it 
has been processed successfully. The claims user will receive a workflow 
notification, and will process the payment manually by creating a claim, associating 
earnings, and by choosing a payment method. See Chapter 10, "Claim and 
Deduction Management" for more information on claim settlement and payment 
methods. The Earned column in the budget will get updated after the payment is 
made. Use the following procedure to initiate payment for a chargeback or third 
party accrual transaction.

Note: The Process button will not appear after you accept the 
disputed lines. To process the transaction after accepting the 
disputed lines, you must navigate back to the Chargeback 
Summary page and reselect the transaction.
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Prerequisites
A transaction in the Processed status.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to Indirect Sales Management > Chargeback.

2. Click the batch number corresponding to the transaction.

3. Click Initiate Payment.

The transaction status changes to Closed. The claims user will receive a 
workflow notification.

11.3 Indirect Inventory Tracking
Wholesalers may buy a number of products from your organization and store it as 
inventory. Wholesalers’ inventory levels can be automatically tracked in Oracle 
Trade Management. You can track the quantity of products that wholesalers have 
purchased from your organization and the quantity of products that they have sold.

The inventory level (in quantity) for a wholesaler is tracked as follows:

■ Beginning Inventory

The Administrator in your organization can set the period starting from when it 
would like to track the wholesalers’ inventory levels. The starting period can be 
set only once for each wholesaler. Thereafter, the system automatically 
calculates the beginning inventory levels for the next period.

■ Inventory In

Inventory In stores information of all sales data and orders placed by the 
wholesaler. It includes details of all products that the wholesaler purchases 
from the manufacturer. This data is extracted from Oracle Order Management 
and gets automatically updated. Based on the setups in your organization, the 
sales data can be converted to a common unit of measurement for products.

■ Inventory Out

Inventory Out stores information of all the indirect sales data that the 
wholesaler submits as a part of chargeback submission.

■ Adjustments
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You can manually and periodically adjust inventory levels based on validations 
from the wholesaler. You can adjust inventory levels only if you have the 
required access and responsibility. Adjustments can be either positive or 
negative. Adjustments are tracked and stored with information on the adjusted 
quantity, adjusted period, adjusted user, adjusted date, adjustment reason.

■ Ending Inventory

Ending Inventory provides information on a wholesaler’s existing inventory 
levels at any point of time.

Ending Inventory = Beginning Inventory + Inventory In - Inventory Out + 
Adjustments

11.3.1 Adjusting Indirect Inventory
Wholesalers who deal with your organization may buy a number of products in 
large quantities. You can track the quantity of products that wholesalers have 
purchased from your organization and the quantity of products that they have sold. 
You can also manually adjust the inventory levels. Use the following procedure to 
view and adjust indirect inventory.

Prerequisites
Oracle Trade Management must be fully implemented.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User 

and navigate to Indirect Sales Management > Inventory Tracking.

2. Click Adjust.

3. In the Indirect Inventory Adjustments page, enter the following details to adjust 
inventory levels for a customer:

a. Select a Customer and a Product.

b. Select an Adjustment Date. This is the date from which the adjustment will 
be effective.

c. Enter the Adjustment Quantity. Enter a positive value or a negative value 
depending on whether you would like to increase the inventory levels or 
decrease the inventory levels.

d. Select a Unit of Measurement, and a Reason Code.
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e. Click Apply.

f. Repeat the previous five steps to adjust inventory levels for another 
customer.

11.4 Special Pricing and Soft Funds
Special Pricing and Soft Funds are features that are available in Oracle Partner 
Management. Special pricing enables partners (wholesaler organizations) to request 
the vendor organization (manufacturers) for a special price or discount to sell 
products that they have not been able to move, or to win a deal for a specific, or to 
meet a competitor’s price. Soft Funds enables partners to request the vendor for a 
budget to execute sales activities such as campaigns to promote the manufacturer’s 
products. In other words the vendor requests for funds to execute trade promotion 
activities on behalf of the partner or the manufacturer. For more information on 
Special Pricing and Soft Funds, see the Oracle Partner Management User Guide.

Topics included are:

■ Section 11.4.1, "Understanding Special Pricing"

■ Section 11.4.2, "Understanding Soft Funds"

■ Section 11.4.3, "Working With Special Pricing and Soft Fund Requests"

11.4.1 Understanding Special Pricing
Special Pricing enables manufacturers (vendors) to streamline and automate the 
process by which retailers (partners) request discounts on high-volume, competitive 
sales deals. When a partner requires assistance to complete a sale in terms of 
pricing, they request you for a discount or a special price. A partner may also face 
competition from a competitor and can request you for a discount to win the 
customer.

Topics included are:

■ Section 11.4.1.1, "Process Flow"

■ Section 11.4.1.2, "Special Pricing Request Submission"

■ Section 11.4.1.3, "Special Pricing Request Approval"

■ Section 11.4.1.4, "Offer Creation and Sourcing"

■ Section 11.4.1.5, "Special Pricing Request Settlement"
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11.4.1.1 Process Flow
Figure 11–3 illustrates the special pricing process flow, starting from special pricing 
request submission to claim settlement.

Figure 11–3 Process Flow for Special Pricing

Special Pricing Request Submission
Partners or wholesalers request for a special price or discounts on competitive sales 
deals, specific end-customer deals, and on inventory that they have not been able to 
sell.

Approval
After an approver is notified of a special pricing request, the approver logs into the 
system, checks information on the request and either approves or declines the 
request. The status of the request changes accordingly. If any information is missing, 
the approver can decline the request. The partner may provide the missing 
information and resubmit the request.

Offer Creation
After the special pricing request is approved, either an Accrual offer or an 
Off-invoice offer is generated and the system creates a budget request to source 
funds to reimburse the partner.

Offer Sourcing
The offer sources funds from a budget in Oracle Trade Management after the 
budget request is approved, a notification is sent to the submitter notifying them of 
the approval.

Claim Creation and Settlement
After a sale is completed at the discounted price, the partner can submit a claim to 
collect payment. They can provide you the proof of sale and when you approve the 
request, an offer is generated. Off-invoice offers or Scan Data offers are created 
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based on whether the sale is made from new inventory, or from existing inventory. 
Partners can submit claims either manually, online or through a POS file (Point of 
Sale file). The claim is processed in Oracle Trade Management and the partner gets 
paid through check or on-account credit.

11.4.1.2 Special Pricing Request Submission
Partners can submit special pricing requests in two scenarios.

■ Existing inventory - When a partner has already bought products and wants a 
discount for previous purchases. When they request for a special price or 
discount, and you approve it, they can proceed to make the sale to 
end-customers and claim the discounted amount by providing you the proof of 
sale.

■ New inventory - When a partner requests a special price or discount for a new 
purchase and you approve it, they must book an order with you and further 
proceed to make the sale to the end-customer. After they complete the sale, they 
can provide the proof of sale to you and claim the discounted amount. You can 
either let the amount accrue or give it off the invoice.

The types of requests that partners can make are:

■ Blanket Request: When partners have inventory in the warehouse and have not 
been able to sell it, they can ask for a discount to clear the unsold inventory.

■ Bid Request: When partners want to win a deal for specific customers.

■ Meet Competitor Quote: When partners want to match a competitor’s price, 
they can ask you to reduce the price to complete a sale.

11.4.1.3 Special Pricing Request Approval
After the approver in Oracle Partner Management receives notifications of the 
special pricing request, the approver checks information on the request and 
approves or declines the request. If it is a Meet Competitor Quote or Bid Request, 
the approver checks if there are existing requests from the same customer. If a 
request exists, then the new requests (incoming request with the existing request) 
are linked.

After a special pricing request has been approved, budget requests are routed to the 
appropriate budget request approvers (as defined in the approval process 
associated with the request). Before a special pricing request is approved, a default 
budget request is generated. If you are the approver, you can source the budget 
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from one or many budgets. You can also drill into the budget tab and change the 
source of the budget.

If the Special Pricing Request approver does not specify the budget sourcing 
options during approval, the system automatically generates a default budget 
request. The approver can decide whether to use it or change it. This streamlines the 
approval process. If the approver specifies the budget sourcing options, the system 
generates budget requests based on the approver’s changes.

The budgets can be approved manually or automatically. If the Auto-approval 
feature is set in Oracle Trade Management, budgets can be approved automatically.

11.4.1.4 Offer Creation and Sourcing
After the special pricing request is approved, one of the following offers is created:

■ For new inventory, the approver can specify whether to create an Accrual or an 
Off-invoice offer.

■ For existing inventory (Ship from Stock), the system automatically generates a 
Scan Data offer.

When a budget request is approved, either an Accrual offer or an Off-invoice offer is 
generated in the background. Both the offers are generated when the partner makes 
a sale from new inventory. While submitting a request, if the Ship-from-Stock check 
box was selected, you can specify the type of offer that must be generated.

When the partner makes a sale from new inventory, a unique offer number will be 
generated and displayed in the user interface. When requests are approved with 
Off-invoice offers, this offer number can be used while placing orders. When the 
partner makes a sale from existing inventory, the offer number is the same as the 
agreement number displayed in the user interface.

11.4.1.5 Special Pricing Request Settlement
After a sale is completed at a discounted price, the partner may claim the amount 
either by submitting a claim, or by short paying an invoice. These claims and 
deductions are settled through Oracle Trade Management. Autopay must be 
enabled for these claims to be settled in Oracle Trade Management.

When partners submit claims, they can provide the proof of sale. When the special 
pricing approver approves this request, offers are automatically generated. Partners 
can submit claims either manually, online or through a a POS file (Point of Sale file) 
in one of the following ways:
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■ E-mail or fax: When partner submits a claim through e-mail or fax, the special 
pricing user can look up the request and approve or decline the claim. 

■ Online: When the claim is submitted online, the system notifies the claim 
approver who reviews the claim and approves or declines the claim.

■ As a POS file: Each POS file has a type of either Chargeback or Special Pricing. 
If the POS file is of type Special Pricing, claims are automatically generated 
from the claim data included within the POS file.

If the claim request is approved, a claim is automatically created in Oracle Trade 
Management. If the partner short pays an invoice, then it is treated as a deduction. 
If the Autopay feature has been implemented, then the customers will be paid 
automatically; else you, the claims user can settle the claims and deductions by 
associating the offer that is created. You can make payments either in the form of a 
cheque or an on-account credit. For more details on claims and claim settlement 
methods, see Chapter 10, "Claim and Deduction Management".

After the claim requests are settled, the committed, utilized, and earned columns in 
the budget get updated accordingly. Budget checkbook view gives you the exact 
status of the funds at any point of time. You can view all the special pricing offers 
that are associated with the budget by drilling down the paid columns in the 
budget. See Chapter 9, "Budget Management" for more details.

11.4.1.6 Special Pricing Request Statuses
Special pricing request statuses enable you to know the exact status of a special 
pricing request. Table 11–2 describes the various statuses that a special pricing 
request may go through.

Table 11–2 Special Pricing Request Statuses

Status Description

Draft A request has been created but has not yet been submitted for 
approval. A request in the Draft status can be edited.

Pending Approval The request has been submitted for approval. From Pending 
Approval, the status may change to either Declined or 
Approved. You cannot modify the information in the request 
after you submit it for approval.

Approved The status changes to Approved if all the approvers approve 
the request.

Declined The status changes to Declined if either the special pricing 
approver or the budget approver declines the request.
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11.4.2 Understanding Soft Funds
Soft Funds enables vendors to set aside funds to support the trade promotion 
activities of a partner. By assisting partners financially, a partner remains motivated 
and this also helps in building loyalty. The vendor can provide funds for specific 
time periods and base it on fiscal periods of their organization.

Topics included are:

■ Section 11.4.2.1, "Process Flow"

■ Section 11.4.2.2, "Soft Fund Statuses"

11.4.2.1 Process Flow
Figure 11–4 illustrates the soft fund process flow, starting from soft fund request 
submission to claim settlement.

Figure 11–4 Process Flow for Soft Funds

Soft Funds Request Submission
A partner requests for soft funds to execute certain trade promotion activities on 
behalf of the vendor.

Fund Request Approval
When partners submit soft fund requests, they must first be approved by the 
vendor approver. Approvers are internal employees or vendors that are defined in 
AME. They are notified based on rules defined in AME. When the approver 

Archived This means that the request has been archived.

Cancelled The status appears as Cancelled if the request has been 
cancelled.

Table 11–2 Special Pricing Request Statuses

Status Description
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receives a fund request notification, they review the request and check for duplicate 
requests. The approver may either accept or decline the request.

If it is a valid request, the vendor approver checks whether the requested fund 
amount is feasible or not. If it is not feasible, or if the approver requires extra 
information to be able to approve the request, the approver returns the request and 
asks the partner to provide additional information. When the partner resubmits the 
request after providing the additional information required by the vendor, the 
request is routed to the first level approver defined in Oracle Approval 
Management. If the fund request is approved, a budget request is submitted to 
source funds from a budget in Oracle Trade Management.

Budget Sourcing
After the vendor approver approves the fund request, the soft fund sources funds 
from a budget in Oracle Trade Management. The budget source is specified as a 
profile value and the system creates a budget request to source funds from this 
budget. If the Auto-approval option is set, then the budget request is automatically 
approved. If the Auto-approval option is not set, then the request is routed to the 
budget approver.

The budget approver reviews the budget request and may approve or decline the 
request. If the budget approver approves the request, a notification is sent to 
submitter notifying them of the approval.

Claim Creation and Settlement
After the budget request is approved and the partner has executed the desired 
activity, they can submit a claim to redeem the funds. They can specify the actual 
amount spent on the activity and the amount claimed for the activity. When the 
vendors submit claims, the system notifies the claim approver in Oracle Trade 
Management. The claims approval flow begins and the claims approver verifies the 
claim information and approves the request. If Autopay has been implemented, 
then the partner or the wholesaler will be paid automatically; else, you, the claims 
user can manually settle the claims by associating earnings and choosing a payment 
method. You can pay the partner either through on-account credit memo, or by 
check.

After the claims are settled, the committed, utilized, and earned columns in the 
budget get updated accordingly. The budget checkbook view gives you the exact 
status of the funds at any point of time. You can view all the soft fund requests that 
are associated with the budget by drilling down the paid columns in the budget. 
See Chapter 9, "Budget Management" for more details.
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11.4.2.2 Soft Fund Statuses
Soft fund statuses enable you to know the exact status of a soft fund request. 
Table 11–3 describes the various statuses that a soft fund request may go through.

11.4.3 Working With Special Pricing and Soft Fund Requests
Topics included are:

■ Section 11.4.3.1, "Creating and Submitting a Special Pricing Request"

Table 11–3 Soft Fund Statuses

Status Description

Draft A request has been created but has not yet been submitted for 
approval. A request in the Draft status can be edited.

Pending Approval The request has been submitted for approval. From Pending 
Approval, the status may change to either Declined or 
Approved. You cannot modify the information in the request 
after you submit it for approval.

Returned The request has been returned by approver asking for 
additional information.

Return Request Request has been returned when information or collateral is 
missing and the return reason is Collateral Submission 
Required.

Approved The status changes to Approved if all the approvers approve 
the request.

Declined The status changes to Declined if either the special pricing 
approver or the budget approver declines the request.

Archived This means that the request has been archived.

Closed The status appears as Closed if the request has been archived 
after "x" days. The date is greater that the waiting period that 
is specified in the system profile. The status gets changed to 
Closed after "x" days by running a concurrent program.

Deleted The status appears as Cancelled if the request has been 
cancelled.

Void The status appears as Void if the request has been cancelled by 
a vendor super user in the vendor or wholesaler organization. 

Cancelled The status changes to Cancelled if a super user cancels the 
request when it is invalid.
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■ Section 11.4.3.2, "Viewing and Editing Special Pricing Request Details"

■ Section 11.4.3.3, "Creating and Submitting a Soft Fund Request"

■ Section 11.4.3.4, "Viewing and Editing Soft Fund Request Details"

■ Section 11.4.3.5, "Approving, Rejecting, or Reassigning a Special Pricing or a 
Soft Fund Request"

■ Section 11.4.3.6, "Approving a Budget Request for Special Pricing or Soft Funds"

■ Section 11.4.3.7, "Submitting a Special Pricing Request Claim"

■ Section 11.4.3.8, "Submitting a Soft Fund Request Claim"

■ Section 11.4.3.9, "Settling a Special Pricing or a Soft Fund Claim"

■ Section 11.4.3.10, "Viewing Claims and Budgets Associated With a Special 
Pricing or a Soft Funds Request"

11.4.3.1 Creating and Submitting a Special Pricing Request
Special Pricing requests can be created in Oracle Partner Management and also from 
Oracle Trade Management. Use the following procedure to create a special pricing 
request from Oracle Trade Management.

Prerequisites
None.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Indirect Sales Management > Special Pricing Request.

2. Click Create.

3. In the Create Special Pricing Request page, select a distributor from the 
Distributor LOV.

This is the wholesaler or distributor organization for whom you are creating the 
special pricing request.

4. Select a Requestor’s Name; values for the Requestor Phone and Requestor 
E-mail default in.

The Requestor is the contact person in the wholesaler organization. The list of 
values that appears here depends upon the wholesaler organization that you 
have selected in the Distributor LOV.
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5. Select a Request Type, and optionally select the Ship From Stock check box.

The Ship From Stock check box determines whether you will make the sale 
from new inventory or from the existing inventory.

6. Optionally enter a name and description.

7. Select the End Date. The Start Date will be the current date by default. You can 
change the Start Date, and Currency if required.

8. Click Next.

9. Enter the details as required in the End Customer Details region.

The End Customer is the customer to whom the wholesaler intends to sell the 
products.

10. In the Products region, enter the details of the products for which you would 
like to request for a special price or discount. Complete a row for each product.

11. Optionally add notes in the notes region by selecting a Type, and entering any 
form of free text, and clicking Add to Notes. All the notes that you add will 
appear in the List of Notes region.

12. Click Save to save the special pricing request and to submit it at a later point of 
time.

13. If you wish to submit the request immediately, then click Submit.

14. Click Confirm in the Preview Submission page.

The special pricing request status changes to Pending Approval. The special 
pricing request approver will receive a workflow notification.

11.4.3.2 Viewing and Editing Special Pricing Request Details
After creating or uploading a special pricing request, you can view the information 
associated with the request and modify the data. You can also view the associated 
notes and add attachments. Use the following procedure to view and update special 
pricing request details.

Note: The special pricing request does not require approval if you 
are the creator and approver according to the special pricing 
request approval rules.
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Prerequisites
A special pricing request in the Draft status.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Indirect Sales Management > Special Pricing Request.

2. Click the Details icon corresponding to the special pricing request.

All the special pricing request details such as details of the distributor, 
end-customer, and products are displayed.

3. Modify the data as required.

4. Optionally, to view existing notes, or to add new notes to the special pricing 
request:

a. Click the Notes sub tab.

If there are any existing notes, they will be displayed in the List of Notes 
region.

b. To add a new note, in the Add Notes region, select a note type from the 
Type drop-down list.

c. Optionally select a status from the Status drop-down list. See Chapter 12, 
"Common Components" for more information on note statuses.

d. Enter any form of free text, and click Add to Notes.

5. Optionally to add attachments to the special pricing request:

a. Click the Attachments sub tab.

b. From the Add drop-down list, select Desktop File/ Text/ URL to add a file, 
text, or URL, and click Go.

c. Enter a description for the attachment in the Attachment Summary 
Information region.

d. In the Define Attachment region, to add file as an attachment, click Browse 
and select the file that you would like to add. If you wish to add a URL or 
text, then type the URL or the text in the respective fields.

e. Click Apply to add the attachment, or click Add Another to add another 
attachment.

f. Click Save.
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11.4.3.3 Creating and Submitting a Soft Fund Request
Special Pricing requests can be created in Oracle Partner Management and also from 
Oracle Trade Management. Use the following procedure to create a soft funds 
request on behalf of a partner or a wholesaler.

Prerequisites
None.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Trade Planning > Soft Fund Requests.

2. Click Create Request.

3. In the Create Funds Request page, select a partner from the Partner LOV.

This is the wholesaler or distributor organization for whom you are creating the 
special pricing request.

4. Select a Requestor’s Name.

The Requestor is the contact person in the wholesaler organization. The list of 
values that appears here depends upon the wholesaler organization that you 
have selected in the Partner LOV.

5. Select a Benefit Name and an Activity from the respective LOVs.

The activity field determines the activity that will be carried out with the fund.

6. Select a Start Date and End Date for the fund.

This is the range that the fund will be valid for.

7. Enter a name and description in the Request Name and Description fields.

8. Select a currency from the Currency drop-down list, and enter the amount 
requested for the fund, in the Requested Amount field. If the partner is 
contributing towards the fund, then enter the partner’s contribution in the 
Partner Contribution field.

9. Click Next.

10. Select a Request Type, and optionally select the Ship From Stock check box.

The Ship From Stock check box determines whether you will make the sale 
from new inventory or from the existing inventory.

11. Optionally enter a name and description.
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12. Select the End Date. The Start Date will be the current date by default. You can 
change the Start Date, and Currency if required.

13. Click Next.

14. Enter details in the Expense Breakdown region.

This is the breakdown of expenses for the trade promotion activity. The 'Total' 
and 'Requested Amount' are amounts that will be utilized for an activity.

15. Enter details in the Performance Objectives region.

This is the outcome that is expected for an activity. This information will enable 
you to measure the success of your trade promotion expenditure.

16. Enter details in the Products region.

These products are the products that will be promoted by the trade promotion 
activity.

17. Enter details in the Geography region.

These are the geographical regions where the trade promotion activity will be 
executed.

18. Optionally add notes in the notes region by selecting a Type, and entering any 
form of free text, and clicking Add to Notes. All the notes that you add will 
appear in the List of Notes region.

19. Optionally add attachments to the soft fund request.

20. Click Save to save the changes.

21. Click Submit to submit the request for approval.

22. Click Confirm.

The soft fund request status changes to Pending Approval. The special pricing 
request approver will receive a workflow notification.

11.4.3.4 Viewing and Editing Soft Fund Request Details
After creating or uploading a special pricing request, you can view the information 
associated with the request and modify the data. You can also view the associated 

Note: The soft fund request status does not require approval if 
you are the creator and approver according to the approval rules.
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notes and add attachments. Use the following procedure to view and update special 
pricing request details.

Prerequisites
A special pricing request in the Draft status.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Trade Planning > Soft Fund Requests.

2. Click the Details icon corresponding to the soft fund request.

All the soft fund request details such as the expense breakdown, performance 
objectives, products, and geography will be displayed.

3. Modify the data as required, and click Save.

11.4.3.5 Approving, Rejecting, or Reassigning a Special Pricing or a Soft Fund 
Request
If you are the approver for a special pricing request or a soft fund request, then you 
will receive workflow notifications whenever a request is submitted for approval. 
You can accept, reject, or reassign the request to another approver. After the 
alternate approver approves the request it continues through the approval 
workflow process. Use the following procedure to accept, reject, or reassign a 
request.

Prerequisites
A special pricing request or soft fund request must have been submitted for 
approval.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and do 

either of the following:

– Navigate to Indirect Sales Management > Special Pricing Request to 
approve, reject or resign a special pricing request.

– Navigate to Trade Planning > Soft Fund Requests to approve, reject or 
resign a soft fund request.

2. Click the Details icon corresponding to the special pricing request or soft fund 
request you would like to approve, reject, or reassign.
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If it is a special pricing request, then all the details such as details of the 
distributor, end-customer, and products are displayed. If it is a soft fund 
request, then details such as the expense breakdown, performance objectives, 
products, and geography will be displayed.

3. Review the details and click Continue.

4. To approve a special pricing request, click Approve, and click Confirm in the 
Approve Special Pricing Request page. For soft fund requests, you must enter 
the approved amount in the Request Approval page, and then click Confirm.

5. To reject the request, click Decline, and select a Decline Reason in the Decline 
Special Request page or the Decline Request page (in case of soft fund requests), 
and then click Decline again.

6. To reassign the request to another, click Reassign, select an Approver’s name in 
the Reassign Request Approval page, and click Confirm.

11.4.3.6 Approving a Budget Request for Special Pricing or Soft Funds
After a special pricing request has been approved by the special pricing request 
approver, an off-invoice offer or an accrual offer will be generated in the 
background. These offers must source funds from a budget to offer the discounts or 
the special price. Even in case of soft fund requests, funds must be sourced from an 
existing budget. The budget sourcing options for special pricing requests and soft 
fund requests are specified in System Parameters. If you are the owner of the 
budget that will fund these requests, then you will receive notifications if the 
Auto-approval feature is not set. Use the following procedure to approve a budget 
request for a special pricing request or a soft funds request.

Prerequisites
A special pricing request or a soft funds request must have been submitted. They 
must have been approved by the respective approvers.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management Super User, 

and navigate to Workflow > Worklist. You can also launch the worklist by 
navigating to Home > Tools > View Notification Work List.The list of open 
notifications is displayed.

2. Select the notification that corresponds to the request that must be approved.

3. Click Approve.
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11.4.3.7 Submitting a Special Pricing Request Claim
If you have appropriate permissions you can submit claims on behalf of partners, to 
get reimbursed for the discounted amount. While submitting a claim off line, 
partners may manually send you the claim information, that is, their proof of 
performance, and then you can submit the claim on their behalf. Use the following 
procedure to submit a special pricing request claim.

Prerequisites
An approved special pricing request must exist.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Indirect Sales Management > Special Pricing Requests.

2. Click the Submit Claim icon corresponding to the special pricing request for 
which you would like to submit the claim.

11.4.3.8 Submitting a Soft Fund Request Claim
If you have appropriate permissions you can submit claims on behalf of partners, to 
get reimbursed for the discounted amount. While submitting a claim off line, 
partners may manually send you the claim information, that is, their proof of 
performance, and then you can submit the claim on their behalf. Use the following 
procedure to submit a soft funds request claim.

Prerequisites
An approved soft funds request must exist.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Trade Planning > Soft Fund Requests.

2. Click the Submit Claim icon corresponding to the soft funds request for which 
you would like to submit the claim.

3. In the Claim Details region, select the customer name from the Pay To LOV.

4. Select a Payment Type and Reason, and optionally enter your comments.

5. Review the fund request details and the performance objectives.

6. In the Expense Breakdown region, enter the amount spent for each activity.
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This will give a breakdown view of how and what exactly the funds have been 
spent for.

7. Click Submit.

11.4.3.9 Settling a Special Pricing or a Soft Fund Claim
After special pricing or soft fund claims are submitted, these claims are treated as all 
the other claims in Oracle Trade Management. The claims user can view the claims 
that have been submitted for special pricing or soft funds, and settle them. If you 
are the claims user and the person who is responsible for settling claims that are 
related to special pricing or soft funds, then you must settle these claims from the 
Claims tab. Check and On-account credit memo are the two settlement methods 
that are available for special pricing and soft fund claims.

For the detailed procedures on how to settle claims with a check or a credit memo, 
see Section 10.7.17, "Settling Claims, Debit Claims, Deductions, and Overpayments" 
in the Claims chapter.

11.4.3.10 Viewing Claims and Budgets Associated With a Special Pricing or a 
Soft Funds Request
After a special pricing request or a soft funds request is submitted for approval, you 
can view the budget details. After the request has been processed, you can also 
view the claim details. Use the following procedure to view claims and budgets that 
are associated with a special pricing request or a soft fund request.

Prerequisites
■ To view the associated budget, the special pricing request or soft funds request 

must have been submitted for approval.

■ To view the associated claims, claims must have been created for the special 
pricing request or the soft fund request.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and do 

either of the following:

– Navigate to Indirect Sales Management > Special Pricing Request to view 
the view the budgets and claims that are associated with a special pricing 
request.
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– Navigate to Trade Planning > Soft Fund Requests to view the budgets and 
claims that are associated with a soft fund request.

2. Click the Details icon corresponding to the special pricing request or soft fund 
request you would like to approve, reject, or reassign.

If it is a special pricing request, then all the details such as details of the 
distributor, end-customer, and products are displayed. If it is a soft fund 
request, then details such as the expense breakdown, performance objectives, 
products, and geography will be displayed.

3. Click the Claims sub tab to view the associated claims.

If there are any claims that have been created to settle the request, they will be 
displayed here.

4. Click the Budgets sub tab to view the budgets from which funds have been 
sourced for the request.

A list of all the budgets from which the request is sourcing funds from will be 
displayed here.

11.5 Referrals
Referral Management is a feature that is available in Oracle Partner Management 
whereby the partner (retailer or wholesaler) refers a business prospect, lead, or an 
opportunity to a vendor (manufacturer). If the referral results in an order, the 
partner can claim incentive for the referral. When partners claim incentives, offers 
and claims are automatically generated in Oracle Trade Management, and these 
claims are settled by the claims user. For more information on Referral 
Management, see Oracle Partner Management User Guide.

11.5.1 Process Flow
Figure 11–5 illustrates the process flow for referrals, starting from referral 
submission to claim settlement.
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Figure 11–5 Process Flow for Referrals

Submission
A partner submits a referral. Alternately, the vendor can also submit referrals on 
behalf of a partner. After a referral is submitted, it has to be approved by the 
appropriate person. If it is approved, a lead is created in the system. If it is rejected, 
the partner is notified accordingly.

Referral Validation and Approval
The approver reviews the referral, searches for duplicate referrals, and approves or 
declines the referral. Before approving the referral, the approver checks if the 
referral matches any existing referral, lead, opportunity, and contact.

Lead-Opportunity Conversion and Offer Creation
If the lead is converted to an opportunity and the opportunity results in an order, an 
offer is generated in Oracle Trade Management.

Claim Creation and Settlement
If a partner’s referral results in orders in the system, they have to be compensated 
for the same. Whenever a referral results in a successful order, the partner accrues 
incentives accordingly. These accruals are accumulated in the partner’s account. 
This offer sources funds from a budget. The Administrator specifies the budget 
source as a profile value. Accruals that are claimed by the partner are posted for 
orders that are placed and shipped.A claim is automatically created in Oracle Trade 
Management after shipments for the order are complete. The claim is routed to the 
claims user who views the claim and adjusts the claim amount if necessary. The 
compensation is posted to the partner for acceptance. If the partner accepts the 
claim, the claim is processed further and settled.



Referrals

11-46 Oracle Trade Management User Guide



Common Components 12-1

12
Common Components

Sections in this chapter include:

■ Section 12.1, "Collaboration"

■ Section 12.2, "Security and User Types"

■ Section 12.3, "User Profile Overview"

■ Section 12.4, "Trade Profile"

■ Section 12.5, "System Parameters"

■ Section 12.6, "Custom Setups, Mandatory Rules, and Locking Rules"
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12.1 Collaboration
Sales organizations are composed of teams that include many team members. 
Budget, Offer, and Claim collaboration enables you to communicate and coordinate 
the efforts within the team to deal with problems and track them. You can create 
contact points for different trade promotion objects and activities (budgets, offers, 
claims, and so on), communicate with the team members through notes and 
attachments, assign and keep track of tasks, and add or remove team members or 
groups from the activities of the trade promotion object.

Topics included are:

■ Section 12.1.1, "About Notes, Tasks, and Attachments"

■ Section 12.1.2, "Creating and Editing a Note"

■ Section 12.1.3, "Creating a Task"

■ Section 12.1.4, "Adding and Modifying an Attachment"

■ Section 12.1.5, "Adding or Removing a Contact Point"

■ Section 12.1.6, "Adding or Removing Groups and Users From an Offer"

12.1.1 About Notes, Tasks, and Attachments
Topics included are:

■ Notes

■ Tasks

■ Attachments

Notes
Notes enables you write and record information that you would like to 
communicate to others who deal with a trade promotion object at various levels. 
You can create any number of notes, and edit and modify notes. In Oracle Trade 
Management, you can associate notes to trade promotion objects such as budgets, 
offers, quota, and claims. When you create a note, you must select a category. This 
enables all the users concerned with that category to view the notes.

For example, to create a note for the approvers of an offer, you must select the 
category--"Approval" and create the note. This enables the approvers to view this 
note when the offer is submitted for approval.
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When you create a note, you can make it public or private, or publish it. When you 
make the note public, everyone can view the note. If the note is private, only you 
can view the note. If you publish the note, only your team members will be able to 
view the note. Notes can be used from different applications in the Oracle 
E-Business Suite and are stored in the same Notes table.

The key features of notes are as follows:

■ Notes are displayed with their type, text, author, and date

■ You can capture large amounts of data, such as log files and text

■ Notes can be translated to other languages

■ Notes can be private (only you can access it) or public (other users can read 
from or write to it)

■ Note types are available to categorize business transactions such as searching 
for a note

■ You can attach text, files, or URLs to a note

■ Notes can be up to 32K in size

■ You can refine your note search by entering Related To information or selecting 
a match option.

Tasks
Tasks enables you to assign follow-up activities such as resolving problems related 
to the budget, offer, claim, and so on. A task may be a follow-up action, a reminder, 
or a daily work assignment. For example, a support manager of a company may 
want to create a task for an employee stating, “Please call back customer by 
9:00am.” This task specifies that the employee must call back the customer.

When you create a task, you must specify certain parameters such as the priority of 
the task, the scheduled date, and the group or team member to whom you assign 
the offer. You can also create a task hierarchy and create many sub tasks under a 
parent task.

You can perform the following activities related to tasks:

■ Create tasks of specific task types and associate them to customers

■ Relate tasks to business objects, and assign tasks to specific resources

■ Define and manage your task efforts

■ Add notes and attachments to add more details to your tasks
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■ View and modify the details of a task in the Task Details page

■ View your tasks in the Tasks Summary page

■ Use Task Search to create personalized saved searches that you can use to 
search for tasks

■ Create repeating tasks to reoccur during a specific interval such as every day

■ Manage task contacts

■ Mass create tasks for a team or group

The task status appears as In Planning when the task is in the planning stage. The 
task status changes to Assigned after you assign the task to the group or a team 
member. If the task is complete, the group or the team member can close the task, 
after which the task status appears as Closed.

For any task, the owner and the assignee have complete access to view and update 
the task. You can assign only private tasks to an assignee. For example, if you give 
access to a resource B for all tasks, then the privileges are granted only for private 
tasks. An assignee cannot delete the private task.

You can also add notes and attachments to a task. You can edit, delete, view, update, 
and search for a task only if you fulfill one of the following conditions:

■ You are the owner or assignee of the task

■ You have access to the task

■ You are a team member of the group that is either the owner or assignee of the 
task

Attachments
Attachments are used for sharing and storing information about trade management 
activities. You can add files, text, or web addresses as attachments to budgets, 
offers, and claims. After you add the attachments, the associated team members can 
access and download them.

For example, you create an offer for a customer to offer an incentive if the customer 
displays a product banner in his store for one month. The customer performs as 
expected and raises a claim. You have a photograph of the banner display as proof 
of performance. You scan this photograph and add it as an attachment to the claim.
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12.1.2 Creating and Editing a Note
The following procedure describes how to create and edit a note for a budget. You 
can also use this procedure to create and edit a note for any trade promotion object.

Prerequisites
An existing budget.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Budget > Budgets.

2. Click the hyperlink of the budget.

3. Click the Collaboration side navigation link, and then click Notes.

4. Click Create.

5. Select a note type from the Type drop-down list.

The note will be classified based on the type that you select. This will enable 
you to search for notes belonging to a particular type.

6. Select the Status.

7. Type in any form of free text for the note. If the text is more than what the field 
can hold, click More and enter the text.

8. Click Create.

9. Click Create and Create Another to create another note immediately.

12.1.3 Creating a Task
The following procedure describes how to create a task for an offer. Use this 
procedure to create a task for any other trade promotion object. However, a budget 
cannot have any tasks associated with it.

Prerequisites
An existing offer.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Trade Planning > Offers.
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2. Click the Collaboration side navigation link, and then click Tasks.

3. Click Create.

4. Select a task type from the Type drop-down list.

The task will be classified based on the type that you select. This will enable 
you to search for tasks belonging to a particular type.

5. Type in a subject for the task, and optionally enter a description for the task.

6. Select a priority for the task, and select a status.

7. Select the categories. Optionally check the Private check box if you want to 
make the task private.

8. Optionally Select a Parent Task if any. Doing this will make the existing task a 
subtask of the selected parent task.

9. Optionally check the Notify check box.

10. In the Dates region of the page, optionally select the time zone.

11. Select Planned, Scheduled, or Actual dates, and select the corresponding Start 
Date, Start Time, End Date, and End Time.

12. In the Assign To region of the page, select the Resource Type from the Assignee 
drop-down list.

13. Select the Name from the LOV. The list displayed depends upon the Resource 
Type that you select. After you select the name, the Job Title, Phone, and E-mail 
details default in.

14. In the Customer region of the page, select the Type, Account, Name, and 
Address 1.

15. Optionally enter the phone number, and the address of the organization, if you 
must enter any other phone number and address that does not exist in the 
application for the selected customer.

16. Optionally select a Phone Number, and enter an e-mail address.

17. In the References section, optionally select the Type, and Name, and enter the 
description.

18. Click Create.

19. Click Create and Create Another to create another task immediately.
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12.1.4 Adding and Modifying an Attachment
The following procedure describes how to add an attachment to an offer. You can 
also use this procedure to add an attachment for any other trade promotion object.

Prerequisites
An existing offer.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Trade Planning > Offers.

2. Click the hyperlink of the offer.

3. Click the Collaboration side navigation link, and then click Attachments.

4. Click Create.

5. Enter a Description for the attachment.

6. Select from one of the following options:

– File: to add an existing file as an attachment.

– Text: to enter text and add it as an attachment.

– URL: to add a url as an attachment.

7. Click Create.

All the attachments that are added to the offer are listed in the Offer Details - 
Attachments page. To modify an existing attachment:

1. Select the attachment, and make the required changes.

2. Click Update.

12.1.5 Adding or Removing a Contact Point
Contact points for trade promotion objects serve as a reference to direct customers 
for further information. You can specify contact points for a budget, offer, or claim. 
A trade promotion object may have any number of contact points. Contact points 
can be defined for one of the following:

User: The selected individual becomes the contact point.

Team: All the individuals who belong to the specific team become the contact 
points.
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This procedure describes how to create a contact point for an offer. Use this 
procedure to create contact points for any object.

Prerequisites
An existing offer.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Trade Planning > Offers.

2. Click the hyperlink of the offer.

3. Click the Collaboration side navigation link, and then click Contact Point.

4. Select a contact type (Address, E-mail, and so on), and select a value from the 
Name LOV. The values that appear in the name LOV depend upon the contact 
type that you select.

5. To remove a contact point, click the corresponding Remove icon.

6. Click Update.

12.1.6 Adding or Removing Groups and Users From an Offer
The Team option enables you to add or remove other groups or users to the 
activities of budgets, offers, quotas, or claims. By using this option, you can assign 
access to team members. The access that the group or team member gets depends 
upon the group type that the team member belongs to.

For example, if you add the Administrator Group to a budget, then all the team 
members belonging to that group will have administrator rights on the budget.

The following procedure describes how to add users to an offer. Use this procedure 
to add users to any other trade promotion object.

Prerequisites
An existing offer.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Trade Planning > Offers.

2. Click the hyperlink of the offer.
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3. Click the Collaboration side navigation link, and then click Team.

4. Select either User or Role from the User/Role drop-down list, and select the 
appropriate value.

5. Optionally check the Edit Metrics check box.

6. Click Update.

12.2 Security and User Types
Oracle Trade Management provides different access levels based on the security 
group. Under this rule, the owner of the an object such as a claim, budget, offer, and 
so on, can change the all the fields including the Owner field. A member of the 
security group can update claim information except the Owner. A non-member 
cannot update any field. An application profile option is also provided to disable 
this feature, if necessary.

The security of the object is ensured by dividing the users into different types. Each 
user type has defined access permissions that determine the actions that users can 
perform on the claim. Only those users who create or own the trade management 
object can view and update parameters of the respective object. The authority to 
view and edit an object also depends on the hierarchy.

For example, a Vice President of Sales or a Regional Sales Director may view and 
update objects, such as offers that belong to their reporting subordinates. Offer 
owners can select users to view the promotional activity vertically through the sales 
hierarchy while limiting visibility across the hierarchy. For example, peer Sales 
Representatives of the same region who manage separate account bases may be 
denied editing rights, and in some cases viewing rights to each others promotional 
activities.

Table 12–1 describes the different user types and the access levels in Oracle Trade 
Management. These user types apply to all the modules in Oracle Trade 
Management.

Table 12–1 User Types

User Type Access Level

AMS:Admin Group Update all the fields:

■ Including the fields that are locked by locking rules

■ Excluding the fields that are locked by the system
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12.3 User Profile Overview
Oracle Trade Management includes a few attributes that you may modify. The 
Profile link in the top right corner of the page displays a profile page with items 
such as passwords, calendar preferences, navigation preferences, default currency 
and other attributes.

Access to many of the tabs is controlled by a responsibility. Each user is given a 
responsibility which determines what tabs are displayed and what rights a user 
may have. You can modify user profiles based on your preferences. The changes 
that you make to your user profile do not affect the functionality of the application.

Topics included are:

■ Section 12.3.1, "Changing Password"

■ Section 12.3.2, "Setting Calendar Preferences"

■ Section 12.3.3, "Personalizing Navigation and Display"

■ Section 12.3.4, "Setting Application Preferences"

12.3.1 Changing Password
Use the following procedure to change your password.

Owner Update all fields:

■ Including the Owner field

■ Excluding those locked by system

■ Excluding those locked by locking rules

The Owner can add team members

Team Member with Edit 
Metrics

Update all fields:

■ Excluding the Owner field

■ Excluding those locked by system

■ Excluding those locked by locking rules

A Team Member with Edit Metrics can add team 
members

Team Member without Edit 
Metrics

View the object (budget, offer, claim, and so on)

Table 12–1 User Types

User Type Access Level
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Prerequisites
None.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and click 

the Profile link.

2. Navigate to Account Setting > Change Password.

3. Enter your current password and the new password.

4. Re-enter the new password.

5. Click Update.

12.3.2 Setting Calendar Preferences
You can set your calendar preferences to modify the manner in which the calendar 
items are displayed in your personal calendar. You can modify the weekly setup, 
add new resources to your calendar, create new groups, and subscribe to group 
calendars.

Prerequisites
None.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and click 

the Profile link.

2. Click the Calendar tab.

3. To modify the manner in which the calendar items are displayed:

a. Click the Personalize horizontal navigation link.

b. In the Calendar Personal Preferences page, modify the details as required, 
and click Update.

4. To add new users to the activities of your calendar:

a. Click the Privileges horizontal navigation link.

b. Search either by resource name or username to grant access to other users
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If you would like the user only to view your calendar, then add the user 
under the View Only Access region. If you wish to grant the user complete 
access to your calendar, then add the user under the Full Access region.

c. Click Update.

5. To create a new subscription group or to subscribe to an existing group:

a. Click the Group Calendar horizontal navigation link.

b. To create a new group, click Request New Group.

c. Enter a Group Name and Group Description, and click Send Request

You will receive e-mail notifications when you submit your request and 
after the request is processed.

d. To subscribe to an existing group, click Subscribe To Group.

e. Select a Group Name; the description defaults in.

f. Optionally select a Display Color.

In your calendar, the group will be displayed in the color that you select 
here.

g. Optionally add a Prefix Event Title.

6. To change your calendar views, click the Switch Calendar horizontal 
navigation link, and click Switch Calendar.

7. To change your time zone, click the Time Zone horizontal navigation link, 
select a time zone, and click Update. 

12.3.3 Personalizing Navigation and Display
Navigation preferences, display preferences, and quick menu enable you to switch 
responsibilities and set default responsibilities, specify the manner in which data 
must be displayed, and customize the quick menu.

Prerequisites
None.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and click 

the Profile link.
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2. Click the Personalization tab.

3. Click the Navigation Preferences horizontal navigation link.

a. To switch responsibilities, select a responsibility from the Current 
Responsibility drop-down list, and click Update.

b. To set a default responsibility, select a responsibility from the Default 
Responsibility drop-down list, and click Update. This is the responsibility 
with which you will log in next time.

4. To customize the data display, click the Display Preferences horizontal 
navigation link, modify the details as required, and click Update.

5. To customize the quick menu, click the Quick Menu horizontal navigation link.

a. Move the required items from the Available menus to the Favorite menus.

All the items that you move will be added to the Quick menu.

b. Click Update.

12.3.4 Setting Application Preferences
Application preferences enables you to set general preferences for data display, and 
also specify the default searches that each of the tabs in Oracle Trade Management 
must display. Use the following procedure to set application preferences.

Prerequisites
None.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and click 

the Profile link.

2. Click the Trade Management tab.

3. Click the General horizontal navigation link, and set general preferences for 
data display as follows:

a. Select a Country and Time Zone.

b. Select a value from the Search Screen Rows drop-down list.

This is the number of rows that will be displayed whenever you perform a 
search.
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c. Select either Yes or No from the Enable Tip Text drop-down list.

If you select Yes, then tip text will be displayed for all the pages.

d. Select either Yes or No from the Enable Record Count drop-down list.

e. Select whether you would like to view the side navigation links for the 
pages.

4. To specify the default searches that each of the tabs in Oracle Trade 
Management must display, click the respective horizontal navigation link.

a. A list of all searches that you have created for the tab are displayed. For 
example, if you click the Offers horizontal navigation link, then all the 
searches that you have created for offers will be displayed here.

b. Select the search that you would like to set as default.

c. Click Update.

12.4 Trade Profile
Manufacturers may deal with multiple customers. Each customer may have 
different preferences for payment, such as different means, methods, and frequency 
for payments. Trade profile of a customer can store the frequency for paying a 
customer, the customer's preference for receiving the payment in check or in credit, 
as well as any threshold amount whereby a customer gets paid only if the 
customer's accruals reach the threshold limit. Based on these preferences and 
schedule setups, you can set Autopay to periodically reimburse customers for their 
accruals.

Trade profile of a customer serves the following main purposes:

■ Link to Vendor Setup

The Administrator can link a customer with the vendor setup in Oracle 
Payables so that the related claims can be settled with checks.

■ Assigning Days Due

If claims are not settled on time, they become disputed items in Oracle 
Receivables. To avoid such situations, the Administrator may establish a time 
period for claim settlement.

For example, your organization determines that all claims for an important 
customer must be resolved with 15 days from the time they are created. In the 
customer's trade profile, the default days due is assigned as 15 days. When a 
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claim for this customer is created on January 1st, it automatically gets a due 
date of January 16th.

12.5 System Parameters
System Parameters define the basic functionality for budgets, offers, and claims. 
System Parameters includes the following components:

■ Set of Books

When you create a budget, offer, or claim in Oracle Trade Management, you can 
define it in any currency. In the background, however, a functional currency is 
always recorded with the budget. The functionality currency is the main 
currency used by a Set of Books. In cases when the exchange type is unclear, the 
currency that is specified in the System Parameters will be used. The GL 
postings are created in the functional currency.

■ Accounting

GL integration parameters are determined in the System Parameters. 

■ Sales or Expense or Charge Account

When accruals are created either from a Lump Sum, Accrual, Scan Data or 
Volume offers, such accruals may be treated as liabilities by some companies. 
These accruals are tracked in the General Ledger. Oracle Trade Management 
provides GL integration by creating the accounting entries--Debit Sales or 
Expense or Charge, and Credit Liability.

The accounting entries that are created by Oracle Trade Management during 
accrual use the GL accounts from the following setups:

■ As defined on a budget itself

■ According to any Account Generator workflow updates. For more details 
on the Account Generator Workflow, see Section 9.6.15, "Advanced General 
Ledger Integration" in the Budgets chapter. 

■ As defined in the System Parameters

■ Accrual Liability Account

Liabilities represent the monetary obligations of an organization. When accruals 
are created either from a Lump sum, Accrual, Scan Data, or Volume offers, such 
accruals may be treated as liabilities because the customers will ultimately claim 
the amount through claims or deductions.
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These liabilities are tracked in the General Ledger. Oracle Trade Management 
provides GL integration by creating the accounting entries--Debit Sales or 
Expense or Charge, and Credit Liability. Crediting the liability account means 
that the liability balance will be increased.

■ Receivable Clearing Account

When a claim or deduction is created and associated to promotional accruals, 
during claim settlement, if the settlement method is a credit memo, the GL 
entries--Debit Liabilities, and Credit Receivables Clearing are created. While the 
Liabilities account that is used will be the same as the account used at the time 
of accruals, the Oracle Receivables clearing accounts that will be used during 
claim settlement will be taken from the following setups:

■ As defined on the Claim Type

■ According to the Account Generator workflow updates.

■ As defined in the System Parameters

■ Vendor Clearing Account

If a promotional claim is settled by a check instead of a credit, the GL 
entries--Debit Liabilities, and Credit Vendor Clearing are created. While the 
Liabilities account that is used will be the same as the account used at the time 
of accruals, the Oracle Payables clearing account that is used during claim 
settlement will be taken from the following setups:

■ As defined on Claim Type

■ According to the Account Generator workflow updates.

■ As defined in the System Parameters

System Parameters enables the Administrator to setup the following information 
for claims:

■ Claim Reason

When a deduction or an overpayment comes through Oracle Receivables, the 
claim reason is often not supplied by the customer's remittance and therefore 
the claim reason is unknown when the claim is created. In such cases, the Claim 
Reason selected in the System Parameters will default on the deductions or 
overpayments.

For example, the Administrator in an organization can set it up such that all 
deductions and overpayments that do not have a reason are created with the 
claim reason--"Unknown Claim Reason".
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■ Claim Type

When deductions or overpayments come through the Oracle Receivables, 
sometimes, the claim type is not captured. Such claims will therefore be created 
with the claim type defaulted from the System Parameters page.

For example, the Administrator in an organization may set such claim types as 
Unknown Claim Type, To be Determined, and so on.

■ Days Due

The number of days due determines the due date of each claim. If this is not set 
up for customers, the due date can be defaulted from System Parameters. When 
a claim is created, the days that are due according to the customer's Trade 
Profile will first be assessed to determine the due date of the claim. But if that is 
not assigned, the number of days due that is set up in the System Parameters 
will be used to derive the due date of the claim.

■ Default Owner

An owner of a claim is the person responsible for driving a claim to resolution. 
Claims may be assigned based on various criteria such as claim type, reason, 
customer or geographical attributes. In cases when certain claims are created 
and for various reasons the claims assignment territories fail to assign an owner, 
it is still imperative that a default owner be assigned. This default owner may 
be an Administrator or a Claims Analyst who will be responsible for resolving 
the claims or for finding the proper owners.

12.6 Custom Setups, Mandatory Rules, and Locking Rules
Topics included are:

■ Custom Setups

■ Mandatory Rules

■ Locking Rules

Custom Setups
Custom Setups generally serve the following purposes:

■ Defining the prefix for the source code or number (a unique identifier for a 
budget, offer, or claim)

■ Determining the layout of the navigation items on the side navigation bar
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■ Determining whether a budget, offer, or claim requires approval

For a budget, however, the last function does not apply since a budget almost 
always requires approval. The only time when a budget does not require approval 
is when the one and only approver according to approval rule setups is actually the 
budget owner himself.

Mandatory Rules
Mandatory Rules enable you to control data entry by mandating that certain fields 
must always be entered on screen by users. In addition to data mandated by 
system, mandatory rules can be created to make other data fields mandatory.

For example, Business Unit in a budget is not a system mandatory field. Ordinarily 
users have a choice to select value for it or not. If the Management wants to ensure 
that users always select value for this for reasons such as proper classifications, 
reports, and so on, a mandatory rule may be created for Business Unit.

Locking Rules
Locking Rules are another way for organizations to control data entry by 
disallowing updates to certain data at certain statuses.

For example, you cannot update certain fields and information after an offer 
becomes active because they are locked.

Note: By design, locking rules are ignored for the Oracle Trade 
Management Super User responsibility. Whenever a user is logged 
in as Oracle Trade Management Super User, the user can update the 
fields that are locked.
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A
Home Page and Calendar

This appendix describes the components in the Oracle Trade Management home 
page. It also explains how to use the Calendar.

Sections in this chapter include:

■ Section A.1, "Home Page"

■ Section A.2, "Calendar"
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A.1 Home Page
Topics included are:

■ Section A.1.1, "Tools"

■ Section A.1.2, "Marketing"

■ Section A.1.3, "News and Encyclopedia"

■ Section A.1.4, "Resources and Reports"

A.1.1 Tools
The Tools page contains links to External Tools and Internal Tools. External tools 
include all the links and applications that you can access from outside Oracle Trade 
Management. The options that appear here depend upon the implementation 
setups.

Internal Tools include the following:

■ Territory Lookup: Enables you to find an organization and know which 
territory it belongs to.

■ Events: Enables you to search for records of active events.

A.1.2 Marketing
The Marketing page includes links to the following information. The options that 
appear here depend upon the implementation setups.

■ Deliverables: Includes category wise links to lists of all the deliverables that 
exist within Oracle Trade Management.

■ Event Schedules: Includes categorizes links to lists of all the event schedules 
that exist within Oracle Trade Management.

■ Offers: Includes links to all the offer types that exist within Oracle Trade 
Management. You can view the list of all offers belonging to a particular offer 
type by clicking on the relevant link. For example, click the Accrual link to view 
all accrual type of offers that have been created.

■ Campaign Schedules: Includes category wise links to lists of all the campaign 
schedules that exist within Oracle Trade Management.

■ Pricelists: Includes links to all the pricelists. The pricelists are classified based 
on their currency type. All the pricelists that are of a specific currency type are 
grouped accordingly. To view all the pricelists of a specific currency, click the 
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respective currency. For example, click Australian Dollar to view all the 
pricelists that have currency type = Australian Dollars.

■ Products: Includes a category wise listing of all the products that exist within 
Oracle Trade Management

A.1.3 News and Encyclopedia
You can access the latest news from the News page. The information that appears 
here is based on the news preferences setting in your organization.

The Encyclopedia page contains links to My Channels, Categories, Publish, and 
Administration. The Encyclopedia sub tab is set up by using the Oracle Marketing 
Encyclopedia System. The options that appear here depend upon the 
implementation setups. The following sections briefly describe the significance of 
each of these links, and the tasks that you can perform. See the Oracle Marketing 
Encyclopedia System User Guide for more information.

My Channels
Channels are the lowest level in the hierarchy of categories that contain published 
items. My Channels screen displays all the categories and channels to which you 
have subscribed. The My Channels link includes the following:

■ My Group Channels: Enables you to view information such as links and reports 
with respect to a specific channel of information. For example, you can view 
information and useful links related to a specific channel, say, Sales and 
Marketing.

■ My Territories: Enables you to view different territory hierarchies.

■ My Messages: Enables you to view all your messages.

■ My Published Items: Published items are all the items such as notes and tasks 
that have been published. Publishing items to a specific team or group enables 
all the team members belonging to the group to view these items. My Published 
Items enables you to remove published items from the repository and select a 
specific item to edit by clicking on it.

Categories
Categories are a means to store, organize, and distribute different types of content 
items such as Company News, Marketing, and Sales in the Oracle Marketing 
Encyclopedia System repository. The Categories page enables you to view category 
wise information that is related to your organization. The options that appear here 
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depend upon the implementation setups. It also contains links from where you can 
access your messages, notifications, and approvals.

Publish
The Publish page enables you to publish an item type of a file, URL, or a message to 
various categories or groups. See the Oracle Marketing Encyclopedia System User 
Guide for more information.

Administration
The Administration page enables you to perform the following tasks:

■ Create and manage content types for published items.

■ Create and manage new categories, and groups.

■ Establish hierarchical relationship among categories.

■ Create and manage perspectives for published items.

■ Create and assign properties to new channels, and edit and remove existing 
channels.

■ Assign channel access privileges, and user and group privileges.

See the Oracle Marketing Encyclopedia System User Guide for more information.

A.1.4 Resources and Reports
The Resources page enables you to search for Employees, Groups, and Teams. You 
can perform the following tasks by using this option:

■ Search for an employee, and view the employee details along with the 
organization structure. You can view and add skill sets to the employee’s 
profile. You can view the Role History of the employee and find out in what 
capacities the person has worked in your organization. You can also view the 
list of groups of which the employee is or has been a member of.

■ Search for a specific group, and view the group details such as the list of 
members belonging to specific group. You can view the group hierarchy 
including the child and parent groups if they exist. You can also view a list of all 
the group members.

■ Search for employees with a specific set of roles. For example, you can find a list 
of employees who are the Managers and also the Administrators.

■ Search for teams and view team-related information.
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The Reports page includes a number of reports that are related to the business 
activities of your organization. You can access these reports by navigating to Home 
Page > Reports.

A.2 Calendar
Calendar enables you to create and manage appointments for your activities. By 
using the calendar, you can:

■ Choose from the different calendar views, and view public calendars.

■ Create and view notes and attachments.

■ View availability of other team members, and send them e-mails.

■ Create and view appointments for current and future dates.

Topics included are:

■ Section A.2.1, "Calendar Views"

■ Section A.2.3, "About Public Calendar"

■ Section A.2.4, "Creating an Appointment"

A.2.1 Calendar Views
The different calendar views that are available are Daily, Weekly, Monthly, and 
Yearly, and Combination. The calendar view that you select determines the manner 
in which the dates and appointments will be displayed. For example, if you select 
Daily, you can view the calendar for the current day only, whereas if you select 
Weekly, you can view the calendar for the current week.

Combination view enables you to see the calendar for the current day and a list of 
all your tasks. You can view the task details, and also create or remove tasks from 
this screen.

A.2.2 Adding a Team Member and Checking Availability
By using the calendar, you can check the availability of a team member. You can 
must add team members to your calendar in order to view their availability. Use the 
following procedure to add new team members to your calendar and check their 
availability.
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Prerequisites
None.

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Calendar > Views.

2. Click the Availability side navigation link.

If there are any existing team members, you can see their names, and their 
schedules for the current day. All the time periods without appointments will 
be highlighted as Available. If there are any appointments for any of the time 
periods, then the respective time period will be highlighted as Unavailable.

3. To add a new team member to your calendar, click Add Resource.

4. In the Lookup page, select the name of the team member whom you would like 
to add.

5. Click Add.

6. Repeat the previous two steps to add another team member.

A.2.3 About Public Calendar
Public calendars are group calendars that can be accessed by members of a 
particular group. For example, the sales management team in an organization can 
have a public calendar called Management Calendar that includes meeting and 
presentation appointments for all the managers. Each of the managers can subscribe 
to this group to view the activities that are related to this calendar.

See Chapter 12, "Common Components" for information on how you can subscribe 
to public calendars.

A.2.4 Creating an Appointment
When you create an appointment, you will receive e-mails reminding you about the 
appointment. Use the following procedure to create an appointment.

Prerequisites
None.



Calendar

Home Page and Calendar A-7

Steps
1. Log into Oracle Trade Management as Oracle Trade Management User and 

navigate to Calendar > Views.

2. Click the Appointments side navigation link.

3. Enter a name for the appointment.

4. In the Start Date field and Start Time field select the date and time for the 
appointment, and select a Time Zone.

5. Optionally select a duration for the appointment.

6. Select an appointment type from the Type drop-down list.

7. Optionally select a Priority and Category.

8. Select a Reminder option from the Remind Me drop-down list.

9. Optionally enter a description, and optionally add a person in the References 
region.

10. Click Create.

11. Click Create and Create Another to immediately create another appointment.
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Glossary

Accrual

An allowance, which is accumulated by manufacturers or suppliers, for their 
retailers or distributors. Accruals are generally calculated as the percent of invoice 
price of products sold to the retailers or distributors. It is the practice of accounting 
for transactions ahead of time when money exchanges hands.

Administration

A main tab in Oracle Trade Management that gives access to a variety of 
administrative functions.

Administrator

The person who has access to the Administration tab in Oracle Trade Management. 
The Administrator is responsible for all the implementation setups, and running 
and scheduling concurrent programs.

Approval Rule

Rules that are created in Oracle Trade Management (and also in other parts of the 
Oracle E-Business Suite), to control the routing and sequence of approval requests. 
This means that users do not have to manually select the correct approver. They can 
simply submit a request for approval, and it gets routed to the designated approver 
according to the approval rules.

Associate Earning

The action of linking the customers’ earnings to Claims or Deductions. The terms 
"earning" and "accrual" are used interchangeably in Oracle Trade Management.
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Attachment

Electronic document that can be uploaded or linked to Oracle Trade Management. 
Other users can download these attachments.

Attachment Type

When attachments are added at various levels within Oracle Trade Management, an 
attachment type such as file, URL, or text must be selected.

B2B

Business-to-Business.

B2C

Business-to-Consumer.

Beneficiary

A customer who is different from a qualifying customer, but who is eligible to 
receive payments and earnings.

Budget Source

Names of budgets that are created in Oracle Trade Management. You can request 
funds from various budget sources to cover costs of offers, special pricing requests, 
soft fund requests, chargebacks, and third party accruals.

Budget Source Value

The amount being requested or approved from a budget source.

Budget Thresholds

Alerts that can be raised when a budget is being depleted too quickly or too slowly.

Business Rules

The rules and guide lines that govern how an organization uses an Oracle product.

Business Unit

A grouping of users within the application, defining the organizational structure.

Charges

Charges include the money spent by organizations to run their business. In Oracle 
Trade Management, the terms "charges" and "expenses" are used interchangeably.
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Claim System Parameters

A collection of settings that govern how claims are processed by the system.

COGS

Cost of Goods Sold.

Cost

Expenditure incurred by trade promotion and sales activities. These expenditures 
can be paid immediately, or be accrued and paid later.

Credit

Credit and Debit are two entries for an accounting transaction.

CSV File

A comma delimited data file type.

Data Sources

Field maps for external data sources.

Debit

Debit and Credit are two entries for an accounting transaction.

Delayed Discounts

Discounts that are given without reducing the amounts invoiced. Customers can get 
the money later by submitting a claim, or through a deduction, or automatic 
payments. In Oracle Trade Management, delayed discounts are also called Accrual 
Offers.

Discoverer

Oracle’s data query tool.

Display Priority

A business attribute of the posting’s content type used to prioritize the 
recommended content for display, based on business objectives. For example, 
prioritize the recommended products based on price, and display the highest priced 
product.
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DNC

Do Not Contact. A flag in marketing databases and lists indicating people who do 
not wish to be contacted.

Flat File

See CSV File.

Funds Accrual Engine

The program that manages all the accruals in Oracle Trade Management.

Interaction

Any interaction (or touch point) with a customer or prospect. For example, contacts 
may be targeted, and they may respond, register, attend, and evaluate (dependent 
upon the activity type). Interactions may later be qualified and rated, and may 
become leads.

General Ledger

The system that holds all the records of accounting transactions. Financial 
statements are built up in this system.

General Ledger Account

The General Ledger Account records and summarizes the accounting transactions.

General Ledger Journal Entry

An accounting record.

General Ledger Posting (GL Posting)

An official entry that affects the financial position of a company.

Interaction Import

A functionality in Oracle Telesales that will allow interactions and/or new 
customer/prospect records to be imported from pre-defined format flat files into 
customer master records.

Intersect

A value that is used in List Build and Selection. Use this option to create a selection 
that includes only the intersect (overlap) of two chosen lists.
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Oracle iStore

An Oracle product that is designed for producing electronic commerce websites.

Item

A product that is set up in Oracle Inventory. The terms "item" and "product" are 
used interchangeably in this document.

Item Category

A way to group or classify items in Oracle Inventory. An item category may consist 
of multiple segments. Categories can be grouped by category sets. Each item can 
belong to multiple categories. The term "item category" is used interchangeably in 
this document with the term "product family".

JSP

Java Server Page.

JTF

Java Technical Foundation.

Lead

A qualified sales opportunity that results from a trade promotion or sales activity.

Liability

This is a balance sheet item which represents a monetary obligation that the 
company has.

Lists

Lists of customers or prospective customers that may have demographic or 
previous purchase history information associated with the people or companies on 
the list.

List Import

A function in which external data, such as a rented or purchased list, may be 
permanently or temporarily added to an organization’s internal customer and 
prospect data.

List Import Table

A database table where records imported from a rented or purchased list are stored. 
Records may be added to TCA from the List Import Table.
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LOV

List of Values.

Manufacturer

Manufacturer in Oracle Trade Management, is the organization that manufactures 
the products. In Oracle Partner Management, a manufacturer is known as a Vendor.

Margin

Gross Profit divided by Sales. Margin is communicated in terms of a percentage.

Multi Org

Used to describe the capabilities of the Oracle E-Business Suite in dealing with 
multiple organizations/languages/currencies, etc.

Partner

Term used in Oracle Partner Management to represent either a wholesaler or 
retailer.

Promotion

The terms "offer" and "promotion" are used interchangeably. A promotion is a 
discount that is offered on the products to entice the customers to purchase them.

Promotional Accrual

The terms "promotional accrual", "accrual", and "earning" are used interchangeably 
in Oracle Trade Management.

Object

Oracle Trade Management uses the term "object" to refer to various building blocks 
used in the application. These include Quotas, Quota Allocations, Budgets, Budget 
Allocations, Offers, Campaigns, and Products.

OC or OM

Order Capture or Order Management, a part of the Oracle E-Business Suite 
allowing orders to be created and passed for fulfillment.

Operating Unit

An organization under a legal entity that secures data for applications such as 
Order Management, Oracle Receivables, Oracle Payables and others. Each 
responsibility in Oracle applications is tied to a specific operating unit.
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Organization

A company (or other logical grouping of contacts) in TCA

Owner

The name of the person within Oracle who owns or is responsible for the Oracle 
Trade Management object.

Page

A logical entity describing a JSP template or an HTML page.

Personalize

A function that allows an Oracle Trade Management user to personalize many 
screens, to produce a listing of chosen columns only, and/or to filtered or select 
specific data only.

PHP

Personal Home Page.

Product

A main tab in Oracle Trade Management, that gives access to create and manage 
products, product hierarchies, and product pricing in the Oracle E-Business Suite.

Product Family

A value in several pick lists, giving a choice of products. Messages, campaigns, 
events and deliverables may all be associated with specific product families.

Program

A rollup folder to group together campaigns and events. Any number of programs 
can be created, to produce a program hierarchy.

Receipt

A record in Accounts Receivables to track a customer's payment.

Revenue

Money, which is gained by companies. Revenue represents cash inflow. The terms 
"sales" and "revenues" are used interchangeably in Oracle Trade Management. 
However, there may be revenues that are not directly linked to sales.
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Remittance

Remittance is the payment that customers make for the goods and services that they 
have purchased.

Retailer

Retailer is the organization that sells the manufacturer’s products to the 
end-customer. A retailer can buy products either from the manufacturer or the 
wholesaler.

Related Products

Related products are user-defined links between different products. You can 
associate an unlimited number of product relations. Related products are used by 
various Oracle applications. For example, a call center agent using Oracle TeleSales 
can use related products to identify cross-sell or up sell opportunities, and 
prerequisites.

Response

Any communication back from a customer or prospect. After qualification, a 
response can become a lead. A response that cannot be qualified as a lead can be 
further targeted with lead maturation programs.

Return

Another term used to describe Profit. The difference of the selling price of an item 
and the items costs.

ROI

Return on Investment. ROI may be communicated in terms of value (dollars) and 
also as percentage. ROI may be defined as the cost of a promotional event in Oracle 
Trade Management.

Sales

The terms "sales" and "revenues" are used interchangeably in Oracle Trade 
Management.

Sales Management

Team of individuals who plan and monitor the sales activities in an organization. 
Sales Management is the top level hierarchy in a sales team.
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Sales Representative

Sales team member who achieves the sales targets that are allocated by the Sales 
Management. Sales Representative is the person who drives the field sales activities 
in a territory or region.

Segment

Segments represent specific sub-divisions of the total audience.

SIC

Standard Industrial Classification.

SQL

Structured Query Language

Status

Seen in many places within Oracle Trade Management, the status field shows where 
the quota, budget, or an offer, event, schedule, deliverable is in the approvals 
process.

Third Party

A manufacturer may deal with retailers and end-customers indirectly through 
wholesalers. In such cases, the retailers and end-customers are referred to as Third 
Parties.

Trade Promotion Activity

Trade promotion activity can be any form of activity such as an offer or a campaign 
that aims at promoting the products and increasing sales.

Trading Community Architecture (TCA)

The Oracle customer model (or schema), that serves as a single repository for all 
data about organizations, customers, contacts, partners, vendors, and relationships.

Trade Promotion Object

See Object.

UI

User Interface.
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Unearned Payments

These are claim payments that are made to a customer above what the customer has 
earned.

UOM

Unit of Measure.

URL

Universal Resource Locator.

Vendor

Term used in Oracle Partner Management to represent a manufacturer.

Wholesaler

A wholesaler organization is the one that directly buys the products from the 
manufacturer, and sells it to the wholesalers and the actual end customers.

Word Replacement Rules

Rules that govern the comparison of entries during list import to determine 
whether a duplicate entries is being imported.

Word Standardization or Word Replacement

In order to successfully deduplicate a list, words such as street identifiers (Avenue = 
Ave), first names (William = Bill), and States (California = CA) will be temporarily 
standardized for the purposes of comparison. The use of Word Standardization 
does not change the text of the actual records. Names of organizations may 
similarly be temporarily standardized.

Workbook

A term used in Oracle Discoverer. A workbook represents selection criteria that will 
be applied against records in the database.

Workflow

Oracle Workflow is a product that is used to track and relay approvals and 
notifications according to business rules.

Worksheet

A spreadsheet of customers or prospects, or both, that is extracted from a database 
by Oracle Discoverer.
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Index
A
account manager dashboard, 6-1

account allocation, 6-15
account plan, 6-21
account planning, 6-20

account plan, 6-21
activities region, 6-21
discount calculator, 6-10
Gantt chart, 6-22
offer evaluator, 6-9
offer worksheet, 6-9
sales graphs, 6-22

budget summary, 6-7
viewing, 6-7

claim summary, 6-7
viewing, 6-7

competitors’ products, 6-23
updating, 6-6, 6-23

discount calculator, 6-10
Gantt chart, 6-22
key performance indicators, 6-4
KPI, 6-4
my accounts, 6-5
my products, 6-5
offer evaluator, 6-9
offer worksheet, 6-9

evaluating offers, 6-12
quick links, 6-5
regions, 6-4

personalizing, 6-8
retail pricing, 6-23

updating, 6-6, 6-23
sales graphs

viewing, 6-22
sales performance, 6-5
target allocation, 6-15

product spread, 6-17
thresholds, 6-5

accrual liability account, 12-15
accrual offer, 7-5
accrual parameters, 9-8
advanced options, 7-26

specifying, 7-29
application preferences

setting, 12-13
associated earnings, 10-12
attachments, 12-4

adding and modifying, 12-7
auto assign owner, 10-31
autolockbox, 10-18
automatic write-off, 10-58

viewing claims eligible for automatic 
write-off, 10-60

autopay, 10-55
running, 10-56
viewing autopay log, 10-58
viewing autopay request, 10-58

B
backdating offers, 7-37
base sales, 7-40
base volume, 7-44
base volume source, 7-44
beneficiary party, 7-28
budget summary, 6-7
budget thresholds, 9-10
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adding, 9-13
budget-offer validation, 9-17

relax customer, 9-18
relax product, 9-18

budgets, 9-1
adjustments, 9-44

creating, 9-46
decrease committed, 9-45
decrease committed and utilized, 9-45
increase committed, 9-45
increase committed and utilized, 9-45

advanced GL integration, 9-55
allocation, 9-26

activating, 9-34
creating, 9-30
process, 9-26
top-down bottom-up budgeting, 9-29

approval, 9-22
approving, 9-25
initiating, 9-25
process, 9-23

basic GL integration, 9-54
budget category, 9-9
budget delete, 9-22
budget mass transfer, 9-41

committed but unearned funds, 9-41
fund period, 9-41

budget request, 9-37
approving or rejecting, 9-41
creating, 9-38

budget transfer, 9-38
creating, 9-40

budget-offer validation, 9-17
relax customer, 9-18
relax product, 9-18

buying groups, 9-15
checkbook view, 9-59
committed but unearned funds, 9-41
copy budget, 9-22
creating, 9-11
customer budget view, 9-64

viewing, 9-65
customers, 9-15

bill-to, 9-15
ship-to, 9-15

sold-to, 9-15
fixed budget, 9-5

creating, 9-11
defining market eligibility, 9-19
updating products, 9-21

fully accrued budget, 9-6
accrual parameters, 9-8
accrue funds for customers, 9-6
accrue funds for sales, 9-7
creating, 9-11
defining market eligibility, 9-20
updating products, 9-21

GL posting details, 9-66
GL postings for off-invoice offers, 9-53
holdback amount, 9-12
integration to sales orders (accrual offers), 9-48
integration to sales orders (off-invoice 

offers), 9-48
market eligibility, 9-14, 9-15

buying groups, 9-15
qualifier contexts and attributes, 9-16

offer checkbook, 9-63
product eligibility, 9-16
recalculated committed, 9-42

viewing, 9-44
reconciliation, 9-56

reconcile un-utilized, 9-56
reconcile un-utilized and unpaid 

earnings, 9-57
reconciling, 9-58

roll-up view, 9-60
segments, 9-16
self view, 9-60
statuses, 9-23
system status, 9-23
territories, 9-16
thresholds, 9-10

adding, 9-13
top-down bottom-up budgeting, 9-29

approving or rejecting a request 
submission, 9-33

submitting a change request, 9-32
transaction drill down, 9-66
updating accounting details, 9-13
user status, 9-24
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utilization, 9-35
buying groups, 9-15

settling claims for, 10-69

C
calendar, A-5

adding a team member, A-5
checking availability, A-5
creating an appointment, A-6
public calendar, A-6
setting calendar preferences, 12-11
views, A-5

campaigns, 8-1
creating, 8-5
processes, 8-3
schedule, 8-2
sourcing budgets, 8-7
status transitions, 8-2
understanding, 8-2

changing password, 12-10
chargeback, 11-3

acquisition cost, 11-9
verification, 11-9

flat files, 11-6
initiating payment, 11-24
item verification, 11-9
lines, 11-6

accepting disputed lines, 11-23
viewing and updating, 11-21

price list, 11-9
verification, 11-9

reconciliation, 11-11
settlement, 11-14
statuses, 11-15
submission, 11-6

importing, 11-20
processing, 11-23

tolerances, 11-10
negative, 11-10
positive, 11-10

validation, 11-8
acquisition cost verification, 11-9
item verification, 11-9
price list verification, 11-9

wholesaler inventory verification, 11-8
wholesaler inventory, 11-8

verification, 11-8
check, 10-65

settling a claim with, 10-72
claim, 10-5
claim summary, 6-7
claims, 10-1

actions, 10-16
approval, 10-33

approving, 10-35
process, 10-33
submitting for approval, 10-35

approving requests for unearned 
payments, 10-52

assignment, 10-31
auto assign owner, 10-31
automatic assignment, 10-31

associated earnings, 10-12
auto assign owner, 10-31

reassigning claim ownership, 10-32
automatic write-off, 10-58

viewing claims eligible for automatic 
write-off, 10-60

autopay, 10-55
running, 10-56
viewing autopay log, 10-58
viewing autopay request, 10-58

buying groups, 10-12
check, 10-65
claim, 10-5

creating, 10-18
mass creating, 10-19
settling claims for buying groups, 10-69
settling claims for related customer 

accounts, 10-68
settling with a check, 10-72
settling with a contra charge, 10-71
settling with an on-account credit 

memo, 10-70
settling with invoice credit, 10-73

claim aging view
viewing, 10-83

claim details, 10-36
claim history, 10-43
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claim history rules, 10-43
claim lines, 10-12
claim report, 10-83

viewing, 10-83
claim settlement history

viewing, 10-84
claim settlement methods, 10-65
claim split

rules, 10-39
splitting, 10-40

claim types, 10-8
classes, 10-5

claim, 10-5
debit claim, 10-5
deduction, 10-6
overpayment, 10-6

contra charge, 10-66
customer reason, 10-10

mapping, 10-10
debit claim, 10-5

creating, 10-18
mass creating, 10-19
settling with a debit memo, 10-74

deduction, 10-6
creating non-transaction related 

deduction, 10-22
creating transaction-related 

deduction., 10-20
non transaction-related, 10-6
promotion-related, 10-6
settling with a return materials 

authorization, 10-79
settling with an on-account credit 

memo, 10-70
settling with chargeback, 10-78
settling with invoice credit or an invoice line 

credit, 10-76
settling with invoice tax only credit, 10-77
settling with previous credit memo, 10-75
settling with write-off, 10-79
transaction-related, 10-6

duplicate claims, 10-41
marking a claim as duplicate, 10-41

invoice credit, 10-76
invoice credit memo, 10-65

invoice line credit, 10-76
invoice tax only credit, 10-77
lines

associating earnings, 10-29
creating, 10-26

lockbox integration, 10-18
mass settlement, 10-53

netting overpayments, 10-54
on-account credit memo, 10-66
Oracle Discoverer, 10-42
overpayment, 10-6

creating, 10-24
netting overpayments, 10-54
settling with an on-account cash 

application, 10-82
settling with debit memo, 10-74
settling with previous debit memo, 10-80
settling with receipt write-off, 10-81

ownership, 10-31
primary owner, 10-31
reassigning claim owners, 10-32
team ownership, 10-31

paying over earnings by thresholds, 10-51
previous on-account credit memo, 10-66
pricing simulations, 10-17
promotional payments, 10-48

creating claims, 10-49
views, 10-49

reasons, 10-9
related customer accounts, 10-12
related documents, 10-41
research tools, 10-36
return material authorization (RMA), 10-66
scan data offer adjustments, 10-44
setups for integration purpose, 10-8
split, 10-37
standard memo lines, 10-66
statuses, 10-33
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